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Preface

The TraceFinder 2.1 application is the newest application in the series of Thermo Scientific 
GC/MS and LC/MS analytical software.

 To suggest changes to documentation or to Help

Complete a brief survey about this document by clicking the button below.
Thank you in advance for your help.

Related Documentation
TraceFinder includes Help and these manuals as PDF files: 

• TraceFinder User Guide

• TraceFinder Administrator Quick Reference Guide

• TraceFinder Acquisition Quick Reference Guide

• TraceFinder Analysis Quick Reference Guide

• TraceFinder Shortcut Menus Quick Reference Guide

• TraceFinder Custom Reports Tutorial

Contents

• Related Documentation

• Special Notices

• System Requirements

• System Activation

• Contacting Us

http://www.surveymonkey.com/s/PQM6P62
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 To view TraceFinder documents using the Start menu

Choose Start > All Programs > Thermo TraceFinder > Manuals.

 To open TraceFinder Help and access related documents from the application

1. Open the TraceFinder application and choose Help > TraceFinder Help. 

• To find a particular topic, use the Help Contents, Index, or Search panes.

• To create your own bookmarks, use the Favorites pane.

2. To view the user guide or quick reference guides, choose Help > Manuals> User Guide 
or Quick Reference Guide.

The PDF opens in a new window.

Special Notices
This guide includes the following types of special notices:

IMPORTANT  Highlights information necessary to prevent damage to software, loss of 
data, or invalid test results; or might contain information that is critical for optimal 
performance of the system.

Note  Highlights information of general interest.

Tip  Highlights helpful information that can make a task easier.
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System Requirements
Your system must meet these minimum requirements.

System Requirements

Computer • 2.33 GHz processor dual core with 4 GB RAM
• CD/R-ROM drive
• Video card and monitor capable of 1280 × 1024 resolution
• 75 GB available on drive C
• NTFS format

Instruments 
(supported or 
required)

Autosamplers:
• TriPlus™
• AS3000
• Accela™ AS

GC Devices:
• FOCUS™ GC
• Trace GC Ultra™
• Trace 1300 Series

LC Devices:
• Accela 1250 Pump
• Accela Pump
• Dionex™
• TLX-1
• LX2
• Agilent™ 1100
• Agilent 1200

GC/MS and LC/MS mass spectrometers
Software • Microsoft™ Windows™ XP Professional SP3 

or Windows 7 Professional
• Microsoft Office 2007 SP2 or Microsoft Excel™ 2007 SP2
• Microsoft .NET Framework 4.0 Extended
• Thermo Foundation™ 2.0 SP1
• Thermo Xcalibur™ 2.2 SP1
• Adobe™ Reader™ 10.0
• NIST™ 2008
• Thermo LC Devices 2.5 SP2 or Thermo GC Devices 2.2
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System Activation
When you first start the TraceFinder application, a dialog box displays the number of days 
remaining in your 60-day free trial. If your free trial has expired, the License Activation 
window opens. 

Two types of licenses are available:

• 60-Day Evaluation Version (free of charge)

• Full Version Single License 

The evaluation version is full-featured and automatically expires 60 days after activation. Any 
attempt to set back the system date automatically terminates this version. You can purchase 
and then activate the full version of the TraceFinder application at any time, during or after 
the free evaluation, without reinstalling the software. 

Each activation key is valid only for a single license. Any additional installation generates a 
different license and requires a different activation key.

For questions regarding activation, contact Thermo Fisher Scientific Technical Support in 
San Jose, CA:

• E-mail: ThermoMSLicensing@thermofisher.com

• Fax: 408-965-6120

Note  You can open the License Activation window at any time during your trial period by 
choosing Help > License Activation from the TraceFinder menu. If you already have a 
permanent license, a message tells you that your product is fully licensed.

mailto:ThermoMSLicensing@thermofisher.com
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 To request an activation key

1. In the License Activation window, enter your information in the User Info area.

As you type, the License Text box creates an XML text string with your information.

2. In the Barcode box, type the barcode printed on the TraceFinder CD.

The form of the barcode number is either xxxx-xxxx-xxxx or xxxx-xxxx-xxxx-xxxx.

3. When you finish entering all your information, click Copy.

The application copies this XML text to the Clipboard.

If you have not completed all the information, a pop-up box opens, identifying the 
missing information.

4. Paste this XML text in the body of an e-mail and send the e-mail to 
ThermoMSLicensing@thermofisher.com.

mailto:ThermoMSLicensing@thermofisher.com
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 To use your activation key

1. When you receive your activation key, copy it from the e-mail.

2. Choose Help > License Activation from the TraceFinder menu.

The License Activation window opens.

3. Click Paste.

The application pastes the contents of the Clipboard to the License Text box.

4. Click Set.

The application is activated according to the type of authorization your license gives you. 

Contacting Us
There are several ways to contact Thermo Fisher Scientific for the information you need. 

 To contact Technical Support

Find software updates and utilities to download at mssupport.thermo.com.

 To contact Customer Service for ordering information

 To get local contact information for sales or service

Go to www.thermoscientific.com/wps/portal/ts/contactus.

 To copy manuals from the Internet

Go to mssupport.thermo.com, agree to the Terms and Conditions, and then click 
Customer Manuals in the left margin of the window. 

Note  You must run the TraceFinder application with ITAdmin or LabDirector rights 
when entering the activation key.

Phone 800-532-4752

Fax 561-688-8736

E-mail us.techsupport.analyze@thermofisher.com

Knowledge base www.thermokb.com

Phone 800-532-4752

Fax 561-688-8731

E-mail us.customer-support.analyze@thermofisher.com

Web site www.thermo.com/ms

mailto:us.techsupport.analyze@thermofisher.com
http://www.thermokb.com
http://www.thermo.com/ms
http://mssupport.thermo.com
http://www.thermoscientific.com/wps/portal/ts/contactus
http://mssupport.thermo.com
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 To suggest changes to documentation or to Help

• Fill out a reader survey online at www.surveymonkey.com/s/PQM6P62.

• Send an e-mail message to the Technical Publications Editor at 
techpubs-lcms@thermofisher.com.

http://www.surveymonkey.com/s/PQM6P62
mailto:techpubs-lcms@thermofisher.com
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Introduction

This chapter describes general features of the TraceFinder software.

About the TraceFinder Application
The TraceFinder application targets the environmental and food safety market, creating the 
workflows that laboratories use. It supports a focused workflow for specific nonbioanalytical 
laboratory use, instrument control, and method development functionality in a single 
software package. TraceFinder is the primary application for the TSQ Quantum™ XLS triple 
quadrupole mass spectrometers.

The TraceFinder application can export SRM data in .xml format so that other applications 
can import the files into their databases. 

The TraceFinder application can import the following file types:

• Sample lists in .csv or .xml format

See “Defining the Sample List” on page 255.

• Processing (.pmd) and instrument (.meth) method files from the Xcalibur data system 

See “Working with Master Methods” on page 100 or “Working with Instrument 
Methods” on page 228.

• Compounds from files that use the datastore (.xml) format

See “Adding Compounds, Quantitative Peaks, and Confirming Ions to a Datastore” on 
page 62.

Contents

• About the TraceFinder Application

• TraceFinder Summary of Features

• TraceFinder Workflow

• Reporting Features
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• Batches, methods, or templates from the following applications:

– TraceFinder 1.0

– TraceFinder 1.1

– TraceFinder 2.0

– QuanLab Forms or EnviroLab Forms 2.5

– QuanLab Forms or EnviroLab Forms 3.0

See “Converting Legacy Data” on page 19.

The TraceFinder application checks the accuracy and precision of data against systems that 
have previously been certified against a standard processing program, such as the Statistical 
Analysis System (SAS). 

Supported File Types

The TraceFinder application supports the following file types:

• Comma-separated values (.csv): A set of file formats used to store tabular data in which 
numbers and text are stored in plain textual form that can be read in a text editor. Lines in 
the text file represent rows of a table, and commas in a line separate fields in the tables 
row.

• Extensible Markup Language (.xml): A generic framework for storing any amount of text 
or any data whose structure can be represented as a tree. The only indispensable 
syntactical requirement is that the document has exactly one root element (also called the 
document element). This means that the text must be enclosed between a root start-tag 
and a corresponding end-tag.

• Instrument method (.meth): A proprietary file format for the Xcalibur software suite with 
specific instructions that enable scientific instruments to perform data acquisition.

• Processing method (.pmd): A proprietary file format for the Xcalibur software suite with 
specific instructions on processing data that was acquired through the instruments 
attached to the system.

• Raw data (.raw): The file type for acquired samples on the system.
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TraceFinder Directory Structure

The TraceFinder application creates folders for projects/subprojects/batches and templates in 
the C:\Thermo\TraceFinder\2.1\EFS directory. Within each batch folder, the application 
creates folders for data, methods, and reports.

Figure 1. Example batch directory structure

IMPORTANT  You cannot rename or move the folders created by the TraceFinder 
application.
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TraceFinder Summary of Features
The TraceFinder system provides a workflow-oriented approach to high-throughput 
quantitation. The system uses a batch-centric approach and tools to automate and speed up 
the processes of method creation, loading samples, automatically generating data, manually 
reviewing and editing results, and finalizing the data review and reporting process. 

The TraceFinder software package includes data acquisition, processing, reviewing, and 
reporting capabilities designed to assist analysts in environmental applications. The 
application has a fully automated acquisition mode and a manual data analysis mode. You can 
use the data acquisition system to create and submit batches and monitor real-time review of 
results. 

The TraceFinder application uses a comprehensive processing method to provide improved 
handling of ion ratio calculations, reviewing, and reporting. In addition, it can compare the 
mass spectra and integrate the processes of data review and reporting. 

Key features include the following: 

• Role-based authorization for LabDirector, ITAdmin, Supervisor, Technician, and QAQC 
(quality assurance) roles

• Configuration mode for user administration, project administration, datastore 
administration, and application administration

• Method Development mode for editing instrument methods, setting processing and error 
flag parameters, and setting report options

• Choice of acquisition wizards:

– Acquisition batch mode that guides you in creating batches and running samples

– Batch template wizard similar to the interface used in the EnviroLab Forms 
application

• Analysis mode with batch views, data review, local method views, and report views

• Database-capable method development

• Quantification workflows, supporting capabilities present in the LCquan™ and 
EnviroLab Forms applications

• Standard and customized report formats

Features of the common workflow core include the following:

• Acquisition and processing

• Peak detection

• Quantification to include calibration

• Error analysis and flag setting

• Reporting

• Data persistence

• Raw data file handling
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TraceFinder Workflow
The TraceFinder application is structured with a typical laboratory workflow in mind. You 
create a batch, and the system injects samples into the instrument, runs the samples, analyzes 
the data, and generates a report. You can set up a master method for specific compound 
groups or assays that you expect to run in your laboratory. When you are ready to run a 
particular type of sample, select the appropriate method and begin. 

When using the TraceFinder application, follow these basic steps:

1. Create and save a master method in the Method Development mode. 

A master method combines the instrument method and processing method that define 
how the raw data is acquired and processed, how the error checking information evaluates 
the results, and how the results appear in reports. 

2. Create and submit a batch using one of the batch wizards.

A batch lists samples for processing and reporting using a specified method. Each row of a 
batch represents a unique sample. 

3. Monitor the status of the batch in the Real Time Status view. 

The real-time display is visible from the dashboard and all the TraceFinder modes. You 
can begin another batch while you watch the real-time display of the currently acquiring 
batch.

4. Evaluate the data in the Analysis mode. 

The Analysis mode includes views where you can review batches, batch data, reports, and 
local methods.

5. View and print reports in the Report View of the Analysis mode. 

Use the Report View to view or print the reports for the currently selected batch.

Note  At any time, you can quickly view the system status by looking in the lower 
right corner of the TraceFinder window. This area displays a green, yellow, or red 
status light and a description of the number of samples in the queue (if any). 
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Reporting Features
The report engine can generate several different types of reports designed to meet the needs of 
the laboratory, the laboratory's customers, and key regulatory agencies that might review the 
results. The following types of reports meet the requirements of various methods and 
worldwide regulatory agencies, helping to track the performance of LC and GC systems and 
methods. The reports divide into three groups: Standard, Custom, and Target Screening.

For additional information about standard, custom, or target screening reports and examples 
of each standard report type, see “Reports” on page 423. Examples of standard reports (as 
PDF files) are also located in the C:\Thermo\TraceFinder\2.1\EFS\ExampleReports folder.

Standard Report Types
• Batch Report 
• Batch Report Rev 1
• Blank Report 
• Breakdown Report
• Calibration Report 
• Check Standard Report 
• Chromatogram Report 
• Compound Calibration Report 
• Compound Calibration Report - Alternate
• Confirmation Report 
• Confirmation Report 2
• High Density Calibration Report 
• High Density Internal Standard Report
• High Density Internal Standard Report Long
• High Density Sample Report 1 
• High Density Sample Report 1 Long
• High Density Sample Report 2 
• High Density Sample Report 2 Long 
• High Density Sample Report 3 
• High Density Sample Report 3 Long
• Internal Standard Summary Report 
• Ion Ratio Failure Report 
• LCSLCSD Report
• Manual Integration Report 
• Method Detection Limit Report
• Method Report
• Method Validation Report
• MSMSD Report
• Quantitation Report 
• Quantitation Report - 2
• Solvent Blank Report
• Surrogate Recovery Report 
• TIC Report 
• TIC Summary Report 
• Tune Report
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Custom Report Types

• AltCalibrationReport
• Alternate BatchReport
• Alternate CalibrationReport
• Alternate ConfirmationReport
• Alternate MatrixSpikeReport
• Alternate SampleReport
• Alternate SummaryReport
• BatchReport
• BlankReport 
• CalibrationDensityReport 
• CalibrationReport 
• CheckStandardReport
• CompoundCalibrationReport 
• ConfirmationReport 
• ConfirmationReport2
• HighDensitySampleReport1Long
• HighDensitySampleReport2Long
• HighDensitySampleReport3Long
• HighDensitySampleReport4
• HighDensitySampleReport5
• QuantitationReport
• SteroidAnalysisReport

Target Screening Report Types

Target Screening reports are available only when you install ToxID™ software and enable the 
Target Screening features. For a detailed procedure for enabling target screening features, see 
“Target Screening” on page 90.

• Target Screening Long Report
• Target Screening Summary Report
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2

Getting Started

This chapter includes the procedures for getting started with the TraceFinder application.

Contents

• Installing the TraceFinder Application

• Installing the Power Modules

• Installing the NIST and QED Libraries

• Launching the NIST Library Browser

• Launching the Qual Browser

• Converting Legacy Data

• Choosing a Mode
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Installing the TraceFinder Application
Follow these instructions to install, start, and log in to the TraceFinder application.

 To install the TraceFinder application

1. Insert the TraceFinder CD, open the TraceFinder launcher, and click Next.

The InstallShield Wizard opens.

2. Click TraceFinder 2.1, and follow the instructions in the InstallShield Wizard.

The installer verifies that you have the appropriate versions of the Thermo Foundation 
and Thermo Xcalibur applications and updates them if necessary. 

The wizard continues the installation.

3. When prompted, choose to install either the GC or LC version of the software, as 
applicable.

4. When the installation completes, do not launch the TraceFinder application.

5. Open the TraceFinder launcher again, and click Next.

IMPORTANT  If prompted to install Thermo Foundation, click Yes, and then when 
prompted to restart your computer, click OK. 
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6. Click NIST Library, and follow the instructions to install the NIST library (required for 
ToxID).

When the wizard prompts you to select a destination folder, select C:\Program 
Files\NISTMS.

7. Install the appropriate device drivers, and configure the instruments in the Thermo 
Foundation Instrument Configuration dialog box.

You can now start your TraceFinder application. 

 To install example data

(Optional) Click Example Data, and follow the instructions to install an example project 
that contains example batch data.

 To start the TraceFinder application

1. Configure your instruments.

You cannot configure your instruments while the TraceFinder application is running.

2. Double-click the TraceFinder icon on your desktop, or go to Start > All Programs > 
Thermo TraceFinder > TraceFinder EFS. 

By default, user security is not enabled and the application does not require a password. 
To enable user security, see “User Security” on page 90.

 To log in to the TraceFinder application (when user security is enabled)

1. Enter your assigned user name in the TraceFinder login screen.

Before you can log in to the TraceFinder application, a system administrator must set up a 
user account for you. The administrator assigns you a user name and password and gives 
you permission to access specific modes. 

2. Enter your password.

If your user name or password does not match, the system reports this error:

Correct the user name or password, or contact your system administrator.

3. Click Login.

The TraceFinder dashboard opens. See “TraceFinder Dashboard” on page 35. 

4. To exit the TraceFinder application without logging in, click Exit TraceFinder.

IMPORTANT  If you are the administrator logging in for the first time with user 
security enabled, use Administrator/Password as the username/password. 
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Figure 2. TraceFinder login screen

Table 1. Login screen parameters

Parameter Description

Username The user’s assigned user name.

Password The assigned password for the user name.

Login Verifies the user name and password, and displays the dashboard.

Exit TraceFinder Closes the TraceFinder application without logging in.



 2 Getting Started
Installing the Power Modules

Thermo Scientific TraceFinder User Guide 13

Installing the Power Modules
Follow these instructions to install and enable the TraceFinder power modules for 
multiplexing.

 To install the power modules 

1. Follow the instructions to install the TraceFinder application. 

See “Installing the TraceFinder Application” on page 10.

2. Open the TraceFinder launcher again, and click Next.

3. Click TraceFinder Power Modules, and follow the instructions to install the 
multiplexing module.

4. License the power modules.

Licensing for the power modules follows the same procedures as the TraceFinder 
application licensing. See “System Activation” on page x. 

 To enable the power modules

1. Start the TraceFinder application.

2. Go to the Configuration mode.

3. Click Application Configuration in the navigation pane.

4. Click Optional Features.

5. On the Optional Features page, select the Multiplexing check box.

For detailed instructions, see “Multiplexing” on page 92.

6. Click Apply.

A message prompts you to restart the TraceFinder application so that your changes can 
take effect.

7. Click Yes.
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Installing the NIST and QED Libraries
When you are using triple quadrupole instruments, follow these instructions to install the 
NIST and QED libraries.

 To install the NIST library

1. Open the TraceFinder launcher, and click Next.

2. Click NIST Library.

The NIST 08 MS Search and AMDIS Setup wizard opens.

3. Follow the instructions in the setup wizard.

4. When the wizard prompts you to select a destination folder, select 
C:\Program Files\NISTMS.

 To install the QED library

1. On your desktop, double-click the Xcalibur icon, .

The Thermo Xcalibur Roadmap opens.
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2. Choose Tools > Library Manager from the main menu.

The Thermo Library Manager dialog box opens, showing the NIST library in the NIST 
Libraries list.

3. Click Add.

The Add Library dialog box opens.

4. Click Browse, and locate your QED library in the C:\Thermo folder.

5. Click OK.

The Xcalibur application reports that it has added the library to the NIST application.

6. Click Dismiss to close the message box.

The Xcalibur application adds the QED library to the NIST Libraries list in the Library 
Manager dialog box.
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7. Click Exit in the Thermo Library Manager dialog box.

8. Start the TraceFinder application.

9. Go to the Method Development mode.

10. Click Method View in the navigation pane.

11. Choose File > New > Method Template from the main menu.

The Method Template Editor displays the QED NIST Library in the Use These Libraries 
list.
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Launching the NIST Library Browser
Use the NIST MS Search tool to search the NIST library.

 To open the NIST library browser

Choose Go > Launch Library Browser from the TraceFinder main menu.

The NIST MS Search window opens.

For detailed instructions about using the library browser, refer to the Help in the NIST MS 
Search window.
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Launching the Qual Browser 
Use the Xcalibur application’s Qual Browser to view chromatograms and spectra from raw 
data files or qualitative processing results. 

 To open the Qual Browser

Choose Go > Launch Qual Browser from the TraceFinder main menu.

The Thermo Xcalibur Qual Browser opens.

For detailed instructions about using the Qual Browser, refer to the Qual Browser Help.
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Converting Legacy Data
Use the TraceFinder Legacy Data Converter to convert methods, batches, method templates, 
or batch templates from the source versions of TraceFinder 1.0.1/1.1/2.0, EnviroLab Forms, 
QuanLab Forms, or ToxLab Forms to compatible TraceFinder 2.1 target versions.

 To open the TraceFinder Legacy Data Converter

Choose Go > Launch Legacy Data Converter from the TraceFinder main menu.

The TraceFinder Legacy Data Converter window opens.

This section includes the following topics:

• Converting Methods

• Converting Batches

• Converting Method Templates

• Converting Batch Templates

Table 2. Version compatibility

Source  TraceFinder 2.1 target 

General EFS  Clinical 
Research

 Forensic 
Toxicology

TraceFinder 2.0 General    

TraceFinder 2.0 EFS 

TraceFinder 2.0 Clinical Research  

TraceFinder 1.1 General    

TraceFinder 1.1 EFS 

TraceFinder 1.0.1 

EnviroLab Forms 3.1 

QuanLab Forms 3.1    

ToxLab Forms 3.1  

EnviroLab Forms 2.5.2 

QuanLab Forms 2.5.2    

ToxLab Forms 2.5.2  
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Converting Methods

Use the data converter to convert legacy methods to TraceFinder 2.1 methods.

 To convert a method 

1. In the Data Type list, select Method.

The TraceFinder Legacy Data Converter displays the interface for converting methods.

2. In the Source Version list, select the version of the method that you will convert.

The Methods to be Converted table displays the methods in the Methods folder for the 
selected source version. The application verifies that the method file is in the .mmx file 
format.

3. To convert a method that is not in the default list, do the following:

a. Click the Source Folder icon, .

The application adds a Source Folder box to the window.

b. Click Browse and locate a method folder.

You can select a specific method folder or a folder that contains multiple methods. 

c. Click OK in the Browse for Folder dialog box.

The application displays the selected folder in the Methods to be Converted table. 

When you select a folder that contains multiple method folders, the application displays 
all the methods.
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4. In the Target Version list, select the version that you are converting to.

The list displays only TraceFinder configurations with compatible data. See “Version 
compatibility” on page 19.

5. In the Target Drive list, select a fixed drive.

You cannot write the converted files to a mapped drive.

6. (Optional) In the New Name column, change the default new name for each method that 
you want converted.

When you populate the Methods to be Converted table, the application checks each 
method to see if a method with this name exists in the target folder. 

• If the method name already exists in the target folder, the default new name is the 
original name with “_1” appended. 

• If the method name does not exist in the target folder, the application keeps the 
original method name.

7. Select the check box for each method that you will convert, 

and click .

The application confirms that all methods to be converted use the .mmx file format.

When the conversion process begins, the application displays a status bar and a Cancel 
button. You can cancel pending conversions, but not the method that is currently 
converting.

When the Status column reports that a method is successfully converted, the application 
writes the converted file to the C:\Thermo\TargetVersion\Methods folder.

8. To view a log of the conversion, click View Log.

The application opens a cumulative log file for the session in a Microsoft Notepad text 
editor window.

IMPORTANT  The conversion cannot overwrite an existing file name. If the new name 
is identical to an existing method file, the conversion will fail. When you manually 
enter a new name, you must verify that the name does not already exist.

Note   If a method conversion fails, the Status column displays an error icon. Hold 
your cursor over the icon to display the error message.
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Figure 3. Sample log file for converting a method
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Converting Batches

Use the data converter to convert legacy batches to TraceFinder 2.1 batches.

 To convert a batch

1. In the Data Type list, select Batch.

The TraceFinder Legacy Data Converter displays the interface for converting batches.

2. In the Source Version list, select the version of the batch that you will convert.

The Batches to be Converted table displays all batches in the Projects folder for the 
selected source version.

3. To convert a batch that is not in the default list, do the following:

a. Click the Source Folder icon, .

The application adds a Source Folder box to the window.

b. Click Browse and locate a batch folder.

You can select a specific batch folder or a project or subproject folder that contains 
multiple batches. 

c. Click OK in the Browse for Folder dialog box.

The application displays the selected folder and all batches in that folder in the Batches to 
be Converted table. 

IMPORTANT  A valid batch file (.btx) must be inside a folder with the same name. For 
example:
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When you select a project or subproject folder that contains multiple batch folders, the 
application displays all the batches.

4. In the Target Version list, select the version that you are converting to.

The list displays only TraceFinder configurations with compatible data. See “Version 
compatibility” on page 19.

5. In the Target Drive list, select a fixed drive.

You cannot write the converted files to a mapped drive.

6. Do one of the following to create a project and subproject for the converted batch:

In the Target Default Project and Subproject boxes, type the name of a project and 
subproject.

–or–

Select the Replicate Original Project/Subproject check box.

7. (Optional) In the New Name column, change the default new name for each batch that 
you want converted.

When you populate the Batches to be Converted table, the application checks each batch 
to see if a batch with this name exists in the target folder. 

• If the batch name already exists in the target folder, the default new name is the 
original name with “_1” appended. 

• If the batch name does not exist in the target folder, the application keeps the original 
batch name.

8. Select the check box for each batch that you will convert, 

and click .

The application confirms that all batches to be converted use the .btx file format.

When the conversion process begins, the application displays a status bar and a Cancel 
button. You can cancel pending conversions, but not the batch that is currently 
converting.

IMPORTANT  The conversion cannot overwrite an existing file name. If the new name 
is identical to an existing batch folder, the conversion will fail. When you manually 
enter a new name, you must verify that the name does not already exist.
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When the Status column reports that a batch is successfully converted, the application 
writes the converted batch to the C:\Thermo\TargetVersion\Projects folder and uses either 
the original project and subproject names or the new names that you entered.

9. To view a log of the conversion, click View Log.

The application opens a cumulative log file for the session in a Notepad text editor 
window.

Figure 4. Sample log file for converting a batch

Note   If a batch conversion fails, the Status column displays an error icon. Hold your 
cursor over the icon to display the error message.
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Converting Method Templates

Use the data converter to convert legacy method templates to TraceFinder 2.1 method 
templates.

 To convert a method template

1. In the Data Type list, select Method Template.

The TraceFinder Legacy Data Converter displays the interface for converting method 
templates.

2. In the Source Version list, select the version of the method template that you will convert.

The Method Templates to be Converted table displays the method templates in the 
Templates folder for the selected source version. The application verifies that the method 
template file is in the .pmtx file format.

3. To convert a method template that is not in the default list, do the following:

a. Click the Source Folder icon, .

The application adds a Source Folder box to the window.

b. Click Browse and locate a template folder.

You can select a specific template folder or a folder that contains multiple templates. 

c. Click OK in the Browse for Folder dialog box.

The application displays the selected folder in the Method Templates to be Converted 
table. 

When you select a folder that contains multiple method template folders, the application 
displays all the method templates.
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4. In the Target Version list, select the version that you are converting to.

The list displays only TraceFinder configurations with compatible data. See “Version 
compatibility” on page 19.

5. In the Target Drive list, select a fixed drive.

You cannot write the converted files to a mapped drive.

6. (Optional) In the New Name column, change the default new name for each method 
template that you want converted.

When you populate the Method Templates to be Converted table, the application checks 
each method template to see if a method template with this name exists in the target 
folder. 

• If the method template name already exists in the target folder, the default new name 
is the original name with “_1” appended. 

• If the method template name does not exist in the target folder, the application keeps 
the original method template name.

7. Select the check box for each method template that you will convert, 

and click .

The application confirms that all method templates to be converted use the .pmtx file 
format.

When the conversion process begins, the application displays a status bar and a Cancel 
button. You can cancel pending conversions, but not the template that is currently 
converting.

When the Status column reports that the template is successfully converted, the 
application writes the converted template to the 
C:\Thermo\TargetVersion\Templates\Methods folder.

8. To view a log of the conversion, click View Log.

The application opens a cumulative log file for the session in a Notepad text editor 
window.

IMPORTANT  The conversion cannot overwrite an existing file name. If the new name 
is identical to an existing method template file, the conversion will fail. When you 
manually enter a new name, you must verify that the name does not already exist.

Note   If a template conversion fails, the Status column displays an error icon. Hold 
your cursor over the icon to display the error message.
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Figure 5. Sample log file for converting a method template
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Converting Batch Templates

Use the data converter to convert legacy batch templates to TraceFinder 2.1 batch templates.

 To convert a batch template

1. In the Data Type list, select Batch Template.

The TraceFinder Legacy Data Converter displays the interface for converting batch 
templates.

2. In the Source Version list, select the version of the batch template that you will convert.

The Batch Templates to be Converted table displays the batch templates in the Templates 
folder for the selected source version.

3. To convert a batch template that is not in the default list, do the following:

a. Click the Source Folder icon, .

The application adds a Source Folder box to the window.

b. Click Browse and locate a template folder.

You can select a specific batch template folder or a folder that contains multiple batch 
templates. 

c. Click OK in the Browse for Folder dialog box.

The application displays the selected folder in the Batch Templates to be Converted table. 

IMPORTANT  A valid batch template file (.btx) must be inside a folder with the same 
name. For example:
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When you select a folder that contains multiple batch template folders, the application 
displays all the batch templates.

4. In the Target Version list, select the version that you are converting to.

The list displays only TraceFinder configurations with compatible data. See “Version 
compatibility” on page 19.

5. In the Target Drive list, select a fixed drive.

You cannot write the converted files to a mapped drive.

6. (Optional) In the New Name column, change the default new name for each batch 
template that you want converted.

When you populate the Batch Templates to be Converted table, the application checks 
each batch template to see if a batch template with this name exists in the target folder. 

• If the batch template name already exists in the target folder, the default new name is 
the original name with “_1” appended. 

• If the batch template name does not exist in the target folder, the application keeps 
the original batch template name.

7. Select the check box for each batch template that you will convert, 

and click .

The application confirms that all batch templates to be converted use the .btx file format.

When the conversion process begins, the application displays a status bar and a Cancel 
button. You can cancel pending conversions, but not the template that is currently 
converting.

When the Status column reports that the template is successfully converted, 
the application writes the converted template folder to the 
C:\Thermo\TargetVersion\Templates\Batches folder. 

IMPORTANT  The conversion cannot overwrite an existing file name. If the new name 
is identical to an existing batch template file, the conversion will fail. When you 
manually enter a new name, you must verify that the name does not already exist.

Note   If a template conversion fails, the Status column displays an error icon. Hold 
your cursor over the icon to display the error message.
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8. To view a log of the conversion, click View Log.

The application opens a cumulative log file for the session in a Notepad text editor 
window.

Figure 6. Sample log file for converting a batch template
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Choosing a Mode
When user security is enabled, the dashboard displays the options applicable to the current 
user’s assigned role. The following table shows the available modes for each user role.
 

Follow these procedures:

• To choose a mode

• To display a log of instrument errors

• To monitor instrument status

• To watch the real-time display from the dashboard

 To choose a mode

1. From the dashboard, click the mode where you want to work.

The dashboard shows only the modes that you have permission to use. See “TraceFinder 
Dashboard” on page 35. 

2. To change modes from within any of the TraceFinder application modes, click a mode 
button in the navigation pane.

Table 3. User roles and mode access

User role Method 
Development Acquisition Analysis Configuration

LabDirector    

ITAdmin 

Supervisor   

Technician  

QAQC 

Note  When user security is not enabled, all modes are available to all users.
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 To display a log of instrument errors 

1. Right-click the status light in the lower right corner of any mode.

2. Choose Instrument Log.

The Instrument Log dialog box opens.

The Instrument Log displays all instrument errors that have occurred since the 
TraceFinder application started or since the last time that you cleared the message log.

3. Do any of the following:

• Click Refresh to display errors that occur after you open the Instrument Log dialog 
box.

• Click Clear Messages to remove messages from the Instrument Log display.

The application clears messages only from the Instrument Log display. These 
messages remain in the following log file:

C:\Thermo\TraceFinder\2.1\EFS\Logs\TraceFinder.log 

• Click OK to dismiss the Instrument Log dialog box.

 To monitor instrument status

Look at the status light in the lower right corner of the TraceFinder window.

 Green indicates that the instrument is ready.

 Yellow indicates that the instrument is in standby mode.

 Red indicates that the instrument is turned off or no device is configured. 
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 To watch the real-time display from the dashboard

Click Real Time Status.

The real-time status is displayed at the bottom of the dashboard.

For descriptions of all the features of the real-time display, see “Real-Time Display” on 
page 279. 
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TraceFinder Dashboard

A dashboard without user security or for a user in the LabDirector role looks like this.

Table 4. TraceFinder dashboard screen parameters  (Sheet 1 of 2)

Parameter Description

Real Time Status Opens the real-time display for the current acquisition. The acquisition 
progress is displayed within the current mode window. 

Help Opens the TraceFinder Help.

Log Off Logs off the current user and displays the login screen. This function is 
available only when user security is enabled. See “User Security” on 
page 90.

Acquisition Opens the Acquisition mode where you can create and review batches, 
batch data, reports, and local methods. See Chapter 5, “Using the 
Acquisition Mode.” 

This mode is available only when you select the Acquisition Batch 
Wizard style in the Configuration mode. See “Batch Wizard Style” on 
page 94.
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Analysis Opens the Analysis mode where you can review batches, batch data, 
reports, and local methods. See Chapter 6, “Using the Analysis Mode.” 

Method 
Development

Opens the Method Development mode where you can create a master 
method, an instrument method, or a development batch. See 
Chapter 4, “Using the Method Development Mode.” 

Configuration Opens the Configuration mode where you can set permissions, assign 
users to roles, configure available reports and import new reports, and 
maintain the various databases, including the Compound Datastore. 
See Chapter 3, “Using the Configuration Mode.” 

Table 4. TraceFinder dashboard screen parameters  (Sheet 2 of 2)

Parameter Description
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3

Using the Configuration Mode

This chapter discusses the configuration tasks assigned to the ITAdmin and LabDirector roles 
when user security is enabled. When user security is not enabled, all users have access to all 
features in the Configuration mode except the User Administration tasks.

Users in the ITAdmin or LabDirector role are responsible for the following:

• Handling the databases

• Applying roles to users

• Understanding security, users, and groups

• Creating local users and network groups

• Creating projects and subprojects

• Maintaining compounds in the compounds datastore

 To access the Configuration mode

Click Configuration from the dashboard or the navigation pane.

The Configuration mode navigation pane opens.

Contents

• User Administration

• Project Administration

• Compound Datastore

• Application Configuration
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Figure 7. Configuration mode navigation pane

Table 5.  Configuration mode navigation pane functions  (Sheet 1 of 2)

Function Description

User Administration Opens the User Administration view where you can add, remove, or edit user accounts 
and permissions. See “User Administration” on page 40.

When user security is not enabled, this task pane is not available. When user security is 
enabled, this task pane is available only to users in the LabDirector or ITAdmin role. See 
“Application Configuration” on page 67.

Project Administration Opens the Project Administration view where you can create and manage projects and 
subprojects. See “Project Administration” on page 49.

Available only to users in the LabDirector or ITAdmin role.

Available only when you select the Acquisition Batch Wizard as 
your wizard style in the Application Configuration view.

Available only when you select the Compound Datastore option 
in the Application Configuration view.
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Compound Datastore Opens the Compound Datastore view where you can manage the definition of 
compounds in the current datastore. See “Compound Datastore” on page 55. 

This task pane is available only when you have selected the Compound Datastore option 
on the Optional Features page of the Application Configuration view. See “Application 
Configuration” on page 67. 

Application Configuration Opens the Application Configuration view where you can specify available reports, 
application defaults, and detection algorithms. You can also enable the user security, 
target screening, compound datastore, multiplexing, and batch wizard features. See 
“Application Configuration” on page 67. 

Table 5.  Configuration mode navigation pane functions  (Sheet 2 of 2)

Function Description
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User Administration
In the User Administration view of the Configuration mode (when user security is enabled), 
users in the LabDirector or ITAdmin role can add, remove, or edit user accounts and 
permissions. 

For detailed descriptions of each user role and the permissions and responsibilities for each 
role, see “Choosing User Roles” on page 46.

 To open the User Administration view

1. Click Configuration from the dashboard or the navigation pane.

The Configuration navigation pane opens. 

2. Click the User Administration task pane.

The User Administration view opens. See “User Administration view” on page 44.

Note  The User Administration view is available only when you enable user security. 
Follow the instructions “To turn on user security” on page 90.
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Editing User Information

Follow these procedures:

• To add a user

• To edit user information

• To change a user password

• To remove a user

 To add a user

1. Click the Add User icon, .

The application enables the parameters in the User area at the bottom of the view. 

2. Type a unique name in the Username field.

3. Select a role from the Role list.

A user in the LabDirector or ITAdmin role must assign each user to one of these defined 
roles. For detailed information about the permissions allowed for each role, see “Choosing 
User Roles” on page 46.

4. Type the user’s password and type it again to confirm it.

Make sure to communicate the password to the user.

5. (Optional) Type the user’s full name, account number, phone number, and e-mail 
address. 

6. To enable this user login, select the Enabled check box.

You can disable a user login without deleting the user’s information. Follow the 
instructions “To edit user information” on page 42. 
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7. Do one of the following:

When all the user information is correct, click the Save Changes icon, .

The TraceFinder application adds the new user to the User Listing table, and the 
parameters in the User area are unavailable.

–or–

To discard all information and not create a new user from 
the parameter values you entered, click the Cancel Changes icon, .

The application discards all information and the parameters in the User area are 
unavailable. 

 To edit user information

1. In the User Listing table, select a user.

The user information populates the parameter fields in the User area.

2. Click the Edit User icon, .

The application enables the parameters in the User area.

3. Edit any of the parameter values.

If you are editing your own user name, the Enabled check box is unavailable because you 
cannot make your own account unavailable.

Note  Clicking anywhere in the row selects the user.
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4. Do one of the following:

When all the user information is correct, click the Save Changes icon, .

The TraceFinder application adds the new parameter values to the User Listing, and the 
parameters in the User area are unavailable.

–or–

To discard all changes and not save the edits, click the Cancel Changes icon, .

All changes are discarded, and the parameters in the User area are unavailable.

 To change a user password

1. In the User Listing table, select a user.

The user information populates the parameter fields in the User area.

2. Click the Edit User icon, .

The parameters in the User area are enabled.

3. Click Reset Password.

The application makes the password and confirming password visible as a string of 
asterisks ******.

4. In the Password box, select ****** and type a new password.

5. In the Confirm Password box, select ****** and retype the new password.

6. Click the Save Changes icon, .

Make sure to communicate the new password to the user. 
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 To remove a user

1. In the User Listing table, select a user.

The user information populates the parameter fields in the User area.

2. Click the Remove User icon, .

If you select your current user name, the Remove User icon is unavailable. You cannot 
remove yourself.

3. When prompted, confirm that you want to remove this user. 

If the user is currently logged in to the TraceFinder application, the user’s current session 
is not affected.

4. Click OK.

Figure 8. User Administration view

Note  Clicking anywhere in the row selects the user.

Note  Rather than completely removing the user, you can disable a user login without 
removing all the user information from the system. Follow the instructions “To edit user 
information” on page 42. 
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Table 6. User Administration view parameters 

Parameter Description

Security Groups All permission levels defined in the TraceFinder application. For detailed descriptions of 
user permissions, see “Choosing User Roles” on page 46.

User Listing

Username User login name.

Role Security group that defines user permissions.

Account Number User account number.

Phone Number User telephone number.

Email Address User e-mail address.

Reset Password Enables the Password and Confirm Password parameters so that you can change them.

Enabled Available or unavailable status for the user account.

User

Username Login name for the current user.

Role Security group that defines the current user’s permissions.

Password Login password for the current user.

Full Name The current user’s actual name.

Account Number Optional account number for the current user.

Phone Number Optional telephone number for the current user.

Email Address E-mail address for the current user. Used to notify user of a randomly generated 
password.

Enabled Allows or disallows access for this user. When this user is currently logged in, disallowing 
takes effect after the user logs off.

Reset Password Makes the password visible as a string of asterisks that you can select and change.

Icon Function

 Add User Enables the fields in the User area where you can enter information for a new user.

 Remove User Deletes all information for the selected user.

 Edit User Enables the User area where you can edit any of the parameters for the selected user.

 Save Changes Adds the new parameter values to the User Listing table and disables the parameters in 
the User area.

 Cancel Changes Discards all new or edited information.
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Choosing User Roles 
This section describes the responsibilities for five different user roles when user security is 
enabled: LabDirector, ITAdmin, Supervisor, Technician, and QAQC.

TraceFinder Mode Access

A laboratory director or an IT administrator assigns you to a role that gives you access to 
specific modes of the TraceFinder application. When you log in, the dashboard displays links 
to only the modes that you can access.
 

LabDirector

In the LabDirector role, you review graphically applicable data and manipulate data, batches, 
methods, and instruments. 

A laboratory director is responsible for these tasks:

• Creating or editing methods for new levels of detection or adding new compounds to the 
existing database

• Reviewing data from the mass spectrometer

• Running samples and reviewing data collected by others

• Reporting the data

• Understanding the results and giving final approval of the released data before archiving

ITAdmin

In the ITAdmin role, you set security, manage users into roles, and manipulate the various 
databases. You are responsible for adding compounds into the various compound databases. 

An IT administrator is responsible for these tasks: 

• Handling the databases

• Applying roles to users

• Understanding security, users, and groups

• Creating local users and network groups

IMPORTANT  User roles are in effect only when user security is enabled. When user 
security is not enabled, all users have access to all modes.

Table 7. User roles and mode access

User role Method 
Development Acquisition Analysis Configuration

LabDirector    

ITAdmin 

Supervisor   

Technician  

QAQC 
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Supervisor

In the Supervisor role, you are responsible for setting up the instrument samples and using 
previously built sequences and methods for processing and acquiring data. You also develop 
and edit methods for processing and acquiring data, review the data, and distinguish between 
the need to rerun samples or pass reports up to the lab manager for final review. On a daily 
basis, you establish the priority for a list of samples to run and create the sequence of events.

A supervisor is responsible for these tasks: 

• Submitting samples 

• Creating and submitting batches

• Reporting the data to management

• Creating or editing methods for new levels of detection or adding new compounds to the 
existing database

• Reviewing data from the mass spectrometer

• Understanding the results, who ran the batch, and who passed along the results before 
giving intermediate approval and sending the data to management

• Modifying new compounds or adjusting methods for specific result sets

Technician

In the Technician role, you are responsible for setting up the instrument samples and using 
previously built sequences and methods for processing and acquiring data. You also edit 
existing methods for processing and acquiring data, review collected data, and distinguish 
between the need to rerun samples or pass reports up to the supervisor. On a daily basis, you 
are responsible for gathering the list of samples to run and creating the sequence of events. 

A technician is responsible for these tasks:

• Submitting samples 

• Creating and submitting batches

• Creating data to be reviewed by management

• Receiving instructions for new sets of samples for the TraceFinder application to analyze 
after finishing the current analysis

• Reviewing data from the mass spectrometer

• Understanding the resulting data, making integration changes, and passing those changes 
up for further approval
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QAQC

In the QAQC role, you review graphically applicable data and interpret the data, but you do 
not manipulate the data.

A QAQC technician is responsible for these tasks: 

• Reviewing data from the mass spectrometer

• Understanding the results and who ran and passed along the results before giving 
intermediate approval and sending the data to management

• Receiving instructions for new sets of samples for the TraceFinder application to analyze 
after finishing the current analysis

Note  In the QAQC role, you have access only to the Analysis mode.
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Project Administration 
When user security is enabled, users in the LabDirector or ITAdmin role can create and 
manage projects and subprojects on fixed or network drives in the Project Administration 
view of the Configuration mode.

This section includes the following topics:

• Working with Drives

• Working with Projects

 To open the Project Administration view

1. Click Configuration from the dashboard or the navigation pane.

The Configuration navigation pane opens. See “Configuration mode navigation pane” on 
page 38.

2. In the Configuration navigation pane, click Project Administration.

The Project Administration view opens.

By default, all projects are created under a main Projects folder on drive C:

C:\Thermo\TraceFinder\2.1\EFS\Projects
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Working with Drives

Drives can be any of the following: 

• Fixed: Directly connected to your computer.

• Network: Either a remote box or a mapped drive. A shared folder that is mapped to a 
drive letter might physically exist on your computer, but because it is mapped, it is 
considered to be a Network drive.

• Removable: Temporary drives such as a 3.5-inch disk or a USB drive.

Follow these procedures:

• To choose a drive

• To change the default drive

• To hide a drive from the display

• To refresh the display

 To choose a drive

1. In the Available Drives area, click any drive other than the default C: drive.

If you have not created a Projects directory on this drive, you see this message:

2. Click Create Projects Directory.

The TraceFinder application adds a new Projects directory to the selected drive. To create 
projects and subprojects on this drive, see “To create projects or subprojects” on page 52.
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 To change the default drive

Select the check box in the Default column.

You can set only fixed drives as the default drive. The default drive is the only drive that 
you can use to acquire data.

 To hide a drive from the display

Clear the check box in the Show column.

The application does not list the hidden drive in the drive lists. You cannot hide the 
default drive.

 To refresh the display

Right-click and choose Refresh from the shortcut menu.

The Available Drives table refreshes to show any drives that have changed (for example, if 
you inserted a USB drive). You can now configure any new drives.
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Working with Projects

When you create a batch, the application stores the data files, local method, and reports in a 
project and subproject that you create in the C:\Thermo\TraceFinder\2.1\EFS\Projects folder.

If you installed the TraceFinder example data, the main Projects folder includes an Example 
project folder that contains subprojects with example batches that you can use to experiment. 
To install the example data from the InstallShield Wizard, see the instructions “To install 
example data” on page 11.

Follow these procedures:

• To create projects or subprojects

• To delete projects or subprojects

• To remove all empty folders

• To copy the folder hierarchy from another drive

 To create projects or subprojects

1. Select the top-level project.

You can select the main Projects folder and create a new project under it, or you can select 
one of the existing projects and create a subproject under it.

When you select a project folder, the application enables the plus sign icon, , 
indicating that you can create a folder within the selected folder.

2. Click the plus sign.

The TraceFinder application creates a new, unnamed project folder under the selected 
project.

3. While the new project is still highlighted, type a new name.

Project names are limited to 30 characters and can contain spaces and special characters, 
except for the following special characters: \ / : * ? " < > |

4. To save the new name, press ENTER or click anywhere in the view.

Note  After you add a subproject to a project, you cannot rename the project.
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 To delete projects or subprojects

1. Select the project or subproject that you want to delete.

You can delete projects that do not have subprojects. You can delete subprojects that do 
not have batches. When the selected project or subproject is available for deletion, the 
application enables the minus sign icon, .

2. Click the minus sign, or right-click and choose Remove Project from the shortcut menu.

3. At the prompt, click Yes to remove the selected project or subproject.

 To remove all empty folders 

1. Select the project or subproject that contains empty folders.

2. Right-click and choose Remove All Empty Child Folders from the shortcut menu. 

A dialog box asks if you want to remove all empty folders.

3. Click OK.

The application removes all folders that have no folders or files. There is no undo for this 
command.
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 To copy the folder hierarchy from another drive 

1. Select the top-level Projects directory in the Project Administration area.

When you copy the hierarchy from the drive to your Projects folder, the application will 
add new folders to the current hierarchy, but it will not remove folders. 

2. Right-click and choose Copy Folder Hierarchy from Drive from the shortcut menu.

3. Choose a drive from the list of available drives.

At the prompt, you must confirm that you want to create a folder hierarchy that matches 
that of the specified drive. 

4. Click OK.

To replicate the hierarchy from the specified drive, the application will add new folders to 
the current hierarchy, but it will not remove folders. 

IMPORTANT  The Copy Folder Hierarchy from Drive command copies only the 
project and subproject folders; it does not copy batches within the folders.
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Compound Datastore
When user security is enabled, users in the LabDirector or ITAdmin role can manage 
compound definitions in the current datastore in the Compound Datastore view.

This section includes the following topics:

• Opening and Saving a Datastore

• Adding Compounds, Quantitative Peaks, and Confirming Ions to a Datastore

• Choosing Experiment Types

For a description of all the parameters in the Compound Datastore view, “Compound 
Datastore view” on page 59.
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Opening and Saving a Datastore

You can use the default datastore or you can create your own datastore. The Compound 
Datastore task pane is available only when the Compound Datastore feature is enabled. See 
“Enabling Optional Features” on page 88.

Follow these procedures:

• To open the Compound Datastore editor

• To open a compound datastore

• To create a new compound datastore

• To save a datastore

• To save a datastore to a new name

 To open the Compound Datastore editor

1. Click Configuration from the dashboard or the navigation pane.

The Configuration navigation pane opens. See “Configuration mode navigation pane” on 
page 38.

2. Click the Compound Datastore task pane.

The current datastore opens in the Compound Datastore view. For a detailed list of all 
parameters and functions in the Compound Datastore view, see “Compound Datastore 
view” on page 59.
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 To open a compound datastore

1. Click Load Compound Datastore in the Compound Datastore task pane. 

The Open Compound Datastore dialog box opens.

2. Double-click the name of the datastore that you want to open. 

The selected datastore opens in the Compound Datastore view. See “Compound 
Datastore view” on page 59. 

 To create a new compound datastore

Click New Compound Datastore in the Compound Datastore task pane.

A new, empty datastore opens in the Compound Datastore view. 

You can import a file of compounds into the new datastore (by following the instructions, 
To import compounds), or you can manually add compounds one at a time (by following 
the instructions, To add a compound to the datastore).

 To save a datastore

1. Click Save Compound Datastore in the Compound Datastore task pane.

The application stores the database as

…\Thermo\TraceFinder\2.1\EFS\Databases\filename.xml
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If the datastore contains any compounds that do not have associated quantitative peaks, 
the Invalid Compound Datastore Not Saved dialog box opens, listing the compounds.

2. To add a quantitative peak row to the listed compounds, click Continue.

The application returns you to the Compound Datastore view.

3. Add quantitative peaks to the incomplete compounds before you save the datastore.

See “To add a quantitative peak to a compound” on page 64. 

 To save a datastore to a new name

1. Click Save As Compound Datastore in the Compound Datastore task pane.

The Save Compound Datastore dialog box opens. 

2. Type a file name for the new compound datastore.

3. Click OK.

The application stores the database as

…\Thermo\TraceFinder\2.1\EFS\Databases\filename.xml

Table 8. Save Compound Datastore dialog box parameters

Parameter Description

Compound Datastore 
Name

Lists the file name for the new datastore.

Overwrite Overwrites the selected datastore.

OK Writes the new datastore to the Databases folder.

Cancel Closes the dialog box and makes no changes to the datastore.
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Figure 9. Compound Datastore view
 

Table 9. Compound Datastore view parameters  (Sheet 1 of 3)

Parameter Description

Function icons

 Adds a new compound row. 

Removes the selected row and all quantitative peak and confirming ion rows within it.

Adds a new quantitative peak row to the compound. Each compound requires at least one 
quantitative peak.

 Removes the selected row and all confirming ion rows within it.

Adds a new confirming ion row to the quantitative peak.

Removes the selected confirming ion row.

Select Experiment Types 
To Display 

Specifies one of these experiment types that each use a different structure for the mass 
filter. See “Choosing Experiment Types” on page 66.

• SRM: Selected Reaction Monitoring
• XIC: Extracted Ion Chromatogram
• SIM: Single Ion Monitoring

Compound parameters

Compound Name Alphanumeric name assigned to the compound.

Experiment Type Experiment type: SRM, XIC, or SIM. 

Category (Optional) Alphanumeric identifier. 
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Ionization (Optional) Alphanumeric identifier. 
Valid values: None, ESI, APCI, EI, CI, or APPI
Default: None

Chemical Formula (Optional) Alphanumeric chemical identifier.

Quantitative peak parameters

Precursor Mass The mass-to-charge ratio (m/z) of a precursor ion. The location of the center of a target 
precursor-ion peak in mass-to-charge ratio units. 
In confirming ion rows, the precursor mass is a noneditable copy of the quantitative peak 
precursor mass.
Available only for SRM experiments.
Default: 0.0
Range: 10.000 to 2999.999

Product Mass The mass-to-charge ratio of the quantitation ion. The location of the center of a target 
quan-ion peak in mass-to-charge ratio (m/z) units. 
Available only for SRM experiments.
Default: 0.0
Range: 10.000 to 2999.999

Mass The mass-to-charge ratio of the quantitation ion. The location of the center of a target 
quan-ion peak in mass-to-charge ratio (m/z) units. 
Available only for XIC and SIM experiments.
Default: 0.0
Range: 10.000 to 2999.999

Collision Energy The energy used when ions collide with the collision gas.
Available only for SRM experiments.
Range: –250.00 to 250.00

RT (min) Retention time. The application uses RT and Window values to determine the start and 
stop time for the acquisition. 
Range: 0.00 to 999.00
Start time = RT – (Window/2)
Stop time = RT + (Window/2)
Start and stop range: 0.00 to 999.00

Window (sec) The application uses RT and Window values to determine the start and stop time for the 
acquisition. 
Range: 0.00 to 499.50
Start time = RT – (Window/2)
Stop time = RT + (Window/2)
Start and stop range: 0.00 to 999.00

Polarity + (positive) or – (negative)

Lens (Optional) Range: –400 to 400

Table 9. Compound Datastore view parameters  (Sheet 2 of 3)

Parameter Description
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Energy Ramp (Optional) 
Available only for SRM experiments.
Range: 0.00 to 200.00

Confirming ion parameters

Precursor Mass The mass-to-charge ratio of a precursor ion. The location of the center of a target 
precursor-ion peak in mass-to-charge ratio (m/z) units. 
Available as a noneditible field only for SRM experiments.
Default: 0.0
Range: 10.000 to 2999.999

Product Mass The mass-to-charge ratio of the quantitation ion. The location of the center of a target 
quan-ion peak in mass-to-charge ratio (m/z) units. 
Available only for SRM experiments.
Default: 0.0
Range: 10.000 to 2999.999

Mass The mass-to-charge ratio of the quantitation ion. The location of the center of a target 
quan-ion peak in mass-to-charge ratio (m/z) units. 
Available only for XIC and SIM experiments.
Default: 0.0
Range: 10.000 to 2999.999

Collision Energy The energy used when ions collide with the collision gas. 
Available only for SRM experiments.
Range: –250.00 to 250.00

Table 9. Compound Datastore view parameters  (Sheet 3 of 3)

Parameter Description
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Adding Compounds, Quantitative Peaks, and Confirming Ions to a Datastore

In the Compound Datastore view, you can import compounds into the datastore, add or 
remove compounds from the datastore, add quantitative peaks and confirming ions to a 
compound, or remove quantitative peaks or confirming ions from a compound.

Follow these procedures:

• To import compounds

• To add a compound to the datastore

• To remove a compound

• To add a quantitative peak to a compound

• To remove a quantitative peak

• To add a confirming ion to a quantitative peak

• To remove a confirming ion

 To import compounds

1. Click Import Compounds in the Compound Datastore task pane.

2. Browse to a .csv or .xml compounds file and click Open.

The TraceFinder application imports the compounds from the imported file, adds them 
to any compounds already in the datastore, and alphabetically sorts them.

When the application imports a compound that contains multiple quantitative peaks and 
confirming ions, it lists all the peaks under a single compound name, as in this example 
for Monuron:
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 To add a compound to the datastore

1. Click the Add Compound icon, , or right-click the compounds list 

and choose Add Compound from the shortcut menu.

The application adds a new, empty compound row to the end of the compounds table. 

2. Click the first table cell, and type the required Compound Name parameter.

3. (Optional) Change the value for the Experiment Type. 

The default is SRM. For descriptions of available experiment types, see “Choosing 
Experiment Types” on page 66.

After you add a quantitative peak to the compound, you cannot change the experiment 
type, even if you cancel the quantitative peak.

4. (Optional) Type a value or select a value from the Category list. 

You can use any alphanumeric string. After you type a new Category value, that value is 
available from the list.

5. (Optional) Change the values for Ionization.

The default is None.

6. (Optional) Type a value for the Chemical Formula. 

You can use any alphanumeric string. 

Each compound requires at least one quantitative peak.

 To remove a compound

1. Select the compound row that you want to delete.

2. Click the Remove Compound icon, , or right-click 

and choose Remove Compound from the shortcut menu.

3. If you are sure you want to delete the selected row, at the prompt, click OK.

The application removes the selected row and all quantitative peak and confirming ion 
rows within it.

Tip  If you add a row of compound information and do not complete all the column 
required values, you can right-click and choose Cancel to remove the entire row. You 
can cancel only an incomplete compound row. 
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 To add a quantitative peak to a compound

1. Select the compound.

2. Click the Add Quan Peak icon, , or right-click 

and choose Add Quan Peak from the shortcut menu. 

The application adds a new quantitative peak row to the compound. A quantitative peak 
includes quantitative values for the compound. Each compound requires at least one 
quantitative peak.

3. Enter all required parameters. 

For a list of required and optional parameters, see the list of “Compound Datastore view 
parameters” on page 59.

4. Repeat steps 2 through 3 to add as many as six quantitative peaks to the compound. 

 To remove a quantitative peak 

1. Select the row of the quantitative peak that you want to delete.

2. Click the Remove Quan Peak icon, , or right-click 

and choose Remove Quan Peak from the shortcut menu.

3. If you are sure you want to delete the selected row, at the prompt, click OK.

The application removes the selected row and all confirming ion rows within it.

Tip  You cannot add another new compound or save the compound datastore until 
you enter all required quantitative peak parameters or remove incomplete quantitative 
peaks from the compound. 

Tip  If you add a row of quantitative peak information and do not complete all the 
required values, you can right-click and choose Cancel to remove the entire row. You 
can cancel only incomplete quantitative peak rows. 

Quantitative peak row
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 To add a confirming ion to a quantitative peak 

1. Click the Add Confirming Ion icon, , or right-click the quantitative peak row 

and choose Add Confirming Ion from the shortcut menu.

The application adds a new confirming ion row to the quantitative peak. A confirming 
ion includes a mass value. 

2. Type the required column values for the confirming ion. 

The required confirming ion values differ for each experiment type. See “Choosing 
Experiment Types” on page 66.

3. Repeat steps 1 through 2 to add as many as 10 confirming ions to the quantitative peak.

 To remove a confirming ion

1. Select the confirming ion row that you want to delete.

2. Click the Remove Confirming Ion icon, , or right-click 

and choose Remove Confirming Ion from the shortcut menu.

3. If you are sure you want to delete the selected row, at the prompt, click OK.

The application removes the selected confirming ion row.

 To filter a list

Click the funnel icon, , in the column header.

For each column, the application displays filterable criteria (compound names, 
experiment types, categories, or ionization methods) in a list. In all lists, you can choose 
to view all criteria or a specific type of criterion for that column.

Tip  If you add a row of confirming ion information and do not complete all the 
required values, you can right-click and choose Cancel to remove the entire row. You 
can cancel only incomplete confirming ion rows. 

Confirming ion row
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Choosing Experiment Types

The TraceFinder application uses three experiment types: SRM, XIC, and SIM. 

A compound datastore can include multiple experiment types for a single compound; 
however, each compound name and experiment type combination must be unique.

SRM: Selected Reaction Monitoring

The SRM experiment type supports triple quadrupole LC/MS. The mass filter includes 
precursor mass and narrow mass ranges to identify product masses. Imported compounds 
with no experiment type are treated as SRM data.

Confirming ions include values for product mass, collision energy, and a noneditable 
precursor mass.

XIC: Extracted Ion Chromatogram

The mass filter is a single, full scan which is post-processed to extract a peak for the ions of 
interest.

Confirming ions include a single mass value.

SIM: Single Ion Monitoring

The SIM experiment type supports single quadrupole LC/MS and Exactive™ systems. The 
mass filter includes narrow mass ranges to identify product masses.

Confirming ions include a single mass value.
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Application Configuration
When user security is enabled, users in the LabDirector or ITAdmin role can enable features 
such as available reports, user security, compound datastore, reporting defaults, multiplexing, 
detection algorithms, and target screening. You can also choose the reports that are available 
to users, the application defaults, and the defaults used for peak detection.

This section includes the following tasks:

• Specifying the Reports Configuration

• Specifying Configuration Defaults

• Specifying Detection Parameters

• Enabling Optional Features

 To open the Application Configuration view

1. Click Configuration from the dashboard or the navigation pane.

The Configuration navigation pane opens. See “Configuration mode navigation pane” on 
page 38.

2. Click Application Configuration.

The Application Configuration view opens. 

3. In the Application Configuration list, click the type of information that you want to 
configure.

Table 10. Application Configuration pages 

Page

Reports See “Specifying the Reports Configuration.” 

Defaults See “Specifying Configuration Defaults” on page 73.

Detection See “Specifying Detection Parameters” on page 76.

Optional Features See “Enabling Optional Features” on page 88.
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Specifying the Reports Configuration 

When user security is enabled, users in the LabDirector or ITAdmin role can configure a list 
of reports that are available to all users when they generate reports from the Method 
Development, Analysis, and Acquisition modes. From the Reports page, you can configure 
the standard, custom, or target screening reports.

Example PDF files of report formats are located in the following folder:

C:\Thermo\TraceFinder\2.1\EFS\ExampleReports

Follow these procedures:

• To open the Reports page

• To specify which reports are available

• To import new reports

 To open the Reports page

In the Application Configuration view, click Reports.

The Reports page of the Application Configuration view opens. For a list of reports, see 
“Reports” on page 70.

 To specify which reports are available

1. Use the directional arrows to move reports from the Installed Reports pane to the 
Displayed Reports pane.

In the Method Development, Analysis, and Acquisition modes, users can access all 
reports in the Displayed Reports pane.

2. To create a single composite report for an entire batch (rather than a separate report for 
each sample), select the Batch Level check box for the report.

Rather than creating separate reports for each sample, the application uses a composite of 
the data from all the samples to create a single report for the entire batch. Batch-level 
reports are prepended with a B to differentiate them.

Tip  Use the CTRL or SHIFT keys to select multiple reports.

Note  Only reports that can aggregate data at the batch level have the Batch Level 
check box enabled. By default, the application selects the Batch Level feature for all 
these reports.
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3. Do one of the following:

Apply the current selections as follows:

a. Click Apply.

A message prompts you to restart the TraceFinder application so that a user can access 
the reports you selected for the Method Development, Analysis, and Acquisition 
modes.

b. To restart the TraceFinder application now, click Yes, or to remain on the Reports 
page, click No.

–or–

To return the report selections to their original state (when you first opened this page), 
click Undo Changes.

 To import new reports

1. Click Import.

2. In the browser, locate a Crystal Reports .dll or Custom Reports .xltm file and open the 
file.

The application writes the imported report to the TraceFinder installation directory and 
displays the new report in the Installed Reports pane.



3 Using the Configuration Mode
Application Configuration

70 TraceFinder User Guide Thermo Scientific

Reports

The application uses the following standard, custom, and target screening reports (see 
Figure 10, Figure 11, and Figure 12, respectively). For descriptions of the parameters on the 
Reports page, see “Reports page parameters” on page 72.

Figure 10. Reports page showing standard reports
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Figure 11. Reports page showing custom reports

Figure 12. Reports page showing target screening reports

Note  Target screening reports are available only when you install the ToxID software and 
enable the target screening features. See “Enabling Optional Features” on page 88.
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Table 11.  Reports page parameters 

Parameter Description

Installed Reports All reports listed in this pane are potentially available but are not 
selected for use in the application.

Displayed Reports All reports listed in this pane are selected for use in the 
application.

>> Moves all reports from the Installed Reports list to the Displayed 
Reports list.

> Moves the selected reports from the Installed Reports list to the 
Displayed Reports list.

< Moves the selected reports from the Displayed Reports list to the 
Installed Reports list.

<< Moves all reports from the Displayed Reports list to the Installed 
Reports list.

Import Opens a browser where you can select a report file to add to the 
Installed Reports list.

Undo Changes Returns the report selections to their original state (when you 
first opened this page).

Apply Applies the current selections, and prompts you to restart the 
TraceFinder application so that a user can access the reports you 
selected for the Method Development, Analysis, and Acquisition 
modes.
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Specifying Configuration Defaults

Use the Application Configuration view of the Configuration mode to specify the default 
laboratory and instrument names, the displayed mass precision, and the intensity scale to use 
for reporting. When user security is enabled, only users in the LabDirector or ITAdmin role 
can access these features.

Follow these procedures:

• To open the Application Defaults page

• To specify a default laboratory name and instrument name

• To specify default mass precision and the intensity scale

 To open the Application Defaults page

In the Application Configuration view, click Defaults.

The Application Defaults page of the Application Configuration view opens.



3 Using the Configuration Mode
Application Configuration

74 TraceFinder User Guide Thermo Scientific

 To specify a default laboratory name and instrument name

1. Type the name of your laboratory in the Lab Name box.

When you create a method, the application uses this default laboratory name for the 
Laboratory Name value on the General page of the Master Method View. The application 
uses this laboratory name in the report headings.

The application does not apply this default laboratory name to previously created 
methods. By default, the laboratory name is Default Laboratory.

2. Type the name of your instrument in the Instrument Name box.

When you create a batch, the application uses this default instrument name for the 
Instrument Name value. The application uses this instrument name in the report 
headings.

3. In the Application Configuration view, click Apply.

The application does not apply this default instrument name to previously created 
batches. By default, the instrument name is Thermo Scientific Instrument.

4. Click Yes.

 To specify default mass precision and the intensity scale

1. In the Display Mass Precision box, set the mass precision decimal places value to an 
integer from 2 to 6, inclusive.

The default number of digits to display is 2. The TraceFinder application uses this mass 
precision value to display mass values in the following locations: 

• Reports:
– Blank Report
– Confirmation Report (data spectra, library spectra, quantitation ion display, and 

qualitative ion display)
– All High Density reports (m/z values)
– Ion Ratio Failure Report (quantitation ion and qualitative ion)
– Manual Integration Report (m/z value)
– Qualitative Summary Report (all m/z values)
– Quantitation Report (QIon)

• All peaks on the Detection pages in the Method Development mode
• The spectrum display in the Analysis mode
• The spectrum display in the Method Forge dialog box

IMPORTANT  When you create a method using a raw data file, the application reads 
the filter precision value from the raw data file to create scan filters; however, the 
Tracefinder application uses the Display Mass Precision value when showing masses 
that are not embedded within filter strings and masses that are displayed on spectral 
plots.
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2. Select Relative or Absolute from the Chromatogram Intensity Scale list.

This sets the default display type for both quantitation and qualitative chromatograms 
displayed in data review and reports. 

3. In the Application Configuration view, click Apply.

4. Click Yes.
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Specifying Detection Parameters

When user security is enabled, users in the LabDirector or ITAdmin role can specify detection 
parameters for the Genesis, ICIS, or Avalon detection algorithms. Use the Peak Detection 
Defaults page to specify a peak detection algorithm and its options and to determine the area 
under a curve.

This section includes procedures for specifying the following detection algorithms:

• Genesis Detection Method

• ICIS Detection Method

• Avalon Detection Method

 To specify common detection parameters

1. In the Application Configuration view, click Detection.

The Peak Detection Defaults page opens. See “Common peak detection areas.” 

2. In the Detector Type list, select a detector type.

3. In the Mass Tolerance area, do the following:

a. Select the unit of measure that you want to use. 

b. In the Value box, specify the number of millimass units or parts per million to use as 
the upper limit.

The application applies this mass tolerance to the extracted chromatograms. The default 
is 500 MMU.

4. In the Retention Time area, do the following:

a. In the Window box, specify the width of the window (in seconds) to indicate how far 
around the expected retention time the system will look for a peak apex. 

b. In the View Width box, specify the viewable size (in minutes) of the ion 
chromatogram display. 

5. In the Ion Ratio Parameters area, do the following:

a. In the Window Type box, select Absolute or Relative as the calculation approach for 
determining the acceptable ion ratio range. 

b. In the Window (+/-%) box, select the acceptable ion ratio range. 

c. In the Ion Coelution box, select the maximum difference in retention time between a 
confirming ion peak and the quantification ion peak.

6. In the Peak Detection Parameters area, select one of the detection algorithms: Genesis, 
ICIS, or Avalon.
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Figure 13. Common peak detection areas

Table 12. Common peak detection parameters 

Parameter Description

Detector Type Reserved for future releases.

Mass Tolerance

Units • (Default) MMU (millimass units) 
MMU is a static calculation to the extracted mass.

• PPM (parts per million) 
PPM is a variable calculation dependent on the actual mass. The smaller the mass, the 
narrower the tolerance range. The larger the mass, the wider the tolerance range.

Value Upper limit of MMU or PPM.
Default: 500
Range: 0.1 through 50 000

Retention Time

Window (sec) Width of the window (in seconds) to indicate how far around the expected retention time 
the system will look for a peak apex. 

View Width (min) Viewable size (in minutes) of the ion chromatogram display. Changing the view width does 
not affect the process of peak detection; the TraceFinder application uses it only for 
graphical display. 

Ion Ratio Parameters

Window Type The absolute or relative calculation approach for determining the acceptable ion ratio range. 

Window (+/-%) The acceptable ion ratio range.

Ion Coelution (min) The maximum difference in retention time between a confirming ion peak and the 
quantification ion peak.
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Genesis Detection Method

The TraceFinder application provides the Genesis peak detection algorithm for backward 
compatibility with Xcalibur 1.0 studies. 

Figure 14. Genesis peak detection page

Table 13. Genesis peak detection page parameters  (Sheet 1 of 3)

Parameter Description

Sensitivity Specifies the Genesis peak detection algorithm.

Detection Method Highest peak: Uses the highest peak in the chromatogram for component identification. 

Nearest RT: Uses the peak with the nearest retention time in the chromatogram for 
component identification.
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Smoothing Determines the degree of data smoothing to be performed on the active component peak 
prior to peak detection and integration. The ICIS peak detection algorithm uses this value.
Default: 1 
Range: Any odd integer from 1 through 15 points

S/N threshold Current signal-to-noise threshold for peak integration. Peaks with signal-to-noise values less 
than this value are not integrated. Peaks with signal-to-noise values greater than this value 
are integrated. 
Range: 0.0 to 999.0

Enable Valley 
Detection

Uses the valley detection approximation method to detect unresolved peaks. This method 
drops a vertical line from the apex of the valley between unresolved peaks to the baseline. 
The intersection of the vertical line and the baseline defines the end of the first peak and the 
beginning of the second peak. 

Expected Width (sec) The expected peak width parameter (in seconds). This parameter controls the minimum 
width that a peak is expected to have if valley detection is enabled. 

With valley detection enabled, any valley points nearer than the expected width/2 to the top 
of the peak are ignored. If a valley point is found outside the expected peak width, the 
TraceFinder application terminates the peak at that point. The application always terminates 
a peak when the signal reaches the baseline, independent of the value set for the expected 
peak width. 
Range: 0.0 to 999.0

Constrain Peak Width Constrains the peak width of a component during peak integration of a chromatogram. You 
can then set values that control when peak integration is turned on and off by specifying a 
threshold and a tailing factor. Selecting the Constrain Peak Width check box enables the 
Peak Height (%) and Tailing Factor options.

Peak Height (%) A signal must be above the baseline percentage of the total peak height (100%) before 
integration is turned on or off. This text box is active only when you select the Constrain 
Peak Width check box. 
Range: 0.0 to 100.0%

Tailing Factor A factor that controls how the TraceFinder application integrates the tail of a peak. This 
factor is the maximum ratio of the trailing edge to the leading side of a constrained peak. 
This text box is active only when you select the Constrain the Peak Width check box. 
Range: 0.5 through 9.0

Min Peak Height (S/N) For the valley detection approximation method to use the Nearest RT Peak Identification 
criteria, this peak signal-to-noise value must be equaled or exceeded. For component 
identification purposes, the TraceFinder application ignores all chromatogram peaks that 
have signal-to-noise values that are less than the S/N Threshold value. 
Range: 0.0 (all peaks) through 999.0

Table 13. Genesis peak detection page parameters  (Sheet 2 of 3)

Parameter Description
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Peak S/N Cutoff The peak edge is set to values below this signal-to-noise ratio. 

This test assumes it has found an edge of a peak when the baseline adjusted height of the 
edge is less than the ratio of the baseline adjusted apex height and the peak S/N cutoff ratio. 

When the S/N at the apex is 500 and the peak S/N cutoff value is 200, the TraceFinder 
application defines the right and left edges of the peak when the S/N reaches a value less 
than 200. 
Range: 50.0 to 10000.0

Valley Rise (%) The peak trace can rise above the baseline by this percentage after passing through a 
minimum (before or after the peak). This criteria is useful for integrating peaks with long 
tails.

This method drops a vertical line from the apex of the valley between unresolved peaks to 
the baseline. The intersection of the vertical line and the baseline defines the end of the first 
peak and the beginning of the second peak. 

When the trace exceeds rise percentage, the TraceFinder application applies valley detection 
peak integration criteria. This test is applied to both the left and right edges of the peak. 
Range: 0.1 to 500.0

Valley S/N Specifies a value to evaluate the valley bottom. Using this parameter ensures that the 
surrounding measurements are higher. 
Default: 2.0
Range: 1.0 to 100.0

# Background Scans Number of background scans performed by the TraceFinder application.

Report Noise As Determines if the noise used in calculating S/N values is calculated using an RMS 
calculation or peak-to-peak resolution threshold. Options are RMS or Peak to Peak.

Table 13. Genesis peak detection page parameters  (Sheet 3 of 3)

Parameter Description
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ICIS Detection Method

The ICIS peak detection algorithm is designed for MS data and has superior peak detection 
efficiency at low MS signal levels. 

Figure 15. ICIS peak detection page

Table 14. ICIS peak detection page parameters  (Sheet 1 of 3)

Parameter Description

Sensitivity Specifies the ICIS peak detection algorithm.

Detection Method Highest peak: Uses the highest peak in the chromatogram for component identification. 

Nearest RT: Uses the peak with the nearest retention time in the chromatogram for 
component identification.

Smoothing Determines the degree of data smoothing to be performed on the active component peak 
prior to peak detection and integration. The ICIS peak detection algorithm uses this value.

Range: Any odd integer from 1 through 15 points
Default: 1 
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Area Noise Factor The noise level multiplier used to determine the peak edge after the location of the possible 
peak. The ICIS peak detection algorithm uses this value. 

Range: 1 through 500
Default: 5

Peak Noise Factor The noise level multiplier used to determine the potential peak signal threshold. The ICIS 
peak detection algorithm uses this value.

Range: 1 through 1000
Default: 10

Baseline Window The TraceFinder application looks for a local minima over this number of scans. The ICIS 
peak detection algorithm uses this value.

Range: 1 through 500
Default: 40

Constrain Peak Width Constrains the peak width of a component during peak integration of a chromatogram. You 
can then set values that control when peak integration is turned on and off by specifying a 
peak height threshold and a tailing factor. Selecting the Constrain Peak Width check box 
enables the Peak Height (%) and Tailing Factor options.

Peak Height (%) A signal must be above the baseline percentage of the total peak height (100%) before 
integration is turned on or off. This text box is active only when you select the Constrain 
Peak Width check box. 

Range: 0.0 to 100.0%

Tailing Factor A factor that controls how the TraceFinder application integrates the tail of a peak. This 
factor is the maximum ratio of the trailing edge to the leading side of a constrained peak. 
This text box is active only when you select the Constrain the Peak Width check box. 

Range: 0.5 through 9.0

Min Peak Height (S/N) For the valley detection approximation method to use the Nearest RT Peak Identification 
criteria, this peak signal-to-noise value must be equaled or exceeded. For component 
identification purposes, the TraceFinder application ignores all chromatogram peaks that 
have signal-to-noise values that are less than the S/N Threshold value. 

Range: 0.0 (all peaks) through 999.0

Noise Method The options are INCOS or Repetitive.

INCOS: Uses a single pass algorithm to determine the noise level. The ICIS peak detection 
algorithm uses this value. 

Repetitive: Uses a multiple pass algorithm to determine the noise level. The ICIS peak 
detection algorithm uses this value. In general, this algorithm is more accurate in analyzing 
the noise than the INCOS Noise algorithm, but the analysis takes longer. 

Table 14. ICIS peak detection page parameters  (Sheet 2 of 3)

Parameter Description
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Min Peak Width The minimum number of scans required in a peak. The ICIS peak detection algorithm uses 
this value.

Range: 0 to 100 scans
Default: 3

Multiplet Resolution The minimum separation in scans between the apexes of two potential peaks. This is a 
criteria to determine if two peaks are resolved. The ICIS peak detection algorithm uses this 
value.

Range: 1 to 500 scans
Default: 10 

Area Tail Extension The number of scans past the peak endpoint to use in averaging the intensity. The ICIS 
peak detection algorithm uses this value.

Range: 0 to 100 scans
Default: 5

Area Scan Window The number of allowable scans on each side of the peak apex. A zero value defines all scans 
(peak-start to peak-end) to be included in the area integration. 

Range: 0 to 100 scans
Default: 0 

RMS Specifies that the TraceFinder application calculate noise as RMS. By default, the 
application uses Peak To Peak for the noise calculation. RMS is automatically selected if you 
manually determine the noise region.

Table 14. ICIS peak detection page parameters  (Sheet 3 of 3)

Parameter Description
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Avalon Detection Method

The Avalon peak detection algorithm is designed for UV data. The Avalon peak detection 
algorithm also supports negative peaks. You can edit the Event values from the “Avalon Event 
List.” 

Figure 16. Avalon peak detection page

Table 15. Avalon peak detection page parameters 

Parameter Description

Sensitivity Specifies the Avalon peak detection algorithm.

Detection Method Highest peak: Uses the highest peak in the chromatogram for component identification. 

Nearest RT: Uses the peak with the nearest retention time in the chromatogram for 
component identification.

Smoothing Determines the degree of data smoothing to be performed on the active component peak 
prior to peak detection and integration. The ICIS peak detection algorithm uses this value.
Default: 1
Range: Any odd integer from 1 through 15 points

Time/Event/Value Displays the events specified in the Avalon Event List dialog box. Initially displays only the 
default events that cannot be edited or deleted.

Edit Opens the Avalon Event List dialog box where you can edit the Time/Event/Value 
parameters. See “Avalon Event List.” 
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Avalon Event List

The event list includes both user-defined and noneditable default events. The application 
displays the default events when you choose Avalon sensitivity. You cannot delete these events 
or change their time or values. For a detailed list of events and value ranges, see Event types.

Figure 17. Avalon Event List dialog box

Table 16. Avalon Event List dialog box parameters 

Parameter Description

Time (Min) Specifies the start time of the event.

Event Specifies the type of event. For a detailed list of events and value 
ranges, see “Event types.” 

Value Specifies the value of the event.

Add Adds a new event to the list with the current Time/Event/Value 
parameters.

Delete Removes the selected Time/Event/Value parameter from the event 
list.

Change Applies the current parameter values.

Cancel Closes the dialog box without making any changes. Any additions, 
deletions, or changes revert to their original state.

Apply Closes the dialog box.
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Figure 18. Event types

Table 17. Event type descriptions  (Sheet 1 of 2)

Event type Description

Start Threshold Specifies the threshold at the start of a peak. The Start Threshold is 
directly related to the RMS noise in the chromatogram.
Range: 0 to 999 999 999

End Threshold Specifies the threshold at the end of a peak. The End Threshold is 
directly related to the RMS noise in the chromatogram.
Range: 0 to 999 999 999

Area Threshold Controls the area cutoff. Any peaks with a final area less than the area 
threshold will not be detected. This control is in units of area for the 
data. 
Range: 0 to 999 999 999

P-P Threshold The peak-to-peak resolution threshold controls how much peak 
overlap must be present before two or more adjacent peaks create a 
peak cluster. Peak clusters have a baseline drop instead of 
valley-to-valley baselines. Specified as a percent of peak height 
overlap.
Range: 0.1 to 99.99

Negative Peaks Permits detection of a negative going peak. Automatically resets after 
finding a negative peak.
Valid values: On or Off

Bunch Factor Specifies the number of points grouped together during peak 
detection. This event controls the bunching of chromatographic 
points during integration and does not affect the final area 
calculation of the peak. A high bunch factor groups peaks into 
clusters.
Range: 0 to 999
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Tension Controls how closely the baseline should follow the overall shape of 
the chromatogram. A lower tension traces the baseline to more 
closely follow changes in the chromatogram. A high baseline tension 
follows the baseline less closely, over longer time intervals. 
Range: 0 to 999.99 minutes

Tangent Skim Using this event, you can tangent skim any peak clusters. By default, 
it chooses the tallest peak in a cluster as the parent. You can also 
identify which peak in the cluster is the parent. Tangent skim peaks 
are detected on either side (or both sides) of the parent peak. Tangent 
skim automatically resets at the end of the peak cluster.
Range: 0 to 1

Shoulders On Allows peak shoulders to be detected (peaks which are separated by 
an inflection rather than a valley) Sets a threshold for the derivative.

Shoulders Off Disables peak shoulder detection.
Range: 0 to 50

Force Cluster On Force the following peaks to be treated as a cluster (single peak).

Force Cluster Off End the forced clustering of peaks.

Disable Cluster On Prevent any peaks from being clustered.

Disable Cluster Off Permit clusters to occur again.

Table 17. Event type descriptions  (Sheet 2 of 2)

Event type Description
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Enabling Optional Features 

In the Application Configuration view of the Configuration mode, you can enable the 
following features:

• User Security

• Target Screening

• Quick Acquisition

• EPA Tune Criteria

• Compound Datastore

• Multiplexing

• Delay Calibration Calculation

• Batch Wizard Style

• Acquisition Submission Options
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 To open the Optional Features page

In the Application Configuration view, click Optional Features.

The Optional Features page of the Application Configuration view opens.



User Security

When user security is enabled, all users must log in to the TraceFinder application for access 
to only those modes assigned to their user role. See “Choosing User Roles” on page 46.

 To turn on user security

1. Select the User Security check box.

When this check box is selected, all users must log in to the TraceFinder application for 
access to the modes assigned to their user role. See “Choosing User Roles” on page 46. 
When user security is enabled, only users in the LabDirector or ITAdmin roles can access 
the Configuration mode.

When this check box is cleared, users are not required to log in to the TraceFinder 
application. When they start the application, the dashboard is the first screen that users 
see and all modes are available to them. The User Administration view in the 
Configuration mode is hidden from all users except those assigned the LabDirector or 
ITAdmin role.

2. Click Apply.

A message prompts you to restart the TraceFinder application so that your changes can 
take effect.

3. Click Yes.

Target Screening

You must have the ToxID application installed on your computer before you can generate 
Target Screening reports.

 To enable target screening

1. Select the Target Screening (ToxID) check box.

2. Click Apply.

A message prompts you to restart the TraceFinder application so that your changes can 
take effect.

3. Click Yes.

For a list of available target screening reports, see “Reports” on page 70.

IMPORTANT  If you are the administrator logging on with user security enabled, you 
can use Administrator/Password as the username/password. 
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Quick Acquisition

The quick acquisition option enables the Quick Acquisition feature in the Acquisition, 
Analysis, or Method Development mode.

 To enable quick acquisition

1. Select the Quick Acquisition (EnviroLab/ToxLab/QuanLab Forms) check box.

2. Click Apply.

A message prompts you to restart the TraceFinder application so that your changes can 
take effect.

3. Click Yes.

For a description of the Quick Acquisition features, see “Working with Master Methods” on 
page 100.

EPA Tune Criteria

When you select the EPA Tune Criteria option, the application supports Tune, Breakdown, 
and Tune/Breakdown sample types and MSTune and Breakdown compound types. This 
option changes the Breakdown method to a Tune/Breakdown method on the General page of 
the Master Method View and adds the Tune tab to the QAQC page of the Master Method 
View. 

 To enable the tune criteria

1. Select the EPA Tune Criteria check box.

By default, the EPA Tune Criteria option is selected.

2. Click Apply.

A message prompts you to restart the TraceFinder application so that your changes can 
take effect.

3. Click Yes.

For a description of the Tune/Breakdown method on the General page of the Master Method 
View, see “Editing the General Page” on page 121.

For a description of the Tune page on the QAQC page of the Master Method View, see 
“Editing the QAQC Page” on page 183.

Note  The Quick Acquisition feature is not available when you enable multiplexing. See 
“Multiplexing” on page 92.
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Compound Datastore

 To enable the compound datastore 

1. Select the Compound Datastore check box.

By default, the Compound Datastore option is not selected.

2. In the Application Configuration view, click Apply.

3. Click Yes.

The application implements the following changes:

• Displays the Acquisition List page on the Compounds page in the Master Method 
View. See “Editing the Compounds Page” on page 129.

• Displays the Compound Datastore task pane on the Configuration mode navigation 
pane. See “Compound Datastore” on page 55.

• Enables the Export SRM Data command in the Method Development mode. See 
“Exporting SRM Data” on page 227.

Multiplexing

The Multiplexing options are available only when you have installed the Power Modules. See 
“Installing the Power Modules” on page 13.

 To specify multiplexing features

1. Select the Multiplexing check box.

2. Choose 2 Channels or 4 Channels.

3. When you are using 2 channels, select a 1- or 2-arm autosampler configuration.

The 1 arm configuration enables channels 1 and 3; the 2 arm configuration enables 
channels 2 and 4.
When you use a 4-channel configuration, autosampler 1 uses channels 1 and 3 and 
autosampler 2 uses channels 2 and 4.

4. Click Apply.

A message prompts you to restart the TraceFinder application so that your changes can 
take effect.

5. Click Yes.

When you enable multiplexing, the following optional features are not available:
• Quick Acquisition
• Batch Template Wizard
• Single Sample Submission (Intelligent Sequencing)

The application uses multiplexing features in the Acquisition mode when you specify 
channels for a sample in a batch (see “Defining the Sample List” on page 255) or monitor an 
acquisition (see “Devices Page” on page 282).
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Delay Calibration Calculation

Use the Delay Calibration Calculation... option to make the application wait until it processes 
the last calibration sample in a batch before it calculates the calibration curve (faster) instead 
of recalculating the calibration curve after each calibration sample (more responsive). 

 To delay calculation of a calibration curve

1. Select the Delay Calibration Calculation... check box.

By default, this option is selected.

2. In the Application Configuration view, click Apply.

3. Click Yes.
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Batch Wizard Style

Use the Batch Wizard Style option to choose one of two styles for your batch wizard.

 To select a wizard style

1. In the Batch Wizard Style list, select a wizard style:

• Acquisition Batch Wizard: Adds the Acquisition mode to the navigation pane. This 
mode is similar to the Acquisition mode in the TraceFinder 1.1 application. See 
Chapter 5, “Using the Acquisition Mode.”  

When you enable multiplexing, the application automatically enables this wizard 
style.

• Batch Template Wizard: The default wizard style that is similar to the acquisition 
wizard in the EnviroLab Forms, ToxLab Forms, and QuanLab Forms applications. 
See “Creating a Batch Using the Batch Wizard” on page 331.

2. Click Apply.

A message prompts you to restart the TraceFinder application so that your changes can 
take effect.

3. Click Yes.

Acquisition Submission Options

To control acquisitions, you can enable full-sequence or single-sample submission options. 
When you submit batches from the Acquisition mode, development batches from the 
Method Development mode, or Quick Acquisition batches from any mode, they run in 
first-in-last-out order. The last batch submitted is the first batch to run unless you submit a 
batch as a priority batch in Acquisition mode.

• When you are using Full Sequence Submission, priority batches always run immediately 
after the currently acquiring batch completes.

• When you are using Single Sample Submission, priority batches always run immediately 
after the currently acquiring sample completes.

 To specify acquisition submission features

1. Select either the Full Sequence Submission or the Single Sample Submission option:

• Full Sequence Submission: Supports look-ahead features of the autosampler. When 
the instrument method specifies the look-ahead feature, the Tracefinder application 
functions like a multiplex driver and feeds the autosampler the next vial position.

Note  The Batch Template Wizard feature is not available when you enable 
multiplexing. See Multiplexing.
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When you submit a batch, the autosampler begins preparation for all sample 
injections when the pre-run condition begins. All samples in the batch must 
complete before other batches (even higher priority batches) can begin.

• Single Sample Submission: Supports intelligent-sequencing features. When you 
submit a batch, the autosampler begins preparing for one sample injection at a time. 
Higher priority batches can interrupt the sample sequence in the currently acquiring 
batch.

2. Click Apply.

A message prompts you to restart the TraceFinder application so that your changes can 
take effect.

3. Click Yes.

Note  The Single Sample Submission feature is not available when you enable 
multiplexing. See “Multiplexing” on page 92.
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4

Using the Method Development Mode

This chapter includes method development tasks assigned to the Supervisor or LabDirector 
role when user security is enabled.

From the Method Development mode, you can create a master method, an instrument 
method, or a simple development batch to test your instrument method. 

You can also use the Quick Acquisition feature to quickly submit a single sample from any 
view in the Method Development mode.

 To access the Method Development mode

Click Method Development from the dashboard or the navigation pane.

The Method Development navigation pane opens. For detailed descriptions of all the 
features on the Method Development navigation pane, see “Method Development 
navigation pane.” 

Contents

• Working with Master Methods

• Working with Instrument Methods

• Working with Development Batches

• Using Quick Acquisition
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Figure 19. Method Development navigation pane

Table 18. Method Development navigation pane commands  (Sheet 1 of 2)

Command Description

Method View See “Working with Master Methods” on page 100.

Create Method Opens the Create Master Method dialog box where you can choose the process that you 
want to use to start your master method. 

Open Method Opens the Open Master Method dialog box where you can choose a master method to 
open.

Available only when you select the Acquisition Batch Wizard 
as your wizard style in the Configuration mode.

Available only when you enable the Compound 
Datastore feature in the Configuration mode.
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Import Published 
Method

Opens the Import Published Method dialog box where you can select a published method 
to import.

Export SRM Data Writes the selected reaction monitoring (SRM) table to the following file:

…\Thermo\TraceFinder\2.1\EFS\Methods\methodname.xml

You can use this data in the instrument method editor when you open the TSQ 2.1 
application. This command is displayed only when you enable the Compound Datastore 
option in the Configuration mode. See “Compound Datastore” on page 92.

The compounds in the Acquisition List must contain at least one SRM experiment type.

Recent Files Displays recently saved master methods.

Instrument View See “Working with Instrument Methods” on page 228.

New Instrument 
Method

Opens the Instrument View where you can specify instrument settings for your configured 
instruments.

If the instrument that you want to use is not configured, close the TraceFinder application, 
configure the instrument, and then reopen the application. You cannot configure an 
instrument while the TraceFinder application is running.

Open Instrument 
Method

Opens a browser where you can choose an instrument method to open.

Development Batch See “Working with Development Batches” on page 235.

Select Batch Location Specifies a location to store temporary development batch raw data files.

New Sample List Removes acquired samples from your development batch so that you can start a new sample 
list.

Open Qual Browser Opens the Thermo Xcalibur Qual Browser where you can view the acquired raw data files.

Table 18. Method Development navigation pane commands  (Sheet 2 of 2)

Command Description
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Working with Master Methods
The TraceFinder application uses a master method to specify the nature and types of 
acquisition, processing, and reporting that occur with a batch of samples. When you are 
testing for compounds in an assay, you can create a method designed specifically for that type 
of application. 

A master method contains a list of compounds and settings for detecting, processing, and 
reporting those compounds. 

When you create a master method, the TraceFinder application uses the method to determine 
how the software works with a set of samples to provide a set of meaningful results. The 
application uses an instrument method to define how raw data is acquired. The rest of the 
master method defines how the raw data is processed, how the flags information evaluates the 
results, and how the reporting functionality defines the output for your data and results. 

The TraceFinder application applies your master method to a batch, which is a list of one or 
more samples to be processed and reported. Together, the master method and batch provide a 
workflow-oriented approach to the data processing and information reporting for batches of 
samples. 

To speed up the creation of master methods, you can create a method template. Using a 
method template helps you to develop methods faster because the TraceFinder application 
saves all of your commonly used method settings in a template, such as the number of 
confirming ions or the use of data-dependent data. 

This section includes instructions for the following tasks:

• Creating a New Master Method

• Editing a Master Method

• Creating a Method Template

• Importing Published Master Methods

• Exporting SRM Data
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Creating a New Master Method

To begin a master method, follow any of four different procedures in the Create Master 
Method dialog box:

• Creating a New Method with Method Forge

• Importing an Xcalibur Master Method

• Associating a Raw Data File

• Selecting Compounds from the Compound Datastore

With each procedure, you start the method in a specific way and then use the common 
features of the Master Method View to complete and save your master method.

Figure 20. Create Master Method dialog box

Available only when you enable the Compound Datastore feature in the Configuration mode.
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Creating a New Method with Method Forge

With Method Forge, you can create a new master method by manually selecting peaks, 
selecting multiple compounds, renaming peaks, or comparing mass spectra from the library 
searches. You can also choose to let the TraceFinder application automatically create a master 
method for you. For detailed descriptions of all the Method Forge parameters, see “Method 
Forge dialog box parameters” on page 108.

When the TraceFinder application automatically creates a master method for you, it performs 
the following functions:

• Reviews your raw data file and identifies compounds that are present in your sample. 

• Uses your mass spectral reference libraries to assign compound names and CAS numbers.

• Uses mass spectral information to select potential quantification and confirming ions and 
a reference mass spectrum for the compound. 

Follow these procedures:

• To automatically select compounds to create a new method

• To manually select compounds to create a new method

 To automatically select compounds to create a new method

1. From the Method View task pane, click Create Method.

The Create Master Method dialog box opens. See “Create Master Method dialog box” on 
page 101.

2. Select the Use Method Forge option and click OK.

The Method Forge dialog box opens. For detailed descriptions of all the features on the 
Method Forge dialog box, see “Method Forge dialog box” on page 108.

Use Method Forge to create a master method from an existing raw data file or to create a 
new raw data file to use for the master method. 

Note  When the identified peak is from an analog trace, the application does not perform 
a library search and does not identify any confirming ions.
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3. In the Method Forge dialog box, do one of the following:

Select the Use the Default Template option. 

–or–

Select the Select a Custom Template option and highlight your custom template in the 
Method template table.

For detailed instructions on creating a custom method template, see “Creating a Method 
Template” on page 216.

4. Select the Name the Master Method check box and type a name for your master method.

You can enter an existing method name and overwrite it when you create the method. If 
you do not specify a name, the application names the method for the raw data file used to 
create the method.

5. Select the Automatically Create the Master Method check box.

6. Specify a raw data file by doing one of the following:

a. In the Raw File Selection area, choose Use an Existing Raw Data File.

b. Click the browse button and locate a raw data file to use for the method.

c. Go to step 8.

–or–

a. In the Raw File Selection area, choose Acquire a New Raw Data File.

b. From the Instrument method list, select a method (.meth) file to use for acquiring the 
data.

c. In the Raw Filename box, type the name of the file where the TraceFinder application 
will write the raw data file.

d. In the Path box, type a path or click the browse button and locate a folder where the 
application will save the raw data file.

e. (Optional) Type a comment about the acquired sample or the data file.

7. If you chose to acquire a new raw data file, do one of the following:

Choose Manual Injection.

–or–

Specify the autosampler settings:

a. Choose Use Autosampler.

b. In the Vial Position box, type a vial position.

c. In the Injection Volume box, type an injection volume.

The minimum injection volume allowed is 0.1 μL; the maximum injection volume 
allowed is 5000 μL.
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8. To automatically create the master method, click OK (or Overwrite).

As the Method Forge creates the method, it displays the following status:

• For analog peaks, the Method Forge displays the detected peak as Peak@(RT)Analog. 
The Method Forge does not perform a library search for peaks found in analog traces.

• For mass spectral peaks, the Method Forge process searches the NIST library and 
displays the identified compound names instead of the peak times.

When the acquisition completes, Method Forge performs peak detection, datastore 
searching (except for analog peaks), and identification of characteristic ion and reference 
spectrum. Method Forge then loads this information into a new master method. This 
process occurs immediately if you selected a previously acquired raw data file.

If the compounds in the raw data file that you used to create the method are not in the 
current compound datastore, the TraceFinder application displays the compounds in the 
Edit Compound Dependent Parameters dialog box.

9. (Optional) Select the compounds that you want to add to the compound datastore and 
click Add to CDS.

The selected compounds are added to the current compound datastore.

Note  You must click Add to CDS before you continue to the method.
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10. To use these compounds in your method and close the dialog box, click Continue to 
Method.

The TraceFinder application uses all compounds found in the raw data file in your 
method and displays the General page of the Master Method View. For detailed 
descriptions of all the features on the General page, see “General page” on page 126.

11. From the Instrument Method list on the General page, select an instrument method.

12. From the Qualitative Peak Processing Template list, select a method template for 
performing peak detection on quantitative samples following target compound analysis.

13. From the Background Subtraction Range Option list, select how you want the 
background subtraction range determined from one of these options:

• Before Peak: Averages and subtracts a specified number of scans before the apex of 
the peak.

• After Peak: Subtracts a specified number of scans following the apex of the peak.

• Both Sides of Peak: Subtracts a specified number of scans from each side of the apex 
of the peak.

14. To save the new method, choose File > Save from the main menu.

For a detailed description of how to modify a master method, see “Editing a Master 
Method” on page 119.
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 To manually select compounds to create a new method

1. From the Method View task pane, click Create Method.

The Create Master Method dialog box opens. See “Create Master Method dialog box” on 
page 101.

2. Select the Use Method Forge option and click OK.

The Method Forge dialog box opens. For detailed descriptions of all the features on the 
Method Forge dialog box, see “Importing an Xcalibur Master Method” on page 110.

3. Do one of the following:

Select the Use the Default Template option. 

–or–

Select the Select a Custom Template option and highlight your custom template in the 
Method Template table.

For detailed instructions about creating a custom method template, see “Creating a 
Method Template” on page 216.

4. Select the Name the Master Method check box and type a name for your master method.

You can enter an existing method name and overwrite it when you create the method. If 
you do not specify a name, the method is named for the raw data file used to create the 
method.

5. Ensure that the Automatically Create the Master Method check box is not selected.

6. To select a raw data file, click the browse button and locate the file.
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7. To manually create the master method, click OK (or Overwrite).

The Master Method View displays a list of possible matches in the Library Results pane. 
The TraceFinder application displays the best match in the Compound Name list and 
displays the peak spectrum for that compound.

8. To use a compound other than the compound chosen by the TraceFinder application, 
scroll to the spectrum for that compound and select the compound name in the header of 
the spectrum pane. 

Selected 
compound
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9. After you manually select your compound, click Create to create the master method. 

The TraceFinder application uses all compounds found in the raw data file in your 
method and displays the General page of the Master Method View. For detailed 
descriptions of all the features on the General page, see “General page” on page 126.

10. From the Instrument Method list on the General page, select an instrument method.

11. To save the new method, choose File > Save from the main menu.

For a detailed description of how to modify a master method, see “Editing a Master 
Method” on page 119. 

Figure 21. Method Forge dialog box

Table 19. Method Forge dialog box parameters  (Sheet 1 of 2)

Parameter Description

Method template selection

Use the Default 
Template

Creates a new method with the default template.

Select a Custom 
Template

Lists all the available method templates.

For detailed instructions about creating a custom method template, see “Creating a Method 
Template” on page 216.
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Name the Master 
Method

The name for the new master method.

Automatically Create 
the Master Method

When the acquisition completes, Method Forge performs peak detection, library searching, 
and identification of characteristic ion and reference spectrum. This information is loaded 
into a new master method. This process occurs immediately when you specify an existing 
raw data file.

Raw file selection

Use an Existing Raw 
Data File

Enables the Raw Filename box where you can select a raw data file used in creating the 
master method.

Acquire a New Raw 
Data File

Enables functions to acquire data to create a raw data file used in creating the master 
method.

Instrument 
Method

The saved method (.meth) file used for acquiring the data.

Raw Filename The file name where the TraceFinder application writes the raw data.
Path The location where the TraceFinder application saves the raw data file.
Sample Comment (Optional) A comment about the acquired sample or the data file.

Manual Injection Performs a manual acquisition.
Use Autosampler Performs an autosampler acquisition.
Vial Position The tray vial number used for the autosampler acquisition.
Injection Amount The volume (in milliliters) injected by the autosampler acquisition.
Function button

Overwrite Overwrites the specified master method name. This function is enabled only when the 
specified master method name already exists.

OK Creates a master method using the data and parameters that you specified.
Cancel Closes Method Forge and does not create a master method.

Table 19. Method Forge dialog box parameters  (Sheet 2 of 2)

Parameter Description
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Importing an Xcalibur Master Method

You can create a new master method from an existing Xcalibur processing method.

 To import an Xcalibur master method

1. From the Method View task pane, click Create Method.

The Create Master Method dialog box opens. See “Create Master Method dialog box” on 
page 101.

2. Select the Import Xcalibur Processing Method option and click OK.

The Import an Xcalibur Method dialog box opens.

3. Click the browse button for the Xcalibur Method to Import box, browse to the Xcalibur 
processing method file, and open the file.

The TraceFinder application imports the compound information from the Xcalibur 
method file.
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4. (Optional) Click the browse button for the Raw Data File to Associate box, browse to a 
raw data file to associate with the method (or select from the list of previously associated 
raw data files), and open the file.

To assure that this raw data file is always available to the method (for example, if you 
move the method to another system), the application saves the raw data file in the method 
folder:

C:\Thermo\TraceFinder\2.1\EFS\Methods\MethodName

5. (Optional) Change the number of decimal places in the Mass Precision box.

You can set the number of mass precision decimal places to any integer between 2 and 6, 
inclusive.

6. Click OK.

If the compounds in the imported Xcalibur method file are not in the Compound 
Datastore, the TraceFinder application displays the compounds in the Edit Compound 
Dependent Parameters dialog box.

Note  When you associate a raw data file, the application reads the filter precision 
from the associated file so that you cannot change the Filter Precision value.



4 Using the Method Development Mode
Working with Master Methods

112 TraceFinder User Guide Thermo Scientific

7. (Optional) Select the compounds that you want to add to the Compound Datastore and 
click Add to CDS.

The selected compounds are added to the current compound datastore.

To add these compounds to the datastore, you must click Add to CDS before you 
continue to the method. When you click Continue to Method, the Edit Compound 
Dependent Parameters dialog box closes and you cannot return to add the compounds.

8. To add these compounds to your method and close the dialog box, click Continue to 
Method.

The TraceFinder application adds all compounds found in the imported Xcalibur method 
and displays the General page of the Master Method View. For detailed descriptions of all 
the features on the General page, see “General page” on page 126.

9. From the Instrument Method list on the General page, select an instrument method.

10. To save the new method, choose File > Save from the main menu.

For a detailed description of how to modify a master method, see “Editing a Master 
Method” on page 119. 
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Associating a Raw Data File

You can use the compounds in a previously acquired raw data file to create a new master 
method.

Follow these procedures:

• To associate a raw data file with the method

• To add compounds to the method

 To associate a raw data file with the method

1. From the Method View task pane, click Create Method.

The Create Master Method dialog box opens. See “Create Master Method dialog box” on 
page 101.

2. Select the Associate a Raw Data File option and click OK.

The Associate a Raw Data File dialog box opens.
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3. Browse to a raw data file to associate with the method (or select from the list of previously 
associated raw data files) and open the file.

To assure that this raw data file is always available to the method (for example, if you 
move the method to another system), the application saves the raw data file in the method 
folder:

C:\Thermo\TraceFinder\2.1\EFS\Methods

4. Select the update options to use for creating your method:

• Update Instrument/Trace Selections: Reads the Detector and Trace options from 
the associated raw data file. On the Detection page, only detector types and traces 
that are defined in the raw data file are available. For detailed descriptions of the 
available Detector and Trace values, see “Signal” on page 150.

• Update Target Ion Ratio Values: Reads the ion ratio values from the associated raw 
data file.

• Update Scan Filters for All Peaks: Updates all peaks with scan filters from the 
associated raw data file.

• Automatically Set Reference Spectrum: Reads a reference spectrum from the 
associated raw data file.

Options that are set to No use the standard values in the method. 

5. Click OK.

The TraceFinder application displays the General page of the Master Method View. For 
detailed descriptions of all the features on the General page, see “General page” on 
page 126.

6. From the Instrument Method list on the General page, select an instrument method.

7. To add compounds to the method, follow the instructions “To add compounds to the 
method” on page 115.

To save the method, it must include at least one compound.

8. To save the new method, choose File > Save from the main menu.

For a detailed description of how to modify a master method, see “Editing a Master 
Method” on page 119. 



 4 Using the Method Development Mode
Working with Master Methods

Thermo Scientific TraceFinder User Guide 115

 To add compounds to the method

1. Click the Compounds tab. 

The Detection page is selected by default.

The Detection page shows an empty Compound list and displays the chromatographic 
data for the compounds in the raw data file.

2. Select a filter from the Filter list.

3. Select the peak in the chromatogram that represents the compound that you want to add 
to the method. 

4. Right-click and choose Add This Peak as New Compound from the shortcut menu.

The TraceFinder application performs a library search for the selected compound. The 
application uses the first match it finds as the compound name, the base peak of the mass 
spectrum as the quantitative peak, and the second and third largest ions as the confirming 
ion peaks. 

Note  When the Compound Datastore is enabled, the Compounds page includes an 
Acquisition List tab. See “Enabling Optional Features” on page 88.

Note  When the peak is from an analog trace, the application does not perform a 
library search and does not identify any confirming ions.
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If the name of the first match is already in the library, the Add New Compound dialog 
box opens.

5. (Optional) Do the following:

a. To use a compound other than the compound already in the library, scroll to the 
spectrum for that compound and select the compound name in the title bar of the 
spectrum pane.

b. In the Type of Compound to Add list, select a compound type.

c. Click OK.

Selected 
compound
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6. Repeat this procedure for each compound that you want to add to the method.

For detailed descriptions of all the features on the Detection page, see “Editing the 
Compounds Page” on page 129. 

For detailed descriptions of how to modify a master method, see “Editing a Master 
Method” on page 119. 

Selecting Compounds from the Compound Datastore

You can select compounds from the compound datastore to create a new master method. This 
method for creating a master method is available only when the compound datastore is 
enabled. See “Compound Datastore” on page 92.

 To select compounds from the datastore

1. From the Method View task pane, click Create Method.

The Create Master Method dialog box opens.

2. Select the Select Compounds from CDS option and click OK.

The Select Compounds to Add dialog box opens, listing all the compounds defined in the 
compound datastore.

3. Select the check box for each of the compounds that you want to add to the method.
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4. To quickly select multiple compounds, right-click and use any of the commands on the 
shortcut menu.

5. Click Apply.

The TraceFinder application adds the selected compounds to the method. 

6. From the Instrument Method list on the General page, select an instrument method.

7. To save the new method, choose File > Save from the main menu.

For a detailed description of how to modify a master method, see “Editing a Master 
Method.” 

Table 20. Select Compounds to Add shortcut menu commands

Command Description

Select All Selects all compounds in the compound datastore.

Deselect All Clears all compounds in the compound datastore.

Copy Down Copies the state (checked or cleared) of the currently selected 
compound to all compounds below it in the compound list.

Note  After you add a compound to a method, the compound is no longer enabled in 
the Select Compounds to Add dialog box. You cannot remove the applied compounds 
from the method by returning to this dialog box. To remove a compound from a 
method, see “Acquisition List” on page 129.
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Editing a Master Method

You can open a master method to view or edit the compounds, method instructions, and 
reporting options in the method.

This section includes instructions for the following tasks:

• Opening a Master Method

• Editing the General Page

• Editing the Compounds Page

• Editing the QAQC Page

• Editing the Groups Page

• Editing the Reports Page

Opening a Master Method

Use the TraceFinder application to open a master method that was created and saved in the 
current TraceFinder application or converted from these legacy applications: TraceFinder, 
EnviroLab Forms, QuanLab Forms, or ToxLab Forms. To convert legacy methods, see 
“Converting Legacy Data” on page 19.

 To open a saved master method

1. Click Method Development from the dashboard or the navigation pane.

The Method Development navigation pane opens.

2. In the Method View task pane, do one of the following:

Click Open Method.

–or–

Click a method name in the Recent Files list. 

When you save a method, the application adds it to the Recent Files list. The Recent Files 
list displays a list of your most recently saved master method files.
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The Open Master Method dialog box opens, displaying all available methods.

3. Select a master method and click Open.

The TraceFinder application copies all components of the selected method including its 
associated instrument method. 

The General page for the selected method opens in the Method View. For detailed 
descriptions of all the features on the General page, see “General page” on page 126.
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Editing the General Page

The General page defines basic information about the master method. For detailed 
descriptions of all the features on the General page, see “General page” on page 126.

Follow these procedures:

• To specify general information for a master method

• To edit the instrument method parameters

• To select a qualitative peak processing template

• To set automated background subtraction options

• To specify a chromatogram reference sample

• To specify mass tolerance

 To specify general information for a master method

1. In the Lab Name box, type the name to be displayed on the top of each printed, saved, or 
exported report.

The default name is Default Laboratory.

2. In the Assay Type box, type the assay type to be targeted by the method.

3. From the Injection Volume box, select the injection volume (in μL) to be used for sample 
injection.

Use the up/down arrows to change the volume in increments/decrements of 1 μL, or use 
the keyboard to enter non-integer injection volumes. 

4. From the Ion Range Calc Method list, select a method for calculating the ion ratio range 
windows.

When you select Level, the TraceFinder application displays a Use Level list where you 
can choose a calibration level. To define the calibration levels on the Compounds page, 
see “Editing the Compounds Page” on page 129.

5. From the Qualitative Peak Processing Template box, select a template for performing 
peak detection on quantitative samples after target compound analysis is complete.

IMPORTANT  The TraceFinder application uses this injection volume in the master 
method, not the injection volume from the instrument method.
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 To edit the instrument method parameters

1. From the Instrument Method list on the General page, select an instrument method. 

2. To edit the instrument method for this master method, click Edit.

The Thermo Xcalibur Instrument Setup dialog box opens. This example of an 
instrument setup shows multiple configured instruments.

3. Edit the values on the instrument page for your instrument.

4. From the main menu in the Thermo Xcalibur Instrument Setup dialog box, 
choose File > Save and then choose File > Exit.

The TraceFinder application returns you to the General page. See “General page” on 
page 126.
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5. To update any changes that were made to the instrument method after you created this 
master method, click Update.

The Update Instrument Method? dialog box opens.

6. Choose one of the following options:

• Send to Xcalibur Method: Overwrites the instrument method in the 
C:\Xcalibur\methods folder with the current instrument method.

• Get From Xcalibur Method: Overwrites the current instrument method with the 
instrument method in the C:\Xcalibur\methods folder.

• Cancel: Make no changes to the instrument method in the current master method.

 To select a qualitative peak processing template

In the Qualitative Peak Processing Template list, select the template that you want to use 
to perform peak detection on quantitative samples after compound analysis is complete.

The application lists all method templates (.pmtx files) in the following folder:

C:\Thermo\TraceFinder\2.1\EFSTemplates\Methods

 To set automated background subtraction options

1. In the Background Subtraction Range Option list, select how you want the subtraction 
range determined from the following options:

• Before Peak: Averages and subtracts a specified number of scans before the apex of 
the peak.

• After Peak: Subtracts a specified number of scans after the apex of the peak.

• Both Sides of Peak: Subtracts a specified number of scans from each side of the apex 
of the peak.

2. In the Number of Scans to Subtract box, enter a number.

This is the number of scans that the TraceFinder application subtracts from the 
background after averaging. If you selected the Both Sides of Peak option, the application 
subtracts this number of scans from each side of the peak.
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3. In the Stepoff Value box, enter a number.

The TraceFinder application uses this offset value to average and subtract scans that are 
not adjacent to the apex of the peak. For example:

If you entered 3 in the Number of Scans to Subtract box and the stepoff value is 5, the 
TraceFinder application ignores the first 5 scans to the left of the peak and applies the 
averaging and subtraction to the 6th, 7th, and 8th scans to the left of the peak.

 To specify a chromatogram reference sample

1. In the Set Chromatogram Reference Sample list, select External.

2. Click Select.

The Open Chromatograph Reference Sample dialog box opens.

3. Select a project from the list of projects.

4. Select a subproject from the list of subprojects.

5. Select a batch from the list of batches.

The TraceFinder application displays only batches that were created using the current 
master method. 

Note  If you are creating a new method, you will not see any reference samples here. 
You must create and save a batch using the current method to see the reference 
samples in this list.
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6. Select a sample from the list of processed samples.

The TraceFinder application displays all the processed samples in the selected batch. To 
use a sample as a reference sample, the sample must have been processed with the current 
master method.

7. Click Open.

The selected sample is displayed as the chromatogram reference sample in the Master 
Method View.

 To specify mass tolerance

1. Select the units of measure that you want to use. 

2. Specify the number of millimass units or parts per million to use as the m/z ± tolerance 
value.

The application applies this mass tolerance to the extracted chromatograms.

Tip  To clear the reference sample from the master method, select None in the Set 
Chromatogram Reference Sample list.
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Figure 22. General page
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Table 21. General page parameters  (Sheet 1 of 2)

Parameter Description

Lab Name The laboratory name to be displayed on the top of each printed, saved, or exported report. 
Default: Default Laboratory
To specify this default laboratory name, see “Specifying Configuration Defaults” on 
page 73.

Assay Type The name for the analysis type to be targeted by the method. The assay type associates the 
method with the analysis of a compound or specific class of compounds (for example, you 
might use an assay type of PAH for the analysis of Polynuclear Aromatic Hydrocarbons).

Injection Volume The system uses the injection volume (in μL) for sample injection. For a more detailed 
explanation, refer to the documentation for the autosampler.

The injection volume in the master method overrides the injection volume in the 
instrument method. 

The injection volume in the batch overrides the injection volume in the master method.

Range: 0.1 through 5000 μL

Mass Precision Number of decimal places used in reports and in peak and spectrum displays. 
Valid values: Integers from 2 to 6, inclusive.

Ion Range Calc 
Method

The TraceFinder application uses the selected ion range calc method to calculate the ion 
ratio range windows: Manual (default), Average, Level, or Weighted average. When you 
select Level, an additional list is displayed where you can select a calibration level amount. 
To define these calibration levels on the Compounds page, see “Editing the Compounds 
Page” on page 129.

Instrument Method Instrument method used for acquiring samples.

Tune/Breakdown Breakdown or tune method used for processing samples.

Edit Opens the Thermo Xcalibur Instrument Setup dialog box where you can edit the 
instrument method.

Update Choose one of the following:

Send to Xcalibur Method: Overwrites the Xcalibur method with the current instrument 
method.

Get From Xcalibur Method: Overwrites the current instrument method with the Xcalibur 
method.

Qualitative Peak 
Processing Template

The TraceFinder application uses the qualitative peak processing template to perform peak 
detection on quantitative samples following compound analysis.

Background 
Subtraction Range 
Option

Valid values: None, Before Peak, After Peak, Both Sides of Peak
Default: None
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Number of Scans to 
Subtract

Valid values: Even numbered integers
Default: 0

Stepoff Value Offset from the selected peak to the first subtracted peak.

Set Chromatogram 
Reference Sample 

Valid values: None, External
Default: None

Set Reference Sample This parameter is enabled only when you set Set Chromatogram Reference Sample to 
External. Click Select to choose a reference sample from the project folders.

Mass Tolerance Upper limit of MMU or PPM.
Default: 500
Range: 0.1 through 50 000

• (Default) MMU (millimass units): MMU is a static calculation to the extracted mass.

• PPM (parts per million): PPM is a variable calculation dependent on the actual mass. 
The smaller the mass, the narrower the tolerance range. The larger the mass, the wider 
the tolerance range.

Notes  Optional notes about the method.

Table 21. General page parameters  (Sheet 2 of 2)

Parameter Description



 4 Using the Method Development Mode
Working with Master Methods

Thermo Scientific TraceFinder User Guide 129

Editing the Compounds Page

Use the Compounds page to set all parameters used to identify, detect, and quantify the target 
compound list. 

From the Compounds page of the Master Method View, you can access the following pages:

Each page on the Compounds page (except the Acquisition List and Real Time Viewer pages) 
uses a right-click shortcut menu. See “Using the Shortcut Menu Commands” on page 181.

Acquisition List

The Acquisition List page displays all compounds defined for the current method. From this 
page, you can add or delete compounds from the method. For detailed descriptions of all the 
features on the Acquisition List page, see “Acquisition List page parameters” on page 131.

The Acquisition List page is displayed only when you enable the Compound Datastore option 
in the Configuration mode. See “Compound Datastore” on page 92.

Follow these procedures:

• To filter the compound list

• To delete a compound from the list

• To add a compound to the list

 To filter the compound list

1. To display a filtered list of compounds, click the funnel icon, , in the column header.

The application displays a list of filterable criteria. In all lists, you can choose to filter by 
All, Blanks, NonBlanks, or by custom filter criteria. Other filter criteria are specific to the 
individual columns.

2. To create a custom filter based on compound values in a specific column, choose Custom 
from the column list.

For detailed instructions about creating a custom filter, see Appendix C, “Using Filter 
Criteria.” 

Acquisition List See also “Acquisition List page parameters” on page 131.

Identification See also “Identification page parameters” on page 134.

Detection See also “Detection page panes” on page 147.

Calibration See also “Calibration page parameters” on page 173.

Calibration Levels See also “Calibration levels page parameters” on page 176.

QC Levels See also “QC levels page parameters” on page 178.

Real Time Viewer See also “Real Time Viewer page parameters” on page 179.
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 To delete a compound from the list 

1. Select the compound to remove from the list.

2. Click the Remove Compound icon, , or right-click and choose Remove 
Compound from the shortcut menu.

A confirmation dialog box opens, listing the compound to be removed.

3. To confirm the deletion, click Yes.

The selected compound is removed from the acquisition list, which has no effect on the 
compound datastore.

 To add a compound to the list

1. Click the Add Compound icon, , or right-click and choose Add Compound from 
the shortcut menu.

The Select Compounds to Add dialog box opens, listing all the compounds defined in the 
compound datastore.

2. Select the check box for each of the compounds that you want to add to the method.

3. To quickly select multiple compounds, right-click and use any of the commands on the 
shortcut menu.

4. Click Apply.

The TraceFinder application adds the compounds to the Acquisition List page of the 
Master Method View. See “Acquisition List page.” 

Table 22. Select Compounds to Add shortcut menu commands

Command Description

Select All Selects all compounds in the compound datastore.

Deselect All Clears all compounds in the compound datastore.

Copy Down Copies the state (checked or cleared) of the currently selected 
compound to all compounds below it in the compound list.
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Figure 23. Acquisition List page

Table 23. Acquisition List page parameters  (Sheet 1 of 2)

Parameter Description

Function Icons

Opens the Select Compounds to Add dialog box that lists all the compounds defined in the 
compound datastore.

Deletes the selected compound. The icon is unavailable when no row is selected. If you used 
the filters to display a subset of compounds, the selected compound might not be visible on 
the Acquisition List page. 

Compound parameters

Compound Name Alphanumeric name assigned to the compound.

Experiment Type Experiment type: SRM, XIC, or SIM.

Category (Optional) Alphanumeric identifier. 

Ionization (Optional) Alphanumeric identifier. 
Valid values: ESI, APCI, EI, CI, or APPI

Chemical Formula (Optional) Alphanumeric chemical identifier.

Quantitative peak parameters

Precursor Mass The mass-to-charge ratio of a precursor ion. The location of the center of a target 
precursor-ion peak in mass-to-charge ratio (m/z) units. 
Available only for SRM experiments.
Range: 10.000 to 2999.999

Product Mass The mass-to-charge ratio of the quantitation ion. The location of the center of a target 
quan-ion peak in mass-to-charge ratio (m/z) units. 
Available only for SRM experiments.
Range: 10.000 to 2999.999

Mass The mass-to-charge ratio of the quantitation ion. The location of the center of a target 
quan-ion peak in mass-to-charge ratio (m/z) units. 
Available only for XIC and SIM experiments.
Range: 10.000 to 2999.999
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Collision Energy The energy used when ions collide with the collision gas. 
Range: –250 to 250

Lens (Optional) Range: –400 to 400

Polarity + (positive) or – (negative)

RT (min) Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

The TraceFinder application uses the RT and Window values to determine the start and stop 
time for the acquisition. 
Range: 0.00 to 999.00
Start time = RT – (Window/2)
Stop time = RT + (Window/2)
Start and stop range: 0.00 to 999.00

Window (sec) Acquisition window. The TraceFinder application uses the RT and Window values to 
determine the start and stop time for the acquisition. 
Range: 0.00 to 499.50
Start time = RT – (Window/2)
Stop time = RT + (Window/2)
Start and stop range: 0.00 to 999.00

Energy Ramp Available only for SRM experiments.
Range: 0.00 to 200.00

Confirming ion parameters

Precursor Mass The mass-to-charge ratio of a precursor ion. The location of the center of a target 
precursor-ion peak in mass-to-charge ratio (m/z) units. 
Available as a read-only field for SRM experiments only.
Range: 10.000 to 2999.999

Product Mass The mass-to-charge ratio of the quantitation ion. The location of the center of a target 
quan-ion peak in mass-to-charge ratio (m/z) units. 
Available only for SRM experiments.
Range: 10.000 to 2999.999

Mass The mass-to-charge ratio of the quantitation ion. The location of the center of a target 
quan-ion peak in mass-to-charge ratio (m/z) units. 
Available only for XIC and SIM experiments.
Range: 10.000 to 2999.999

Collision Energy The energy used when ions collide with the collision gas. 
Available only for SRM experiments.
Range: –250.00 to 250.00

Table 23. Acquisition List page parameters  (Sheet 2 of 2)

Parameter Description
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Identification

The Identification page lists the compounds that are targeted for analysis, reporting, and other 
compound-specific values. For descriptions of all values on the Identification page, see 
“Identification page.” 

 To filter the displayed compounds

From the Show list, select the type of compounds that you want to display in the 
compounds list.

Compound type Description

Quan Compounds Displays only quantitation compounds, such as target 
compounds, internal standards, and surrogates. 

Non Quan Compounds Displays only non-quantitation compounds, such as 
native, breakdown, and tune compounds.

Target Compounds Displays only target compounds.

Internal Standards Displays only internal standard compounds.

Surrogates Displays only surrogate compounds.
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Figure 24. Identification page

 

Table 24. Identification page parameters 

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

The TraceFinder application uses the RT and Window values to determine the start and 
stop time for the acquisition. 
Range: 0.00 to 999.00
Start time = RT – (Window/2)
Stop time = RT + (Window/2)
Start and stop range: 0.00 to 999.00

Compound A list of identified compounds. To customize the compound names, click the cell and type a 
new name. To display a filtered list of compounds, use the Show list.

Compound Type Compound types are Target Compound, Internal Standard, Surrogate, MSTune, Native, 
and Breakdown. The TraceFinder application uses target compounds, internal standards, 
and surrogates in quantitative analysis.

Active Identifies each compound to be included in data review and reporting. By default, all added 
compounds are set to active. This active or inactive setting populates the Batch View and 
Data Review view in the Analysis mode. 

CAS No The Chemical Abstract Service (CAS) number that the TraceFinder application matched 
with each compound. To change or add a number, click the CAS No cell and enter a new 
number.

Use as RT Reference When performing peak detection with retention time standards, the TraceFinder 
application first identifies those compounds identified as retention time standards and then 
uses their observed retention times to adjust any associated target compound.

Reference Compound To be used for retention time adjustment for a compound. This list includes all compounds 
that are selected in the Use as RT Reference column. 

Shortcut menu The Identification page uses a right-click shortcut menu. See “Using the Shortcut Menu 
Commands” on page 181.
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Detection

Use the Detection page to customize peak detection and integration for any ions that define 
peaks and compounds.

From the Detection page, you can access the following pages:

On the Detection page (see “Detection page” on page 146), you can configure how 
characteristic ions for targeted compounds are detected and integrated. You can also edit the 
list of characteristic ions for a specific compound. Refining these parameters in the master 
method for each compound and its ions can reduce the degree of manual integration that 
would otherwise be required. 

You can change the parameters used to identify a quantitative peak, mass range, or confirming 
ion peak. The TraceFinder application automatically uses the first match it finds as the 
compound name, the base peak of the mass spectrum as the quantitative peak, and the second 
and third largest ions as the confirming ion peaks. 

Follow these procedures:

• To filter the displayed compounds

• To change the displayed information for detected peaks

• To add compounds to the method

• To change the compound reference spectrum

• To replace a quantitation mass

• To add a mass to the existing quantitation mass ranges

• To add a quantitative peak

• To add a spectral peak as a new compound

• To replace a quantitative peak with a confirming ion peak

• To set a confirming ion peak as an additional quantitative peak

• To use the cut-and-paste feature on confirming ion peaks

• To add a trace to the real-time viewer

• To replace a confirming ion peak

• To add a mass as a new confirming ion peak

• To save the new method

Times See also “Times page parameters” on page 148.

Signal See also “Signal page parameters” on page 154.

Detect See also “Detect page parameters for Genesis” on page 158.
See also “Detect page parameters for ICIS” on page 162.
See also “Detect page parameters for Avalon” on page 164.

Spectrum See also “Spectrum shortcut menu commands” on page 170.

Ratios See also “Ratios page parameters” on page 172.
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 To filter the displayed compounds

From the Show list, select the type of compounds that you want to display in the 
compounds list.

 To change the displayed information for detected peaks

1. Right-click the chromatogram plot for any of the peaks and hold the cursor over Peak 
Labels.

2. Choose to display labels for the peak area, peak retention time, peak height, or signal to 
noise.

3. To remove a label, select the label type again and clear it.

The application globally applies these label settings to all quantitative peaks, confirming 
peaks, and internal standard peaks in the method. 

Compound type Description

Quan Compounds Displays only quantitation compounds, such as target 
compounds, internal standards, and surrogates. 

Non Quan Compounds Displays only non-quantitation compounds, such as 
native, breakdown, and tune compounds.

Target Compounds Displays only target compounds.
Internal Standards Displays only internal standard compounds.
Surrogates Displays only surrogate compounds.
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 To add compounds to the method

1. From the main menu, choose Master Method > Associate a Raw Data File.

The Associate a Raw Data File dialog box opens.

2. Browse to a raw data file to associate with the method (or select from the list of previously 
associated raw data files) and open the file.

To assure that this raw data file is always available to the method (for example, if you 
move the method to another system), the application saves the raw data file in the method 
folder:

C:\Thermo\TraceFinder\2.1\EFS\Methods

3. To update the target ion ratio values when you associate this raw data file, select the Yes 
option.

4. To update the scan filters when you associate this raw data file, select the Yes option.

5. To set a reference spectrum, do one of the following:

Select the Yes option.

–or–

Select the Yes, with Background Subtraction option.

This feature is available only when you have set background subtraction values on the 
General page of the Master Method View. See “Editing the General Page” on page 121.

6. Click OK.
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The TraceFinder application displays the chromatographic and spectrum data for the 
compounds in the selected raw data file. 

7. Select a filter from the Filter list.

8. Click to select the peak in the chromatogram that represents the compound that you 
want to add to the method. 

9. Right-click and choose Add This Peak as New Compound from the shortcut menu.

The TraceFinder application performs a library search for the selected compound. The 
application uses the first match it finds as the compound name, the base peak of the mass 
spectrum as the quantitative peak, and the second and third largest ions as the confirming 
ion peaks. 

If the name of the first match is already in the library, the Add New Compound dialog 
box opens.
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Figure 25. Add New Compound dialog box

10. (Optional) To use a compound other than the compound already in the library, scroll to 
the spectrum for that compound and select the compound name in the title bar of the 
spectrum pane.

11. In the Type of Compound to Add list, select a compound type.

12. Click OK.

13. Repeat this procedure for each compound that you want to add to the method.

Selected 
compound
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 To change the compound reference spectrum

1. In the raw data file chromatogram pane, click a peak.

The TraceFinder application displays the spectrum for the selected peak in the spectrum 
pane.

2. In the raw data file spectrum pane, right-click and choose Use This Spectrum for 
Compound Reference Spectrum from the shortcut menu.

The TraceFinder application replaces the spectrum on the Spectrum page of the 
quantitative peak pane with this spectrum.

 To replace a quantitation mass 

1. Click the pane for the quantitation mass that you want to replace. 

2. In the raw data file spectrum pane, hold the cursor over a peak.

The red box indicates the selected peak.

3. Right-click and choose Set This Spectral Peak as Quan Value from the shortcut menu.

4. Choose either Don’t Update Ion Ratios or Update Ion Ratios Using This Spectrum.

You can see the updated ion ratios on the Ratios page for the confirming ion peaks. See 
“Ratios” on page 171.

 To add a mass to the existing quantitation mass ranges

1. In the raw data file spectrum pane, hold the cursor over a peak.

The red box indicates the selected peak.

2. Right-click and choose Add This Spectral Peak to Existing Quan Ranges from the 
shortcut menu.

3. Choose either Don’t Update Ion Ratios or Update Ion Ratios Using This Spectrum.

The TraceFinder application adds the selected mass to the existing quantitation mass 
ranges to increase the signal. 

If you chose to update the ion ratios, you can see the updated ion ratios on the Ratios 
page for the confirming ion peaks. See “Ratios” on page 171.
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 To add a quantitative peak

1. In the raw data file spectrum pane, hold the cursor over a peak.

The red box indicates the selected peak.

2. Right-click and choose Add This Spectral Peak as New Quan Peak from the shortcut 
menu.

The application adds a new quantitative peak to the compound.

You can use the shortcut menu in the spectrum pane for this new quantitative peak to 
perform any of the tasks that you would perform on the original quantitative peak.

 To add a spectral peak as a new compound

1. In the raw data file spectrum pane, hold the cursor over a peak.

The red box indicates the selected peak.

2. Right-click and choose Add This Spectral Peak as New Compound from the shortcut 
menu.

The TraceFinder application performs a library search for the selected compound. The 
application uses the first match it finds as the compound name, the base peak of the mass 
spectrum as the quantitative peak, and the second and third largest ions as the confirming 
ion peaks. 

When there are multiple matches, the Add New Compound dialog box opens. See “Add 
New Compound dialog box” on page 142. If the name of the first match is already in the 
library, the dialog box opens with the matching compound selected.
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Figure 26. Add New Compound dialog box

3. (Optional) Make any of the following changes:

a. Change the name for the compound in the Name of New Compound box.

b. Use a compound other than the compound chosen by the TraceFinder application by 
scrolling to the spectrum for that compound and selecting the compound name in 
the title bar of the spectrum pane.

c. In the Type of Compound to Add list, select a compound type.

4. Click OK.

Selected 
compound
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 To replace a quantitative peak with a confirming ion peak

1. When you have multiple quantitative peaks, select the quantitative peak that you want to 
replace.

2. Right-click the header bar for the confirming ion peak that you want to use as the 
quantitative peak, and choose Swap with Quan Peak from the shortcut menu.

The application swaps the quantitative peak and the confirming ion peak. The 
application replaces all information for the quantitative peak with information for the 
confirming ion. This includes the expected retention time that the confirming ion 
inherited from the original quantitative peak. The original quantitative peak replaces the 
confirming ion peak. The application recalculates the ratios for all confirming ion peaks.

 To set a confirming ion peak as an additional quantitative peak

Right-click the header bar for the confirming ion peak and choose Promote to Separate 
Quan Peak from the shortcut menu.

The application creates a new quantitative peak, using information from the confirming 
ion peak. This includes the expected retention time that the confirming ion peak 
inherited from the original quantitative peak. The application removes all references to 
the confirming ion peak from the method.

 To use the cut-and-paste feature on confirming ion peaks

Right-click the header bar for the confirming ion peak that you want to remove and 
choose Cut Confirming Peak from the shortcut menu.

Right-click the header bar for the confirming ion peak that you want to replace and 
choose Paste Confirming Peak from the shortcut menu.

The application pastes the confirming ion peak that you removed. You can paste a deleted 
peak back to the quantitative peak from which it was removed, or you can paste the 
confirming ion peak that was deleted to another quantitative peak for this compound. 
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 To add a trace to the real-time viewer

Right-click the header bar for the quantitative peak or confirming ion peak that you want 
to add to the real-time viewer display and choose Display in Real Time Viewer from the 
shortcut menu.

The application moves the peak to the Traces to Display in Real Time Viewer pane on the 
Real Time Viewer page. See “Real Time Viewer” on page 179.

When you acquire samples with this method, the application displays the m/z 465.36 
trace in addition to the TIC in the Real Time Status pane.

Trace m/z 465.36 added 
to Real Time Viewer

Trace m/z 465.36 added to 
Real Time Status display
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 To replace a confirming ion peak

1. Click the pane for the confirming ion peak that you want to replace. 

2. In the raw data file spectrum pane, hold the cursor over a peak.

The red box indicates the selected peak.

3. Right-click and choose Set This Spectral Peak as Confirming from the shortcut menu.

The TraceFinder application replaces the confirming ion peak with the selected mass.

 To add a mass as a new confirming ion peak 

1. In the raw data file spectrum pane, hold the cursor over a peak.

The red box indicates the selected peak.

2. Right-click and choose Add This Spectral Peak as New Confirming from the shortcut 
menu.

The TraceFinder application adds the confirming ion peak to the quantitative peak.

You can use the shortcut menu in the spectrum pane for this new confirming ion peak to 
perform any of the tasks that you would perform on the original confirming ion peaks.

 To save the new method

1. Choose File > Save.

The Save Master Method dialog box opens.

2. Do one of the following:

Type a new name for the master method and click OK.

–or–

Select a method name to overwrite and click Overwrite.

The TraceFinder application saves the new method data in the following folder:

…\Thermo\TraceFinder\2.1\EFS\Methods 
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Figure 27. Detection page
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Table 25.  Detection page panes

Pane Description

Compound Lists all compounds in the master method. The Compound list uses a right-click shortcut 
menu. See “Using the Shortcut Menu Commands” on page 181.

Quan Peak Displays a chromatogram for the quantitative peak and its confirming ion peaks. The 
quantitative peak and confirming peak panes include additional pages for retention time, 
signal, detection, spectrum, and ratio parameters.

Trace Displays a combination of the Detector and Trace values used for the raw data file.

Filter Displays the filter used for the raw data file.

Reference 
Chromatogram 
and 
Spectra

Displays a reference chromatogram and spectra for the raw data file.

When you view an analog trace, there is no spectra display. To close the spectra pane and use 
the full width to display the chromatogram, click the collapse icon, .

Additional pages

Times Defines the retention time and window for a quantitative peak. 
See “Times” on page 148.

Signal Defines the detector and detection parameters used to display each chromatogram trace. See 
“Signal” on page 150.

Detect Defines the peak detection algorithm and its options. 
See “Detect” on page 156.

Spectrum Defines a reference mass spectrum for a quantitative peak or compound. See “Spectrum” on 
page 166.

Ratios Defines the criteria for evaluating, confirming, or qualifying ions. See “Ratios” on page 171.
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Times

Use the Times page to define the expected retention time or a retention time range for a 
quantitative peak. 

Figure 28. Times page

Table 26. Times page parameters  (Sheet 1 of 2)

Parameter Description

Detection Type Single - Detected: (Default) Specified as a centered retention time window. The application 
integrates a distinct peak. In reports, the application displays the expected retention time 
and actual retention time values as Method RT and Detected RT, respectively. 
Range - Detected: Specified as a retention time start/end range. 
Range - Integrated: Specified as a retention time start/end range. The application integrates 
all peaks within the specified time range.

Expected RT (min) Expected retention time for a single peak. Available only for the Single - Detected detection 
type. 

Window (sec) Width of the window (in seconds) to indicate how far around the expected retention time 
the system looks for a peak apex. Available only for the Single - Detected detection type. 

Parameters for single 
RT detection types

Parameters for RT 
range detection types
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Start/End RT (min) Beginning and ending retention time window that can encompass multiple peaks. Available 
only for the Range - Detected and the Range - Integrated detection types. When you change 
from a Single - Detected detection type, these values default to the previous beginning and 
ending time calculated from the Expected RT and Window values.

View Width (min) Viewable size of the ion chromatogram display. Changing the view width does not affect the 
peak detection process; the TraceFinder application uses it only for graphical display. When 
you select either Range - Detected or Range - Integrated as the detection type, you cannot 
select a View Width value less than the retention time range (end time minus start time).

Shortcut menu

Set Peak Windows 
Settings to All Peaks in 
Compound

Copies the View Width and Window values to all quantitative peaks for the compound and 
updates the compound. 

Available only when a compound has multiple quantitative peaks.

Set Peak Windows 
Settings to All Peaks in 
Method

Copies the View Width and Window values to all quantitative peaks for the method and 
updates the method. 

Table 26. Times page parameters  (Sheet 2 of 2)

Parameter Description
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Signal

Use the Signal page (see “Signal page” on page 154) to define the detector and filters as you 
display each chromatogram trace. For detailed descriptions of all the features on the Signal 
page, see “Signal page parameters” on page 154.

Follow these procedures:

• To specify ranges of ions for detection and integration

• To specify an XIC filter

• To specify an MS filter

 To specify ranges of ions for detection and integration

1. Select MS from the Detector list.

2. Select Mass Range from the Trace list.

3. In the Ranges area, click Edit.

The Edit Mass Ranges dialog box opens where you can define mass ranges using a center 
of mass or start and end values.

Figure 29. Edit Mass Ranges dialog box

4. Enter a value in the Center Mass box and click Add.

A new row with this value opens under Ranges. Center mass values are listed in the Start 
m/z column. The application uses a range of one amu centered on this value.

5. Enter values in the Start m/z and End m/z columns and click Add.

The application adds a row with these start and end values.

Note  The Ranges area is available only when you set the Detector parameter to MS 
and the Trace parameter to Mass Range.



 4 Using the Method Development Mode
Working with Master Methods

Thermo Scientific TraceFinder User Guide 151

6. Add as many ranges as you want.

When you process a batch with this method, the application sums the multiple ions 
specified by these ranges. 

7. Click Apply.

The application applies the parameters to the list of ranges. 

 To specify an XIC filter

1. Select MS from the Detector list.

2. Select Mass Range from the Trace list.

3. Select the XIC option.

4. Click the Filter browse button.

The XIC Filter dialog box opens.

Figure 30. XIC Filter dialog box

Note  The XIC option is available only when you set the Detector parameter to MS 
and the Trace parameter to Mass Range.
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5. Select an Activation type:

6. Select an MS Order:

7. Select a value for the polarity.

Valid values: Positive, Negative, or Any.

8. Select a Scan Mode:

9. Click OK.

The application updates the chromatogram data using the specified XIC filter options.

CID Collision-induced dissociation

MPD Multiple photo dissociation

ECD Electron capture dissociation

PQD Pulsed dissociation

ETD Electron transfer dissociation

HCD Higher energy collision-induced dissociation

Any Allows any activation method.

SAactivation

PTRactivation

NETDactivation Negative electron-transfer dissociation activation

NPTRactivation

Any Allows any MS order.

MS Single mass spec stage

MS2-MS10 Multiple mass spec stages

Ng Nano gram

N1 Nano liter

Par

Full

Zoom

SIM Selective ion monitoring

SRM Selective reaction monitoring

CRM Consecutive reaction monitoring

Any Allows any scan mode.

Q1MS MS using quadrupole 1

Q3MS MS using quadrupole 3
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 To specify an MS filter

1. Select the Filter option.

2. Select MS from the Detector list.

3. Select a trace type from the Trace list.

4. Select a filter from the Filter list.

The application applies the selected filter to the quantitative or confirming ion peak.

5. To apply this same filter to other peaks, right-click and choose one of the following from 
the shortcut menu:

• Set This Filter on All Peaks in This Compound: Applies this filter to all other peaks 
in the compound. 

• Set This Filter on All Compounds: Applies this filter to all peaks in the method.
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Figure 31. Signal page

Table 27. Signal page parameters  (Sheet 1 of 2)

Parameter Description

XIC Specifies an Extracted Ion Chromatogram experiment type that uses a single, full-scan mass filter 
that is post-processed to extract a peak for the ions of interest.

Filter Select from the list of mass filters to use for processing the compound.
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Detector Options are determined by the detection options used to create the method. The method can use the 
standard options (all the listed options) or only the detection options used to acquire an associated 
raw data file.

MS: Mass spectrometer that ionizes sample molecules and then separates the ions according to their 
mass-to-charge ratio (m/z).
PDA: Photodiode array detector providing a linear array of discrete photodiodes on an integrated 
circuit chip. It is placed at the image plane of a spectrometer to allow a range of wavelengths to be 
simultaneously detected.
Analog: Supplemental detectors (for example, FID, ECD). When you select this detector, any 
reports that display a QIon value show the value as Analog and any reports that display spectra show 
the spectra as Not Available.
A/D card: If you have a detector not under data system control, you can capture the analog signal 
and convert it to digital using an interface box (for example, SS420X) for storage in the raw data file.
UV: A UV spectrophotometer (for variable-wavelength detection) or photometer (for 
single-wavelength detection) equipped with a low-volume flow cell. This detector detects analytes 
that readily absorb light at a selected wavelength.

Trace Represents a specific range of the data. The TraceFinder application uses the trace to identify the 
characteristic ions for a compound. 

MS detector options: Mass Range, TIC, or Base Peak.

PDA detector options: Spectrum Maximum, Wavelength Range, or Total Scan.

Analog detector options: Analog 1, Analog 2, Analog 3, or Analog 4. You can configure these 
channel names in your instrument configuration.

A/D Card detector options: AD Card ch1, AD Card ch2, AD Card ch3, or AD Card ch4. You can 
configure these channel names in your instrument configuration.

UV detector options: Channel A, Channel B, Channel C, or Channel D. You can configure these 
channel names in your instrument configuration.

Filter Available only when you select the MS detector. Represents a particular data acquisition channel. 
For example, the filter option + c Full ms [35.00-500.00] represents a positive ion centroid signal 
acquired in single-stage, full-scan mode from m/z 35 to 500.

Ranges Available only when you select the Mass Range Trace.

Edit Opens the Edit Mass Ranges dialog box where you can specify a range of ions for detection and 
integration. See “Edit Mass Ranges dialog box” on page 150.

Start m/z
End m/z

Specifies ranges of ions for detection and integration. The application sums the multiple ions 
specified by these ranges. 

Ranges specified by a center mass value are listed as a single value in the Start m/z column. The 
application uses a range of one amu centered on this value. 

Table 27. Signal page parameters  (Sheet 2 of 2)

Parameter Description
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Detect

Use the Detect page to define the peak detection algorithm (sensitivity) and its options and to 
determine the area under a curve. There are three sensitivity modes: Genesis, ICIS, and 
Avalon. On this page, you can specify how you want each mode to run.

See the following for detailed descriptions of all the features on the Detect page:

• For Genesis sensitivity, see “Detect page parameters for Genesis” on page 158.

• For ICIS sensitivity, see “Detect page parameters for ICIS” on page 162.

• For Avalon sensitivity, see “Detect page parameters for Avalon” on page 164.
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Figure 32. Detect page for Genesis
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Table 28. Detect page parameters for Genesis  (Sheet 1 of 3)

Parameter Description

Sensitivity Specifies the Genesis peak detection algorithm.

Detection Method Highest peak: Uses the highest peak in the chromatogram for component identification. 

Nearest RT: Uses the peak with the nearest retention time in the chromatogram for 
component identification.

Smoothing Determines the degree of data smoothing to be performed on the active component peak 
prior to peak detection and integration.
Default: 1
Range: Any odd integer from 1 through 15 points

S/N Threshold Current signal-to-noise threshold for peak integration. Peaks with signal-to-noise values less 
than this value are not integrated. Peaks with signal-to-noise values greater than this value 
are integrated. 
Range: 0.0 to 999.0

Enable Valley 
Detection

Uses the valley detection approximation method to detect unresolved peaks. This method 
drops a vertical line from the apex of the valley between unresolved peaks to the baseline. 
The intersection of the vertical line and the baseline defines the end of the first peak and the 
beginning of the second peak. 

Expected Width (sec) The expected peak width parameter (in seconds). This parameter controls the minimum 
width that a peak is expected to have if valley detection is enabled. 

With valley detection enabled, any valley points nearer than the expected width/2 to the top 
of the peak are ignored. If a valley point is found outside the expected peak width, the 
TraceFinder application terminates the peak at that point. The application always terminates 
a peak when the signal reaches the baseline, independent of the value set for the expected 
peak width. 

Range: 0.0 to 999.0

Constrain Peak Width Constrains the peak width of a component during peak integration of a chromatogram. You 
can then set values that control when peak integration is turned on and off by specifying a 
peak height threshold and a tailing factor. Selecting the Constrain Peak Width check box 
enables the Peak Height (%) and Tailing Factor options.

Peak Height (%) A signal must be above the baseline percentage of the total peak height (100%) before 
integration is turned on or off. This text box is active only when you select the Constrain 
Peak Width check box. 
Range: 0.0 to 100.0%

Tailing Factor A factor that controls how the TraceFinder application integrates the tail of a peak. This 
factor is the maximum ratio of the trailing edge to the leading side of a constrained peak. 
This text box is active only when you select the Constrain the Peak Width check box. 
Range: 0.5 through 9.0
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Min Peak Height (S/N) For the valley detection approximation method to use the Nearest RT Peak Identification 
criteria, this peak signal-to-noise value must be equaled or exceeded. For component 
identification purposes, the TraceFinder application ignores all chromatogram peaks that 
have signal-to-noise values that are less than the S/N Threshold value. 
Range: 0.0 (all peaks) through 999.0

Peak S/N Cutoff The peak edge is set to values below this signal-to-noise ratio. 

This test identifies an edge of a peak when the baseline adjusted height of the edge is less 
than the ratio of the baseline adjusted apex height and the peak S/N cutoff ratio. 

When the S/N at the apex is 500 and the peak S/N cutoff value is 200, the TraceFinder 
application defines the right and left edges of the peak when the S/N reaches a value less 
than 200. 

Range: 50.0 to 10000.0

Valley Rise (%) The peak trace can rise above the baseline by this percentage after passing through a 
minimum (before or after the peak). 

This method drops a vertical line from the apex of the valley between unresolved peaks to 
the baseline. The intersection of the vertical line and the baseline defines the end of the first 
peak and the beginning of the second peak. 

When the trace exceeds rise percentage, the TraceFinder application applies valley detection 
peak integration criteria. 

The TraceFinder application applies this test to both the left and right edges of the peak. 

The rise percentage criteria is useful for integrating peaks with long tails.

Range: 0.1 to 500.0

Valley S/N Specifies a value to evaluate the valley bottom. Using this parameter ensures that the 
surrounding measurements are higher. 
Default: 2.0
Range: 1.0 to 100.0

# Background Scans Number of background scans performed by the TraceFinder application.

Report Noise As Determines if the noise used in calculating S/N values is calculated using an RMS 
calculation or a peak-to-peak resolution threshold. Options are RMS or Peak to Peak.

Shortcut menu

Apply to All Peaks in 
Method

Updates all compounds in the method with the current settings on the Detect page. These 
updates apply to both quantitative and confirming ion peaks.

Table 28. Detect page parameters for Genesis  (Sheet 2 of 3)

Parameter Description
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Apply to All Peaks with 
Like Sensitivity Setting

Uses the current settings on the Detect page to update all compounds in the method that 
use the Genesis sensitivity mode. These updates apply to both quantitative and confirming 
ion peaks that use the Genesis sensitivity mode.

Apply to All Peaks in 
Compound 

Updates all peaks in the current compound with the current settings on the Detect page. 
These updates apply to both quantitative and confirming ion peaks.

Table 28. Detect page parameters for Genesis  (Sheet 3 of 3)

Parameter Description
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Figure 33. Detect page for ICIS
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Table 29. Detect page parameters for ICIS  (Sheet 1 of 2)

Parameter Description

Sensitivity Specifies the ICIS peak detection algorithm.

Detection Method Highest peak: Uses the highest peak in the chromatogram for component identification. 

Nearest RT: Uses the peak with the nearest retention time in the chromatogram for 
component identification.

Smoothing Determines the degree of data smoothing to be performed on the active component peak 
prior to peak detection and integration.
Default: 1
Range: Any odd integer from 1 through 15 points

Area Noise Factor The noise level multiplier used to determine the peak edge after the location of the possible 
peak. 
Default: 5 
Range: 1 through 500

Peak Noise Factor The noise level multiplier used to determine the potential peak signal threshold.
Default: 10
Range: 1 through 1000

Baseline Window The TraceFinder application looks for a local minima over this number of scans.
Default: 40
Range: 1 through 500

Constrain Peak Width Constrains the peak width of a component during peak integration of a chromatogram. You 
can then set values that control when peak integration is turned on and off by specifying a 
peak height threshold and a tailing factor. Selecting the Constrain Peak Width check box 
enables the Peak Height (%) and Tailing Factor options.

Peak Height (%) A signal must be above the baseline percentage of the total peak height (100%) before 
integration is turned on or off. This text box is active only when you select the Constrain 
Peak Width check box. 
Range: 0.0 to 100.0%

Tailing Factor A factor that controls how the TraceFinder application integrates the tail of a peak. This 
factor is the maximum ratio of the trailing edge to the leading side of a constrained peak. 
This text box is active only when you select the Constrain the Peak Width check box. 
Range: 0.5 through 9.0

Min Peak Height (S/N) For the valley detection approximation method to use the Nearest RT Peak Identification 
criteria, this peak signal-to-noise value must be equaled or exceeded. For component 
identification purposes, the TraceFinder application ignores all chromatogram peaks that 
have signal-to-noise values that are less than the S/N Threshold value. 
Range: 0.0 (all peaks) through 999.0
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Noise Method The options are INCOS or Repetitive.

INCOS: Uses a single pass algorithm to determine the noise level.

Repetitive: Uses a multiple pass algorithm to determine the noise level. In general, this 
algorithm is more accurate in analyzing the noise than the INCOS Noise algorithm, but the 
analysis takes longer. 

Min Peak Width The minimum number of scans required in a peak.
Default: 3
Range: 0 to 100 scans

Multiplet Resolution The minimum separation in scans between the apexes of two potential peaks. This is a 
criterion to determine if two peaks are resolved.
Default: 10
Range: 1 to 500 scans

Area Tail Extension The number of scans past the peak endpoint to use in averaging the intensity.
Default: 5
Range: 0 to 100 scans

Area Scan Window The number of allowable scans on each side of the peak apex. A zero value defines all scans 
(peak-start to peak-end) to be included in the area integration. 
Default: 0
Range: 0 to 100 scans

RMS Specifies that the TraceFinder application calculate noise as RMS. By default, the 
application uses Peak To Peak for the noise calculation. RMS is automatically selected if you 
manually determine the noise region.

Shortcut menu

Apply to All Peaks in 
Compound 

Updates all peaks in the current compound with the current settings on the Detect page. 
These updates apply to both quantitative and confirming ion peaks.

Apply to All Peaks in 
Method

Updates all compounds in the method with the current settings on the Detect page. These 
updates apply to both quantitative and confirming ion peaks.

Apply to All Peaks with 
Like Sensitivity Setting

Uses the current settings on the Detect page to update all compounds in the method that 
use the ICIS sensitivity mode. These updates apply to both quantitative and confirming ion 
peaks that use the ICIS sensitivity mode.

Table 29. Detect page parameters for ICIS  (Sheet 2 of 2)

Parameter Description



4 Using the Method Development Mode
Working with Master Methods

164 TraceFinder User Guide Thermo Scientific

Figure 34. Detect page for Avalon

Table 30. Detect page parameters for Avalon  (Sheet 1 of 2)

Parameter Description

Sensitivity Specifies the Avalon peak detection algorithm. 

Detection Method Highest Peak: Uses the highest peak in the chromatogram for component identification. 

Nearest RT: Uses the peak with the nearest retention time in the chromatogram for 
component identification.
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Smoothing Determines the degree of data smoothing to be performed on the active component peak 
prior to peak detection and integration.
Default: 1
Range: Any odd integer from 1 through 15 points

Autocalc Initial Events Automatically calculates the events in the Event list.

Edit Opens the Avalon Event List dialog box. See “Avalon Event List” on page 85.

Shortcut menu

Apply to All Peaks in 
Compound 

Updates all peaks in the current compound with the current settings on the Detect page. 
These updates apply to both quantitative and confirming ion peaks.

Apply to All Peaks in 
Method

Updates all compounds in the method with the current settings on the Detect page. These 
updates apply to both quantitative and confirming ion peaks.

Apply to All Peaks with 
Like Sensitivity Setting

Uses the current settings on the Detect page to update all compounds in the method that 
use the Avalon sensitivity mode. These updates apply to both quantitative and confirming 
ion peaks that use the Avalon sensitivity mode.

Table 30. Detect page parameters for Avalon  (Sheet 2 of 2)

Parameter Description
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Spectrum

Use the Spectrum page to store a reference mass spectrum for a quantitative peak or 
compound.

For detailed descriptions of all the shortcut menu commands on the Spectrum page, see 
“Spectrum shortcut menu commands” on page 170.

Follow these procedures:

• To update confirming ion ratios

• To change the quantitation mass used for a quantitative peak

• To add ions together to get an accumulated signal

• To add a quantitative peak to an existing compound

• To add one or more confirming ions to an existing compound

• To zoom in on the chromatogram or spectrum displays

 To update confirming ion ratios

1. Click a peak in the quantitative peak chromatogram pane.

The mass spectrum for the peak is displayed in the Spectrum pane. 

2. Right-click the Spectrum pane and choose Update Confirming Ion Ratios with This 
Spectrum from the shortcut menu.

 To change the quantitation mass used for a quantitative peak

1. Click a peak in the chromatogram pane.

The mass spectrum for the peak is displayed in the spectrum pane. 

2. In the spectrum pane, hold the cursor over the mass-to-charge value for an ion.

A red box around the ion’s m/z value indicates that the ion is selected.

3. Right-click and choose one of the following commands from the shortcut menu:

• Set This Mass as Quan Mass > Don’t Update Ion Ratios

• Set This Mass as Quan Mass > Update Ion Ratios Using This Reference Spectrum

The following examples show an original quantitative peak and a quantitative peak with an 
updated quantitation mass.
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Figure 35. Original quantitative peak mass example

The TraceFinder application replaces the original quantitation mass with the selected 
mass.

Figure 36. Updated quantitative peak example

Original quantitative peak mass

New quantitative peak mass
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 To add ions together to get an accumulated signal

1. Hold the cursor over the m/z value for an ion in the Spectrum pane. 

A red box around the ion’s m/z value indicates that the ion is selected.

2. Right-click and choose Add This Mass to Existing Quan Mass Range from the shortcut 
menu.

You can now update the ion ratios to adjust the confirming ion comparisons to the new 
summed quantitative peak signal.

 To add a quantitative peak to an existing compound

1. Click the peak in the Quan Peak chromatogram pane.

The mass spectrum for the peak is displayed in the Spectrum pane. 

2. In the Spectrum pane, hold the cursor over the m/z value for an ion.

A red box around the ion’s m/z value indicates that the ion is selected.

3. Right-click and choose Set This Mass as New Quan Peak from the shortcut menu. 

The TraceFinder application adds this ion as a new quantitative peak.

New quantitative peak mass
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 To add one or more confirming ions to an existing compound

1. Click the peak in the chromatogram pane.

The mass spectrum for the peak is displayed in the Spectrum pane. 

2. In the Spectrum pane, hold the cursor over the m/z value for an ion.

A red box around the ion’s m/z value indicates that the ion is selected. 

3. Right-click and choose to Add This Mass as New Confirming Ion from the shortcut 
menu.

The TraceFinder application adds the selected mass as a confirming peak for this 
quantitative peak.

 To zoom in on the chromatogram or spectrum displays

1. Drag the cursor to delineate a rectangle.

The display zooms in on the specified rectangle.

2. To return to the original display, right-click and choose Reset Scaling from the shortcut 
menu.
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Figure 37. Spectrum page

Table 31. Spectrum shortcut menu commands 

Command Description

Update Confirming Ion Ratios 
With This Spectrum

Updates the confirming ion ratios using the selected peak.

Set This Mass as Quan Mass Adds the quantitation mass of the selected ion to the quantitation mass used for 
the quantitative peak. You can choose to update the ion ratios or not update the 
ion ratios using this reference spectrum.

Add This Mass to Existing Quan 
Mass Range

Adds the selected mass to your existing quantitation mass range. You can choose 
to update the ion ratios to adjust the confirming ion comparisons to the new 
summed quantitative peak signal.

Set This Mass as New Quan Peak Adds a new quantitative peak to an existing compound.

Add This Mass as New 
Confirming Ion

Adds one or more confirming ion peaks to an existing compound.

Reset Scaling Returns the chromatogram or spectrum display to its original size. 
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Ratios

Use the Ratios page (see “Ratios page” on page 172) to define the criteria for evaluating the 
confirming or qualifying ions. The TraceFinder application detects compounds that have 
confirming ion values outside their acceptable window and flags them in the Acquisition 
mode and on reports. 

For detailed descriptions of all the features on the Ratios page, see “Ratios page parameters” 
on page 172.

 To specify ion ratio criteria

1. Select the Enable check box to enable the confirming ion. 

2. In the Target Ratio box, select the theoretical ratio of the confirming ion’s response to the 
quantification ion’s response. 

3. In the Window Type list, select Absolute or Relative as the calculation approach for 
determining the acceptable ion ratio range. 

4. In the Window (+/-%) box, select the acceptable ion ratio range. 

5. In the Ion Coelution box, select the maximum difference in retention time between a 
confirming ion peak and the quantification ion peak.

In the following example

• The target ratio is expected to be 61.02% and the window is Absolute 20%, so the 
acceptable window for this confirming ion peak is 41.02–81.02%. 

• However, if the window type is Relative, the plus or minus value is 20% of 61.02% 
(or 12.20%), so the acceptable window for this confirming ion peak is 
48.82–73.22%. 
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Figure 38. Ratios page

Table 32. Ratios page parameters

Parameter Description

Enable Makes the ion ratio criteria available.

Target Ratio (%) The theoretical ratio of the confirming ion’s response to the quantification ion’s response. 

Window Type The absolute or relative calculation approach for determining the acceptable ion ratio range. 

Window (+/-%) The acceptable ion ratio range.

Ion Coelution (min) The maximum difference in retention time between a confirming ion peak and the 
quantification ion peak.

Shortcut menu

Set Ion Ratio to All 
Confirming Peaks in 
Compound

Copies the Window Type, Window, and Ion Coelution values to all confirming ion peaks 
for the compound and updates the compound. 
Available only when a compound has multiple confirming ion peaks.

Set Ion Ratio to All 
Confirming Peaks in 
Method

Copies the Window Type, Window, and Ion Coelution values to all quantitative peaks for 
the method and updates the method. 
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Calibration

Use the Calibration page to set or edit the mathematical model used for preparing the initial 
calibration evaluation for one or more calibration standards. 

Each target compound can have its own initial calibration settings, independent of the other 
compounds. You can modify the calibration approach on this page or in Acquisition mode 
when you view the results of an actual calibration batch. 

For detailed descriptions of all the features on the Calibration page, see Calibration page 
parameters.

 To specify an internal standard for a compound

1. On the Identification page, specify at least one compound in the method as an internal 
standard compound type. 

See “Identification” on page 133.

2. On the Calibration page, do the following:

a. In the Standard Type column, select Internal.

b. In the ISTD column, select the compound that you want to use as the internal 
standard for this compound.

The application lists only compounds specified as internal standards on the 
Identification page.

To view the internal standard peak in the Analysis mode, see “Peak Display Panes” on 
page 358.

Figure 39. Calibration page

Table 33. Calibration page parameters  (Sheet 1 of 2)

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

Compound The compound name.

Compound Type Displays the compound type as a Target Compound, Internal Standard, Surrogate, 
MSTune, Native, or Breakdown. 
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Calibration Levels

On the Calibration levels page (see “Calibration Levels page” on page 175) for a master 
method, you can define the standards for calibration. You can edit calibration levels and 
concentrations for master methods only. The contents of this page are read-only when you are 
editing a local method. 

For detailed descriptions of all the features on the Calibration Levels page, see “Calibration 
levels page parameters” on page 176.

 To specify calibration levels and concentrations

1. Select the compound whose calibration levels and concentrations that you want to define. 

2. In the Manage Calibration Levels area, type a value for the first calibration level.

The application adds a new, empty calibration level row beneath the edited row.

Standard Type Specifies Internal or External standards.

Response Via The use of area or height.

Curve Type Specifies Linear, Quadratic, or AverageRF curve types.

Origin The origin treatment as Ignore, Include, or Force. The Origin and Weighting columns are 
active only when you are using Linear or Quadratic curve types. 

Weighting Specifies the weighting as Equal, 1/X, 1/X^2, 1/Y, or 1/Y^2.

Units The units to be displayed with the calculated values.

ISTD The internal standard (ISTD) for a target compound or surrogate when the standard type is 
set to Internal. When you set the standard type to External, this field is inactive. The list 
displays all compounds with the compound type of Internal Standard.

Amount The amount of the internal standard for ISTD compounds. 

Shortcut menu The Calibration page uses a right-click shortcut menu. See “Using the Shortcut Menu 
Commands” on page 181.

Table 33. Calibration page parameters  (Sheet 2 of 2)

Parameter Description
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3. Continue adding calibration levels.

When you finish adding calibration levels, you can specify the concentrations for each 
compound at each level.

4. To enter the concentrations to the table, do the following:

a. Select the first calibration level table cell.

b. Click the cell again to make it editable.

c. Type a concentration value.

5. Repeat Step 4 for all calibration levels associated with the first compound.

6. To specify the same concentration values for all compounds, select the value that you 
want to copy, right-click, and choose Copy Down from the shortcut menu. 

Figure 40. Calibration Levels page
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QC Levels 

Use the QC levels page (see “QC Levels page”) for a master method to define the standards 
for QC levels. You can edit QC levels for master methods only. The contents of this page are 
read-only when you are editing a local method. For detailed descriptions of all the features on 
the QC Levels page, see “QC levels page parameters.” 

 To specify QC levels and concentrations

1. Select the compound whose QC levels, percentage test values, and concentrations that 
you want to define.

2. In the QC Levels area, type a name for the first QC level.

The TraceFinder application adds a new, empty QC level row beneath the edited row.

3. Type a value for the % Test.

The % Test is the acceptable difference (as a percentage) between the known amount and 
the calculated (measured) amount of each QC level.

Table 34. Calibration levels page parameters 

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that 
the compound is retained on the column. 

Compound The compound name.

Cal1-Caln User-defined calibration levels for the compound.

Manage Calibration Levels Defines values for each of the calibration level values for the selected compound.

Shortcut menu The Calibration Levels page uses a right-click shortcut menu. See “Using the Shortcut 
Menu Commands” on page 181.
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4. Continue adding QC levels and values for the percentage test.

When you finish adding QC levels, you can specify the concentrations for each level for 
each compound.

5. To enter the concentration values to the table, do the following:

a. Select the first QC level table cell.

b. Click the cell again to make it editable.

c. Type a concentration value.

6. Repeat Step 5 for all QC levels associated with the first compound.

7. To specify the same concentration values for all compounds, select the value that you 
want to copy, right-click, and choose Copy Down from the shortcut menu. 
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Figure 41. QC Levels page

Table 35. QC levels page parameters 

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

Compound The compound name.
QC1-QCn User-defined quality control levels for the compound.
QC levels

Level User-defined quality control level names.
% Test A value for the acceptable difference (as a percentage) between the known amount and 

calculated (measured) amount of each QC level.
Shortcut menu The QC Levels page uses a right-click shortcut menu. See “Using the Shortcut Menu 

Commands” on page 181.
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Real Time Viewer 

Use the Real Time Viewer page to specify which traces display in the real-time status pane 
when you perform acquisition in the Acquisition mode or when you acquire a development 
batch in the Method Development mode. See “Real-Time Display” on page 279.

Figure 42. Real Time Viewer page

 

Table 36. Real Time Viewer page parameters  (Sheet 1 of 2)

Parameter Description

Show Quan Peaks 
Only

Displays only quantitative peaks in the compounds list. Quantitative peaks are indicated 
with a black dot in the Quan Peak column.

Displayable Traces

Quan Peak Checks indicate quantitative peak traces. Unchecked traces indicate confirming ion peaks.

Compound Name Names of all compounds in the method.
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Trace Lists the simple mass or precursor mass for all traces—both quantitative peak and 
confirming ion peak—for each compound.

Moves the selected trace to the Traces to Display in Real Time Viewer pane.

Moves the selected trace to the Displayable Traces pane.

Moves all traces to the Displayable Traces pane. 
To move multiple traces to the Traces to Display... pane, hold down the SHIFT key, select 
multiple traces, and then click .

Traces to Display in 
Real Time Viewer (0/25)

List the traces to be displayed and the display order in the real-time viewer in the 
Acquisition mode. Maximum number of traces is 25. 

Move to Top Moves the selected trace to the top of the Traces to Display... list and the second position in 
the real-time display. The TIC is always the first position in the real-time display.

Move Up Moves the selected trace up one position in the list.

Move Down Moves the selected trace down one position in the list.

Move to Bottom Moves the selected trace to the bottom of the list.

Table 36. Real Time Viewer page parameters  (Sheet 2 of 2)

Parameter Description
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Using the Shortcut Menu Commands

Each page on the Compounds page (except the Acquisition List and Real Time Viewer pages) 
uses right-click shortcut menu commands to display or hide the retention column, remove 
compounds from the method, copy and paste data, or save the compound list to a .csv file.

Table 37.  Compounds page shortcut menu commands (Sheet 1 of 2)

Command Description

Copy Down Copies the value in the selected row to all rows below it. This 
command is available only when you have selected a value that 
can be copied down. See Appendix B, “Using Copy Down and 
Fill Down.” 

Display Retention Time 
Column

Displays or hides the RT column in the compound list.

Delete Compound From 
Method

Removes the selected compound from the current master 
method.

Copy Copies the data in the selected rows or columns to the Clipboard. 
Use this command to copy compound information to another 
application, such as an Excel spreadsheet. You cannot paste this 
data back into the method development compound list.

Copy With Headers Copies the data in the selected rows or columns and the 
associated column headers to the Clipboard. Use this command 
to copy sample information to another application, such as an 
Excel spreadsheet. You cannot paste this data back into the 
method development compound list.

Paste Pastes a single column of copied data from another application, 
such as an Excel spreadsheet, into the selected column. The 
pasted data must be valid data for the selected column.
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Undo Last Paste Removes the last pasted item in the method development 
compound list. 

Export to CSV File Opens the Save As dialog box where you can save the current 
compound list to a .csv file.

Sort by Compound 
Name

Sorts the compounds alphabetically from A to Z.

Sort by Retention Time Sorts the compounds from shortest retention time to longest 
retention time.

Add This Compound to 
CDS

Adds the selected compound to the compound data store. When 
the compound already exists in the compound data store, the 
TraceFinder application updates the compound data store with 
the current compound information.

This command is available only on the Detection page shortcut 
menu when the Compound Datastore is enabled. See “Enabling 
Optional Features” on page 88.

Add All Compounds to 
CDS

Adds all compounds in the current method to the compound 
data store. When any of these compounds already exist in the 
compound data store, the TraceFinder application updates the 
compound data store with the current compound information.

This command is available only on the Detection page shortcut 
menu when the Compound Datastore is enabled. See “Enabling 
Optional Features” on page 88.

Table 37.  Compounds page shortcut menu commands (Sheet 2 of 2)

Command Description
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Editing the QAQC Page

Use the QAQC page to set limits and ranges so that the TraceFinder application can review 
the data and results as an aid to final approval.

From the QAQC page of the Master Method View, you can access these additional pages:

• Limits

• Calibration

• Chk Std

• Breakdown

• Matrix Blank

• ISTD

• Solvent Blank

• Surrogate

• Lab Control

• Meth Val

• Matrix Spike

• Tune



4 Using the Method Development Mode
Working with Master Methods

184 TraceFinder User Guide Thermo Scientific

Limits 

Use the Limits page to define levels of review for quantified results. Quantified results appear 
on printed and electronic reports. You can also define when a quantified value is reported 
instead of reporting less than a particular limit. 

Figure 43. Limits page

Table 38. Limits page parameters 

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

Compound The compound name.

LOD 
(Detection Limit)

Limit of detection. The lowest amount that can be detected. Usually derived from a method 
detection limit (mdl) study.

LOQ 
(Quantitation Limit)

Limit of quantitation. The lowest amount that can be confidently and accurately 
quantitated. This is usually the lowest calibration amount.

LOR Limit of reporting. Also called cutoff in some industries. This is the lowest amount that can 
be reported, as determined by each laboratory’s standard operating practices.

ULOL 
(Linearity Limit)

Upper limit of linearity. This is usually the highest calibrator amount.

Carryover Limit The highest amount of a substance that does not leave a residual amount in the instrument. 
If a substance has a carryover limit of 5, amounts higher than 5 usually dirty the instrument 
and leave residue behind, tainting the following sample. A carryover limit of less than 5 does 
not leave any residual amounts of the substance.
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Calibration 

Use the Calibration page to define acceptable criteria for initial calibration. The TraceFinder 
application makes the evaluation by comparing the initial calibration results for each 
compound found in the sample to the values defined on this page. 

On the Calibration report, the application flags the calculated values for internal standard 
compounds that exceed these limits.

Figure 44. Calibration page

Table 39. Calibration page parameters

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

Compound The compound name.

R^2 Threshold The minimum correlation coefficient (r2) for an acceptable calibration (when in linear or 
quadratic mode). 

Max RSD (%) The maximum relative standard deviation (RSD) for an acceptable calibration (when in 
average RF mode). 

Min RF The minimum average response factor (RF) for an acceptable calibration (when in average 
RF mode). 

Max Amt Diff (%) The maximum deviation between the calculated and theoretical concentrations of the 
calibration curve data points (when in linear or quadratic mode). 
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Chk Std 

Use the Chk Std page to review the calibration on an ongoing basis. The TraceFinder 
application makes the evaluation by comparing the quality check standard results for each 
compound in the sample to the initial calibration using values defined on this page. 

On the Check Standard report, the TraceFinder application flags the calculated values for 
internal standard compounds that exceed these limits.

For linear and quadratic modes, the maximum difference for the calculated concentration in 
the Chk Std sample versus the theoretical value is set on the QC Levels page of the 
Compounds page.

Figure 45. Chk Std page

Table 40. Chk Std page parameters

Parameter Description

RT Retention time. The time after injection when the compound 
elutes. The total time that the compound is retained on the 
column. 

Compound The compound name.

Max RF Diff (%) The maximum deviation between the response factor (RF) of the 
Chk Std sample and the average response factor from the 
calibration (when in average RF mode). 

Min RF The minimum response factor for the Chk Std sample (when in 
average RF mode). 
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Breakdown

Use the Breakdown page to view and edit values used for the evaluation of breakdown and 
degradation reporting. The TraceFinder application makes the evaluation by calculating the 
ratio of breakdown compounds to the native compounds. 

 To display the list of compounds in a group

Click anywhere in the group row.

 To select a group for breakdown calculation

Select the Active check box in the group row.

You can select any group in the method for breakdown calculation, but the application 
calculates and reports only those that contain breakdown and native compounds. 

Figure 46. Breakdown page

Table 41. Breakdown page parameters

Parameter Description

Groups Lists all groups created on the Groups page. See “Editing the 
Groups Page” on page 200.

Active Specifies which groups are used for analysis.

Max % Breakdown The maximum allowable percentage of breakdown to native 
compounds. This value is calculated by summing the responses of 
the breakdown compounds and dividing them by the sum of the 
native compounds. 

On the Breakdown Report, the application flags the calculated 
values for breakdown and native compounds that exceed these 
limits. 

Compounds for Group Lists all compounds in the selected group.
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Matrix Blank

Use the Matrix Blank page to define acceptable levels of target compounds in blank samples. 
The TraceFinder application makes the evaluation by comparing the calculated concentration 
for each compound in the sample to the maximum concentration defined on this page. You 
can enter the maximum concentration as a percentage of a flag value or as a specified value. 

For detailed descriptions of all the features on the Matrix Blank page, see Matrix Blank page 
parameters.

On the Matrix Blank report, the application flags the calculated values for target compounds 
that exceed these limits. 

 To specify the maximum concentration as a percentage

1. From the Method column list, select one of the following methods:
• % of LOD
• % of LOQ
• % of LOR

2. In the Percentage column, type a percentage value.

 To specify the maximum concentration

1. From the Method column list, select Concentration.

2. In the Max Conc column, type an absolute value.

Figure 47. Matrix Blank page

Table 42.  Matrix Blank page parameters  (Sheet 1 of 2)

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

Compound The compound name.

Method The evaluation process used for comparing the calculated concentration. You can specify no 
maximum, a specific concentration, or a percentage of the LOR, LOD, or LOQ. 
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Percentage The percentage of the LOR, LOD, or LOQ if you are using the percentage approach. 

Max Conc The maximum concentration if you are using an absolute value. 

Table 42.  Matrix Blank page parameters  (Sheet 2 of 2)

Parameter Description
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ISTD 

Use the ISTD page to review the response and retention time of internal standards (when 
available). The TraceFinder application makes the evaluation by comparing the area and 
retention time results for each internal standard compound in the sample to a specified range.

If all of your target compounds are set to external calibration mode or if you have not 
identified any compounds as internal standards, this page does not show any values. 

Figure 48. ISTD page

Table 43. ISTD page parameters 

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

Compound The compound name.

Min Recovery (%) The minimum and maximum percent recoveries for the internal standards to define an 
acceptable range. For check standards, the TraceFinder application compares the response of 
each internal standard in each sample to a range around the average of the responses of that 
compound in all of the calibration standards. For all other samples, the application calculates 
the comparison range around the check standard responses if a check standard is available in the 
batch. If no check standard is available, the application tests against the initial calibration.

Max Recovery (%)

Min RT (–min) The minimum and maximum drift (in minutes) for the internal standards to define an 
acceptable range. For check standards, the TraceFinder application compares the retention time 
of each internal standard in each sample to a range around the average of the retention times of 
that compound in all of the calibration standards. For all other samples, the application 
calculates the comparison range around the check standard retention times if a check standard 
is available in the batch. If no check standard is available, the application tests against the initial 
calibration.

Max RT (+min)

CV Test (%) Coefficient of Variance test. The coefficient of variance percentage is the standard deviation of 
the multiple samples of one level, multiplied by 100, and then divided by the average of the 
multiple samples of that level. This calculation is based on the areas of the peaks.
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Solvent Blank 

Use the Solvent Blank page to view or edit QC values for solvent reporting. The application 
makes the evaluation by comparing the calculated response for each compound in the sample 
to the maximum response defined on this page. 

On the Solvent Blank report, the TraceFinder application flags the calculated values for target 
compounds that exceed these limits. 

Figure 49. Solvent Blank page

Table 44. Solvent Blank page parameters

Parameter Description

RT Retention time. The time after injection when the compound 
elutes. The total time that the compound is retained on the 
column. 

Compound The compound name.

Method The evaluation process to use as a response for the quantitation ion 
only (Quan Ion RT) or as a summed response for the quantitation 
ion and any confirming ions (All Ion RT). To deactivate the 
solvent blank test for a specific compound, select None. 

Upper Limit Specifies an upper limit for each compound in the sample when 
you select an evaluation process. These values are not 
concentrations; they are raw response values.



4 Using the Method Development Mode
Working with Master Methods

192 TraceFinder User Guide Thermo Scientific

Surrogate 

Use the Surrogate page to view or edit values for surrogate recovery reporting. The application 
makes the evaluation by comparing the calculated concentration for each compound in the 
sample to the theoretical concentration and range defined on this page. 

You can use these parameters to evaluate the performance of your method. For this evaluation, 
prepare, analyze, and evaluate a number of samples (typically 4 to 10) to document method 
accuracy and precision as a comprehensive whole. 

On the Surrogate Recovery report, the application flags the calculated values for method 
validation compounds that exceed these limits. 

Figure 50. Surrogate page

Table 45. Surrogate page parameters 

Parameter Description

RT Retention time. The time after injection when the compound 
elutes. The total time that the compound is retained on the 
column. 

Compound The compound name.

Theo Conc Values for the compounds that represent the expected theoretical 
concentration of that compound in the sample. 

Min Recovery (%) A range of the allowable minimum recovery percentage and the 
maximum recovery percentage that the application can determine 
by comparing the observed calculated concentration in the analysis 
to the expected concentration. Each method validation compound 
can have its own values for these fields, independent of other 
method validation compounds. 

Max Recovery (%)
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Lab Control 

Use the Lab Control page to view and edit QC values for lab control sample (LCS) and lab 
control sample duplicate (LCSD) analyses. The application makes the evaluation by 
comparing the calculated concentration for each compound in the sample to the theoretical 
concentration and range defined on this page. 

You can prepare samples (typically known as clean matrices) as LCS or LCSD. These 
represent samples where you have added known concentrations of target analytes. To define 
an LCS and its duplicate in a batch, select the appropriate sample type and a common 
sample ID. 

On the Lab Control report, the application flags the calculated values for spiked compounds 
that exceed these limits.

Figure 51. Lab Control page

Table 46. Lab Control page parameters 

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

Compound The compound name.

Theo Conc Values for the lab control compounds that represent the expected theoretical concentration of 
that compound in the sample. 

Min Recovery (%) A range of the allowable minimum recovery percentage and the maximum recovery percentage 
that the application can determine by comparing the observed calculated concentration in the 
analysis to the expected concentration. Each LCS or LCSD compound can have its own values 
for these fields, independent of other LCS or LCSD compounds. 

Max Recovery (%)

Max RPD Specifies a maximum value for relative percent difference (RPD) between two spiked samples. 
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Meth Val 

Use the Meth Val page to view or edit QC values for method validation reporting. The 
application makes the evaluation by comparing the calculated concentration for each 
compound in the sample to the theoretical concentration and range defined on this page. 

You can use these parameters to evaluate the performance of your method. For this evaluation, 
prepare, analyze, and evaluate a number of samples (typically four to 10) to document 
method accuracy and precision as a comprehensive whole. To define a method validation 
sample in the batch, select the appropriate sample type. 

On the Method Validation report, the application flags the calculated values for method 
validation compounds that exceed these limits. 

Figure 52. Meth Val page

Table 47. Meth Val page parameters

Parameter Description

RT Retention time for the compound.
Compound The compound name.
Theo Conc Values for the compounds that represent the expected theoretical concentration of that 

compound in the sample. 
Min Recovery (%)

Max Recovery (%)

A range of the allowable minimum recovery percentage and the maximum recovery 
percentage that the application can determine by comparing the observed calculated 
concentration in the analysis to the expected concentration. Each method validation 
compound can have its own values for these fields, independent of other method validation 
compounds. 

Max RSD (%) The maximum relative standard deviation of the set of observed concentrations for a 
component across the set of method validation samples. 
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Matrix Spike 

Use the Matrix Spike page to view or edit QC values for matrix spike and matrix spike 
duplicate analyses. The application makes the evaluation by comparing the calculated 
concentration for each compound in the sample (after subtracting the original sample value) 
to the theoretical concentration and range defined on this page. 

To evaluate matrix spike or matrix spike duplicate compounds, prepare samples as MS or 
MSD. These represent samples where you have added known concentrations of target 
analytes. To define a sample, its MS, and its MSD in the batch, select the appropriate Sample 
Type and a Sample ID. 

Sample IDs must be unique. Duplicating Sample IDs can cause incorrect samples to be 
included in reports.

On the MS/MSD report, the application flags the calculated values for spiked compounds 
that exceed these limits. 

Figure 53. Matrix Spike page

Table 48. Matrix Spike page parameters 

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

Compound The compound name.

Theo Conc Values for the matrix spike compounds that represent the expected theoretical concentration 
of that compound in the sample. You can apply or not apply the dilution factor for a sample 
to the calculated matrix spike concentrations.

Min Recovery (%) A range of the allowable minimum recovery percentage and the maximum recovery 
percentage that can be determined by comparing the observed calculated concentration in 
the analysis to the expected concentration. Each matrix spike sample can have its own values 
for these fields, independent of other matrix spike samples. 

Max Recovery (%)

Max RPD Specify a maximum value for relative percent difference (RPD) between two spiked samples. 
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Tune

Use the Tune page (see “Tune page” on page 199) to specify mass spectral comparison criteria 
according to Environmental Protection Agency (EPA) tune methods. Your master method 
must include one (and only one) compound specified as an MSTune compound type. The 
QAQC evaluation compares the mass list of the compound to the values in the tune method.

An MSTune sample contains Decafluorotriphenylphosphine (DFTPP) or 
bromofluorobenzene (BFB) and is handled differently from other samples in the master 
method. The TraceFinder application handles it as a qualitative examination of the mass 
spectrum of a specific compound rather than evaluates it on a quantitative basis.

Follow these procedures:

• To select an EPA tune method

• To manually submit a mass spectrum for tune evaluation

 To select an EPA tune method

1. Choose a method from the Method list.

• For some methods, the Use Only Selected Method option is available.

• For some methods, the Perform Background Subtraction option is available.

The application displays the mass spectral reference for the selected method.
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2. (Optional) Select the Use Only Selected Method check box.

The application uses only the specified EPA tune method for tune criteria testing. 

If this option is not selected and the tune spectrum fails against the specified tune criteria, 
the application performs the comparison against other EPA tune method criteria. The 
Tune report displays the pass/fail status of the tune spectra against all methods used for 
comparison.

3. (Optional) Select the Perform Background Subtraction check box.

• The 8000 and CLP series methods require background subtraction. 

• The 500 and 600 series do not require background subtraction but you can choose to 
use it.

The Tune report displays the retention time and scan range of the spectrum.

4. (Optional) Click Max Stepoff to select a number or type a number in the box.

The Max Stepoff field defines the maximum number of scans as the range before and 
after the Tune compound peak that is to be used for background subtraction. For 
example, a maximum stepoff of 1 means that the background spectrum is taken one scan 
before the left edge of the tune peak or one scan after the right edge of the tune peak. If 
using the left edge background spectrum fails the tune test, the system automatically tries 
the right edge of the spectrum. A maximum stepoff of 2 means trying up to four tests 
using four different background spectrum: two scans before the left edge, one scan before 
the left edge, one scan after the right edge, and two scans after the right edge. EPA 
guidelines assign a maximum stepoff value of 20. 

 To manually submit a mass spectrum for tune evaluation

1. Click Select File and Mass Spectrum.

2. In the browser, select a raw data file and click Open.

The Thermo Xcalibur Qual Browser opens.

Note  This Max Stepoff value is not related to the Stepoff Value parameter on the 
General page of the master method. The Stepoff Value on the General page applies 
only to the reference spectrum set for the master method and does not affect the Tune 
method.
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Figure 54. Thermo Xcalibur Qual Browser

3. In the Qual Browser, do the following:

a. Select the tune compound peak that you want to use.

b. Select the background subtraction parameters to use, and generate the mass 
spectrum.

For detailed instructions, refer to the Qual Browser documentation.

c. When the process is complete, choose View > Spectrum List.

d. Right-click the spectrum list and choose Export > Clipboard.

e. On the TraceFinder Tune page, click Create Tune Report as PDF.
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Figure 55. Tune page

Table 49. Tune page parameters 

Parameter Description

Tune parameter

Tune Compound Compound specified as a tune compound on the Identification page. See “Identification” 
on page 133.

Method Environmental Protection Agency (EPA) methods used for tuning.

Use Only Selected 
Method

Specifies that the application use only the specified EPA tune method for tune criteria 
testing. 

Perform Background 
Subtraction

Specifies that the application average and subtract the mass spectra as specified in the 
background subtraction settings on the General page for the master method. See “To set 
automated background subtraction options” on page 123.

Max Stepoff Specifies the maximum number of scans as the range before and after the Tune compound 
peak to be used for background subtraction.

Ad Hoc Tune Report

Select File and Mass 
Spectrum

Opens a browser where you can select a raw data file to use for the tune report.

Create Tune Report as 
PDF

Creates an ad hoc tune report using the mass spectrum data saved to the Clipboard.
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Editing the Groups Page

Use the Groups page of the Master Method View (see “Groups page”) to organize compounds 
into functional or logical groups. You can use these groups for creating a subset of target 
compounds. For detailed descriptions of all the features on the Groups page, see “Groups page 
parameters.” 

For quantitative processing, the TraceFinder application processes all compounds in the 
method and stores the complete result set, but only those in the selected group are visible in 
the Acquisition mode. Limiting the displayed compounds to those in the selected group can 
be useful when working with a master method containing a large list of compounds, only 
some of which are required for analysis in certain samples. In that case, the application 
requires only a single method and can reduce the results. To display only those compounds to 
be used in quantitative processing, select Quan Compounds from the Show list. 

You can create multiple groups and include the same compound in more than one group. 

 To create a group

1. From the Show list, select the type of compounds that you want to view.

2. At the bottom of the Groups area, click Add Group.

The Add a New Group dialog box opens.

3. Type a name for the new group and click OK.

The new group appears in the Groups area.

4. Drag a compound from the Compounds area onto a group name (as if you were moving 
files into a folder).

5. To remove all the compounds from a group, rename the group, or delete it, right-click the 
group name and choose from the shortcut menu.

6. To remove a single compound, right-click the compound name in the group and choose 
Remove from Group from the shortcut menu.
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Figure 56. Groups page

Table 50. Groups page parameters 

Parameter Description

Compounds Lists all available compounds.

Groups Lists all available groups.

Add Group Opens the Add a New Group dialog box where you can create a 
new group.

Shortcut menu

Empty Group Removes all compounds from the selected group.

Rename Group Changes the name of the selected group.

Delete Group Removes the selected group and all the compounds in it.

Remove From Group Removes the selected compound from its group.
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Editing the Reports Page

Use the Reports page to specify how you want to save or print your reports. For detailed 
descriptions of the features on the Reports page, see “Reports page parameters.” 

For the quantitation report types, you can modify quantitation limits flags, user interface 
options, and quantitation flag options on the Quan Report Settings page. 

For target screening report types, you can modify default report options, semi-quantitative 
results options, ion ratio calculation methods, the exact mass window, and Exactive options 
on the Target Screening Settings page.

This section includes instructions for the following tasks:

• Specifying Report Formats

• Specifying Quan Report Settings

• Specifying Target Screening Settings

Specifying Report Formats

• For each standard report, you can create a hardcopy printout, a PDF file, or an XML file. 

• For each custom report, you can create a hardcopy printout or an Excel Macro-Enabled 
Workbook (.xlsm) file. 

• For each target screening report, you can create a hardcopy printout or a PDF file. 

In addition to the report type, you can specify a report description for each of your reports. 
The default report description is the report name.

 To specify report types and output formats

1. Click the Reports tab.

The Reports page displays the following columns for all configured reports:

• Example: Click the magnifying glass icon to open an example PDF of the report type

• Report Name, Report Description, and Report Type

• For standard report types: Options to create a hardcopy, PDF file, or XML file

• For custom report types: Options to create a hardcopy or Excel Macro-Enabled 
Workbook file

• For target screening report types: Options to create a hardcopy or PDF file

• Batch Level: Option that indicates which reports are batch-level reports

For information about configuring which reports are available when you create a master 
method or which reports create a batch-level report, see “Specifying the Reports 
Configuration” on page 68.
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2. To edit the Report Description, double-click the name and type your new description.

The TraceFinder application uses this description for all reports that use this master 
method. You cannot edit the Report Description from other report views.

3. To specify the type of report output to create for each report type, select the check box in 
the appropriate column.

4. To duplicate the output type for all reports, click the cell to select it, and then right-click 
and choose Copy Down from the shortcut menu.

All check boxes in the column below the selected cell duplicate the selected or cleared 
state of the selected cell. This action applies only to reports where this output format is 
available.

By default, all report types are cleared.

Figure 57. Reports page

Table 51.  Reports page parameters  (Sheet 1 of 2)

Parameter Description

Example Opens a PDF that displays an example of the report type.

Report Name The name of a report. 

Report Description The user-defined description to be used on a report. 

Report Type The type of report: Standard, Custom, or Target Screening. 

Print Sends reports to the printer. 

Create PDF Saves reports as PDF files. 
Available only for standard and target screening reports.

Create XML Exports reports in XML format. 
Available only for standard reports.
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Create XLSM Exports reports in Excel Macro-Enabled Workbook (.xlsm) format.
Available only for custom reports.

Batch Level Rather than creating separate reports for each sample, the application uses a composite of 
the data from all the appropriate samples to create a single report for the entire batch. 
Batch-level reports are prepended with a B to differentiate them.
You cannot select this option from the Reports page. You must select the Batch Level option 
for the report in the report configuration. See “Specifying the Reports Configuration” on 
page 68. 

Table 51.  Reports page parameters  (Sheet 2 of 2)

Parameter Description
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Specifying Quan Report Settings 

Use the options on the Quan Report Settings page to choose parameters for flagging values 
and displaying information in standard report types.

Follow these procedures:

• To specify quantitation limits

• To specify user interface options

• To specify quantitation flag options

• To correct surrogates

• To track the use of the tune file

 To specify quantitation limits

1. To report the calculated concentration at all times or only when the quantified value 
exceeds LOD, LOQ, or LOR, choose the appropriate value from the Report 
Concentration list.

For a description of concentration limits, see “Editing the QAQC Page” on page 183. 

2. To select the number of decimal places to report for calculated concentrations, set the 
value in the Decimal Places to be Reported box.

3. To include a chromatogram of the sample in the Quantitation Report, select the Show 
Chromatogram on Quantitation Report check box.

4. To display only valid compounds, select the Display Compounds Above Set Limit 
check box.
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 To specify user interface options

1. To shade a compound row on any of the reports if a value fails one of the criteria used for 
evaluation, select the Shade Row when Sample is Outside of Evaluation Criteria 
check box.

2. To separate the ion overlay pane from the confirming ion plots, select the Separate Ion 
Overlay Display check box.

3. To use an alternate format for the Calibration Report designed to print more concisely 
and limit the report to a maximum of seven calibration standards, select the Use 
Alternate Calibration Report Format check box.

4. To display flags and a legend on high density reports, select the Display Quan Flags and 
Legend check box.

 To specify quantitation flag options

Select the values that you want to display in the report.

Values are above or below the limits defined on the Quan page. 

These flags appear on a variety of reports and are defined in “Quan Report Settings page 
parameters.” 
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 To correct surrogates

Select the Correct Surrogates check box.

The TraceFinder application applies the conversion factor (specified in the sample row in 
the batch) to the sample’s calculated concentrations for surrogates as the conversion factor 
is applied to target compounds.

 To track the use of the tune file

1. Select the Enable Tune Time Tracking check box.

This option tracks the number of hours between the last instrument tune and each 
sample acquisition.

2. In the Tune File Lifetime box, enter the number of hours that you want to allow between 
the last instrument tune and a sample acquisition. 

Any sample acquired outside this maximum allowable time is flagged on the Batch report. 
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Figure 58. Quan Report Settings page
 

 

Table 52. Quan Report Settings page parameters  (Sheet 1 of 2)

Parameter Description

Quan Limits Flags

Report Concentration Reports the concentration at all times or only when the quantified value exceeds either the 
limit of detection (LOD), the limit of quantitation (LOQ), or the limit of reporting (LOR). 
Report concentration: Always, >LOD, >LOQ, or >LOR.

Decimal Places to be 
Reported

Number of decimal places to be included in the report. Maximum value is 6.

Show Chromatogram 
on Quantitation 
Report

Displays a chromatogram (TIC trace) of the sample on the quantitation report. 

Display Compounds 
Above Set Limit

Prints only the positive compounds in a sample. If a compound is above the specified Quan 
Flag Options limits, the TraceFinder application reports the compound.

User Interface Options

Shade Row When 
Sample is Outside of 
Evaluation Criteria

Shades a compound row on any of the reports if a value fails one of the criteria used for 
evaluation. 

Separate Ion Overlay 
Display

Separates the ion overlay pane from the confirming ion plots in an analysis. 

Use Alternate 
Calibration Report 
Format

Uses an alternate format for the Calibration Report that is designed to print more concisely 
(this report is limited to a maximum of seven calibration standards). 

Display Quan Flags 
and Legend

Displays manual flags, confirming manual flags, quantitation flags, and a legend on 
high-density reports.
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Quan Flag Options
Values that are above or below limits defined on the Limits page. These flags appear on a 
variety of reports. 

Flag Values Below 
LOD

Flags values below the limit of detection (LOD).

Flag Values Below 
LOQ

Flags values below the limit of quantitation (LOQ).

Flag Values Above 
LOR

Flags values above the limit of reporting (LOR).

Flag Values Above 
ULOL

Flags values above the upper limit of linearity (ULOL).

Flag Values Above 
Carryover

Flags values above the carryover limit.

Flag Values Between 
LOD and LOQ

Flags values between the limit of detection and the limit of quantitation known as the J flag.

Surrogate Correction Option

Correct Surrogates Applies the conversion factor (specified in the sample row in the batch) to the sample’s 
calculated concentrations for surrogates as the conversion factor is applied to target 
compounds. For example, if you added surrogates to the sample as part of sample 
preparation and you require a dilution for analysis, the TraceFinder application dilutes the 
surrogates and target compounds and applies a dilution correction to correct for this 
dilution. However, if you added surrogates after a dilution has occurred, then you can leave 
the option cleared so that, while the target compounds are corrected for the dilution, the 
surrogates are reported “as is.”

Tune Time Tracking Options

Enable Tune Time 
Tracking

Tracks the number of hours between the last instrument tune and each sample acquisition.

Tune File Lifetime Specifies the maximum number of hours between the last instrument tune and a sample 
acquisition. Any sample acquired outside this maximum allowable time is flagged on the 
Batch report.

Table 52. Quan Report Settings page parameters  (Sheet 2 of 2)

Parameter Description
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Specifying Target Screening Settings 

Use the options on the Target Screening Settings page to set the parameters required to 
produce Target Screening reports. For detailed descriptions of the features on the Target 
Screening Settings page, see “Target Screening Settings page parameters” on page 213.

The TraceFinder application uses these parameters to process a raw data file and create a 
report similar to a ToxID report. See “Example Target Screening Summary Report” on 
page 215.

Follow these procedures:

• To specify the default parameters

• To calculate and report semi-quantitative results

• To specify the ion ratio calculation method

• To specify the exact mass window

• To specify the Exactive parameters

 To specify the default parameters

1. Click the Processing Configuration File browse button and select a configuration file 
(.csv).

2. From the Screening Method list, select one of these compound screening methods.
• (Default) Auto Detect
• Based on Full MS2 scans
• Based on SRM and MS2 scans
• Based on MS2 and MS3 scans
• Based on MS3 scans
• Based on accurate mass scans
• Based on SRM scans
• Based on Exactive screening method

3. Type the name of the company to print on the report.
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4. Type the name of the laboratory to print on the report.

5. Click the Company Logo browse button and select a graphic file (.jpg, .gif, or .bmp) to 
print on the report.

6. In the m/z Window box, enter a value for the window above and below the m/z value for 
the compounds.

7. In the RT Window box, enter a value for the window above and below the retention time 
value for the compounds.

8. In the MS2 Search Library boxes, type the names of as many as three search libraries for 
searching MS/MS spectra.

9. In the MS3 Search Library boxes, type the names of as many as three search libraries for 
searching MS3 spectra.

10. Select the Use Full MS Scan to Confirm check box if you want to confirm library search 
results with parent ion peak detection in the full scan. 

When the application does not detect a peak in the full scan, the compound is not 
reported as a hit.

 To calculate and report semi-quantitative results

1. In the Semi Quantitative area, do the following:

a. Select the Report Semi-Quantitative Result check box.

b. Type the measurement units. 

The measurement units are used only for labeling purposes.

2. Select either the Scan Intensity or Peak Area option. 

• Scan Intensity: The application measures the intensity of the MS/MS peak without 
performing background subtraction. 

• Peak Area: The application measures the peak area of the reconstructed full-scan 
chromatogram peak of the parent ion. When you select Peak Area, the Use Full MS 
Scan to Confirm check box is automatically selected.
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 To specify the ion ratio calculation method

1. Select the Use Scan at Peak Apex or Use Average Scan option.

• Use Scan at Peak Apex: The application calculates the ion ratio based on the peak 
apex scan spectrum.

• Use Average Scan: The application calculates the ion ratio based on the average scan 
spectrum over the range of the peak’s half height. The relative intensity in the 
configuration file must use the selected scan method.

2. In the Ion Ratio Window (%) box, type the acceptable percentage of the intensity of the 
qualifier ion to the quantitation ion.

For example, when the Ion Ratio Window is 20% and the quantitation ion has an 
intensity/height of 100, the specified confirming ion/mass must have a height of at least 
80 to be considered found.

 To specify the exact mass window

Type a total window width value in parts per million for the Exact Mass Window.

For example, when you expect a mass of 50 with a window of 2, the algorithm creates an 
XIC based on the responses of all masses from 49 to 51.

 To specify the Exactive parameters

1. Type values for Adduct 1, Adduct 2, and Adduct 3. 

These values identify the adducts listed in and applied throughout the configuration file. 
Adducts are polarity sensitive. For negative ionization, enter negative adduct values. 
These values default to H+, NH4+, and Na+, respectively.

2. To search the entire raw data file for the specified peak, do the following:

a. Select the No Specified Retention Time check box.

b. Select either the First Peak or Highest Peak option. 

When the search finds more than one m/z match in the raw data file, the application 
uses the specified peak for processing.
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3. Select the Report All Compounds Listed in Configuration File check box to report all 
compounds in the configuration file whether or not matches are found for them. 

The default reports on only those compounds where matches are found in the raw data 
file. This option applies to the Exactive™ experiment only. 

Figure 59. Target Screening Settings page 

 

Table 53. Target Screening Settings page parameters  (Sheet 1 of 2)

Parameter Description

Processing 
Configuration File

Specifies a configuration file (.csv).

Screening Method Specifies one of the following screening methods:
• (Default) Auto Detect
• Based on Full MS2 scans
• Based on SRM and MS2 scans
• Based on MS2 and MS3 scans
• Based on MS3 scans
• Based on accurate mass scans
• Based on SRM scans
• Based on Exactive screening method

Note  Using the Auto Detect method, the ToxID application can identify the screening 
experiment implemented in the acquired data file.

Company Name Specifies the name of the company to print on the report.

Laboratory Name Specifies the name of the laboratory to print on the report.

Company Logo Specifies a graphic file (.jpg, .gif, or .bmp) to print on the report.

m/z Window (mu) Specifies a value for the window above and below the m/z value for the compounds.
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RT Window (min) Specifies a value for the window above and below the retention time value for the 
compounds.

MS2 Search Library Specifies the names of as many as three search libraries for searching MS/MS spectra.

MS3 Search Library Specifies the names of as many as three search libraries for searching MS3 spectra.

Use Full MS Scan to 
Confirm

Specifies that the application confirms library search results with parent ion peak detection 
in the full scan. When the application does not detect a peak in the full scan, the compound 
is not reported as a hit.

Semi Quantitative

Report 
Semi-Quantitative 
Result

Includes the semi-quantitative results in the target screening reports.

Measurement Unit Units used for labeling purposes.

Calculation Based On Specifies one of the following calculation methods:
• Scan Intensity: Specifies that the application measures the intensity of the MS/MS peak 

without performing background subtraction. 
• Peak Area: Specifies that the application measures the peak area of the reconstructed 

full-scan chromatogram peak of the parent ion. When you select Peak Area, the Use Full 
MS Scan to Confirm check box is automatically selected.

Ion Ratio Calculation Method (In SRM Experiment)

Use Scan at Peak Apex Specifies that the application calculates the ion ratio based on the peak apex scan spectrum.

Use Average Scan Specifies that the application calculates the ion ratio based on the average scan spectrum 
over the range of the peak’s half height. The relative intensity in the configuration file must 
use the selected scan method.

Ion Ratio Window(%)

Accurate Mass Experiment

Exact Mass Window Specifies a value in parts per million for the accurate mass experiment.

Exactive

Adduct 1–n Specifies the adducts listed in and applied throughout the configuration file. Adducts are 
polarity sensitive. For negative ionization, enter negative adduct values.
Defaults: Adduct 1: H+, Adduct 2: NH4+, and Adduct 3: Na+

No Specified Retention 
Time 

Specifies either First Peak or Highest Peak to use for processing when the search finds more 
than one m/z match in the raw data file.

Report All Compounds 
Listed in Configuration 
File

Specifies that in an Exactive experiment, the application reports all compounds in the 
configuration file whether or not matches are found for them. 
Default: Reports only those compounds where matches are found in the raw data file.

Table 53. Target Screening Settings page parameters  (Sheet 2 of 2)

Parameter Description
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Figure 60. Example Target Screening Summary Report

Your Company Name
Summary Report

Raw File Name: C:\Xcalibur\examples\ToxID\Exact_Mass\Exact_Mass_Test.RAW
Config File Name: C:\Xcalibur\examples\ToxID\Exact_Mass\ConfigFile_Exact_mass.csv
Sample Name: Laboratory: Your Lab Name
Acquistion Start Time: 3/24/2008 4:46:43 PM
Screening Conditions: Based on accurate mass scans. Exact mass window (ppm): 30, RT window(min): 0.50.
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2.391.99
2.84 4.16
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4.824.06 7.68 9.47
5.19

5.364.12 10.151.53
3.57

3.49
3.130.87 3.80 12.50

4.18

4.33 11.50
3.98

3.72 4.12

NL: 2.03E5
m/z= 240.15580-240.16300
F: FTMS + c ESI Full ms
[120.00-1000.00]

NL: 1.26E7
m/z= 250.17665-250.18415
F: FTMS + c ESI Full ms
[120.00-1000.00]

NL: 1.18E7
m/z= 278.18643-278.19477
F: FTMS + c ESI Full ms
[120.00-1000.00]

NL: 2.12E6
m/z= 328.14938-328.15922
F: FTMS + c ESI Full ms
[120.00-1000.00]

NL: 4.59E6
m/z= 342.16507-342.17533
F: FTMS + c ESI Full ms
[120.00-1000.00]

NL: 9.08E6
m/z= 337.20734-337.21746
F: FTMS + c ESI Full ms
[120.00-1000.00]

Peak
Number

Compound Name Expected
m/z

Detected
m/z

Delta
(mDa)

Delta
(ppm)

Expected
RT

Actual RT Intensity

1 Albuterol 240.15940 240.15939 -0.0 -0.0 2.58 2.58 199505
2 Alprenolol 250.18040 250.18039 -0.0 -0.0 4.50 4.66 12604499
3 Amitriptyline 278.19060 278.19061 0.0 0.0 5.00 5.19 11769755
4 6-Acetylmorphine 328.15430 328.15433 0.0 0.1 3.30 3.57 2112090
5 6-Acetylcodeine 342.17020 342.17035 0.1 0.4 4.10 4.18 4593306
6 Acebutolol 337.21240 337.21246 0.1 0.2 3.80 3.98 9077282
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Creating a Method Template

In the TraceFinder application, you can create a processing method using a method template 
that contains common settings.

Follow these procedures:

• To open the Method Template Editor

• To specify peak criteria

• To identify the peaks

• To specify confirming ions

• To calibrate the compounds

• To enter a note for the method

• To save the method template

 To open the Method Template Editor

1. Click Method Development from the dashboard or the navigation pane.

The Method Development navigation pane opens.

2. Click Method View in the navigation pane.

3. From the main menu, choose File > New > Method Template.

The Method Template Editor opens. For a complete description of the Method Template 
Editor, see “Method Template Editor dialog box” on page 222.
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 To specify peak criteria

1. In the Find the Peaks area, select a sensitivity level.

In selecting the degree of sensitivity, you define how extensively the peak detector 
algorithm searches for low-level peaks. 

• The Genesis peak detection algorithm is provided for backward compatibility with 
Xcalibur 1.0 studies. 

• The ICIS peak detection algorithm is designed for MS data and has superior peak 
detection efficiency at low MS signal levels. 

• The Avalon peak detection algorithm is designed for integrating UV/Vis and analog 
chromatograms. 

2. To look for peaks only in a certain range of the entire chromatogram, select the Limit the 
Retention Time Range check box and specify a retention time (RT) range. 

3. To indicate whether to select peaks by relative height or area and the percentage of the 
highest peak that results in compound selection, select the Enable Peak Threshold check 
box.

To consider a peak for a processing method, the TraceFinder application uses the Enable 
Peak Threshold filter to determine which peaks meet the specified percentage of the 
largest peak.

4. To display a specific number of the largest peaks by height or area, select the Only Select 
Top Peaks check box and enter the number of peaks to display.
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 To identify the peaks

1. In the Use these Libraries box, select the libraries that you want to search.

All libraries loaded on your instrument are displayed in the Use these Libraries box. 

2. To limit the number of hits returned when the system searches a spectrum against the 
selected libraries, set a value in the Limit Library Hits box.

3. To specify how to sort the library searches, select a value from the Best Match Method 
list.

 To specify confirming ions

1. To set the number of confirming ions, select the Include Confirming Ions check box 
and enter a value in the Number of Confirming Ions box.

This value is the number of other ions in the spectrum whose ratio is compared to the 
quantitation ion. Using this ratio, you can then determine if it is the target compound or 
something else. This value defaults to 2 because you typically perform a 3-ion experiment 
with one quantitation mass and two confirming ions. 

The system selects the most intense ion to use as the quantitation mass and uses this mass 
for the mathematical operations. 
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2. To define the criteria for evaluating confirming or qualifying ions, select the Specify 
Default Ion Ratio Ranges check box and set the following values:

a. To specify the maximum difference in retention time between a confirming ion peak 
and the quantification ion peak, set a value in the Ion Coelution (min) box. 

b. To specify an absolute or relative calculation approach for determining the acceptable 
ion ratio range, select Absolute or Relative from the Window Type list.

c. To specify the acceptable ion ratio range, set a value in the Window (+/– %) box.

3. To include the peak spectrum in the processing method, select the Include Compound 
Peak Spectrum as Reference Spectrum check box.

 To calibrate the compounds

1. From the Calibration Method list, select Internal or External.

2. From the Curve Type list, select one of the following:

• Linear: All other settings are available with this exception: When you select Include in 
the Origin list, all weighting values are unavailable except for Equal.

• Quadratic: All other settings are available with this exception: When you select 
Include in the Origin list, all weighting values are unavailable except for Equal.

• Average RF: No selections in the Weighting or Origin lists are available. The 
Weighting list is set to Equal, and the Origin list is set to Ignore. 

3. From the Origin list, select one of the following:

• Ignore: Specifies that the origin is not included as a valid point in the calibration 
curve when the curve is generated. When you select Ignore, the calibration curve 
might or might not pass through the origin. 

• Force: Specifies that the calibration curve passes through the origin of the data point 
plot when the calibration curve is generated.

• Include: Specifies that the origin is included as a single data point in the calculation 
of the calibration curve. When you select Include, the calibration curve might or 
might not pass through the origin.
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4. From the Weighting list, select one of the following:

• Equal: Specifies that the origin is included as a single data point in the calculation of 
the calibration curve. When you select Equal, the calibration curve might or might 
not pass through the origin.

• 1/X: Specifies a weighting of 1/X for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted 
by the inverse of their quantity. 

• 1/X^2: Specifies a weighting of 1/X^2 for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted 
by the inverse of the square of their quantity. 

• 1/Y: Specifies a weighting of 1/Y for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted 
by the inverse of their response (or response ratio). 

• 1/Y^2: Specifies a weighting of 1/Y^2 for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted 
by the inverse of the square of their response (or response ratio). 

5. From the Response Via list, select Area or Height.

• Area: Specifies that the TraceFinder application use this area value in response 
calculations.

• Height: Specifies that the application use this height value in response calculations. 

 To specify qualitative peak processing

1. Select the Use Genesis Algorithm for Qual Processing check box and specify a value for 
internal standard matching. 

The application uses the Genesis algorithm to match internal standards in a range 
plus/minus the value that you specify. For additional information about the Genesis 
algorithm, see “Genesis Detection Method” on page 78.

This parameter is available only when the Sensitivity parameter in the Find the Peaks area 
is set to ICIS.

2. Select or clear the Exclude Matching Quan Peaks check box and specify a value for the 
exclusion window.

The application excludes quantitative peaks in a range plus or minus the value that you 
specify.
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3. To process samples that include data-dependent scans, select the Use Data Dependent 
Scans check box.

When you process a sample using this feature, the application uses the TIC trace to find 
all data-dependent full scans, lists them, and performs a library search against the 
data-dependent MS/MS or MSn scan.

In addition to the peak information, the TIC Report and TIC Summary Report display 
information about the data-dependent filtered data. See Appendix A, “Reports.” 

 To enter a note for the method

Type in the Notes box, or paste text from another application using CTRL+V.

You can add a note to your method template to explain what makes this template unique. 

 To save the method template

1. Choose File > Save from the Method Template Editor menu.

The Save Method Template dialog box opens.

2. Do one of the following:

Type a new name for the master method and click OK.

–or–

Select a method name to overwrite and click Overwrite.

The TraceFinder application saves the new method template in the following folder:

…\Thermo\TraceFinder\2.1\EFS\Templates\Methods 
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Figure 61. Method Template Editor dialog box
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Table 54. Method Template Editor dialog box parameters  (Sheet 1 of 3)

Parameter Description

Find the peaks

Sensitivity Defines how extensively the peak detector algorithm searches for low-level peaks. 

Limit the Retention 
Time Range

Min RT specifies the beginning of the range. Max RT specifies the end of the range. 

Enable Peak Threshold Specifies whether to select peaks by relative height or area and the percentage of the highest 
peak that results in compound selection.

Only Select Top Peaks Displays a specific number of the largest peaks by height or area.

Identify the peaks

Use These Libraries Lists the libraries that you can search.

Limit Library Hits Specifies the number of hits returned when the system searches a spectrum against the 
selected libraries.

Best Match Method Specifies how to sort the library searches. 
Valid values: Search Index, Reverse Search Index, Match Probability

Handle confirming ions

Include Confirming 
Ions/
Number of Confirming 
Ions

Specifies the number of confirming ions, which are other ions in the spectrum whose ratio 
is compared to the quantitation ion to identify the compound.

This value defaults to 2 because you typically perform a 3-ion experiment with one 
quantitation mass and two confirming ions.

Specify Default Ion 
Ratio Ranges

Enables the ion ratio range features.

Ion Coelution specifies the maximum difference in retention time between a confirming 
ion peak and the quantification ion peak. 

Window Type specifies an Absolute or Relative calculation approach for determining the 
acceptable ion ratio range.

Window (+/-%) specifies the acceptable ion ratio range.

Include Compound 
Peak Spectrum as 
Reference Spectrum

Includes the peak spectrum in the processing method. Use this setting to perform a spectra 
comparison in Data Review. 

Calibrate the compounds

Calibration Method Specifies an internal or external calibration method.

Curve Type Specifies a linear, quadratic, or average RF curve type.
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Origin Specifies that the origin is ignored, forced, or included in the generated calibration curve.
• Ignore: Specifies that the origin is not included as a valid point in the calibration curve 

when the curve is generated. When you select Ignore, the calibration curve might or 
might not pass through the origin. 

• Force: Specifies that the calibration curve passes through the origin of the data point 
plot when the calibration curve is generated.

• Include: Specifies that the origin is included as a single data point in the calculation of 
the calibration curve. When you select Include, the calibration curve might or might 
not pass through the origin.

Weighting Specifies the weighting for the calibration data points.
• Equal: Specifies that the origin is included as a single data point in the calculation of 

the calibration curve. When you select Equal, the calibration curve might or might not 
pass through the origin.

• 1/X: Specifies a weighting of 1/X for all calibration data points during the least-squares 
regression calculation of the calibration curve. Calibrants are weighted by the inverse 
of their quantity. 

• 1/X^2: Specifies a weighting of 1/X^2 for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted by 
the inverse of the square of their quantity. 

• 1/Y: Specifies a weighting of 1/Y for all calibration data points during the least-squares 
regression calculation of the calibration curve. Calibrants are weighted by the inverse 
of their response (or response ratio). 

• 1/Y^2: Specifies a weighting of 1/Y^2 for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted by 
the inverse of the square of their response (or response ratio). 

Response Via Specifies if the TraceFinder application uses area or height in response calculations.
• Area: Specifies that the application use this peak area value in response calculations.
• Height: Specifies that the application use this peak height value in response 

calculations. 

Qualitative Peak Processing

Use Genesis Algorithm 
For Qual Processing

The application uses the Genesis algorithm to match internal standards. 

ISTD Matching Excludes all the target compounds found in the method and does not list these compounds 
in the TIC Report or in the Qual Mode view in the Data Review.

Table 54. Method Template Editor dialog box parameters  (Sheet 2 of 3)

Parameter Description
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Exclude Matching Quan 
Peaks

Exclusion Window

Compares the retention time of the internal standard in the method to the found retention 
time of the internal standard in the library search and excludes peaks outside the Exclusion 
Window range. 

Defines a range plus/minus the Exclusion Window value that you specify.

Use Data Dependent 
Scans

Constrains the Qual Mode view in the Data Review to only data-dependent scan spectra. 
See “Qual Mode” on page 375. In addition to the peak information, the TIC Report and 
TIC Summary report display information about the data-dependent filtered data.

Table 54. Method Template Editor dialog box parameters  (Sheet 3 of 3)

Parameter Description
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Importing Published Master Methods 

In the TraceFinder application, you can import published methods to use for detecting, 
processing, and reporting. The Tracefinder installation provides the following folder of 
published methods:

…\Thermo\TraceFinder\2.1\EFS\Published Master Methods

 To import a published master method

1. From the Method View task pane, click Import Published Method. 

The Import Published Method dialog box opens.

2. Select a method to import.

3. Click Import.

The application reports that the method successfully imported and saves the method in 
the following folder:

…\Thermo\TraceFinder\2.1\EFS\Methods

You can use any of the Open Method commands to open this method just as you would a 
method that you created.
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Exporting SRM Data

In the TraceFinder application, you can export your selected reaction monitoring (SRM) data 
to an XML file. The Export SRM Data command is displayed only when you enable the 
Compound Datastore option in the Configuration mode. See “Compound Datastore” on 
page 92.

 To export SRM data to an XML file

1. Open the master method whose SRM data that you want to export.

2. From the Method View task pane, click Export SRM Data. 

The TraceFinder application writes the data in the SRM table to the following file:

…\Thermo\TraceFinder\2.1\EFS\Methods\methodname.xml

The data in this file matches the TSQ .xml data, which you can use in the instrument 
method editor of the TSQ application.

Figure 62. SRM TSQ Quantum example
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Working with Instrument Methods
An instrument method is a set of experiment parameters that define the operating settings for 
an autosampler, mass spectrometer, and so on. Instrument methods are saved as file 
type .meth.

Follow these procedures:

• To open the Instrument View

• To create a new instrument method

• To create a new multiplexing instrument method

• To open an instrument method

• To import an instrument method

 To open the Instrument View

1. Click Method Development from the dashboard or the navigation pane.

The Method Development navigation pane opens.

2. Click the Instrument View task pane.

IMPORTANT  Do not open the Thermo Foundation Instrument Configuration window 
while the TraceFinder application is running.



 4 Using the Method Development Mode
Working with Instrument Methods

Thermo Scientific TraceFinder User Guide 229

 To create a new instrument method

1. Click New Instrument Method in the Instrument View task pane.

The Thermo Xcalibur Instrument Setup window opens.

Figure 63. Example instrument setup showing multiple configured instruments

2. Click the icon for the instrument that you want to use for the method.

3. Edit the values on the instrument page.

4. From the main menu in the Thermo Xcalibur Instrument Setup window, choose File > 
Save As.

The Save As dialog box opens.
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5. Select an instrument method name to overwrite or type a new name for the instrument 
method, and click Save.

The File Summary Information dialog box opens.

6. (Optional) Type a comment about the new instrument method.

7. Click OK.

The TraceFinder application saves the new instrument method in the following folder:

…\Xcalibur\methods
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 To create a new multiplexing instrument method

1. Click New Instrument Method in the Instrument View task pane.

The Thermo Xcalibur Instrument Setup window opens.

Figure 64. Example instrument setup showing a configured multiplexed instrument

2. Click the icon for the instrument that you want to use for the method.

3. Edit the values for the instrument method.

For information about specifying multiplexing values, refer to the documentation for 
your multiplexed instrument.

4. Specify the channels that you want to use for acquisition. For example:

5. From the main menu in Thermo Xcalibur Instrument Setup window, choose File > 
Save As.

The Save As dialog box opens.
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6. Select an instrument method name to overwrite or type a new name for the instrument 
method, and click Save.

The File Summary Information dialog box opens.

7. (Optional) Type a comment about the new instrument method.

8. Click OK.

The TraceFinder application saves the new instrument method in the following folder:

…\Xcalibur\methods
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 To open an instrument method

1. Click Open Instrument Method on the Instrument View task pane.

An instrument method browser opens.

2. In the browser, do one of the following:

• Select an instrument method from the list and click Open.

• Click Xcalibur Instrument Method, select a method from the list of recent 
methods, and click Open.

The selected method opens in the Thermo Xcalibur Instrument Setup window. You can 
edit this method and save the changes, or you can save this method with another name.

Figure 65. Example instrument setup showing multiple configured instruments

Note  To open Help for any of your configured instruments, click Help on the 
instrument page.
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 To import an instrument method

1. From the Instrument View task pane, click Import Published Method. 

The Import Published Method dialog box opens. This dialog box lists the master 
methods in the Published Master Methods folder. You can import instrument methods 
that are associated with these published master methods. 

2. Select a method that includes the instrument method that you want to import.

For instructions about importing the master methods, see “Importing Published Master 
Methods” on page 226.

3. Click Import.

The Save Instrument Method dialog box opens.

4. Do one of the following:

Type a new name for the instrument method and click OK.

–or–

Select an instrument method name to overwrite and click Overwrite.

The application reports that the method successfully imported.

You can use any of the Open Instrument Method commands to open this method just as you 
would an instrument method that you created.
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Working with Development Batches 
In the Development Batch view, you can test your instrument method in real time by creating 
and acquiring test samples. Development batches let you test different instrument methods 
and optimize parameters, such as MS source parameters and autosampler variables, to find the 
best conditions for a master method. Development batches are not designed for high 
throughput in everyday analysis.

This section includes instructions for the following tasks:

• Creating a Development Batch

• Editing Samples in a Development Batch

• Acquiring Samples in a Development Batch

Creating a Development Batch
You create a development batch to test your instrument method and use it to acquire samples 
only once. You cannot save a development batch; you can save only the raw data files created 
when you acquire the samples in the batch.

Follow these procedures:

• To open the Development Batch view

• To specify a location for development batch data

• To add samples to the development batch

• To insert samples into the development batch

• To copy a sample

 To open the Development Batch view

1. Click Method Development from the dashboard or the navigation pane.

The Method Development navigation pane opens.

2. In the Method Development navigation pane, click Development Batch.

The Development Batch view opens a new, empty batch.

Note  The Channel column is available only when you have enabled multiplexing in 
the Configuration mode. See “Multiplexing” on page 92.



4 Using the Method Development Mode
Working with Development Batches

236 TraceFinder User Guide Thermo Scientific

 To specify a location for development batch data

1. To specify a location for the files, click Select Batch Location in the Development Batch 
task pane.

By default, the TraceFinder application writes the temporary files, raw data files, and .sld 
method file to the following folder:

…\Thermo\TraceFinder\2.1\EFS\Temp

2. In the browser, do one of the following:

Locate the folder that you want to use for the development batch files and click OK.

–or–

Create a new folder:

a. Locate and select the folder where you want to create a new folder for the batch 
files.

b. Click Make New Folder.

The TraceFinder application creates a new folder in the selected folder.

c. Right-click the New Folder file name and choose Rename from the shortcut 
menu.

d. Type the name for the folder.

e. Click OK.

The TraceFinder application creates all development batch files in the specified folder.

 To add samples to the development batch

Do one of the following:

Right-click and choose Add Sample from the shortcut menu.

–or–

To add multiple sample rows, enter the number of rows and click the Add Sample icon.

The application adds the specified number of new, empty samples to the end of the 
sample list.
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 To insert samples into the development batch

1. Select the sample above which you want to insert empty samples.

2. Do one of the following:

Right-click and choose Insert Sample from the shortcut menu.

–or–

To insert multiple sample rows, enter the number of rows and click the Insert Sample 
icon.

The TraceFinder application inserts new, empty samples above the selected sample.

 To copy a sample

1. Select the sample that you want to copy.

2. Right-click and choose Insert Copy Sample from the shortcut menu.

The TraceFinder application adds a copy of the sample above the selected sample. 

Note  You cannot insert samples into an empty batch. You must have at least one 
sample to select before you can use this icon.
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Editing Samples in a Development Batch

A development batch requires fewer parameters than a real batch, but the mechanism for 
managing the information is the same. 

For detailed instructions about using the Copy Down or Fill Down commands to enter 
column values, see Appendix B, “Using Copy Down and Fill Down.” 

A development batch uses the same shortcut menu features as a batch in the Batch View. For 
detailed descriptions of the right-click shortcut menu features, see “Batch View Shortcut 
Menu” on page 307.

Follow these procedures:

• To enter column values

• To resize or reorganize the columns

• To remove selected samples from the list

• To remove all samples from the list

 To enter column values

1. Double-click the Filename column and type a file name for the raw data file.

2. (Optional) Enter values for the Sample Name or Sample ID columns.

3. Enter a vial position for each sample.

4. Enter an injection volume for each sample.

The minimum injection volume value allowed is 0.1 μL; the maximum injection volume 
value allowed is 5000 μL.

5. To enter an instrument method for each sample, click the down arrow in the Instrument 
Method column and select a method from the list.

This list contains all the available instrument methods.

6. To enter a channel for each sample, click the down arrow in the Channel column and 
select a channel from the list.

You cannot specify the auto channel selection in a development batch.

Note  The Channel column is available only when you have enabled multiplexing in 
the Configuration mode. See “Multiplexing” on page 92.
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Figure 66. Completed Development Batch

 To resize or reorganize the columns

1. To resize a column, drag the header separator on the right side of the column.

2. To move a column, drag the column header.

You cannot move the Filename column.

 To remove selected samples from the list

1. Select the samples that you want to remove.

Use the first column to ensure that the samples are selected.

2. Right-click and choose Remove Selected Samples from the shortcut menu.

 To remove all samples from the list

1. Click New Sample List in the Development Batch task pane.

One of the following happens:

• If the samples in the current batch have all been acquired, the list is cleared.

• If the samples in the current list have not been acquired, a message confirms that you 
want to clear them and start a new list. 

2. To create a new empty list, click Yes. 

Note  You cannot save a development batch when you create a new one; you can only 
create, acquire, and discard each batch after you use it. The TraceFinder application 
saves only the generated raw data files in the specified batch location.

Selected samples
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Acquiring Samples in a Development Batch

In a development batch, you can submit the entire batch for acquisition or submit only 
selected samples.

Follow these procedures:

• To acquire selected samples

• To acquire the batch

 To acquire selected samples

1. Select the samples that you want to acquire.

2. Right-click and choose Submit Selected Samples from the shortcut menu, 

or click the Submit Selected Samples icon, .

The TraceFinder application creates a raw data file for each selected sample. It writes the 
raw data files and all temporary working files to the following folder:

…\Thermo\TraceFinder\2.1\EFS\Temp

When the acquisition is complete, the application deletes all the temporary working files. 
Only the raw data files and a MethodDevelopment.sld file remain in the folder.

If you acquire a sample more than once, the application time-stamps the subsequent raw 
data files with the acquisition time.

 To acquire the batch

Right-click and choose Submit Batch from the shortcut menu, 

or click the Submit Batch icon, .

The TraceFinder application creates a raw data file for each sample in the batch and 
an .sld method file. The TraceFinder application writes the raw data files, the .sld method 
file, and all temporary working files to the specified folder.

When the acquisition is complete, the application deletes all the temporary working files. 
Only the raw data files and a MethodDevelopment.sld file remain in the folder.

If a sample is acquired more than once, the subsequent raw data files are time-stamped 
with the acquisition time.
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Viewing Raw Data Files in the Qual Browser

You can view the chromatogram and spectra for completed samples in a development batch.

Follow these procedures:

• To open the Qual Browser

• To display the last completed raw data file in the Qual Browser

 To open the Qual Browser

In the Development Batch task pane, click Open Qual Browser.

The Thermo Xcalibur Qual Browser window opens.

For detailed instructions about using the Qual Browser, refer to the Qual Browser Help. 
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 To display the last completed raw data file in the Qual Browser

On the Acquisition page of the real-time viewer, right-click and choose View Last File in 
Qual Browser from the shortcut menu.

The last completed file opens in the Qual Browser. 

When all samples are completed, you can view the last raw data file for the batch.
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Using Quick Acquisition
You can use the quick acquisition feature to quickly submit a single sample from any view in 
the Method Development mode.

 To run a quick acquisition

1. Choose Go > Quick Acquire Sample from the main menu.

The Quick Acquisition dialog box opens.

2. Select an instrument method.

3. Type a name for the raw data file that you acquire.

4. Click the browse button and locate a folder where you want to write the acquired raw 
data file.

5. Select either the manual injection or the autosampler option:

To perform manual injection, do the following:

a. Select the Manual Injection option.

b. Click OK.

The application submits the sample to the Acquisition queue. See “Acquisition Page” 
on page 280.

To perform autosampler injection, do the following:

Note  The Quick Acquisition feature is available only when you enable it in the 
Configuration mode. See “Enabling Optional Features” on page 88.
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a. Select the Use Autosampler option.

b. In the Vial Position box, type a vial position.

c. In the Injection Volume box, type an injection volume.

The minimum injection volume allowed is 0.1 μL; the maximum injection volume 
allowed is 5000 μL.

d. Click OK.

The Quick Acquisition dialog box opens.

e. Select the Use check box for the device that you want to use for this acquisition.

f. (Optional) Select the Start Device check box to indicate the device that will initiate 
communication with the other instruments. 

This is usually the autosampler.

g. (Optional) Select the Start When Ready check box, which starts all instruments 
together when they are all ready. 

When this is cleared, individual instruments can start at different times and then 
must wait for the last instrument to be ready.

h. (Optional) Select the Priority check box to place the sample immediately after any 
currently acquiring sample.

i. (Optional) Select a value for the Post-run System State: Unknown, On (default), 
Off, or Standby.

The application sets the system to this state after it acquires the last sample.

j. Click OK.

The application submits the sample to the Acquisition queue. See “Acquisition Page” 
on page 280.
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5

Using the Acquisition Mode 

This chapter describes the tasks associated with the Acquisition mode.

This mode is available only when you select the Acquisition Batch Wizard style in the 
Configuration mode. See “Batch Wizard Style” on page 94. 

When you plan to work with multiple samples or use similarly designed batches, use the 
Acquisition mode to reduce the amount of data you must enter. 

Because the nature and types of batches are often similar (in some cases specified by laboratory 
standard practices), you can define a batch template that supplies the basic structure of a 
batch. 

If you have a master method, you can create a batch and run the samples. Batches represent 
one or more samples that are to be acquired, processed, reviewed, and reported as a set. After 
you create a batch of samples, you can submit the batch and review the results in the Analysis 
mode or you can go directly to viewing and printing reports. 

You can set up a calibration batch with known concentrations of the target compounds and 
compare the calibration values against samples in future batches. 

You can also use the Quick Acquisition feature to quickly submit a single sample from any 
page in the Acquisition mode. See “Using Quick Acquisition” on page 277.

Contents 

• Working with Batches

• Using Quick Acquisition

• Real-Time Display

• Sample Types

Note  When user security is enabled, only a user in the LabDirector or Supervisor role can 
create a batch template.
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Working with Batches 
This section includes instructions for the following tasks:

• Opening and Navigating the Acquisition Mode

• Creating Batches

Opening and Navigating the Acquisition Mode

 To access the Acquisition mode

Click Acquisition from the dashboard or the navigation pane.

The Acquisition mode navigation pane opens. 

The TraceFinder application does not use the navigation pane in the Acquisition mode in the 
same way it uses the navigation pane in other modes. In the Acquisition mode, this pane 
keeps track of your progress as you move through the views to create and submit a batch or a 
batch template. 

Figure 67. Task pane when you enter the Acquisition mode 

The status of each view in the Acquisition mode shows you which tasks are completed and 
which tasks are not.

As you complete each view, the task panes display the parameters you specified for your batch. 

Completed view

Incomplete required view

Current view

Unvisited view
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Figure 68. Example task pane when you have completed the Acquisition mode

Categories in the Sample Definition list:

QC Samples: Chk Std

Calibration Samples: Cal Std

Blank Samples: Matrix Blank

Unknown Samples: All other samples
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Creating Batches

To create a batch, follow these major steps in Acquisition mode:

1. Selecting a Batch

2. Defining the Sample List

3. Selecting and Reviewing Reports

4. Submitting the Batch

The following workflows show the different Acquisition views required for each batch 
creation approach. Depending on your approach to creating a batch, use one of these specific 
workflows. 

 To create an original batch

To create an original batch, start with the instructions “To start a new batch” on 
page 250.

 To acquire a previously saved (.tbr) batch

To acquire a previously saved batch, start with the instructions “To select a 
ready-to-acquire batch” on page 252.

Batch and
Method

Finish

Reports

Samples

Batch

Finish Samples
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 To edit and process a previously acquired batch

To process a previously acquired batch, start with the instructions “To select a previously 
acquired batch” on page 253.

 To create a batch template

To create a batch template, start with the instructions “To create a batch template” on 
page 254 and then click Save on the Finish page.

Note  When user security is enabled, this workflow is available only to users in the 
LabDirector or Supervisor role. 

Batch

Finish

Samples

Finish

Samples

Template and
Method



5 Using the Acquisition Mode
Working with Batches

250 TraceFinder User Guide Thermo Scientific

Selecting a Batch

In a Template Selection view of the Acquisition mode, you can choose to create a new batch in 
any of your current projects/subprojects. 

Follow these procedures:

• To start a new batch

• To start a new batch from a template

• To select a ready-to-acquire batch

• To select a previously acquired batch

• To create a batch template

 To start a new batch

1. Click the New Batch tab.

2. Select the project and subproject where you want to create the new batch.

3. Type a name for the new batch in the Batch Name box.

If the name you enter is not unique, a red warning flashes.

4. Select a method from the Method Selection list.

The Method Compound Data pane displays the compounds in the method. You cannot 
edit the compounds list from the Acquisition mode.

5. To continue to the next view, click Next.

The Sample Definition view opens. See “Defining the Sample List” on page 255.
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 To start a new batch from a template

1. Click the New Batch tab. 

2. In the Available Templates pane, select the template and method combination that you 
want to use.

The system creates a batch name with the selected template name and the date and time 
stamp. You can change the default project, subproject, and method associated with this 
template. 

3. (Optional) Select a different project and subproject where you want to create the new 
batch.

4. (Optional) Select a different method to use for the new batch.

5. To continue to the next view, click Next.

The Sample Definition view of the Acquisition mode opens. See “Defining the Sample 
List” on page 255.
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 To select a ready-to-acquire batch

1. Click the Ready to Acquire tab.

All your unacquired, saved batches are displayed with the file extension .tbr (to be run). 
The TraceFinder application stores all .tbr batches in the following folder:

…\Thermo\TraceFinder\2.1\EFS\Projects\projectname\subprojectname

2. Select the batch you want to acquire.

3. To continue to the next view, click Next.

The Finish view of the Acquisition mode opens. From the Finish view, you can save the 
batch, submit the batch for acquisition, or go to the Sample Definition view to edit the 
sample list for this batch.

• If the batch is unreadable, the application reports that the batch file is not valid and 
cannot be opened.

• If a sample in the batch is unreadable, the application cannot open the sample. The 
application creates a new sample with the same name and flags the sample. You must 
complete the missing information such as Sample Type, Level, and so forth, and then 
save the batch before you submit it for acquisition. Alternatively, you can browse in a 
new raw data file to replace the corrupt file.

4. Do one of the following:

• To prepare the batch for acquisition, click Submit.

For detailed instructions, see “Submitting the Batch” on page 269. 

–or–

• To edit the sample list, click Previous.

For detailed instructions, see “Defining the Sample List” on page 255.

–or–

• To save the batch to the Ready to Acquire list, click Save.

The TraceFinder application saves your batch as a to-be-run (.tbr) file, closes the 
Acquisition mode, and returns you to the application dashboard.

The application saves the .tbr batches in the following folder:

…\Thermo\TraceFinder\2.1\EFS\Projects\projectname\subprojectname
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 To select a previously acquired batch

1. Click the Acquired Batches tab.

From this page, you can resubmit a previously acquired batch, edit the batch, or save it to 
be acquired later.

2. In the Project pane, select a project name.

All subprojects included in the selected project are displayed in the Subproject pane.

3. In the Subproject pane, select a subproject name.

The Batch pane displays all previously acquired batches included in the selected 
subproject.

4. In the Batch pane, select the batch you want to reacquire.

5. To continue to the next view, click Next.

The Sample Definition view of the Acquisition mode opens. See “Defining the Sample 
List” on page 255.

• If the batch is unreadable, the application reports that the batch file is not valid and 
cannot be opened.

• If a sample in the batch is unreadable, the application creates a new sample with the 
same name and flags the sample. You must complete the missing information such as 
Sample Type, Level, and so forth, and then save the batch before you submit it for 
acquisition. Alternatively, you can browse in a new raw data file to replace the corrupt 
file.
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 To create a batch template

1. Click the Template tab.

2. Select the project and subproject where you want to create the new batch template.

3. Type a name for the new batch template in the Template Name box.

4. Select a method from the Method Selection list.

5. The Method Compound Data pane displays the compounds in the method. You cannot 
edit the compounds list from the Acquisition mode.

6. To continue to the next view, click Next.

7. The Sample Definition view of the Acquisition mode opens. See “Defining the Sample 
List.” 

Note  When user security is enabled, this page is available only to users in the 
LabDirector or Supervisor role. 
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Defining the Sample List

In the Sample Definition view of the Acquisition mode, you can create a list of samples for the 
batch. You can add samples, insert samples, import a sample list, or remove samples from the 
list. To create the sample list, you can use either of two sets of function buttons (described in 
the following graphic) or you can use commands on the shortcut menu (see the Shortcut 
Menu section of the “Sample Definition view parameters” on page 263).

As you enter sample values, you can use the Copy Down and Fill Down commands to quickly 
enter column values. For detailed instructions on using Copy Down and Fill Down to enter 
column values, see Appendix B, “Using Copy Down and Fill Down.” 

Follow these procedures:

• To add samples to the list

• To insert samples into the list

• To import samples into the list

• To remove samples from the list

• To reinject a sample from a previously acquired batch

• To select channels for the batch

• To assign a specific channel to a sample

Icons in the toolbar

Buttons at the bottom of the template selection page

Add samples

Insert samples

Import samples

Remove samples

Add samples Insert samples Import samples
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When you finish defining the list of samples, click Next.

• When you are creating a batch from scratch, creating a batch from a template, or 
editing a batch template, the Report Selection view opens. See “Selecting and 
Reviewing Reports” on page 265.

• When you are editing a previously acquired batch or a .tbr batch, the Finish Selection 
view opens. See “Submitting the Batch” on page 269.

 To add samples to the list

1. Select the number of sample rows to add and click Add, .

2. Type a file name in the Filename column for each sample. 

Each file name must be unique. 

3. Select a sample type from the Sample Type list for each sample. 

For a detailed description of each sample type, see “Sample Types” on page 292.

4. For each Cal Std or Chk Std sample, select a level from the Level list.

The sample levels are defined in the master method. If there is nothing to select in the 
Level list, do the following:

a. Return to the Method Development mode.

b. Open the method.

c. Click the Compounds tab.

d. Click the Calibration Levels tab.

e. Add the levels.

f. Save the method.

g. Return to the Analysis mode, and click Update.

For detailed instructions, see Chapter 4, “Using the Method Development Mode.” 

5. Type a vial position in the Vial Position column for each sample. 

Available sample types

Matrix Blank Solvent Unknown/TIC

Cal Std Chk Std Unknown

LCS MDL MS

LCSD Method Val MSD

Tune Tune/Breakdown Breakdown

Tip  Use the Fill Down command to make entering vial positions easier.
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6. Type a volume in the Injection Volume column for each sample. 

The minimum injection volume value allowed is 0.1 μL; the maximum injection volume 
value allowed is 5000 μL.

7. (Optional) Type or edit the values for the remaining columns.

For instructions to automatically copy or fill values in these columns, see Appendix B, 
“Using Copy Down and Fill Down.” 

 To insert samples into the list

1. Select the sample above which you want to insert new, unknown samples.

You cannot use the Insert command to create the first sample row.

2. Select the number of samples to insert and click Insert, .

The application inserts the Unknown samples above the selected sample.

3. Type a file name in the Filename column for each sample. 

Each file name must be unique. 

4. Select a sample type from the Sample Type list for each sample. 

For a detailed description of each sample type, see “Sample Types” on page 292.

Note  When you use the horizontal scroll bar at the bottom of the sample list, the 
Status, Filename, Sample Type, and Level columns stay fixed while the other columns 
scroll right and left. 

Available sample types

Matrix Blank Solvent Unknown/TIC

Cal Std Chk Std Unknown

LCS MDL MS

LCSD Method Val MSD

Tune Tune/Breakdown Breakdown

Inserted 
samples
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5. For each Cal Std or Chk Std sample, click the Level cell and select a level from the list.

The sample levels are defined in the master method. If there are no levels to select from 
the Level list, ask a user with Supervisor or LabDirector permissions to edit the method 
and specify the levels. 

For detailed instructions about defining sample levels, see Chapter 4, “Using the Method 
Development Mode.” 

6. Type a vial position in the Vial Position column for each sample. 

7. Type a volume in the Injection Volume column for each sample. 

The minimum injection volume value allowed is 0.1 μL; the maximum injection volume 
value allowed is 5000 μL.

8. (Optional) Type or edit the values for the remaining columns.

Tip  Use the Fill Down command to make entering vial positions easier.

Note  When you use the horizontal scroll bar at the bottom of the sample list, the 
Status, Filename, Sample Type, and Level columns stay fixed while the other columns 
scroll right and left. 
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 To import samples into the list 

1. Click Import, .

The Sample Import Tool dialog box opens.

Use this dialog box to import a sample list from a .csv, .xml, or .sld file.

2. Click Browse and select a .csv, .xml, or .sld file that contains the sample definitions you 
want to import.

3. From the Imported Samples Will Be list, select either Appended to the End of the List 
or Inserted at the Selected Row.

4. Click Import.

The Sample Import Tool dialog box closes, and the specified samples are added to the 
sample list. 

When you import samples from an Xcalibur sequence file (.sld), the TraceFinder 
application makes the following column name substitutions.

When you import samples from an Xcalibur sequence file (.sld), the TraceFinder 
application makes the following sample type substitutions.

Note  The .csv, .xml, or .sld file format must match the TraceFinder file format. 

Xcalibur column TraceFinder column

Position Vial position
Inj Vol Injection volume
Dil Factor Conversion Factor

Xcalibur sample type TraceFinder sample type

Blank Matrix Blank
QC Chk Std
Std Bracket Cal Std
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5. For each Cal Std or Chk Std sample, click the Level cell and select a level from the list.

The sample levels are defined in the master method. If there are no levels to select from 
the Level list, ask a user with Supervisor or LabDirector permissions to edit the method 
and specify the levels. 

For detailed instructions, see Chapter 4, “Using the Method Development Mode.” 

6. Type a vial position in the Vial Position column for each sample. 

7. Type a volume in the Injection Volume column for each sample. 

The minimum injection volume value allowed is 0.1 μL; the maximum injection volume 
value allowed is 5000 μL.

8. (Optional) Type or edit the values for the remaining columns.

9. (Optional) When using multiplexing, select a channel for each imported sample.

Imported samples default to Auto.

Tip  Use the Fill Down command to make entering vial positions easier.

Note  When you use the horizontal scroll bar at the bottom of the sample list, the 
Status, Filename, Sample Type, and Level columns stay fixed while the other columns 
scroll right and left. 
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 To remove samples from the list

1. Select the samples you want to remove.

2. Right-click and choose Remove Selected Samples from the shortcut menu. 

 To reinject a sample from a previously acquired batch 

1. In the sample list, select the sample you want to reinject.

2. Right-click and choose Reinject This Sample from the shortcut menu.

The TraceFinder application creates a copy of the selected sample and appends INJ001 to 
the file name. Additional reinjections of the same sample are numbered INJ002, INJ003, 
and so forth.

The TraceFinder application copies all parameter values from the original sample.

A green status icon indicates previously acquired samples (acquired and processed) and 
the sample name is grayed out. A blue status icon indicates samples created for reinjection 
(not acquired).

When you submit this batch, the application acquires only the reinjection samples. 

 To select channels for the batch

To disable a configured channel, clear the check box for the channel in the Multiplexing 
Channels area at the bottom of the page.

By default, all configured channels are selected. The configured channels are determined 
by the multiplexing settings in the Configuration mode. See “Enabling Optional 
Features” on page 88. 

Disabling a channel in the Multiplexing Channels area does not remove this channel 
selection from the Channels list for each sample. When you assign a channel to a sample, 
be careful not to assign a channel that you disabled.

Tip  Use the CTRL or SHIFT keys to select multiple samples.

Note  These features are available only when you have enabled multiplexing in the 
Configuration mode. See “Multiplexing” on page 92.
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 To assign a specific channel to a sample 

1. Scroll to the Channel column.

All samples default to Auto. 

2. Select a channel from the Channel list. 

When you submit the batch, samples that are set to Auto run on any of the available 
channels and samples that are set to a specific channel run only on that channel.

If you select a channel that is not available for this batch, the application flags the sample 
sequence on the Finish page of the Acquisition mode. See the previous procedure, To 
select channels for the batch.

3. If you see this error, do the following:

a. Click Previous to return to the Sample Definition view.

The incorrect sample is marked with an error flag.

b. Correct the channel selection. 

Note  The Channel column is available only when you have enabled multiplexing in 
the Configuration mode. See “Multiplexing” on page 92.
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Figure 69. Sample Definition view

 

Table 55. Sample Definition view parameters  (Sheet 1 of 2)

Parameter Definition 

Sample Controls

Add Adds the specified number of empty rows to the sample grid.

Insert Inserts the specified number of empty rows above the selected row.

Import Opens the Sample Import Tool where you can import samples defined in a .csv file or 
an .xml file.

Multiplexing Channels These features are available only when you have enabled multiplexing in the Configuration 
mode. See “Multiplexing” on page 92.

All Channels Uses all configured channels to acquire this batch.

Channel 1-n Uses only the selected channels to acquire this batch.

Previous Returns you to the previous Acquisition mode view.

Cancel Confirms that you want to exit the Acquisition mode. When you cancel out of the 
Acquisition mode, your edits are not saved.

Save Saves this batch as a to-be-run (.tbr) batch.

Next Takes you to the next Acquisition mode view.

Shortcut menu

Add Sample Adds a single empty row to the sample grid.

Insert Sample Inserts a single empty row to the sample grid above the selected row.

Insert Copy Sample Copies the currently selected row and inserts a copy above the row.

Reinject Selected 
Samples

Creates a copy of the selected sample and appends INJ001 to the file name. Additional 
reinjections of the same sample are numbered INJ002, INJ003, and so forth.

Remove Selected 
Samples

Removes selected samples from the sample grid.
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Copy Down Copies the value in the selected row to all rows below it. For detailed instructions about 
using the Copy Down command, see Appendix B, “Using Copy Down and Fill Down.” 

Fill Down Enters sequential values in the column starting with the value in the selected row and 
ending with the last row in the column. For detailed instructions about using the Fill 
Down command, see Appendix B, “Using Copy Down and Fill Down.” 

Modify Columns Opens the Modify Columns dialog box. See “Column Display” on page 350.

Enable/Disable Sample 
Weight Calculation

Displays or hides the Sample Volume, Dilution Factor, Sample Weight, Calculation Type, 
and Final Units columns.

Copy Copies the data in the selected rows or columns to the Clipboard. Use this command to 
copy sample information to another application, such as an Excel spreadsheet. You cannot 
paste this data back into the Acquisition mode sample list.

Copy With Headers Copies the data in the selected rows or columns and the associated column headers to the 
Clipboard. Use this command to copy sample information to another application, such as 
a Microsoft Excel spreadsheet. You cannot paste this data back into the Acquisition mode 
sample list. 

For example

Paste Pastes a single column of copied data from another application, such as an Excel 
spreadsheet, into the selected column.

Undo Last Paste Removes the last pasted item in the Acquisition mode sample list. 

Export to CSV File Opens the Save As dialog box where you can save the current sample list to a .csv file.

Status Color Codes  Sample is not acquired. 

 Sample is acquired but not processed.

 Sample is acquired and processed. 

 Sample is currently acquiring.

Table 55. Sample Definition view parameters  (Sheet 2 of 2)

Parameter Definition 

Copy With Headers 
from TraceFinder

Paste into Excel spreadsheet
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Selecting and Reviewing Reports 

On the Report Selection view, you can specify the types of reports you want to create. See 
“Report Selection view” on page 267. For a complete list of report types and examples of 
output files, see Appendix A, “Reports.”  In addition to the report type, you can specify a 
report description for each of your reports. 

For each standard report you generate, you can create a hardcopy printout, a PDF file, or an 
XML file.

For each custom report you generate, you can create a hardcopy printout or an XLSM file. 

For each target screening report you generate, you can create a hardcopy printout or a PDF 
file. 

When you finish specifying your report options, click Next to go to the Finish view and 
submit your batch. See “Submitting the Batch” on page 269.

The application writes the resulting output files for your reports to the following folder:

…\TraceFinder\2.1\EFS\Projects\projectname\subprojectname\batchname\Reports

Follow these procedures:

• To edit a report description

• To preview a standard report

• To specify a standard report in print format or as a PDF, XML, or XLSM file

• To export reports to a specific folder

 To edit a report description

Select the Report Description column and edit the default description.

The default report description is the same as the report name. 

 To preview a standard report

1. Click the magnifying icon, , to view an example of the report type as a PDF file.

The right pane of the view displays an example PDF report with typical PDF viewer 
buttons.

2. To minimize the PDF viewer, click the minimize icon, .

Note  Only Standard report types have preview documents. 
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 To specify a standard report in print format or as a PDF, XML, or XLSM file

1. For each type of report you want to create, select the check box in the Print, Create PDF, 
Create XML, or Create XLSM columns.

2. To duplicate the output type for all reports, right-click the cell and choose Copy Down 
from the shortcut menu.

All check boxes in the column below the selected cell duplicate the selected or cleared 
state in the selected cell. This action applies only to report types that make this output 
format available.

 To specify a custom report in hardcopy or XLSM format

1. For each custom report that you want to create, select the check box in the Print or Create 
XLSM columns.

2. To duplicate the output type for all reports, right-click the cell and choose Copy Down 
from the shortcut menu.

All check boxes in the column below the selected cell duplicate the selected or cleared 
state in the selected cell. This action applies only to report types that make this output 
format available.

 To specify a target screening report in hardcopy format or as a PDF file

1. For each target screening report that you want to create, select the check box in the Print 
or Create PDF columns.

2. To duplicate the output type for all reports, right-click the cell and choose Copy Down 
from the shortcut menu.

All check boxes in the column below the selected cell duplicate the selected or cleared 
state in the selected cell. This action applies only to report types that make this output 
format available.

 To export reports to a specific folder

1. Select the Export Results check box at the bottom of the view.

The Browse For Folder dialog box opens.
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2. Locate and select the folder where you want to save the reports.

3. To create a new reports folder within the selected folder, click Make New Folder and type 
the new folder name. 

4. Click OK.

The application writes all reports to the specified folder in addition to the batch Reports 
folder. 

Figure 70. Report Selection view

Table 56. Report Selection parameters  (Sheet 1 of 2)

Parameter Description

Displays an example PDF for the report type. This example provides a model of the report 
type only; it does not reflect your specific data. This is available for standard reports only.

Report Name The name of a report. 

Report Title User-editable description to be used on a report. 

Report Type The type of report: Standard, Custom, or Target Screening. 

Print Reports to be sent to the printer. 

Create PDF Reports to be saved as PDF files. 
Available only for standard and target screening reports.

Create XML Reports to be exported in XML format. 
Available only for standard reports.

Create XLSM Reports to be exported in Excel Macro-Enabled Workbook (.xlsm) format.
Available only for custom reports.
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Batch Level Rather than creating separate reports for each sample, the application uses a composite of 
the data from all the samples to create a single report for the entire batch. Batch-level reports 
are prepended with a B to differentiate them.
You cannot select this option from the Report Selection page. You must select the Batch 
Level option for the report in the report configuration. See “Specifying the Reports 
Configuration” on page 68. 

Shortcut menu:
Copy Down

Copies the selected or cleared state to all subsequent reports in the column. 

Table 56. Report Selection parameters  (Sheet 2 of 2)

Parameter Description
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Submitting the Batch

In the Finish view of the Acquisition mode, you can specify a startup method, a shutdown 
method, or a calibration batch. You can save the batch to be acquired later, or you can acquire 
and process data and optionally create reports. See “Finish view” on page 275.

Follow these procedures:

• To specify startup or shutdown methods

• To automatically update the timed SRM information

• To specify a calibration batch

• To specify device states

• To save a batch for later acquisition

• To start an acquisition

• To view the output files

 To specify startup or shutdown methods

1. Select a method from the System Startup Method list.

The TraceFinder application runs this method before running the batch. No autosampler 
injection takes place. This feature is not available for all instruments.

2. Select a method from the System Shutdown Method list.

The TraceFinder application runs this method after running the batch. This feature is not 
available for all instruments.

 To automatically update the timed SRM information 

Select the Auto TSRM Update check box.

When you submit the batch, the application updates the TSQ method with mass 
transitions, collision energy, and other appropriate data for TSRM functionality.

Note  If you are working with a batch template, the only available function is Save.
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 To specify a calibration batch

1. In the Calibration area, select a calibration (.calx) file from the list.

2. To add calibration data from the current batch to the selected calibration file, select the 
Extend Calibration option. 

 To specify device states

In the System Status area, select the name of the device, right-click, and then choose a 
device state from the shortcut menu.

 

Note  You must acquire at least one batch with the current method to create a .calx 
calibration file.

Table 57. Instrument states (Sheet 1 of 2)

Instrument state Description

Turn Device On Keeps the system in the On state when the current run finishes, 
so you can begin another run without waiting. All power and 
flows are maintained at operational levels. 
Default: On

Turn Device Standby Keeps the system in the Standby state when the current run 
finishes, so you can begin another run with only a short delay 
between runs. 

Some devices do not have a Standby feature. For devices with 
this feature, the device enters a power-saving or 
consumable-saving mode, and you can switch the device back 
on in approximately 15 minutes. Depending on the 
instrument, this state turns liquid flows off but maintains 
heaters and other subsystems in an On state so that there is no 
warm-up time required when you change from Standby to On. 
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 To save a batch for later acquisition

From the Finish view, click Save.

The TraceFinder application saves your batch as a to-be-run (.tbr) file, closes the 
Acquisition mode, and returns you to the application dashboard.

 To start an acquisition

1. Click Submit.

The Submit Options dialog box opens. For detailed descriptions of the parameters, see 
“Submit Options dialog box” on page 273.

2. (Optional) Select the Create Reports check box.

3. Select the Use check box for the device that you want to use for this acquisition.

4. (Optional) Select the Start Device check box to indicate the device that will initiate 
communication with the other instruments. 

This is usually the autosampler.

5. (Optional) Select the Start When Ready check box, which starts all instruments together 
when they are all ready. 

When this is cleared, individual instruments can start at different times and then have to 
wait for the last instrument to be ready.

Turn Device Off Keeps the system in the Off state when the current run 
finishes. The Off state indicates that all power to the 
instrument, which the TraceFinder application can control, is 
turned off. This includes power to all heaters and 
subassemblies, but in some cases not all subassemblies. 

Some devices do not have an Off feature. For devices that do 
have this feature, the device enters a power-saving or 
consumable-saving mode, and you can switch the device back 
on. When several runs are queued, the application uses the 
system power scheme of the last submitted run. 

Instrument status indicators

Green indicates that the device is turned on or is running.

Yellow indicates that the device is in standby mode or is 
waiting for contact closure.

Red indicates that the device is turned off or that there is an 
error with the device.

Note  By default, the application acquires and processes data when you submit the 
batch.

Table 57. Instrument states (Sheet 2 of 2)

Instrument state Description
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6. (Optional with multiplexing enabled) Select the Priority Sequence check box. 

The application acquires the priority batch on the next available channel or the assigned 
channel.

7. (Optional without multiplexing enabled) Select the Priority Sequence check box and 
then select one of the following priority options to place the batch in the queue:

• Next Available Batch places the batch immediately after the currently acquiring 
batch. 

• Next Available Sample places the batch immediately after the currently acquiring 
sample.

8. Do one of the following:

To start the selected processes, click OK.

The selected processes begin, and the TraceFinder application returns you to the 
dashboard and shows the real-time display at the bottom of the dashboard. The real-time 
display is visible from the dashboard and all modes. You can begin another batch in the 
Acquisition mode while you watch the real-time display of the currently acquiring batch. 

–or–

Click Cancel to exit the Acquisition mode without performing any tasks.

Note  When you select Full Sequence Submission in the Configuration mode, these 
options are unavailable because the current batch and the current sample are, in effect, 
the same thing. 
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Figure 71. Submit Options dialog box

Parameter Description 

User Name Name of the current user.

Samples Range of samples to be submitted for acquisition, processing, 
or reporting.

Acquire Data (Default) Submits the current batch to acquisition.

Process Data (Default) Processes the data for the current batch.

Create Reports Creates reports for the current batch.
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Priority Sequence With multiplexing enabled, places the batch immediately after 
the currently acquiring batch. 

Without multiplexing enabled, specifies one of the following 
priority options to place the batch in the queue:

Next Available Batch: Places the batch immediately after the 
currently acquiring batch. 

Next Available Sample: Places the batch immediately after 
the currently acquiring sample.

Note  When you select Full Sequence Submission in the 
Configuration mode, these options are unavailable because 
the current batch and the current sample are, in effect, the 
same thing. 

Acquisition pane

Device Name Lists all configured instruments. 

If the instrument you want to use is not configured, close the 
TraceFinder application, configure the instrument, and then 
reopen the TraceFinder application. You cannot configure an 
instrument while the TraceFinder application is running.

Use Specifies the instruments used for this acquisition.

Start Device Specifies the instrument that initiates the communication 
with the other instruments. This is usually the autosampler.

Start When Ready Starts the specified device when all the instruments are ready 
to acquire data. When this is cleared, individual instruments 
can start at different times and then must wait for the last 
instrument to be ready.

Post-run System 
State

Specifies the system state after it acquires the last batch.
On (default), Standby, or Off.

Hide/Show Details Collapses or expands the acquisition details of the Submit 
Options dialog box.

OK Begins the selected processes.

Cancel Closes the Submit Options dialog box without submitting any 
tasks.

Parameter Description 
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 To view the output files

• The TraceFinder application writes saved batches to the subproject folder with the file 
extension .tbr (to be run):

…\TraceFinder\2.1\EFS\Projects\projectname\subprojectname

• For each acquired sample, the application writes an RSX file to the batch Data folder:

…\projectname\subprojectname\batchname\Data

• The application saves method information to the batch Methods folder:

…\projectname\subprojectname\batchname\Methods\methodname

• The application writes the reports to the batch Reports folder:

…\projectname\subprojectname\batchname\Reports

Figure 72. Finish view
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Table 58. Finish view parameters 

Parameter Description 

System Status The System Status pane displays the following: 
• Devices used for the acquisition
• Project, subproject, and name of the batch
• Number of samples in the batch
• Number of standard and custom reports to be printed and saved as PDF, XML, or 

XLSM files
• Local method and instrument method used for the batch
• Number of compounds in the method

System Startup 
Method

The instrument method that runs before the batch. No autosampler injection takes place. 
This feature is not available for all instruments.

System Shutdown 
Method

The instrument method that runs after the batch. No autosampler injection takes place. 
This feature is not available for all instruments.

Auto TSRM Update Updates the TSQ method with mass transitions, collision energy, and other appropriate data 
for TSRM functionality.

Calibration • Use calibration: Uses the selected calibration file to process the current data.
• Extend calibration: Adds calibration data from the current batch to the selected 

calibration file.

Save Saves the current batch as a to-be-run (.tbr) file.

Submit Opens the Submit Options dialog box where you can optionally choose to generate reports.
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Using Quick Acquisition
The quick acquisition feature lets you quickly submit a single sample from any view of the 
Acquisition mode.

 To run a quick acquisition

1. Choose Go > Quick Acquire Sample from the main menu.

The Quick Acquisition dialog box opens.

2. Select an instrument method.

3. Type a name for the raw data file that you acquire.

4. Click the browse button and locate a folder where you want to write the acquired raw 
data file.

5. Select either the manual injection or the autosampler option:

To perform manual injection, do the following:

a. Select the Manual Injection option.

b. Click OK.

The application submits the sample to the Acquisition queue. See “Acquisition Page” 
on page 280.

Note  The quick acquisition feature is available only when you enable it in the 
Configuration mode. See “Enabling Optional Features” on page 88.



5 Using the Acquisition Mode
Using Quick Acquisition

278 TraceFinder User Guide Thermo Scientific

To perform autosampler injection, do the following:

a. Select the Use Autosampler option.

b. In the Vial Position box, type a vial position.

c. In the Injection Volume box, type an injection volume.

The minimum injection volume allowed is 0.1 μL; the maximum injection volume 
allowed is 5000 μL.

d. Click OK.

The Quick Acquisition dialog box opens.

e. Select the Use check box for the device that you want to use for this acquisition.

f. (Optional) Select the Start Device check box to indicate the device that will initiate 
communication with the other instruments. 

This is usually the autosampler.

g. (Optional) Select the Start When Ready check box, which starts all instruments 
together when they are all ready. 

When this is cleared, individual instruments can start at different times and then 
must wait for the last instrument to be ready.

h. (Optional) Select the Priority check box to place the sample immediately after any 
currently acquiring sample.

i. (Optional) Select a value for the Post-run System State: Unknown, On (default), 
Off, or Standby.

The application sets the system to this state after it acquires the last sample.

j. Click OK.

The application submits the sample to the Acquisition queue. See “Acquisition Page” 
on page 280.
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Real-Time Display
You can access the real-time display from the dashboard and from any mode in the 
TraceFinder application.

 To access the real-time display from the dashboard

Click Real Time Status.

The real-time status displays at the bottom of the dashboard.

 To access the real-time display from all modes

Click Real Time Status.

The real-time status displays at the bottom of the current view.

Figure 73. Real Time Status display

The real-time status display has four pages of information and a real-time trace pane:

• Acquisition Page

• Instrument Page

• Devices Page

• Queues Page

• Real-Time Trace Display
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Acquisition Page

Use the Acquisition page to monitor the progress as the application acquires the samples. 

 To pause or stop the batches in the queue

Use the Start, , Stop, , or Pause, , icons to control batches in the Acquisition 
queue.
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Instrument Page

Use the Instrument page to monitor the currently acquiring sample. 
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Devices Page

Use the Devices page to monitor the status of the instrument. The feedback you see on the 
Devices page depends on the instrument you are using. The following examples show an 
Accela autosampler and an Aria™ multiplexing device.

Accela Autosampler Feedback

Aria Multiplexing Feedback
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Follow these procedures:

• To pause the autosampler

• To control the channels

• To view the pressure trace

• To control the channels

 To pause the autosampler

1. Click Hold Autosampler.

The autosampler finishes the current autosampler step and then pauses. The LC pumps 
and autosampler continue.

2. To restart the autosampler, click Hold Autosampler again.

 To control the channels

Right-click the channel name and choose a command from the shortcut menu.

Table 59. Autosampler shortcut menu commands

Command Description 

On Turns on a stopped pump and continues acquiring the sample 
list assigned to that channel.

Off After the current sample completes, the application stops 
acquiring and the pump shuts down.

Standby After the current sample completes, the application stops 
acquiring. The pump continues to run.

Disable / Enable Disable: Prevents the channel from receiving samples. When 
you choose Disable during a run, the application finishes the 
current sample on the channel and then stops. 

Enable: Allows the channel to receive samples.

When you disable a channel that is set to On, the channel is 
highlighted in green and the status is READY. You can turn 
the channel to Off or Standby. 
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 To view the pressure trace

1. Click the Pres tab.

The Pressure page displays a pump pressure graph for each sample in the batch. A 
fluctuation or change in the pump pressure could indicate a change in the 
chromatography conditions.

2. To view the pressure for a specific pump, select the Pres 1 or Pres 2 option.

By default, the pressure for all pumps are displayed.

3. To view the pressure for a specific channel, select the corresponding channel number.

By default, the pressure for all channels is displayed.
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 To access the Aria multiplexing controls

Click Direct Control.

The Aria MX Direct Control dialog box opens.

For detailed descriptions of the features in this dialog box, refer to the Transcend Systems 
with Xcalibur Software User Guide.
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Queues Page
Use the Queues page to monitor and control the Acquisition, Processing, and Reporting 
queues:

• Use the Queue-Level Commands to pause or remove batches in any of the queues. 

• Use the Batch-Level Commands to pause or remove entire batches or samples within 
batches from any of the queues.

Queue-Level Commands

Use the queue-level commands to pause or remove batches in any of the queues on the 
Queues page. See “Queue-level shortcut menu” on page 287.

Follow these procedures:

• To pause all batches in a queue

• To remove a single batch from a queue

• To remove all batches in a queue

• To remove all pending batches

 To pause all batches in a queue

1. Select a queue (Acquisition, Processing, or Reporting).

2. Right-click and choose Pause Queue from the shortcut menu.

After the current sample completes, the application pauses all batches and samples in the 
specified queue. Only the selected queue is affected.

3. To restart a paused queue, select the queue, right-click, and choose Resume Queue from 
the shortcut menu.

Note  When multiplexing is enabled, you can have as many as four samples acquiring 
at once. Pausing the Acquisition queue does not affect any acquiring samples.
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 To remove a single batch from a queue

1. Select a queue (Acquisition, Processing, or Reporting).

2. Right-click and choose Stop Active Batch from the shortcut menu.

The application confirms that you want to remove the active batch from the selected 
queue. After the current sample completes, the application removes the batch and all 
pending samples from the queue. Only the selected queue is affected.

 To remove all batches in a queue

1. Select a queue (Acquisition, Processing, or Reporting).

2. Right-click and choose Stop All Batches from the shortcut menu.

The application removes all batches with pending samples from the selected queue. The 
current sample continues to acquire. Only the selected queue is affected.

 To remove all pending batches

1. Select a queue (Acquisition, Processing, or Reporting).

2. Right-click and choose Remove Pending Batches from the shortcut menu.

The application removes all batches that contain only pending samples. Only the selected 
queue is affected.

Figure 74. Queue-level shortcut menu

 

Note  This command is available only when there are active batches in the queue. 
Paused batches and batches that contain only pending samples are not “active.”

Note  A pending batch is a batch in which all samples are pending. If any sample in 
the batch is active, the batch is not affected by this command.

Table 60. Queue-level shortcut menu commands (Sheet 1 of 2)

Command Description 

Pause Queue After the current sample completes, the application pauses the 
specified queue. Only the selected queue is affected.

Stop Active Batch Removes all pending samples from the specified queue. The active 
sample is not affected.
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Batch-Level Commands

Use the batch-level commands to pause or remove entire batches or samples within batches 
from any of the queues on the Queues page. See “Batch-level shortcut menu.” 

Follow these procedures:

• To stop a batch

• To remove a pending batch

• To remove pending samples from a batch

• To remove a single pending sample from a batch

 To stop a batch

1. Select an active batch in any of the queues (Acquisition, Processing, or Reporting).

2. Right-click and choose Stop Batch from the shortcut menu.

The application confirms that you want to remove the selected batch from the queue. 
After the current sample completes, the application removes the batch and all pending 
samples from the queue.

 To remove a pending batch

1. Select a pending batch in any of the queues (Acquisition, Processing, or Reporting).

2. Right-click and choose Remove Pending Batch from the shortcut menu.

The application confirms that you want to remove the selected batch from the queue and 
then removes the batch from the queue.

Stop All Batches Removes all pending samples and batches from the specified 
queue. The active sample is not affected.

Remove Pending 
Batches

Removes all pending batches from the specified queue. The active 
batch is not affected.

Table 60. Queue-level shortcut menu commands (Sheet 2 of 2)

Command Description 

Note  The batch must have at least one active sample and one pending sample.

Note  A pending batch is a batch in which all samples are pending. If any sample in 
the batch is active, this command is not available.
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 To remove pending samples from a batch

1. Select a batch in any of the queues (Acquisition, Processing, or Reporting).

The batch must have at least one pending sample. 

2. Right-click and choose Remove Pending Samples from the shortcut menu.

The application confirms that you want to remove all pending samples from the batch 
and then removes the samples. If the batch includes only pending samples, the 
application removes the batch from the queue.

 To remove a single pending sample from a batch

1. Select a pending sample.

2. Right-click and choose Remove Sample from the shortcut menu.

The application confirms that you want to remove the selected sample from the batch and 
then removes the sample.

Figure 75. Batch-level shortcut menu

Table 61. Batch-level shortcut menu commands

Command Description 

Stop Batch After the current sample completes, the application removes all 
samples in the selected batch.

Remove Pending Batch Removes all samples from the selected pending batch.

Remove Pending 
Samples

Removes all pending samples from the selected batch.



Real-Time Trace Display

As each sample acquires, the real-time chromatogram pane shows the retention time and 
intensity of the TIC trace.

By default, the real-time display shows only the TIC trace as each sample acquires. To observe 
specific traces, such as the internal standard, use the RTV Display Traces function to display 
multiple traces.

When you create your method, you can specify additional traces to display in the real-time 
viewer and in which order the traces are displayed. The application always displays the TIC 
trace in the top pane. See “Real Time Viewer” on page 179.

 To display multiple traces

Right-click the chromatogram pane and choose the number of traces you want to display.

The chromatogram pane displays real-time chromatograms for the selected number of 
traces. 

The TIC is always displayed at the top. When there are more traces than can fit in the 
pane, you can scroll through the traces.

For each trace, the application displays the mass or precursor mass.
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Figure 76. Real-time display with multiple traces
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Sample Types 
The TraceFinder application uses the following sample types in all sample definitions and 
reports. To view example standard reports specific to a sample type, see Appendix A, 
“Reports.” 

Table 62. Sample type definitions

Sample type Definition

Matrix Blank Contains no target compounds but might contain an ISTD when you 
use the internal standard quantitative analysis technique. By analyzing a 
blank sample, you can confirm that there are no residual compounds in 
the solvent system that can cause erroneous results.

Cal Std (Calibration standard) Contains known amounts of all target 
compounds. The purpose of a standard is to measure the response of the 
instrument to the target compounds so that the processing software can 
generate a calibration curve for each compound.

Chk Std (Check standard) Contains a known amount of one or more specific 
target compounds. The application places check standard samples in the 
sequence so that it can test quantitative analysis results for quality 
assurance purposes. After the application analyzes the Chk Std sample, it 
compares the measured quantity with the expected value and an 
acceptability range. The quantitative analysis of a Chk Std sample is 
classified as passed if the difference between the observed and expected 
quantities is within the user-defined tolerance. A Chk Std sample is 
classified as failed if the difference between the observed and expected 
quantities is outside the user-defined tolerance.

Solvent Contains only solvent.

Unknown Used for quantitative analysis of samples.

Unknown/TIC Used for quantitative and qualitative analysis of samples.

LCS Lab control sample.

LCSD Lab control sample duplicate.

MDL Method detection limits sample.

Method Val Method validation sample.

MS Matrix spike sample.

MSD Matrix spike duplicate sample.

Tune Verifies the tune of the system according to EPA guidelines.

Tune/Breakdown Verifies the tune of the system according to EPA guidelines, allowing for 
the degradation of compounds.

Breakdown Checks the degradation of compounds.
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6

Using the Analysis Mode 

This chapter includes instructions for using the features of the Analysis mode.

Use the Analysis mode to do the following:

• Submit a single sample for quick acquisition.

• Submit batches for acquisition, processing, or reports.

• Review batches, batch data, reports, and local methods.

Contents

• Using Quick Acquisition

• Working in the Batch View

• Creating a Batch Using the Batch Wizard

• Working in Data Review View

• Working in the Report View

• Working in the Local Method View

• Working in the Batch Template Editor
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 To access the Analysis mode

Click Analysis from the dashboard or the navigation pane.

The Analysis navigation pane opens.



 6 Using the Analysis Mode
Using Quick Acquisition

Thermo Scientific TraceFinder User Guide 295

Using Quick Acquisition
With the quick acquisition feature, you can quickly submit a single sample from any view of 
the Analysis mode.

 To run a quick acquisition

1. Choose Go > Quick Acquire Sample from the main menu.

The Quick Acquisition dialog box opens.

2. Select an instrument method.

3. Type a name for the raw data file that you acquire.

4. Click the browse button and locate a folder where you want to save the acquired raw data 
file.

5. Select either the manual injection or the autosampler option:

To perform manual injection, do the following:

a. Select the Manual Injection option.

b. Click OK.

The application submits the sample to the Acquisition queue. See “Acquisition Page” 
on page 280.

Note  The quick acquisition feature is available only when you enable it in the 
Configuration mode. See “Enabling Optional Features” on page 88.
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To perform autosampler injection, do the following:

a. Select the Use Autosampler option.

b. In the Vial Position box, type a vial position.

c. In the Injection Volume box, type an injection volume.

The minimum injection volume allowed is 0.1 μL; the maximum injection volume 
allowed is 5000 μL.

d. Click OK.

The Quick Acquisition dialog box opens.

e. Select the Use check box for the device that you want to use for this acquisition.

f. (Optional) Select the Start Device check box to indicate the device that will initiate 
communication with the other instruments. 

This is usually the autosampler.

g. (Optional) Select the Start When Ready check box, which starts all instruments 
together when they are all ready. 

When this is cleared, individual instruments can start at different times and then 
must wait for the last instrument to be ready.

h. (Optional) Select the Priority check box to place the sample immediately after any 
currently acquiring sample.

i. (Optional) Select a value for the Post-run System State: Unknown, On (default), 
Off, or Standby.

The application sets the system to this state after it acquires the last sample.

j. Click OK.

The application submits the sample to the Acquisition queue. See “Acquisition Page” 
on page 280.
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Working in the Batch View
In the Batch View, you can manually create and edit a new batch or open and edit a previously 
saved batch. When you submit a batch, you can acquire and process data and optionally create 
reports for the submitted samples.

 To open the Batch View

1. Do one of the following:

From the dashboard, click Analysis.

–or–

Click Analysis in the navigation pane of the current mode.

2. In the Analysis navigation pane, click Batch View.

The Batch View opens for the currently selected batch. 

This section contains information about the following topics:

• Batch View Panes

• Creating a New Batch

• Editing a Batch

• Editing Report Output Formats

• Submitting a Batch
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Batch View Panes

The Batch View is divided into three panes: 

• Sample List

Use the sample list pane to create a batch. See “Creating a New Batch” on page 309.

• Automated Batch Reports

Use the Automated Batch Reports pane to select the type of output formats that you want 
to generate for the reports. See “Editing Report Output Formats” on page 320.

• Compound Active Status

Use the Compound Active Status pane to make specific compounds active or inactive. See 
“Setting Compound Active Status” on page 322.

Use the Batch View toolbar or shortcut menu to create the sample list and submit samples for 
acquisition. See “Batch View Toolbar” on page 304 or “Batch View Shortcut Menu” on 
page 307.

Sample list

Automated Batch Reports pane Compound Active Status pane

Tip  To resize the panes, drag the separators that divide the panes.
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Sample List

The sample list includes the following features:

• Column Display

• Status Indicators

• Sample Weight Calculation

Column Display

The sample list can contain many columns of information. You can scroll to see all the 
columns of information, and you can customize which columns to display and their display 
order.

Follow these procedures:

• To scroll the sample list

• To customize the column display

 To scroll the sample list

Use the horizontal scroll bar at the bottom of the sample list to view all the information. 

When you use the scroll bar at the bottom of the sample list, the Status, Filename, Sample 
Type, and Level columns stay fixed while the other columns scroll right and left. 

 To customize the column display 

1. Right-click the sample list and choose Modify Columns from the shortcut menu.

The Modify Columns dialog box opens. See “Modify Columns dialog box.” 

2. Use the arrow buttons to move all the columns that you want displayed to the Displayed 
Columns pane.

All the columns you select are displayed after the Status, Filename, Sample Type, and 
Level columns.

3. To arrange the order of the columns, do the following:

a. In the Displayed Columns pane, select a column name.

b. Use Up or Down to move the selected column up or down in the list.

The first column in the list represents the leftmost column in the Batch View sample 
list, and the last column in the list represents the rightmost column in the Batch View 
sample list.

Note  You cannot move the Status, Filename, Sample Type, or Level column.
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4. To change the width of a column, do the following:

a. In the Displayed Columns pane, select the column width.

b. Type a new value for the width.

5. Repeat step 4 for all columns whose widths you want to change, and click OK.

The columns in the sample list immediately reflect your changes. The application uses 
these settings for all sample lists in the Batch View.

Figure 77. Modify Columns dialog box

Table 63.  Modify Columns function buttons  (Sheet 1 of 2)

Function Description

Moves all columns to the Displayed Columns pane.

Moves the selected column to the Displayed Columns pane.
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Status Indicators

Status indicators show the current status of each sample during the acquisition and 
processing.

 Sample is not acquired. 

 Sample is acquired but not processed.

 Sample is acquired and processed. 

 Sample is currently acquiring.

Moves the selected column to the Available Columns pane. You cannot 
move the Status, Filename, Sample Type, or Level column.

Moves all columns except Status, Filename, Sample Type, and Level to the 
Available Columns pane.

Moves the selected column name in the Displayed Columns pane one row 
up in the column order. You cannot move the Status, Filename, Sample 
Type, or Level column.

Moves the selected column name in the Displayed Columns pane one row 
down in the column order. You cannot move the Status, Filename, Sample 
Type, or Level column.

Table 63.  Modify Columns function buttons  (Sheet 2 of 2)

Function Description

Status indicators
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Sample Weight Calculation

Use the features for calculating sample weight to calculate the conversion factor for a sample. 
The application uses different methods to calculate the conversion factor for liquid or solid 
calculation types.

Liquid: SampleVolume DilutionFactor

Solid: (SampleVolume × DilutionFactor) SampleWeight

Manual: The application does not calculate the Conversion Factor. Instead, you can enter the 
Conversion Factor value.

Follow these procedures:

• To display the features for calculating sample weight

• To calculate the conversion factor for a liquid sample

• To calculate the conversion factor for a solid sample

• To manually specify the conversion factor for a sample

 To display the features for calculating sample weight

If the Conversion Factor, Sample Weight, Sample Volume, Calculation Type, Dilution 
Factor, and Final Units columns are not visible, right-click and choose Enable Sample 
Weight Calculation from the shortcut menu.
 

 To calculate the conversion factor for a liquid sample

1. From the Calculation Type list, select Liquid.

For a liquid sample, the Sample Weight value is not editable.

2. In the Sample Volume column, type the volume in ng/mL for your sample.

3. In the Dilution Factor column, type the value for the dilution. 

For example, if you have 1000 ng/mL of a substance that is too concentrated for the mass 
spectrometer, you can dilute it by 1000. Then your injection volume is 1, your conversion 
factor is 1000, and your sample amount is 1000. 

4. In the Final Units column, type the units that you want to use for the calculated amount 
in the Data Review view, on the Active View page in the Report View, or in reports.

The application uses the following formula to calculate the Conversion Factor:

SampleVolume DilutionFactor
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 To calculate the conversion factor for a solid sample

1. From the Calculation Type list, select Solid.

2. In the Sample Weight column, type the weight in ng for your sample.

3. In the Sample Volume column, type the volume in ng/ml for your sample.

4. In the Dilution Factor column, type the value for the dilution.

For example, if you have 1000 ng/ml of a substance that is too concentrated for the mass 
spectrometer, you can dilute it by 1000. Then your injection volume is 1, your conversion 
factor is 1000, and your sample amount is 1000. 

5. In the Final Units column, type the units that you want to use for the calculated amount 
in the Data Review view, on the Active View page in the Report View, or in reports.

The application uses the following formula to calculate the Conversion Factor:

(SampleVolume × DilutionFactor) SampleWeight

 To manually specify the conversion factor for a sample

1. From the Calculation Type list, select Manual.

For a manually calculated sample, the only available columns are the Conversion Factor 
and the Final Units. 

2. In the Conversion Factor column, type the conversion factor to use for your sample.

3. In the Final Units column, type the units that you want to use for the calculated amount 
in the Data Review view, on the Active View page in the Report View, or in reports.

The application uses the specified conversion factor when it calculates the amount for the 
sample.
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Batch View Toolbar

The Batch View includes this toolbar for creating and submitting a batch.

Batch View Sample List 

The sample list displays all the quantitative data for the samples of a batch. 

Status indicators for each sample indicate if the sample is currently acquiring, not acquired, 
acquired, or processed. 

Icon Description

Adds the specified number of new, empty samples to the end of the 
sample list. See the instructions “To add samples to the list” on 
page 310.

Inserts a new, empty sample or samples above the selected sample. See 
the instructions “To insert samples into the list” on page 311.

Removes the selected samples from the sample list. See the 
instructions “To remove samples from the list” on page 312.

Adds imported samples from a .csv, .xml, or .sld file to the sample list. 
See the instructions “To import samples into the list” on page 311.

Submits only the selected samples for acquisition, processing, or 
report generation. See the instructions “To submit selected samples” 
on page 326.

Submits the batch for acquisition, processing, or report generation. 
See the instructions “To submit all samples in the batch” on page 325.

Closes/Opens the Analysis navigation pane.

Opens the Quick Acquisition dialog box where you can quickly 
submit a single sample. See “Using Quick Acquisition” on page 295.
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The sample list includes the following columns of information:

Figure 78. Batch View sample list

Cells in the sample list that are not editable, such as Barcode Actual, are shaded and empty. 

Table 64. Batch View sample list columns  (Sheet 1 of 2)

Column Description

Status  Sample is not acquired. 

 Sample is acquired but not processed.

 Sample is acquired and processed. 

 Sample is currently acquiring.

Filename Name of the raw data file that contains the sample data.

Sample Type Defines how the TraceFinder application processes the sample data. Each sample is classified 
as one of the following sample types:

Matrix Blank, Solvent, Cal Std, Chk Std, Unknown, Unknown/TIC, LCS, LCSD, MDL, 
MS, MSD, Method Val, Tune, Tune/Breakdown, or Breakdown 

Default: Unknown

Level The level defined for a calibration sample or quality control sample.

Sample ID A user-defined, alphanumeric string that identifies a sample.
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Sample Name A user-defined name that identifies a sample.

Vial Position The tray vial number used for an autosampler acquisition.

Injection Volume The injection volume (in microliters) of the injected sample. 

When you are using an autosampler, you can set the default injection volume in the 
Autosampler dialog box in the Instrument View. The minimum and maximum injection 
volumes that you can use depend on the Autosampler you configure. The usable range 
depends on the injection mode and might be smaller than the displayed range.

The Injection Volume value set in the master method overwrites the value in the instrument 
method.

Range: 0.1 through 5000 μL

Calculation Type Liquid: The application calculates the Conversion Factor as 

SampleVolume DilutionFactor

Solid: The application calculates the Conversion Factor as 

(SampleVolume × DilutionFactor) SampleWeight

Manual: Sample Volume, Dilution Factor, Sample Weight, and Final Units columns are not 
available, and the Conversion Factor value is editable.

Conversion Factor Editable only when Calculation Type is Manual. Default: 1

Sample Volume Default: 1

Dilution Factor Default: 1

Sample Weight Available only when Calculation Type is Solid. Default: 1

Final Units Specifies the calculated amount in the Data Review view, on the Active View page in the 
Report View, or in reports.
Default: 1

Instrument Method Specifies the instrument to use for the acquisition.

Channel Specifies the channel on which the sample was run. If the sample is not acquired, the value is 
Pending. The Channel column is available only when you have enabled multiplexing in the 
Configuration mode. See “Multiplexing” on page 92.

Barcode Expected

Barcode Actual

Comment A user-defined comment for the sample.

Table 64. Batch View sample list columns  (Sheet 2 of 2)

Column Description
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Batch View Shortcut Menu

The Batch View includes a shortcut menu for creating a batch.

Table 65. Batch View shortcut menu commands  (Sheet 1 of 2)

Command Description

Add Sample Adds a single empty row to the sample grid.

Insert Sample Inserts a single empty row to the sample grid above the selected row.

Insert Copy Sample Copies the currently selected row and inserts a copy above the row.

Reinject Selected 
Samples

Creates a copy of the selected sample and appends INJ001 to the file name. Additional 
reinjections of the same sample are numbered INJ002, INJ003, and so forth.

Remove Selected 
Samples

Removes selected samples from the sample grid.

Import Samples Opens the Sample Import Tool. See “To import samples into the list” on page 311.

Browse In Raw File Opens a dialog box where you can select a raw data file to use for the selected sample row.

Map Raw Files to 
Samples

Opens a dialog box where you can select multiple raw data files to use for the selected 
sample rows.

Copy Down Copies the value in the selected row to all rows below it. This command is available only 
when you have selected a value that can be copied down.

Fill Down Enters sequential values in the column starting with the value in the selected row and 
ending with the last row in the column. This command is available only when you have 
selected a value that can be filled down.

Modify Columns Opens the Modify Columns dialog box. See “Column Display” on page 350.

Copy Copies the data in the selected rows or columns to the Clipboard. Use this command to 
copy sample information to another application, such as an Excel spreadsheet. You cannot 
paste this data back into the Batch View sample list.

Copy With Headers Copies the data in the selected rows or columns and the associated column headers to the 
Clipboard. Use this command to copy sample information to another application, such as 
an Excel spreadsheet. You cannot paste this data back into the sample list. 

For example

Copy With Headers 
from TraceFinder

Paste into Excel spreadsheet
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Paste Pastes a single column of copied data from another application, such as an Excel 
spreadsheet, into the selected column.

Undo Last Paste Removes the last pasted item in the Batch View. 

Export to CSV File Opens the Save As dialog box where you can save the current sample list to a .csv file.

Table 65. Batch View shortcut menu commands  (Sheet 2 of 2)

Command Description
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Creating a New Batch

In the Batch View, you can create a new batch.

Follow these procedures:

• To create a new batch

• To add samples to the list

• To insert samples into the list

• To import samples into the list

• To remove samples from the list

• To copy a sample

• To reinject a sample

• To edit sample values

• To browse in raw data files

• To customize the column display

 To create a new batch

1. Click New Batch in the Batch View task pane or choose File > New > Batch.

The Create a New Batch dialog box opens.
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2. Select a master method from the Method list. 

3. Select a drive from the Storage Location list. 

The project list displays all projects, subprojects, and batches on the selected drive.

You cannot use network drives to acquire data. For more information about network 
drives, see “Working with Drives” on page 50.

4. Select a project and a subproject and type a name for your new batch.

5. Click Save.

A new, unnamed batch opens with one Unknown sample. 

 To add samples to the list

1. To add a single sample row, right-click the sample list and choose Add Sample from the 
shortcut menu.

2. To add multiple sample rows, select the number of rows and then click the Add Sample 
icon, .

The application adds the specified number of new, empty samples to the end of the 
sample list.

Tip  The application does not display drives that do not have a project and subproject.

Tip  To enable the Save button, you must select a subproject and enter a unique batch 
name. If the Save button is not enabled, either you have entered a name that is already 
used or you have not selected a subproject.
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 To insert samples into the list

Select the sample above which you will insert new, Unknown samples, and then do one of 
the following:

• To insert a single sample row, right-click and choose Insert Sample from the shortcut 
menu. 

• To insert multiple sample rows, select the number of rows and then click the Insert 
Sample icon .

The application inserts the Unknown samples above the selected sample.

 To import samples into the list

1. Choose Batch > Import Samples from the main menu, or click the Import Samples

icon, .

The Sample Import Tool dialog box opens.

From this dialog box, you can import samples from a .csv, .xml, or .sld file.

2. Click Browse and select a .csv, .xml, or .sld file that contains the samples to import.

3. From the Imported Samples Will Be list, select Appended to the End of the List or 
Inserted at the Selected Row.

Inserted 
samples
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4. Click Import.

The Sample Import Tool dialog box closes, and the application adds the specified samples 
to the sample list. 

When you import samples from an Xcalibur sequence file (.sld), the TraceFinder 
application makes the following column name substitutions:

When you import samples from an Xcalibur sequence file (.sld), the TraceFinder 
application makes the following sample type substitutions:

5. (Optional) When using multiplexing, select a channel for each imported sample.

Imported samples default to Auto.

 To remove samples from the list

1. Select the samples that you want to remove.

2. Right-click and choose Remove Selected Samples from the shortcut menu. 

 To copy a sample

1. Select the sample that you want to copy.

2. Right-click and choose Insert Copy Sample from the shortcut menu.

The TraceFinder application inserts the copy above the selected sample.

Xcalibur column TraceFinder column

Position Vial Position

Inj Vol Injection Volume

Dil Factor Conversion Factor

Xcalibur sample type TraceFinder sample type

Blank Matrix Blank

QC Chk Std

Std Bracket Cal Std

Note  The Channel column is available only when you have enabled multiplexing in 
the Configuration mode. See “Multiplexing” on page 92.

Tip  Use the CTRL or SHIFT keys to select multiple samples.
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 To reinject a sample

1. In the sample list, select the sample that you want to reinject.

2. Right-click and choose Reinject This Sample from the shortcut menu.

The TraceFinder application creates a copy of the selected sample and appends INJ001 to 
the file name. Additional reinjections of the same sample are numbered INJ002, INJ003, 
and so forth. The TraceFinder application copies all parameter values from the original 
sample.

 To edit sample values

1. For each sample, do one of the following:

Type a new file name over the current filename.

–or–

Double-click the Filename column and locate a raw data file to use for the sample. 

–or–

Right-click and choose Browse in Raw File from the shortcut menu, and then locate a 
raw data file to use for the sample.

By default, the application sets the Sample Type to Unknown.

2. For each sample, click the Sample Type column and select a sample type from the list.

3. For each Cal Std or Chk Std sample, select a level from the Level list.

The sample levels are defined in the master method. If there is nothing to select in the 
Level list, do the following:

a. Return to the Method Development mode.

b. Open the method.

c. Click the Compounds tab.

d. Click the Calibration Levels tab.

Available sample types

Matrix Blank Solvent Unknown/TIC
Cal Std Chk Std Unknown
LCS MDL MS
LCSD Method Val MSD
Tune Tune/Breakdown Breakdown
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e. Add the levels.

f. Save the method.

g. Return to the Analysis mode, and then click Update.

The application updates the local method with the new sample levels.

For detailed instructions, see Chapter 4, “Using the Method Development Mode.” 

4. Type a vial position in the Vial Position column for each sample. 

5. Type a volume in the Injection Volume column for each sample. 

The minimum injection volume value allowed is 0.1 μL; the maximum injection volume 
value allowed is 5000 μL.

6. (Optional) Type or edit the values for the remaining columns.

For instructions to automatically copy or fill values in these columns, see Appendix B, 
“Using Copy Down and Fill Down.” 

 To browse in raw data files

1. Do one of the following:

Double-click the Filename column.

–or–

Right-click and choose Browse in Raw File from the shortcut menu.

The What Raw File Would You Like to Use dialog box opens.

2. Select a raw data file to use for the sample, or use the CTRL key to select multiple files, 
and then click Open.

The application overwrites the selected, unacquired sample in the batch with the first 
“browsed in” file and inserts any additional browsed in files above the selected sample.

For all browsed in raw data files, the application sets the Status to Acquired, , and sets 
the Sample Type to Unknown. 

Note  When you use the horizontal scroll bar at the bottom of the sample list, the 
Status, Filename, Sample Type, and Level columns stay fixed while the other columns 
scroll right and left. 

Note  You cannot overwrite an acquired sample. When you select a sample that is 
acquired, the application inserts all browsed in files above the selected sample.
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 To customize the column display

1. Right-click the Batch View sample list and choose Modify Columns from the shortcut 
menu.

The Modify Columns dialog box opens.

Table 66.  Modify Columns dialog box function buttons

Function Description

Moves all columns to the Displayed Columns pane.

Moves the selected column to the Displayed Columns pane.

Moves the selected column to the Available Columns pane. You cannot 
move the Status, Filename, Sample Type, or Level columns.

Moves all columns except Status, Filename, Sample Type, or Level to 
the Available Columns pane.

Moves the selected column name in the Displayed Columns pane one 
row up in the column order. You cannot move the Status, Filename, 
Sample Type, or Level columns.

Moves the selected column name in the Displayed Columns pane one 
row down in the column order. You cannot move the Status, Filename, 
Sample Type, or Level columns.
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2. Use the arrow buttons to move all the columns that you want displayed to the Displayed 
Columns pane.

All the columns you select are displayed after the Status, Filename, Sample Type, or Level 
columns.

3. To arrange the order of the columns, do the following:

a. In the Displayed Columns pane, select a column name.

b. Use Up or Down to move the selected column up or down in the list.

The first column in the list represents the leftmost column in the Batch View sample 
list, and the last column in the list represents the rightmost column in the Batch View 
sample list.

4. To change the width of a column, do the following:

a. In the Displayed Columns pane, select the column width.

b. Type a new value for the width.

5. When you have completed your changes, click OK.

The columns in the sample list immediately reflect your changes. The application uses 
these settings for all sample lists in the Batch View.

Note  You cannot move the Status, Filename, Sample Type, or Level columns.
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Editing a Batch

In the Batch View, you can open a saved batch and edit the sample list. You can add samples, 
edit samples, or remove samples. If the batch has already been acquired, you can select specific 
samples for reinjection. If the batch has unacquired samples when you complete your edits, 
you can save it as a to-be-run (.tbr) batch. 

Follow these procedures:

• To open a saved batch

• To open a recent batch

• To edit samples in a batch

• To reinject a sample from a previously acquired batch

• To submit all samples in the batch

• To submit selected samples

 To open a saved batch

1. From the Batch View task pane, click Open Batch.

The Open Batch dialog box opens.

2. Select a drive from the Storage Location list. 

The project list displays all projects, subprojects, and batches on the selected drive.

3. Select a project, subproject, and batch.

4. Click Open.

The selected batch opens in the Batch View.
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 To open a recent batch 

Click a batch name in the Recent Files list.

The selected batch opens in the Batch View.

 To edit samples in a batch

Use the commands described in “Working in the Batch View” on page 297.

You can edit samples, add new samples, reinject acquired samples, or delete samples.

 To reinject a sample from a previously acquired batch

1. In the sample list, select the sample that you want to reinject.

2. Right-click and choose Reinject This Sample from the shortcut menu.

The TraceFinder application creates a copy of the selected sample and appends INJ001 to 
the file name. Additional reinjections of the same sample are numbered INJ002, INJ003, 
and so forth.

The TraceFinder application copies all parameter values from the original sample.

A green status icon indicates previously acquired samples (acquired and processed), and 
the sample name is grayed out. A blue status icon indicates samples created for reinjection 
(not acquired).

When you submit all samples in this batch, the application acquires all samples (including 
previously acquired samples).

Tip  To view the drive, project, and subproject for a recent batch, hold your cursor 
over the batch name.
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3. To save this batch with the new samples for reinjection, choose File > Save > Batch from 
the main menu.

The batch is saved as a .tbr batch. You can open this batch from the Ready to Acquire 
page in the Acquisition mode and submit the batch. The application acquires all 
submitted samples—both the reinjection samples and the previously acquired samples. 
The application appends a timestamp to the acquired raw data files to differentiate each 
acquisition.
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Editing Report Output Formats 

In the Automated Batch Reports pane, you can view the reports that are selected for this batch 
and modify which output formats are generated for each report.

 To edit the sample-level output formats

1. Click the Sample Level tab.

The application displays reports and the output formats as they were specified in the 
method.

For detailed instructions for specifying which reports and output formats are generated, 
see “Specifying the Reports Configuration” on page 68.

2. Select or clear any of the check boxes for your reports.

3. To duplicate an output format for all reports for this sample, right-click the cell and 
choose Copy Down from the shortcut menu.

All check boxes in the column below the selected cell duplicate the selected or cleared 
state in the selected cell. You can duplicate the output type only for reports that have this 
output format available.

4. To duplicate the output format for all samples in the batch, right-click the cell and choose 
Apply Selection to All Samples from the shortcut menu.

Tip  In the Batch View, you can change the output formats but you cannot change 
which reports are available.
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 To edit the batch-level output formats

1. Click the Batch Level tab.

The application displays the reports and the output formats as they were specified in the 
method.

For detailed instructions for specifying which reports and output formats are generated 
and which reports are batch-level, see “Specifying the Reports Configuration” on page 68.

2. Select or clear any of the check boxes for your reports.

3. To duplicate the output format for all reports, right-click the cell and choose Copy Down 
from the shortcut menu.

All check boxes in the column below the selected cell duplicate the selected or cleared 
state in the selected cell. You can duplicate the output type only for reports that have this 
output format available.

Tip  In the Batch View, you can change the output formats but you cannot change 
which reports are available.
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Setting Compound Active Status

In the Compound Active Status pane, you can choose specific compounds to be active or 
inactive.

 To set a compound as active or inactive

1. In the sample list, select a sample.

All compounds in the selected sample are listed in the Compound Active Status pane. 
The default active/inactive status is determined by the identification settings in the local 
method. For information about setting the identification parameters, see “Identification” 
on page 133.

• To display compounds alphabetically, right-click and choose Sort by Compound 
Name from the shortcut menu.

• To display compounds from shorter to longer retention time, right-click and choose 
Sort by Retention Time from the shortcut menu.

2. Select or clear the Active check box for the compound.

When you specify a compound as inactive in this pane, it becomes inactive in the 
Compounds pane in the Data Review view. Inactive compounds are grayed out:

For instructions for changing the active/inactive status in the Data Review view, see 
“Inactive and Excluded Compounds” on page 354.
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Compound Active/Inactive Status

You can specify which compounds are active or inactive in the Local Method View, the Batch 
View, or the Data Review view.

Figure 79. Active and inactive compounds in the Local Method View

For details about setting the status on the Identification page, see “Identification” on 
page 133.

Figure 80. Active and inactive compounds in the Batch View

For details about setting the status in the Batch View, see “Setting Compound Active Status” 
on page 322.
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Figure 81. Active and inactive compounds in the Data Review view

For details about setting the status in the Data Review view, see “Inactive and Excluded 
Compounds” on page 354.

Inactive
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Submitting a Batch

In the Batch View, you can submit an entire batch or only selected samples in the batch. 
When you submit a batch for acquisition and processing, you can choose to create reports for 
the submitted samples. See “Submit Options dialog box” on page 327.

Follow these procedures:

• To submit all samples in the batch

• To submit selected samples

For a description of commands on the shortcut menu, see “Batch View shortcut menu 
commands” on page 307.

 To submit all samples in the batch

1. Click the Submit Batch icon, .

The Submit Options dialog box opens. See “Submit Options dialog box” on page 327.

2. Select the tasks that you want to perform: acquire data, process data, or create reports.

3. (Optional) Click Show Details to display additional Acquisition parameters.

4. Select the Use check box for the device that you want to use for this acquisition.

5. (Optional) Select the Start Device check box to indicate the device that will initiate the 
communication with the other instruments. 

This is usually the autosampler.

6. (Optional) Select the Start When Ready check box to have all instruments start together 
when they are all ready. 

When this is cleared, individual instruments can start at different times and then must 
wait for the last instrument to be ready.

7. (Optional with multiplexing enabled) Select the Priority Sequence check box. 

The application acquires the priority batch on the next available channel or the assigned 
channel.

8. (Optional without multiplexing enabled) Select the Priority Sequence check box and 
then select one of the following priority options to place the batch in the queue:

• Next Available Batch places the batch immediately after the currently acquiring 
batch. 

• Next Available Sample places the batch immediately after the currently acquiring 
sample.

9. To start the selected processes, click OK.
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 To submit selected samples

1. Select the samples to submit.

2. Click the Submit Selected Samples icon, .

The Submit Options dialog box opens. See “Submit Options dialog box.” 

3. Select the tasks that you want to perform: acquire data, process data, or create reports.

4. Select the Use check box for the device that you want to use for this acquisition.

5. (Optional) Click Show Details to display additional Acquisition parameters.

6. (Optional) Select the Start Device check box to indicate the device that will initiate 
communication with the other instruments. 

This is usually the autosampler.

7. (Optional) Select the Start When Ready check box to have all instruments start together 
when they are all ready. 

When this is cleared, individual instruments can start at different times and then must 
wait for the last instrument to be ready.

8. (Optional with multiplexing enabled) Select the Priority Sequence check box. 

The application acquires the priority batch on the next available channel or the assigned 
channel.

9. (Optional without multiplexing enabled) Select the Priority Sequence check box and 
then select one of the following priority options to place the batch in the queue:

• Next Available Batch places the batch immediately after the currently acquiring 
batch. 

• Next Available Sample places the batch immediately after the currently acquiring 
sample.

10. To start the selected processes, click OK.



 6 Using the Analysis Mode
Working in the Batch View

Thermo Scientific TraceFinder User Guide 327

Figure 82. Submit Options dialog box

Table 67. Submit Options dialog box parameters  (Sheet 1 of 2)

Parameter Description 

User Name Name of the current user.

Samples Range of samples to be submitted for acquisition, processing, or 
reporting.

Acquire Data (Default) Submits the current batch to acquisition.

Process Data (Default) Processes the data for the current batch.



6 Using the Analysis Mode
Working in the Batch View

328 TraceFinder User Guide Thermo Scientific

Create Reports Creates reports for the current batch.

Priority Sequence With multiplexing enabled, places the batch immediately after the 
currently acquiring batch. 

Without multiplexing enabled, specifies one of the following 
priority options to place the batch in the queue:

• Next Available Batch places the batch immediately after the 
currently acquiring batch. 

• Next Available Sample places the batch immediately after the 
currently acquiring sample.

Acquisition pane

Device Name Lists all configured instruments. 

If the instrument that you want to use is not configured, close the 
TraceFinder application, configure the instrument, and then 
reopen the TraceFinder application. You cannot configure an 
instrument while the TraceFinder application is running.

Use Specifies the instruments used for this acquisition.

Start Device Specifies the instrument that initiates the communication with the 
other instruments. This is usually the autosampler.

Start When Ready Starts the specified device when all the instruments are ready to 
acquire data. When this is cleared, individual instruments can start 
at different times and then must wait for the last instrument to be 
ready.

Post-run System State Specifies the system state after it acquires the last batch.
On (default), Standby, or Off.

Function buttons

Hide/Show Details Collapses or expands the acquisition details of the Submit Options 
dialog box.

OK Begins the selected processes.

Cancel Closes the Submit Options dialog box without submitting any 
tasks.

Table 67. Submit Options dialog box parameters  (Sheet 2 of 2)

Parameter Description 
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Saving a Batch to a New Location

You can move the current batch to a different project and subproject, or you can make a copy 
of the current batch and save the copy to a different project and subproject.

Follow these procedures:

• To save a batch to another project or subproject

• To move a batch to another project or subproject

 To save a batch to another project or subproject

1. Choose File > Save > Save Batch As from the main menu in the Analysis mode.

The Batch Save dialog box opens.

2. Select a storage location.

3. Select a project.

4. Select a subproject.

5. Type a name for the new batch.

If you are saving the batch to a different subproject, you must give it a unique name. You 
cannot overwrite an existing batch in the new subproject.

6. Click Save.

When you save the batch to a different subproject, the reports reflect the original 
project/subproject and the application does not save the calibration history.
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 To move a batch to another project or subproject

1. Choose File > Save > Move Batch from the main menu in the Analysis mode.

The Batch Save dialog box opens.

2. Select a storage location.

3. Select a project.

4. Select a subproject.

5. Type a name for the new batch.

You must give the batch a unique name in the new subproject. You cannot overwrite an 
existing batch.

6. Click Save.

When you move the batch, the reports reflect the original project/subproject and the 
application does not save the calibration history.
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Creating a Batch Using the Batch Wizard 
Using the Batch Wizard, you can define a sequence composed of various sample types to be 
assembled into a batch of samples. Before you can create a batch with the Batch Wizard, you 
must have a master method and a batch template. See “Creating a New Master Method” on 
page 101 and “Working in the Batch Template Editor” on page 415.

Follow these procedures in the Batch Wizard to create and submit a batch:

• Selecting a Batch Template

• Specifying a Batch

• Submitting the Batch

• (Optional) Selecting Calibration Files and Compounds

The Batch Wizard workflow uses the following pages:

 To open the Batch Wizard

Choose File > New > Batch Using Wizard from the main menu in the Analysis mode, 

or click the Batch Wizard icon, .

The Batch Template Selection page of the Batch Wizard opens. For descriptions of the 
parameters on the Batch Template Selection page, see “Batch Template Selection page” on 
page 333.

Note  This batch wizard is available only when you select the Batch Template Wizard 
(EnviroLab/ToxLab/QuanLab forms) style in the Configuration mode. See “Application 
Configuration” on page 67.

Note  Creating a batch using the Batch Wizard requires that you have previously 
created at least one batch template. See “Working in the Batch Template Editor” on 
page 415.

Batch Template Selection

Calibration and Compound 
Selection

Finish

Batch Specification
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Selecting a Batch Template

From the Batch Template Selection page, you can create a list of samples to acquire or process. 
For descriptions of the parameters on the Batch Template Selection page, see “Batch Template 
Selection page.” 

 To create a sample list

1. From the Project list, select a project.

2. From the Subproject list, select a subproject.

The Available Templates area lists all the templates in the specified subproject.

3. Select a starting vial position. 

The default is vial position 1, but you can choose to start your acquisition at any vial 
position.

4. (Optional) To simplify the sample list, select the Quick Mode check box.

Quick Mode limits the columns of information on the Batch Specification page to the 
following:

• Sample Type

• Sample ID

• Injection Volume

• Conversion Factor

5. From the Available Templates list, select a template that defines your layout preference.

The Template Layout area displays sample information in the selected batch template and 
a list of methods that use the same assay type as your template. 

6. Select an available method.

By default, the application selects the method used to create the batch template, but you 
can choose any method in the Available Methods list.

7. To go to the next wizard page, click Next.

From the Batch Specification page of the wizard, you can customize the batch. 
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Figure 83. Batch Template Selection page

Table 68. Batch Template Selection parameters  (Sheet 1 of 2)

Parameter Description

Starting Vial Position The vial position where you want to begin acquiring samples.
Default: 1

Total Batch Rows The number of sample rows in the batch template.

Assay Type The assay type specified in the master method used to create the batch template.

Quick Mode Limits the columns of information on the Batch Specification page to the following:
• Sample Type
• Sample ID
• Injection Volume
• Conversion Factor

Available Templates All batch templates are saved in the following folder:

…\Thermo\TraceFinder\2.1\EFS\Templates\Batches

Template Layout Displays sample information in the selected batch template.

Available Methods Lists all master methods created with the same assay type as the selected batch template.

Help Opens the “Creating a Batch Using the Batch Wizard” topic (this topic) in the application 
Help tool.
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Next Returns you to the Batch Specification page where you can enter a sample ID, a sample 
name, or a comment. You can also add or remove samples from the sample list or edit the 
column values for the samples. See “Specifying a Batch” on page 335.

Cancel Immediately exits the Batch Wizard and does not save the batch. There is no confirming 
message.

Table 68. Batch Template Selection parameters  (Sheet 2 of 2)

Parameter Description
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Specifying a Batch

From the Batch Specification page, you must enter either a sample ID, sample name, or 
comment. You can also add or remove samples from the sample list or edit the column values 
for the samples. The batch template might contain many samples that you do not want to use 
for your batch. If you do not enter a sample ID, sample name, or comment for these samples, 
the application discards them when you save the batch. For descriptions of the parameters on 
the Batch Specification page, see “Batch Specification page” on page 338.

 To enter a required sample ID, sample name, or comment

1. In the Sample ID column, type an identifier.

The identifier can be any text string.

2. In the Sample Name column, type a name.

The name can be any text string.

3. In the Comment column, type a comment.

The comment can be any text string.

 To simplify the sample list

Select the Quick Mode check box.

In Quick Mode, the Batch Specification page displays only the following columns:

• Sample Type

• Sample ID

• Injection Volume

• Conversion Factor

In Quick Mode, you cannot add or remove samples from the sample list. You can only 
edit these four column values for the samples specified in the template. 

When you are not using Quick Mode, follow these procedures:

• To add samples to the batch

• To remove samples from the batch

• To insert samples into the batch

• To copy a sample

• To move a sample up or down in the sample list

• To browse in a raw data file

Note  The application requires a value in at least one of these fields to acquire a sample. 
When the batch begins acquisition, it discards any sample that does not have a value in at 
least one of these fields. 
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 To add samples to the batch

1. Right-click and choose Add Sample from the shortcut menu, or click the add sample 
icon, .

The application adds a new, Unknown sample to the end of the sample list.

2. In the Filename column for each sample, type a file name.

3. Select a sample type from the Sample Type list for each sample. 

4. For detailed descriptions of sample types, see “Sample Types” on page 292.

5. For each Cal Std or Chk Std sample, select a level from the Level list.

The sample levels are defined in the master method. If there are no levels to select from 
the Level list, do the following:
a. Cancel the Batch Wizard.
b. Return to the Method Development mode.
c. Open the method.
d. Click the Compounds tab.
e. Click the Calibration Levels tab.
f. Add the levels.
g. Save the method.
h. Return to the Analysis mode, open the Batch Wizard, and begin your batch again.

For detailed instructions about defining sample levels, see Chapter 4, “Using the Method 
Development Mode.” 

6. In the Vial Position column for the new sample, type a vial position.

7. In the Injection Volume column for the new sample, type a volume.

The minimum injection volume value allowed is 0.1 μL; the maximum injection volume 
value allowed is 5000 μL.

8. (Optional) Type or edit the values for the remaining columns.

Note  Or, you can right-click and choose Browse in Raw File from the shortcut 
menu. Follow the instructions “To browse in a raw data file.” 

Available sample types

Matrix Blank Solvent Unknown/TIC
Cal Std Chk Std Unknown
LCS MDL MS
LCSD Method Val MSD
Tune Tune/Breakdown Breakdown

Note  The Add Sample function is not available in Quick Mode.
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 To remove samples from the batch

1. Select the samples to remove.

2. Right-click and choose Remove Selected Samples from the shortcut menu, or click the 
remove samples icon, .

The application removes the selected samples from the sample list.

 To insert samples into the batch

1. Select the sample above where you want to insert a new sample.

2. Right-click and choose Insert Sample from the shortcut menu.

The application inserts a new, Unknown sample above the selected sample.

 To copy a sample

1. Select the sample that you want to copy.

2. Right-click and choose Insert Copy Sample from the shortcut menu.

The application inserts the copy above the selected sample.

 To move a sample up or down in the sample list

1. Select the sample that you want to move.

2. Right-click and choose Move Sample Up or Move Sample Down from the shortcut 
menu.

The application moves the selected sample up or down one row in the sample list.

 To browse in a raw data file

1. Double-click the Filename column, or right-click and choose Browse in Raw File from 
the shortcut menu.

A dialog box opens where you can select a raw data file to use for the sample. You can also 
browse in multiple raw data files to create multiple samples.

2. Locate the raw data file to use for the sample and click Open. 

Note  The Remove Selected Samples function is not available in Quick Mode.

Note  The Insert Sample function is not available in Quick Mode.

Note  The Insert Copy Sample function is not available in Quick Mode.

Note  The Move Sample functions are not available in Quick Mode.

Note  The Browse in Raw File function is not available in Quick Mode.
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Figure 84. Batch Specification page

Table 69. Batch Specification parameters  (Sheet 1 of 2)

Parameter Description

Batch Template
Master Method
Batch File
Calibration File

Displays the path names of the batch template, master method, batch file, and calibration 
file used to create this batch. 

Adds a new, Unknown sample to the end of the sample list.
This function is not available in Quick Mode.

Removes the selected sample.
This function is not available in Quick Mode.

Quick Mode Limits the columns of information in the Batch Specification page to the following:
• Sample Type
• Sample ID
• Injection Volume
• Conversion Factor

In Quick Mode, the shortcut menu and add/remove sample icons are unavailable.
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Help Opens the “Creating a Batch Using the Batch Wizard” topic (this topic) in the application 
Help tool.

Back Returns you to the Batch Template Selection page where you can choose a different batch 
template, master method, or starting vial position.

Next Takes you to the Finish page where you can submit the batch for acquisition or processing. 
See “Submitting the Batch.” 

Cancel Immediately exits the Batch Wizard and does not save the batch. There is no confirming 
message.

Shortcut Menu

Add Sample Adds a single empty row to the sample list.

Insert Sample Inserts a new, Unknown sample above the selected row.

Insert Copy Sample Copies the currently selected row and inserts a copy above the row.

Remove Selected 
Samples

Removes selected samples from the sample list.

Move Sample Up Moves the selected sample up one row in the sample list.

Move Sample Down Moves the selected sample down one row in the sample list.

Browse In Raw File Opens a dialog box where you can select a raw data file to use for the sample row. You can 
also browse in multiple raw data files to create multiple samples.

Fill Down Enters sequential values in the column, starting with the value in the selected row and 
ending with the last row in the column. For detailed instructions about using the Fill 
Down command, see Appendix B, “Using Copy Down and Fill Down.” 

Table 69. Batch Specification parameters  (Sheet 2 of 2)

Parameter Description
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Submitting the Batch

From the Finish page, you can change the name of the batch, access the Calibration and 
Compound Selection page to edit the calibration file or edit the list of compounds to identify, 
or save the batch and open it in Batch View. For descriptions of the parameters on the Finish 
page, see “Finish page.” 

Follow these procedures:

• To change the name of the batch

• To save the batch

• To edit the calibration file

• To identify specific compounds or groups of compounds

 To change the name of the batch

Edit the name in the Batch Name box.

You cannot overwrite an existing batch name. If you enter a name for a batch that already 
exists, when you click Finish, the Batch Save dialog box asks you to enter another name. 

 To save the batch

Click Finish.

The application saves the batch and displays it in the Batch View. From the Batch View, 
you can submit the batch for acquisition, processing, or report generation. See 
“Submitting a Batch” on page 325.

 To edit the calibration file 

1. Select the Modify Calibrations or Active Compounds by Group check box.

The application replaces the Finish button with a Next button.

2. Click Next. 

The Calibration and Compound Selection page opens. See “Selecting Calibration Files 
and Compounds” on page 342.

 To identify specific compounds or groups of compounds

1. Select the Modify Calibrations or Active Compounds by Group check box.

The application replaces the Finish button with a Next button.

2. Click Next. 

The Calibration and Compound Selection page opens. See “Selecting Calibration Files 
and Compounds” on page 342. 
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Figure 85. Finish page

Table 70.  Finish parameters  (Sheet 1 of 2)

Parameter Description

Modify Calibrations or 
Active Compounds by 
Group

Enables the Next button that lets you access the Calibration and Compound Selection 
page.
If you have already used the Calibration and Compound Selection page, this option is not 
available.

Batch Name Name of the default batch in this form:
MasterMethodName_MMDDYYYY_

Help Opens the Creating a Batch Using the Batch Wizard topic (this topic) in the application 
Help tool.

Back Returns you to the Batch Specification page where you can enter a sample ID, sample 
name, or comment. You can also add or remove samples from the sample list or edit the 
column values for the samples. See “Specifying a Batch” on page 335.
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Selecting Calibration Files and Compounds

From the Calibration and Compound Selection page, you can edit the calibration file or edit 
the list of compounds that you want to identify. For descriptions of the parameters on the 
Calibration and Compound Selection page, see “Calibration and Compound Selection Page.” 

Follow these procedures:

• To add calibration data to the calibration file

• To identify specific compounds or groups of compounds

 To add calibration data to the calibration file

1. To add calibration data from another batch to the current calibration file, click Extend 
Calibrations.

The Select a Calibration File to Use dialog box opens. The dialog box lists only 
calibration batches that use the same master method as the current batch.

2. Select a calibration file to append to the current calibration file and click OK.

The application appends the selected calibration file to the current file.

Finish Saves the batch and displays it in Batch View. From Batch View, you can submit the batch 
for acquisition, processing, or report generation. See “Submitting a Batch” on page 325.

Next Opens the Calibration and Compound Selection page where you can edit the calibration 
file or edit the list of compounds that you want to identify.

Available only when Modify Calibrations or Active Compounds by Group is checked. 

Cancel Immediately exits the Batch Wizard and does not save the batch. There is no confirming 
message.

Table 70.  Finish parameters  (Sheet 2 of 2)

Parameter Description
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3. To save calibration data from both files into a single file for this batch, click Create New.

4. When you are finished with the Calibration and Compound Selection page, click Next.

The Finish page opens. See “Submitting the Batch” on page 340.

 To identify specific compounds or groups of compounds

1. In the Compound Groups area, select the groups that include the compounds to identify 
in the samples.

2. In the Included Compounds area, select the Active check box for each compound that 
you want to identify in the samples.

3. When you are finished with the Calibration and Compound Selection page, click Next.

The Finish page opens. See “Submitting the Batch” on page 340. 

Figure 86. Calibration and Compound Selection Page

Table 71.  Calibration and Compound Selection parameters  (Sheet 1 of 2)

Parameter Description

Calibration File Name of the current batch in this form:
MasterMethodName_MMDDYYYY_

Create New Saves calibration data from all calibration files to the current calibration file.

Available only after you use Extend Calibrations to append calibration data from another 
calibration file.

Extend Calibrations Adds calibration data from the current batch to the selected calibration file.
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Compound Groups Displays all available groups defined in the Groups page of the Master Method View. See 
“Editing the Groups Page” on page 126.

Included Compounds Displays all available compounds that you can identify in the samples. Compounds 
marked as Active are identified in the batch samples.

Help Opens the “Creating a Batch Using the Batch Wizard” topic (this topic) in the application 
Help tool.

Back Returns you to the Batch Specification page where you can enter a sample ID, sample 
name, or comment. You can also add or remove samples from the sample list or edit the 
column values for the samples. See “Specifying a Batch” on page 335.

Next Opens the Finish page where you can change the name of the batch or save the batch to 
the Batch View. See “Submitting the Batch” on page 340.

Cancel Immediately exits the Batch Wizard and does not save the batch. There is no confirming 
message.

Table 71.  Calibration and Compound Selection parameters  (Sheet 2 of 2)

Parameter Description
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Working in Data Review View
In the Data Review view, you can view the data generated by the master method. Use the Data 
Review view to verify the data for a sample-specific compound before you generate reports. 
You can use the functions in the Data Review view to investigate and edit the quantification 
or qualification values in a batch. 

 To open the Data Review view

1. Do one of the following:

From the dashboard, click Analysis.

–or–

Click Analysis in the navigation pane of the current mode.

2. In the Analysis navigation pane, click Data Review.

The Data Review view for the currently selected batch opens. 

The Data Review view uses a sample list and one of two modes: Quan Mode or Qual Mode. 
The Qual Mode is available only for Unknown/TIC sample types. When you view the data 
for an Unknown/TIC sample type, you can switch between Qual Mode and Quan Mode. 

This section includes the following topics:

• Data Review Sample List

• Quan Mode

• Qual Mode

Note  In the Qual Mode, the application displays peak information for compounds with 
mass spectral data only. The Qual Mode is not available for batches that have analog data 
only (no mass spectra compounds).
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Data Review Sample List

Use the sample list to select a particular sample. To see the columns in a sample list and view 
their descriptions, see “Data Review sample list.” 

Status indicators for each sample indicate if the sample is currently acquiring, not acquired, 
acquired, or processed. 

The sample list includes the following features:

• Column Display

• Status Indicators

• Caution Flags

• Compound Flags

• Inactive and Excluded Compounds

The sample list is the same in both Quan Mode and Qual Mode and displays all the 
quantitative data for the samples of a batch. 

• In Quan Mode, the sample list works with the Compounds pane to select a unique 
sample and compound combination, which then has its textual and graphical values 
displayed in the Quan Mode pane. The list of compounds that are available for a specific 
method is displayed in the Compounds pane.

From the sample list, you can make a compound active or inactive. 

• Switching a compound to inactive status does not remove its data and calculated 
values from the result set. Instead, the TraceFinder application masks the appearance 
of that compound for that particular sample and grays the compound in the 
compounds list. 

• For a calibration standard, the application stops using the data file’s calibration point 
for the calibration and removes it from the graphical view of the calibration curve 
displayed in the Qualification pane. It is no longer part of the result set. 

• In Qual Mode, the sample list works with the peak list to select a unique sample and peak 
combination, which then has its textual and graphical values displayed in the Qual Mode 
pane.
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Figure 87. Data Review sample list

Cells in the sample list that should not have a value, such as the theoretical concentration for 
an unknown, are shaded and empty. Cells that should have a value, but none exists, report 
N/A (not available). Results for compounds that are not detected display N/F (not found).

Table 72. Data Review sample list columns  (Sheet 1 of 3)

Column Description

Status  Sample is not acquired. 

 Sample is acquired but not processed.

 Sample is acquired and processed. 

 Sample is currently acquiring.

Flags Caution flag displayed when a compound within the sample has an error. 

Filename Name of the raw data file that contains the sample data.

Sample Type Defines how the TraceFinder application processes the sample data. Each sample is classified 
as one of the following sample types:

Matrix Blank, Solvent, Cal Std, Chk Std, Unknown, Unknown/TIC, LCS, LCSD, MDL, 
MS, MSD, Method Val, Tune, Tune/Breakdown, or Breakdown 

Level The level defined for a calibration sample or quality control sample.
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Sample ID A user-defined, alphanumeric string that identifies a sample.

Sample Name A user-defined name that identifies a sample.

Vial Position The tray vial number used for an autosampler acquisition.

Injection Volume The injection volume (in microliters) of the injected sample. 

When you are using an autosampler, you can set the default injection volume in the 
Autosampler dialog box in the Instrument View. The minimum and maximum injection 
volumes that you can use depend on the Autosampler you configure. The usable range 
depends on the injection mode and might be smaller than the displayed range.

The Injection Volume value set in the master method overwrites the value in the instrument 
method.

Range: 0.1 through 5000 μL

Integration Mode Indicates whether the peaks have been manually integrated or integrated from the original 
method.

Height The distance from the peak maximum to the peak base, measured perpendicular to the 
ordinate. When the Resp Ratio is specified as Height, this column displays an asterisk 
(*Height).

Area The area obtained by integrating peak intensities from the start to the end of the peak. 
When the Resp Ratio is specified as Area, this column displays an asterisk (*Area).

Actual RT Actual retention time for the compound. Retention time is the time after injection when a 
compound elutes and the total time that the compound is retained on the chromatograph 
column.

Expected RT Expected retention time for the compound.

Calc Amt The amount present in the sample, as determined using the calibration curve and the 
response ratio.

Theo Amt Theoretical amount of the compound expected in the sample. 

Sample Amt The injected volume multiplied by the conversion factor. For example, if you have 
1000 ng/mL of a substance that is too concentrated for the mass spectrometer, you can 
dilute it by 1000. Then your injection volume is 1, your conversion factor is 1000, and your 
sample amount is 1000. 

Resp Ratio The ratio of the Response value to the IS Response value. If the Response is specified as Area 
in the processing method, the units of both Response and IS Response are counts-sec. If the 
Response is specified as Height in the processing method, the units of both Response and IS 
Response are counts.

IS Amt Amount of internal standard.

IS Resp Response of the internal standard.

Table 72. Data Review sample list columns  (Sheet 2 of 3)

Column Description
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Active Displays or hides a compound for a particular sample. When a calibration standard is 
marked inactive, the application no longer uses the data file’s calibration point for the 
calibration and removes it from the graphical view of the calibration curve displayed in the 
Qualification pane. It is no longer part of the result set. 

Excluded Turns a compound on or off in the calibration curve of the Qualification pane. 

%Diff The calculated amount minus the expected amount, divided by the expected amount, and 
then multiplied by 100.

%RSD Standard deviation of the multiple samples of one level, multiplied by 100, and divided by 
the average of the multiple samples of that level. This calculation is based on the calculated 
amounts.

%CV Coefficient of Variance. Standard deviation of the multiple samples of one level, multiplied 
by 100, and divided by the average of the multiple samples of that level. This calculation is 
based on the areas of the peaks.

Channel Specifies the channel on which the sample was run. If the sample is not acquired, the value is 
Pending. The Channel column is available only when you have enabled multiplexing in the 
Configuration mode. See “Multiplexing” on page 92.

Comment A user-defined comment for the sample.

Table 72. Data Review sample list columns  (Sheet 3 of 3)

Column Description
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Column Display

The sample list can contain many columns of information. You can scroll to see all the 
columns of information, and you can customize which columns to display and their display 
order.

Follow these procedures:

• To scroll the sample list

• To customize the column display

 To scroll the sample list

Use the horizontal scroll bar at the bottom of the sample list to view all the information. 

When you use the scroll bar at the bottom of the sample list, the Status, Flags, Filename, 
and Sample Type columns stay fixed while the other columns scroll right and left. 

 To customize the column display 

1. Right-click the Data Review sample list and choose Modify Columns from the shortcut 
menu.

The Modify Columns dialog box opens. See “Modify Columns dialog box.” 

2. Use the arrow buttons to move all the columns that you want displayed to the Displayed 
Columns pane.

All the columns you select are displayed after the Status, Flags, Filename, and Sample 
Type columns.

3. To arrange the order of the columns, do the following:

a. In the Displayed Columns pane, select a column name.

b. Use Up or Down to move the selected column up or down in the list.

The first column in the list represents the leftmost column in the Data Review 
sample list, and the last column in the list represents the rightmost column in the 
Data Review sample list.

4. To change the width of a column, do the following:

a. In the Displayed Columns pane, select the column width.

b. Type a new value for the width.

Note  You cannot move the Status, Flags, Filename, or Sample Type column.
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5. When you have completed your changes, click OK.

The columns in the sample list immediately reflect your changes. The application uses 
these settings for all sample lists in the Data Review view.

Figure 88. Modify Columns dialog box

Table 73. Modify Column dialog box function buttons

Function Description

Moves all columns to the Displayed Columns pane.

Moves the selected column to the Displayed Columns pane.

Moves the selected column to the Available Columns pane. You cannot move the Status, Flags, 
Filename, and Sample Type columns.

Moves all columns except Status, Flags, Filename, and Sample Type to the Available Columns pane.

Moves the selected column name in the Displayed Columns pane one row up in the column order. 
You cannot move the Status, Flags, Filename, and Sample Type columns.

Moves the selected column name in the Displayed Columns pane one row down in the column order. 
You cannot move the Status, Flags, Filename, and Sample Type columns.
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Status Indicators

Status indicators show the current status of each sample during the acquisition and 
processing:

 Sample is not acquired. 

 Sample is acquired but not processed.

 Sample is acquired and processed. 

 Sample is currently acquiring.

Caution Flags 

The Flags column in the sample list displays a caution flag if the sample is not in compliance 
with the method criteria. 

Sample caution flags remain static when you switch between compounds for chromatogram 
review until a change is completed, for example, when a compound is manually integrated 
and no longer falls outside the accepted criteria.

To display a summary of problems found in the sample, click the caution flag. The summary 
does not list compounds that are not found in Unknown sample types. 

Status indicators

Sample caution flags
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Compound Flags

Flags are displayed in these situations:

• When a compound has violated (or is activated by) any of the values set in the method 
(See “Editing the QAQC Page” on page 183.) 

• For compounds that are not found

• For compounds that are not found in Cal Std or Chk Std sample types

• For compounds that are outside the specified ion ratio range

These criteria do not apply to Matrix Blank sample types when the compound is an internal 
standard.

The compounds list is sorted first by flag indicators and then by compound names. 
Compound flags indicate the following:

• Red flags for compounds that have ion ratio failures or method validation failures

• Orange flags for compounds that are below the LOQ, below the LOD, or between the 
LOD and LOQ values specified in the method

• Green flags for compounds that are over the LOR amount specified in the method

• No flag for compounds that have no errors or where no report options are selected
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Inactive and Excluded Compounds

Use the Active and Excluded columns to control which compounds are used for calculating 
the calibration curve and for reporting.

Follow these procedures:

• To make a sample active or inactive

• To exclude a calibration point

 To make a sample active or inactive

1. Select the sample in the sample list.

All compounds in the selected sample are displayed in the Compounds pane. Inactive 
compounds are grayed out.

2. In the Compounds pane, select the compound whose active/inactive status you want to 
change.

3. In the sample list, select or clear the Active check box. 

Use the horizontal scroll bar at the bottom of the table to scroll to the Active column.

Inactive compound
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 To exclude a calibration point

In the sample list, select the Excluded check box for the sample.

Use the horizontal scroll bar at the bottom of the table to scroll to the Excluded column.

The application displays a value that is no longer used for calibration as an empty box in 
the graphical view of the calibration curve.

Excluded 
calibration 
point
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Quan Mode

Use the Quan Mode and the associated Compounds pane to view quantitative information to 
complement the textual information for the selected sample. The Quan Mode displays peak 
information for selected compounds that are found in the processed samples.

In addition to the Data Review Sample List, the Quan Mode view uses the following panes:

• Compounds Pane

• Peak Display Panes

Sample list Compounds pane

Peak display panes
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Compounds Pane

The Compounds pane works with the sample list pane to display textual and graphical values 
for a unique file and compound combination.

 To sort the compounds list

In the Compounds pane, right-click and choose one of the following sort styles from the 
shortcut menu.

 To display specific problems with a compound

Hold the cursor over the flag to view a description of the problems with the compound.

Command Description

Sort by Flag and 
Alphabetical

Sorts the compounds first by flag and then, within each flag 
group, sorts the compounds alphabetically.

Sort by Flag and 
Retention Time

Sorts the compounds first by flag and then, within each flag 
group, sorts the compounds by retention time.

Sort by Alphabetical Sorts the compounds alphabetically (1–n followed by a–z).

Sort by Retention Time Sorts the compounds from shortest retention time to longest 
retention time.
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Peak Display Panes

In the peak display panes, you can display multiple panes of data for each compound.

You can display any of the following types of data:

• Quan Peak

• Confirming Ions

• Calibration Curve

• Ion Overlay

• ISTD

• Reference Peak

• Spectra

 To display peaks for a specific compound

1. In the sample list, select a sample.

The Compounds pane lists all compounds specified in the method and found in the 
sample.

2. In the Compounds pane, select a compound that was found in the sample.

By default, the first display pane shows the quantitative peak for the selected compound.

3. In the second pane, select the additional type of data that you want to display. 

Figure 89. Displaying a compound peak 
1. Select a sample. 2. Select a compound. 3. Select a data type.
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Follow these procedures to change the display of the peak data:

• To change the peak panes

• To zoom in on a peak

 To change the peak panes

In any of the peak panes, right-click the header bar or click the  icon.

 To zoom in on a peak

1. In any of the views, drag your cursor to delineate a rectangle around the peak or spectra. 

The delineated area expands to fill the view.

2. To restore the default view, right-click the chromatogram plot and choose Reset Scaling 
from the shortcut menu. 

Command Description

Make All Panels the 
Same Size

Evenly divides the area to make all panes the same width. 
This command does not change the pane height.

Move Panel Left Moves the current panel one space to the left. This 
command is not available when the current pane is the 
leftmost pane.

Move Panel Right Moves the current panel one space to the right. This 
command is not available when the current pane is the 
rightmost pane.

Add a Panel Adds an empty peak pane to the display. You can display a 
maximum of four peak panes.
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Quan Peak

A compound can have multiple quantitative peaks. You can switch between quantitative 
peaks, but you cannot view multiple quantitative peaks at the same time. The indicator in the 
upper right corner of the Quan Peak pane displays which of the multiple quantitative peaks 
you are viewing. The Quan Peak pane uses a unique shortcut menu. See “Quan Peak pane 
shortcut menu commands” on page 364.

Figure 90. Quantitative peak pane with multiple quantitative peaks

Follow these procedures to modify the quantitative peak data:

• To manually add a peak

• To remove a manually created peak

• To switch between method and manual integration modes

• To change the displayed information for detected peaks

• To modify the peak detection settings

Peak 1 of 2

Peak 2 of 2
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 To manually add a peak

1. Right-click anywhere in the quantitative peak pane, and choose Add Quan Peak from 
the shortcut menu.

The Add Peak command is available only when the application has not detected a peak. 

2. Click to indicate the left and right base points for the peak. 

The application places the peak delimiter tags at these locations and automatically 
updates the peak values (area, height, and so forth) in the result set. 

 To remove a manually created peak

Right-click the pane, and choose Remove Quan Peak from the shortcut menu.

The application removes the manually added peak.

 To manually integrate a quantitative peak 

1. Hold your cursor over one of the two peak delimiter tags in the peak pane.

When the tag can be selected, the cursor changes to a crosshair-style cursor. You can zoom 
in on the baseline to make it easier to select the tag. 

2. Drag the peak delimiter tag to another location and automatically update the peak values 
(area, height, and so forth) into the result set. 

The generated reports for these data identify the manual modifications.

You can store two peak value sets (method and manual integration settings) with each 
compound in each file. These settings can result in a different set of stored values. The 
application originally calculates the method values based on the processing method 
parameters. The manual values are a result of what you have edited. 

Note  The Add Quan Peak command is also available on the Confirming Ions pane.

Note  The Remove Quan Peak command is also available on the Confirming Ions pane.

Manually added 
base points
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 To switch between method and manual integration modes

Right-click the chromatogram view and choose Method Integration Settings or Manual 
Integration Settings from the shortcut menu. 

Initially, the method and manual integration settings that are stored for a compound and 
file are identical. When you switch modes, the saved result set does not change. However, 
when manual data are available, the chromatogram plots and the result set update as you 
switch between method and manual modes. 

As you switch between modes, each pane reflects the changes. The generated reports for 
these data identify the manual modifications.

 To change the displayed information for detected peaks

1. Right-click the peak pane and hold the cursor over Peak Labels.

2. Choose to display labels for the peak retention time, peak height, peak area, or signal to 
noise.

The label types in the list are selected for displayed labels and are cleared for labels that are 
not displayed.

3. To remove a label, select the label type again and clear it.

Label settings are globally applied to quantitative peaks, confirming ion peaks, and 
internal standard peaks. 

Note  The Method Integration Settings and Manual Integration Settings commands are 
also available on the Confirming Ions pane.

Note  The Peak Labels command is also available on the Confirming Ions pane.

Tip  The labels do not always update on all peak displays. To update all labels, select a 
different compound, and then reselect the compound whose labels you changed.
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 To modify the peak detection settings

1. Right-click the chromatogram view and choose one of the following from the shortcut 
menu:

• Peak Detection Settings > Edit Local Method Peak Detection Settings: Makes 
changes to the selected compound for all samples in this batch. 

• Peak Detection Settings > Edit User Defined Peak Detection Settings: Makes 
changes to the selected compound for only the selected sample. The TraceFinder 
application saves these changes with the batch and stops applying the local method 
detection settings to the compound for this sample only.

The Peak Detection Settings dialog box opens where you can adjust detection settings 
that were specified in the method. The title bar of the dialog box lists the selected 
compound and indicates whether you are making changes to only the selected sample or 
to the local method. 

Figure 91. Peak Detection Settings dialog box

Editing all samples in the batch

Editing only the selected sample
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2. Edit any of the detection settings.

For detailed descriptions of all detection settings, see “Detection” on page 135.

3. To save your changes to this compound, click Apply. 

• When you are editing a single sample, the application makes changes to the selected 
compound for this sample. If the sample is a calibration sample type, this update 
changes the calibration curve which, in turn, affects all calculated amounts.

• When you are editing the local method, the application makes changes to the selected 
compound for all samples in this batch.

Note  The Peak Detection Settings commands are also available on the Confirming Ions 
pane.

Table 74. Quan Peak pane shortcut menu commands  (Sheet 1 of 2)

Command Description

Method Integration Settings Use Local Method Peak Detection Settings: Applies the 
local method integration settings to the selected 
compound.

To edit these peak detection settings, use the Peak 
Detection Settings > Edit Local Method Peak Detection 
Settings command.

Use User Peak Detection Settings: Applies the 
user-customized method integration settings to the 
selected compound.

To edit these user-customized settings, use the Peak 
Detection Settings > Edit User Defined Peak Detection 
Settings command.

Manual Integration Settings Displays manual integration settings.

Add Quan Peak
–or–
Remove Quan Peak
–or–
Cancel Add Peak

Adds a peak, removes a peak, or cancels an add peak 
operation in progress.

Confirming Ion List Select the confirming ions to be viewed. Not available for 
analog compounds.

Send RT to Method Sets the current retention time as the expected retention time 
for the compound in the local method.

Peak Labels Displays or hides the peak labels (Label Area, Label 
Retention Time, Label Height, or Label Signal to Noise).
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Show Peak Info Displays peak information for the selected compound. 
For example

Reset Scaling Resets the original scaling after a zoom operation.

Peak Detection Settings Edit User Defined Peak Detection Settings: Opens the 
Peak Detection Settings dialog box where you can make 
changes to the selected compound for this sample.

Edit Local Method Peak Detection Settings: Opens the 
Peak Detection Settings dialog box where you can make 
changes to the selected compound for all samples in this 
batch. 

After you apply either of these updates, the application 
does not retain manual integration settings.

Table 74. Quan Peak pane shortcut menu commands  (Sheet 2 of 2)

Command Description



6 Using the Analysis Mode
Working in Data Review View

366 TraceFinder User Guide Thermo Scientific

Confirming Ions

The Confirming Ions pane displays a graphical view of all qualifying/confirming ions for the 
selected compound and displays calculated ion ratios and ion ratio acceptance windows. A red 
border indicates that an ion ratio is outside of its window. The Confirming Ions pane uses a 
unique shortcut menu. See Confirming Ions pane shortcut menu commands. 

Figure 92. Quantitative peak with multiple confirming ions

Figure 93. Confirming ion with coelution failure

Note  For compounds with an analog detection type, the application displays “No 
Confirming Ions are Enabled” in the Confirming Ions pane.
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 To manually integrate a confirming ion peak

1. Hold your cursor over one of the two peak delimiter tags in the peak pane.

When the tag can be selected, the cursor changes to a crosshair-style cursor. You can zoom 
in on the baseline to make it easier to select the tag. 

2. Drag the peak delimiter tag to another location and automatically update the peak values 
(area, height, and so forth) into the result set. 

The generated reports for these data identify the manual modifications.

You can store two peak value sets (method and manual integration settings) with each 
compound in each file. These settings can result in a different set of stored values. The 
application originally calculates the method values based on the processing method 
parameters. The manual values are a result of what you have edited. 

Note  Because a Blank Report displays only the quantitation mass, when you manually 
integrate a confirming ion, the manual integration flag in the report is displayed on 
the quantitation mass.

Table 75. Confirming Ions pane shortcut menu commands  (Sheet 1 of 2)

Command Description

Method Integration 
Settings

Displays the method integration settings.

Manual Integration 
Settings

Displays the manual integration settings.

Add Quan Peak 
–or–
Remove Quan Peak 
–or–
Cancel Add Quan Peak

Adds a quantitation peak, removes a peak, or cancels an add peak 
operation in progress.

Range Calc Method: 
Manual

Selects the method used to calculate the ion ratio range windows: 
Manual, Average, Weighted Average, or Level. 

Range Calc Level Displays the range based on the calibration level.

Target Ratio Specifies the theoretical ratio of the confirming ion's response to 
the quantification ion's response. 

Window Type Specifies the Absolute or Relative calculation approach for 
determining the acceptable ion ratio range. 

Window Specifies the acceptable ion ratio range as a percentage. 

Peak Labels Displays or hides the peak labels (Label Area, Label Retention 
Time, Label Height, or Label Signal to Noise).

Show Peak Info Displays peak information for the selected compound. 
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Reset Scaling Resets the original scaling after a zoom operation.

Peak Detection 
Settings

Opens the Peak Detection Settings dialog box for the selected 
compound. 

Table 75. Confirming Ions pane shortcut menu commands  (Sheet 2 of 2)

Command Description
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Calibration Curve

The Calibration Curve pane displays a graphical view of the calibration curve for the selected 
compound and key statistical values for evaluating the quality of the calibration. The 
Calibration Curve pane uses a unique shortcut menu. See Calibration Curve pane shortcut 
menu commands.

Figure 94. Quantitative peak with a calibration curve plot

 To manually exclude a calibration point

In the sample list, select the Excluded check box for the sample.

Use the horizontal scroll bar at the bottom of the table to scroll to the Excluded column.

When a value is no longer used for calibration, it is displayed as an empty box in the 
graphical view of the calibration curve.

Excluded 
calibration 
point
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Table 76. Calibration Curve pane shortcut menu commands

Command Description

Standard Type Sets the standard type to External or Internal. 
Calibration Curve Type Sets the calibration curve type to one of the following:

• Linear: Allows all settings with this exception: When Origin 
is set to Include, all Weighting values are grayed out and 
Weighting is set to Equal.

• Quadratic: Allows all settings with this exception: When 
Origin is set to Include, all Weighting values are grayed out 
and Weighting is set to Equal.

• Average RF: Allows no Weighting or Origin selections. All 
Weighting and Origin values are grayed out. Weighting is set 
to Equal, and Origin is set to Ignore. 

Response Via Sets the response to Area or to Height.
Weighting Sets the weighting to equal, 1/X, 1/X^2, 1/Y, or 1/Y^2.
Origin Sets the origin to Ignore, Force, or Include.
Units Sets the units.
Done with Settings Saves the calibration curve settings.
Reset Scaling Resets the original scale in the calibration curve pane.
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Ion Overlay

The Ion Overlay pane represents an overlay of the entire ion set—quantification and 
qualifying/confirming—for the selected sample and compound. Use this pane to graphically 
review the peak apex alignment and co-eluting peak profiles. 

Figure 95. Quantitative peak with confirming ion overlay

Note  For compounds with an analog detection type, the application displays “No Data” 
in the Ion Overlay pane.
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ISTD

The ISTD pane displays the internal standard specified for the compound in the method. See 
“To specify an internal standard for a compound” on page 173.

Figure 96. Quantitative peak with an internal standard
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Reference Peak

The Reference Peak pane displays the reference peak as specified in the method. See “To 
specify a chromatogram reference sample” on page 124.

Figure 97. Quantitative peak with a reference peak
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Spectra

The Spectra pane displays a comparison of the spectra found in the data and the method 
reference. 

Figure 98. Quantitative peak with data and reference spectra

Note  For compounds with an analog detection type, the application displays “Not 
Available” in the Spectra pane.
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Qual Mode

Use the Qual Mode and the associated peak list to view qualitative information that 
complements the textual information for the selected Unknown/TIC sample. The Qual 
Mode view displays detected peaks for the selected sample. From the Qual Mode view, you 
can manually add peaks. The Qual Mode view is available only for Unknown/TIC sample 
types.

Peak list

Chromatogram 
navigation pane

Qualitative peak pane  Spectra pane  Ranking pane

Sample list

Tip  To resize the panes, drag the separators that divide the panes.
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In addition to the Sample List, the Qual Mode view displays data in the following panes:

• Peak List

• Chromatogram Navigation Pane

• Qualitative Peak Pane

• Spectra Pane (Reference and Selected)

• Ranking Pane

Peak List 

The peak list works with the sample list to display graphical values for a unique sample and 
peak combination. For detailed descriptions of parameters on the peak list, see “Peak list 
parameters” on page 378.

 To display peaks for a specific compound

1. From the sample list, select a sample. 

The peak list displays the retention times for peaks identified in the selected sample, the 
values for the best match methods for each peak, and the compound match.

The number of peaks that are listed is specified in the method. You can change the 
number of identified peaks in the Method Template Editor. See “Creating a Method 
Template” on page 216.

2. From the peak list, select a peak in the sample.

The TraceFinder application displays the selected peak in the qualitative peak pane.

When you select a data-dependent sample, the peak can be from either a full scan or a 
QED spectrum of an SRM-filtered chromatogram.

Note  If you select a sample type other than Unknown/TIC, the TraceFinder 
application returns you to Quan Mode. 
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The TraceFinder application displays the Spectra pane with two sections:

• The Qual Data pane shows spectra data for the peak in the raw data file.

• The Qual Library pane shows actual spectra for the identified library compound.

The TraceFinder application locates the selected peak in the navigation chromatogram.

 To remove a peak

1. Select a peak in the peak list.

2. Right-click and choose Remove Selected Peak from the shortcut menu.

The TraceFinder application removes the selected peak from the peak list.

Note  There is no undo for this action, but you can manually add a peak to redefine a 
removed peak. See “Chromatogram Navigation Pane” on page 379.

Reference spectra 
from the library

Actual spectra for the 
compound
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Figure 99. Peak list

Table 77. Peak list parameters

Parameter Description

Filter Filter used to identify the peaks. Specified in the raw data 
file or the master method.

When your raw data file is data-dependent, the filter 
indicates this with a “d”.

Peak RT Peak retention time. The time after injection when the 
compound elutes. The total time that the compound is 
retained on the column. 

SI Search index method used to search the NIST library.

RSI Reverse search index method used to search the NIST 
library.

MP Match probability.

Compound Library compound that matches the identified peak.

Remove Selected Peak Shortcut menu command that removes the selected peak 
from the peaks list.

Data-dependent filter
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Chromatogram Navigation Pane

The chromatogram navigation pane displays all peaks in the selected sample. The peak 
selected in the peak list displays a red marker. See “Chromatogram navigation pane” on 
page 380.

For a description of commands on the shortcut menu, see “Chromatogram navigation pane 
shortcut menu commands” on page 380.

 To zoom in on a peak

1. In the chromatogram navigation pane, drag the cursor to delineate a rectangle around the 
peak. 

The delineated area expands to fill the view.

2. To restore the default view, right-click the chromatogram navigation pane and choose 
Reset Scaling from the shortcut menu. 

 To manually add a peak

1. Zoom in to better identify which peak to add to the results set.

2. Right-click the chromatogram navigation pane, and choose Add Qual Peak from the 
shortcut menu.

3. Click to indicate the left and right base points for the peak. 

The TraceFinder application marks the peak in the chromatogram navigation pane.

The TraceFinder application places the peak delimiter tags at the base point locations and 
automatically updates the peak values in the peak list and qualitative peak pane. 
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Figure 100. Qualitative peak pane with a manually added peak

Figure 101. Chromatogram navigation pane 

 

Table 78. Chromatogram navigation pane shortcut menu commands

Command Description

Add Qual Peak Select the beginning and ending base points for a new 
qual peak.

Reset Scaling Resets the original scaling after a zoom operation.

Manually added 
base points
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Qualitative Peak Pane

The qualitative peak pane displays the selected peak. See “Qualitative peak pane” on 
page 383.

Follow these procedures:

• To zoom in on a peak

• To manually add a peak

• To remove a peak

• To switch between method and manual integration modes

• To change the displayed information for detected peaks

For a description of commands on the shortcut menu, see “Qualitative peak pane shortcut 
menu commands” on page 383.

 To zoom in on a peak

1. In the chromatogram plot, drag the cursor to delineate a rectangle around the peak. 

The delineated area expands to fill the view.

2. To restore the default view, right-click the chromatogram plot and choose Reset Scaling 
from the shortcut menu. 

 To manually add a peak

1. Right-click anywhere in the qualitative peak pane, and choose Add Peak from the 
shortcut menu.

If a peak is already detected, the Add Peak command is not enabled. 

2. Click to indicate the left and right base points for the peak. 

The TraceFinder application places the peak delimiter tags at these locations and 
automatically updates the peak values (area, height, and so forth) in the result set. 

Manually added 
base points
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 To remove a peak

Right-click the chromatogram plot, and choose Remove Peak from the shortcut menu.

The TraceFinder application removes the peak displayed in the qualitative peak pane. All 
data for this peak are removed from the Qual Mode panes.

 To switch between method and manual integration modes

Right-click the chromatogram view and choose Method Integration or Manual 
Integration from the shortcut menu. 

Initially, the method and manual integration settings that are stored for a compound and 
file are identical. When you switch modes, the saved result set does not change. However, 
when manual data are available, the chromatogram plots and the result set update as you 
switch between method and manual modes. 

As you switch between modes, each pane reflects the changes. The generated reports for 
these data identify the manual modifications.

 To change the displayed information for detected peaks

1. Right-click the chromatogram plot and hold the cursor over Peak Labels.

2. Choose to display labels for the peak retention time, peak height, peak area, or signal to 
noise.

The label types in the list are selected for displayed labels and cleared for labels that are 
not displayed.

3. To remove a label, select the label type again and clear it.

Label settings are globally applied to qualitative peaks, confirming peaks, and internal 
standard peaks. 

Tip  The labels do not always update on all peak displays. To update all labels, select a 
different compound, and then reselect the compound whose labels you changed.
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Figure 102. Qualitative peak pane

The qualitative peak pane shortcut menu includes the following commands: 

Table 79. Qualitative peak pane shortcut menu commands

Command Description

Reset Scaling Resets the original scaling after a zoom operation.

Method Integration Displays method integration settings.

Manual Integration Displays manual integration settings.

Peak Labels Displays or hides the peak labels (Label Area, Label 
Retention Time, Label Height, or Label Signal to Noise).

Remove Qual Peak Removes the qualitative peak displayed in the Qual pane. 
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Spectra Pane (Reference and Selected)

The spectra pane displays the reference spectra and the spectra for the selected sample. The 
top pane displays the reference spectra for the identified compound from the library; the 
bottom pane displays the spectra for the selected peak.

Figure 103. Spectra pane

 To zoom in on a peak

1. In the spectra plot, drag the cursor to delineate a rectangle around the peak. 

The delineated area expands to fill the view. 

2. To restore the default view, right-click the chromatogram plot and choose Reset Scaling 
from the shortcut menu. 

Reference 
spectrum from 
the library

Actual spectrum 
for the selected 
peak
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Ranking Pane

The ranking pane displays the three best library matches for the selected peak. Use this pane 
to select a different library entry for the peak. See “Ranking pane.” 

When you select a library entry other than the original entry, the TIC Report and TIC 
Summary Report indicate this with a “P” flag:

For detailed descriptions of ranking pane parameters, see “Ranking pane parameters.” 

 To change the library entry for a selected peak

In the ranking pane, select the check box for the library entry that you want to use to 
identify the selected peak.

• In the Spectra pane, the reference spectra change to show the spectra for the selected 
library entry.

• In the peak list, the SI, RSI, MP, and Compound values update to reflect the selected 
library entry.

P flag

Selected library entry 
in the ranking pane

Reference spectra 
for Pyrazinamide 

Peak list for 
Pyrazinamide



6 Using the Analysis Mode
Working in Data Review View

386 TraceFinder User Guide Thermo Scientific

Figure 104. Ranking pane

Table 80. Ranking pane parameters

Parameter Description

<Check box column> Indicates selected library entries for the selected peak.

Rank Indicates the order of best matches between the selected 
peak and library entries.

SI Search index method used to search the NIST library.

RSI Reverse search index method used to search the NIST 
library.

MP Match probability.

Library Entry Library compound that matches the identified peak.
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Working in the Report View 
Use the Report View to display or generate reports for the currently selected batch in the 
Analysis mode. You must process each sample in the batch before you can view or generate a 
sample-level report for that sample. 

 To open the Report View

1. Click Analysis in the navigation pane from any mode.

2. In the Analysis navigation pane, click Report View.

The Report View for the currently selected batch opens.

 To refresh the Report View

If you make changes to your reports, click New Data Available - Refresh.

This section includes the following topics:

• Viewing Reports

• Generating Reports

• Working with Reports

• Working with the Active View

Figure 105. Report View in Analysis mode

• View Only: Displays a PDF or Excel spreadsheet preview of the selected report type for 
the batch, sample, or compound. See “Viewing Reports.” 

Preview reports for all Standard report types are always available. You must generate 
Custom and Target Screening report types before they are available in this list. 
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The Report View page displays one of the following report outputs:

– Standard reports as PDF files

– Custom reports in XLSM format

– Target Screening reports as PDF files

• Generate Only: Creates all specified report output formats for the selected sample- or 
batch-level report. See “Generating Reports” on page 392. 

Viewing Reports

Use the View Only features to view all configured standard reports and any custom or target 
screening reports that you have generated. After you generate a report, the application displays 
the report in the View Only report list.

Follow these procedures:

• To select a report

• To select a sample

• To select a compound

• To select a sample and a compound

 To select a report 

1. Select the View Only option.

2. Open the Select a Report list to display all configured report types.

These reports reflect the Displayed Reports selections in the Configuration mode. To 
change the configured reports that are available in this view, see “Specifying the Reports 
Configuration” on page 68.

To sort the reports, click the column headers. The application maintains this sort order 
each time you open the Report View for this batch.

To help organize your reports, you can filter the list.
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3. To limit the types of reports to display in the report list, select any combination of report 
filter options in the Filter Reports area.

4. Double-click the name of the report.

The report list closes.

• When the selected report is a batch-level report, the application displays the report on 
the Report View page. 

• When the selected report includes separate reports for each sample, you must select a 
sample file. 

Follow the procedure “To select a sample” on page 390.

• When the selected report includes separate reports for each compound, you must 
select a compound. 

Follow the procedure “To select a compound” on page 390.

• When the selected report includes separate reports for each sample and each 
compound in the sample, you must select both a sample and a compound. 

Follow the procedure “To select a sample and a compound” on page 391.

Table 81. Filter Reports options

Option Behavior

Only Show Automated 
Batch Reports

Displays only reports that have an output format specified 
in the Automated Batch Reports area in the Batch View. 
See “Editing Report Output Formats” on page 320.

Standard Reports Displays Standard report types.

Custom Reports Displays all generated Custom report types. Custom 
reports are not available for viewing until you have 
generated the report. 

Target Screening Reports Displays all generated Target Screening reports. Target 
Screening reports are not available for viewing until you 
have generated the report. 

Note  When you make changes to the method in the Local Method view, to the peaks 
in the Data Review view, or to the samples in the Batch View, you must regenerate the 
custom or target screening reports before these changes take effect.
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 To select a sample

1. Open the Sample File list to display all samples in the batch.

2. To show only samples that would be included in the selected report, select the Only 
Show Samples Relevant… check box. 

For example, if you selected the Check Standard Report, the sample list displays only 
Chk Std samples.

3. Double-click the name of the sample.

The sample list closes. The Report View page displays the sample-level report.

 To select a compound 

1. Open the Compound list to display the names and retention times of all compounds in 
the sample.

2. Double-click a single compound or All Compounds.

The compound list closes. The Report View page displays the compound-level report.

Note  Click the column headers to sort the samples. The application maintains this 
sort order each time you open the Report View for this batch.
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 To select a sample and a compound

1. Open the Sample File list to display all samples in the batch.

2. To show only samples that would be included in the selected report, select the Only 
Show Samples Relevant… check box.

For example, if you selected the Check Standard Report, the sample list displays only 
Chk Std samples.

3. Double-click the name of the sample.

The sample list closes. 

4. Open the Compound list to display the names and retention times of all compounds in 
the sample.

5. Double-click a single compound or All Compounds.

The compound list closes. 

The Report View page displays the compound-level report for the selected sample and 
compound. 

Tip  Click the column headers to sort the samples. The application saves this sort 
order in the Report View for this batch.
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Generating Reports

Use the Generate Only features to create sample-level reports. You cannot use the View Only 
features to view custom or target screening reports until you generate the report. When you 
make changes to the method in the Local Method view or to the peaks in the Data Review 
view, you must regenerate the custom or target screening reports to see the effects of those 
changes. 

Follow these procedures:

• To select a report

• To select a sample

 To select a report

1. Select the Generate Only option.

2. Open the Select a Report list to display the available reports.

The application displays only configured sample-level report types in the list. You cannot 
generate batch-level or compound-level reports from this view. To change the configured 
reports that are available in this view, see “Specifying the Reports Configuration” on 
page 68.

If you have many reports, you can filter the list.



 6 Using the Analysis Mode
Working in the Report View

Thermo Scientific TraceFinder User Guide 393

3. To limit the types of reports to display in the report list, select any combination of report 
filter check boxes in the Filter Reports area.

4. Double-click the name of the report.

The report list closes. You must select a sample file for the selected report. 

 To select a sample

1. Open the Sample File list to display all samples in the batch.

Option Behavior

Only Show Automated Batch 
Reports

Displays only sample-level reports that have an 
output format specified in the Automated Batch 
Reports area in the Batch View. See “Editing Report 
Output Formats” on page 320.

If you have only batch-level reports specified in the 
Batch View, selecting this option excludes all reports 
in the Report Name list.

Standard Reports Displays sample-level Standard report types. 

Custom Reports Displays sample-level Custom report types. 

Target Screening Reports Displays sample-level Target Screening report types. 

Note  Click the column headers to sort the samples. The application saves this sort 
order in the Report View for this batch.
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2. To show only samples that would be included in the selected report, select the Only 
Show Samples Relevant… check box.

For example, if you selected the Check Standard Report, the sample list displays only 
Chk Std samples.

3. Select the check box for each sample that you want to include in the report.

4. Click Generate.

The Report Selection Confirmation dialog box opens.

5. In the What Action Would You Like to Perform area, select the types of reports that you 
want to create.

6. Click Continue.

The application submits the selected samples to the report queue.

When you have already generated this report in the Batch View or Acquisition mode, the 
application time-stamps the new report to differentiate it from the original report.

Note  Click the column headers to sort the samples. The application saves this sort 
order in the Report View for this batch.

Note  The application automatically selects required output formats. These options 
are not editable. 
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7. To view the report you generated, follow the instructions in “Viewing Reports” on 
page 388.

Note  When you make changes to the method in the Local Method view, the peaks in the 
Data Review view, or the samples in the Batch View, you must regenerate the custom or 
target screening reports before those changes take effect.
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Working with Reports

Use the icons on the Report View page to view, print, or export a report.

• A PDF report view is available for all Standard and Target Screening report types. 

• An Excel Macro-Enabled Workbook report view is available for any Custom report types 
that you have generated with the Generate XLSM option selected.

Follow these procedures:

• To print a standard or target screening report

• To export a standard report

• To search for text

• To enlarge the report text

 To print a standard or target screening report

1. Select the report to print from the Select a Report list.

2. (Optional) Select a sample from the Sample File list.

The application displays the report on the Report View page.
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3. Click the Print Report icon, .

The Print dialog box for your default printer opens.

4. Follow the typical procedure to print from your printer.

Landscape reports automatically rotate to fit the paper.

 To export a standard report

1. Select the report that you want to print from the Select a Report list.

2. (Optional) Select a sample from the Sample File list.

The application displays the report on the Report View page.

3. Click the Export Report icon, .

The Export Report dialog box opens.

4. Locate the folder where you want to write the report file.

5. Type a file name for the exported report file.

6. Select a file type from the Save as Type list:

7. Click Save.

The TraceFinder application saves the file as the specified file type and writes the report 
file to the specified folder.
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 To search for text

1. Select a report from the Select a Report list.

2. (Optional) Select a sample from the Sample File list.

The application displays the report on the Report View page.

3. Click the Find Text icon, .

The Find Text dialog box opens.

4. Enter your text and click Find Next.

When the TraceFinder application locates the text, it encloses the text in a red box.

 To enlarge the report text

1. Select a report from the Select a Report list.

2. (Optional) Select a sample from the Sample File list.

The application displays the report on the Report View page.

3. Click the Zoom icon, , and select a zoom scale.



 6 Using the Analysis Mode
Working in the Report View

Thermo Scientific TraceFinder User Guide 399

Working with the Active View

Use the Active View page to view quantitative data for each sample in a report. Data in the 
Active View are labeled with flag information. These flags are based on a comparison of the 
batch data to criteria defined in the master method.

 To display the Active View page 

Click the Active View tab.

The Active View page displays quantitative data and QAQC error flags for each sample. 
See “Active View page.” 

 To display a report

1. Select a report type from the Select a Report list. 

Only the report types created for the current batch are displayed in the list. 

2. (Optional) When the report type includes separate reports for each sample, select a 
sample file.

 To filter which compounds to display 

Click the Showing button to switch the display to either all compounds or only 
compounds that are flagged for failing a QAQC test.



6 Using the Analysis Mode
Working in the Report View

400 TraceFinder User Guide Thermo Scientific

Figure 106. Active View page

Table 82. Active View parameters  (Sheet 1 of 4)

Parameter Description

View Only Makes the Active View pane available.

Generate Only Switches the pane to Report View and makes the Active View pane not available.

Select a Report Displays the report types created for the current batch. 

Sample File Used when the report type includes separate reports for each sample.

Total Rows The number of compound rows currently displayed in the pane. 

Showing Displays all compounds or only the flagged compounds.
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Column headings
Many column headings are specific to individual reports. See “Active View Report Contents” 
on page 404.

Status Indicates the status of the reported compound. 

• A yellow check mark indicates one of the following conditions:
– The compound was manually integrated.
– Any of the confirming peaks was manually integrated.
– The compound has quantitation flags. 

• A red check mark indicates that the QAQC checks failed.

• A green check mark indicates that none of these conditions exist.

When the compound is an internal standard, warnings are displayed only on the internal 
standard report. The Status column is blank for Manual Integration reports.

Compound Name Alphanumeric name assigned to the compound.

Compound Type Target Compound, Internal Standard, Surrogate, MSTune, Native, or Breakdown. 

QAQC Flags Indicates that the QAQC check for the sample failed.

Manual Integration reports do not use the QAQC column.

Quan Flags • Limit of Detection (LOD)
• Limit of Quantitation (LOQ)
• Limit of Reporting (LOR)
• Values between the limit of detection and the limit of quantitation, known as the J flag
• Upper Limit of Linearity (ULOL)

Quan flags do not apply to these sample types: Cal Std, Chk Std, Matrix Blank, or Solvent.

Manual Integration reports do not use the Quan Flag column.

Manual Flags Indicates manually integrated peaks. 

M: Indicates a manually integrated quantitative peak.
m: Indicates a manually integrated confirming peak.

Depending on the selected report, the Active View page contains any or all of the following parameters:

Quan Peak m/z Mass-to-charge ratio for the selected quantitative peak.

Total Response The sum of all Quan Peak Response values for the compound.

Quan Peak Response Response of the quantitative peak.

Quan peak RT Retention time for the quantitative peak.

Theoretical Amount Theoretical amount of the compound. Reports N/A when not applicable.

Concentration

Confirming n Mass Mass of the confirming peak.

Table 82. Active View parameters  (Sheet 2 of 4)

Parameter Description
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Confirming n 
Response

Response of the confirming peak.

Confirming n Manual 
Flag

Indicates a manually integrated confirming peak.

Confirming n Ion 
Ratio Flag

Indicates that the ion ratio is out of range. Not available for analog compounds.

Confirming n Ion 
Ratio

Actual ratio of the confirming ion response to the quantitation ion response.

Confirming n Range Acceptable range for the confirming ion.

Retention Time The time after injection when the compound elutes. The total time that the compound is 
retained on the column. 

Quan Mass The mass-to-charge ratio used to determine the peak area and peak height of the compound.

Response Sum of all Quan Peak Response values for the compound.

Injection 
Concentration

Calculated amount as the sample was injected, with no conversion applied.

Injection Units Injection units specified on the Calibration page in Method Development mode. See 
“Calibration” on page 173.

Sample Concentration The injected concentration multiplied by the conversion factor.

Sample Units Sample units specified on the Calibration page in Method Development mode. See 
“Calibration” on page 173.

QIon Mass range for the quantitative peak. When you select the analog detector in the signal 
parameters for the master method, the application displays this value as Analog and reports 
with spectra displays show the spectra as Not Available. See “Signal” on page 150.

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

Manual Integration reports

m/z Mass-to-charge ratio for the quantitative peak.

Method RT Apex retention time for the method-integrated peak.

Method Peak Height Height of the method-integrated peak.

Method Peak Area Area of the method-integrated peak.

Manual RT Apex retention time for the manually integrated peak.

Manual Peak Height Height of the manually integrated peak.

Manual Peak Area Area of the manually integrated peak.

Table 82. Active View parameters  (Sheet 3 of 4)

Parameter Description
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Internal Standard reports

Std Response Average of the internal standard’s response as found in the calibration file.

Minimum Response Minimum response time as specified on the ISTD page in Method Development mode. See 
“ISTD” on page 190.

Maximum Response Maximum response time as specified on the ISTD page in Method Development mode. See 
“ISTD” on page 190.

Sample Response Area found in the sample.

Std RT Average retention time as found in the calibration file.

Min RT Minimum retention time as specified on the ISTD page in Method Development mode. See 
“ISTD” on page 190.

Max RT Maximum retention time as specified on the ISTD page in Method Development mode. See 
“ISTD” on page 190.

Sample RT Retention time found in the sample.

Graphical data

Quan Peak 1

Calibration curve Displays a graphical view of the calibration curve for the selected compound and key 
statistical values for evaluating the quality of the calibration. 

Spectra Displays a comparison of the spectra found in the data and the method reference. 

QED Spectra Displays the averaged QED spectra from the raw data file and the datastore match. If the 
sample contains no QED data, the page is blank.

Confirming Ions Displays a graphical view of all qualifying/confirming ions for the selected sample and 
compound, and displays calculated ion ratios and ion ratio acceptance windows.

Table 82. Active View parameters  (Sheet 4 of 4)

Parameter Description
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Active View Report Contents

Each standard report that uses the Active View displays values that are common to all reports. 
See “Common Active View report columns” on page 405.

In addition to the common values, the following reports display additional active view 
features:

• Blank Report Active View columns

• Calibration Report Active View columns

• High Density Sample Report 1 and High Density Sample Report 1 Long Active View 
columns

• High Density Sample Report 2 and High Density Sample Report 2 Long Active View 
columns

• High Density Sample Report 3 and High Density Sample Report 3 Long Active View 
columns

• Internal Standard Summary Report Active View columns

• Ion Ratio Failure Report Active View columns

• Manual Integration Report Active View columns

• LCSLCSD Report Active View columns

• Method Detection Limit Report Active View columns

• Method Validation Report Active View columns

• MSMSD Report Active View columns

• Quantitation Report Active View columns

• Solvent Blank Report Active View columns
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Table 83. Common Active View report columns

Column Description

Status Indicates the status of the reported compound. 

• A yellow caution sign indicates one of the following conditions:

– The compound was manually integrated.

– Any of the confirming peaks was manually integrated.

– The compound has quantitation flags. 

– The compound has a QAQC failure.

• A green check mark indicates that none of these conditions exists.

When the compound is an internal standard, warning flags are displayed only on the 
internal standard report. 

Compound Name Alphanumeric name assigned to the compound.

Compound Type Target Compound, Internal Standard, Surrogate, MSTune, Native, or Breakdown. 

QAQC Flags Indicates that the QAQC check for the sample failed. 

The Method Validation and MDL reports do not use the QAQC column.

Quan Flags • Limit of Detection (LOD)
• Limit of Quantitation (LOQ)
• Limit of Reporting (LOR)
• Values between the limit of detection and the limit of quantitation, known as the J flag
• Upper Limit of Linearity (ULOL)

Quan flags do not apply to these sample types: Cal Std, Chk Std, Matrix Blank, or Solvent.

The Calibration report does not use the Quan Flags column. The Method Validation, 
Method Detection Limit, and LCSLCSD reports do not use the Quan Flags column.

Manual Flags Indicates manually integrated peaks. 
• M indicates a manually integrated quantitative peak.
• m indicates a manually integrated confirming peak.

Table 84.  Blank Report Active View columns  (Sheet 1 of 2)

Column Description

Retention Time Retention time for the quantitation mass. The time after injection when the compound 
elutes. The total time that the compound is retained on the column. 

Quan Mass Mass range for the quantitative peak.

Response Sum of all Quan Peak Response values for the compound.

Inj Conc Calculated amount as the sample was injected, with no conversion applied.
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Inj Units Injection units specified on the Calibration page in Method Development mode. See 
“Calibration” on page 173.

Sample Conc Calculated amount multiplied by the conversion factor.

Sample Units Sample units specified on the Calibration page in Method Development mode. See 
“Calibration” on page 173.

Table 85.  Calibration Report Active View columns 

Column Description

Curve Type The type of curve used when calibrating the compound (linear, quadratic, or average 
response factor).

Average RF The average response factor. Applicable if curve type is Average RF.

Average Response The average response for the internal standard across all calibration points. Applies only to 
Internal Standard sample types.

A0 The value with no X. Applies only to linear and quadratic curves. 

A1 The X value. Applies only to linear and quadratic curves.

A2 The X^2 value. Applies only to quadratic curves. 

R^2 The minimum correlation coefficient (r2) for an acceptable calibration (when in linear or 
quadratic mode). 

RSD Relative standard deviation. Applies only to internal standards and targets calibrated with 
an average RF curve.

Level The column specifies the level name; the field value specifies the data point used in 
calibration. This field can be Response Factor for external calibration, Response Ratio for 
internal linear or quadratic, or Relative Response Factor for Internal Average RF. There is 
one column for each level in the curve. If the batch uses an extended calibration, there 
might be more columns than calibration standards in the current batch.

Table 86. High Density Sample Report 1 and High Density Sample Report 1 Long Active View columns  

Column Description

m/z Mass-to-charge ratio for the quantitative peak.

Total Response The sum of all Quan Peak Response values for the compound.

Quan Peak Response Response of the quantitative peak.

Quan Peak RT Retention time for the quantitative peak.

T Amount Theoretical amount of the compound. Reports N/A when not applicable.

Conc Calculated (injected) amount.

Table 84.  Blank Report Active View columns  (Sheet 2 of 2)

Column Description
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Table 87. High Density Sample Report 2 and High Density Sample Report 2 Long Active View columns 

Column Description

m/z Mass-to-charge ratio for the quantitative peak.

Total Response Sum of all Quan Peak Response values for the compound.

Quan Peak Response Response of the quantitative peak.

Quan Peak RT Retention time for the quantitative peak.

T Amount Theoretical amount of the compound. Reports N/A when not applicable.

Conc Calculated (injected) amount.

Confirming 1 Mass Mass of the confirming peak.

Confirming 1 Response Response of the confirming peak.

Confirming 1 Manual Flag Indicates a manually integrated confirming peak.

Confirming 1 Ion Ratio Flag Indicates that the ion ratio is out of range. Not available for analog compounds.

Confirming 1 Ion Ratio Actual ratio of the confirming ion response to the quantitation ion response.

Confirming 1 Range Acceptable range for the confirming ion.

Table 88. High Density Sample Report 3 and High Density Sample Report 3 Long Active View columns  (Sheet 1 of 2)

Column Description

m/z Mass-to-charge ratio for the quantitative peak.

Total Response Sum of all Quan Peak Response values for the compound.

Quan Peak Response Response of the quantitative peak.

Quan Peak RT Retention time for the quantitative peak.

T Amount Theoretical amount of the compound. Reports N/A when not applicable.

Conc Calculated (injected) amount.

Confirming 1 Mass Mass of the confirming peak.

Confirming 1 Response Response of the confirming peak.

Confirming 1 Manual Flag Indicates a manually integrated confirming peak.

Confirming 1 Ion Ratio Flag Indicates that the ion ratio is out of range. Not available for analog compounds.

Confirming 1 Ion Ratio Actual ratio of the confirming ion response to the quantitation ion response.

Confirming 1 Range Acceptable range for the confirming ion.

Confirming 2 Mass Mass of the confirming peak.

Confirming 2 Response Response of the confirming peak.

Confirming 2 Manual Flag Indicates a manually integrated confirming peak.

Confirming 2 Ion Ratio Flag Indicates that the ion ratio is out of range. Not available for analog compounds.
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Confirming 2 Ion Ratio Actual ratio of the confirming ion response to the quantitation ion response.

Confirming 2 Range Acceptable range for the confirming ion.

Table 89.  Internal Standard Summary Report Active View columns

Column Description

Std Response Average of the internal standard’s response as found in the calibration file.

Minimum Response Minimum response time as specified on the ISTD page in Method Development 
mode. See “ISTD” on page 190.

Maximum Response Maximum response time as specified on the ISTD page in Method Development 
mode. See “ISTD” on page 190.

Sample Response Area found in the sample.

Std RT Average retention time as found in the calibration file.

Min RT Minimum retention time as specified on the ISTD page in Method Development 
mode. See “ISTD” on page 190.

Max RT Maximum retention time as specified on the ISTD page in Method Development 
mode. See “ISTD” on page 190.

Sample RT Retention time found in the sample.

Table 90.  Ion Ratio Failure Report Active View columns

Column Description

Quan Ion The ion for quantitative peak.

Qual Ion The ion for the confirming peak.

Quan Ion Response Response of the quantitation ion.

Qual Ion Response Response of the qualitative ion.

Ratio The ratio of the confirming ion response to the quantitation ion response.

Range The acceptable range.

Table 91. Manual Integration Report Active View columns  (Sheet 1 of 2)

Column Description

m/z Mass-to-charge ratio for the quantitative peak.

Method RT Apex retention time for the method-integrated peak.

Method Peak Height Height for the method-integrated peak.

Method Peak Area Area for the method-integrated peak.

Table 88. High Density Sample Report 3 and High Density Sample Report 3 Long Active View columns  (Sheet 2 of 2)

Column Description
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Manual RT Apex retention time for the manually integrated peak.

Manual Peak Height Height of the manually integrated peak.

Manual Peak Area Area of the manually integrated peak.

Table 92.  LCSLCSD Report Active View columns

Column Description

Spike Amount Lab control theoretical concentration.

LCS Concentration Lab control spike concentration.

LCS % Received Lab control concentration percentage.

Lower Limit % Recovery lower limit as specified in the master method. See the Limits section in 
“Editing the QAQC Page” on page 183.

Upper Limit % Recovery upper limit as specified in the master method. See the Limits section in 
“Editing the QAQC Page” on page 183.

LCSD Concentration Lab control spike duplicate concentration.

LCSD % Received Lab control spike duplicate concentration percentage.

RPD Lab control relative percentage difference.

Max RPD Lab control spike maximum relative percentage difference (set in method).

Number of Rec Failures Number of recovery failures for lab control spike concentration and lab control spike 
concentration duplicate.

Number of RPD Failures Number of relative percentage difference failures for lab control spike concentration 
and lab control spike concentration duplicate.

Note  For LCSLCSD batch reports, the application displays the active view peak graphics only when you click a 
field pertaining to a sample, such as the LCS or LCSD concentration fields. 

Table 93. Manual Integration Report Active View columns (Sheet 1 of 2)

Column Description

m/z Mass-to-charge ratio for the quantitative peak.

Method RT Apex retention time for the method-integrated peak.

Method Peak Height Height for the method-integrated peak.

Method Peak Area Area for the method-integrated peak.

Manual RT Apex retention time for the manually integrated peak.

Table 91. Manual Integration Report Active View columns  (Sheet 2 of 2)

Column Description
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Manual Peak Height Height of the manually integrated peak.

Manual Peak Area Area of the manually integrated peak.

Table 94.  Method Detection Limit Report Active View columns

Column Description

Avg Conc The average of the concentration for the compound across all samples.

Std Dev The standard deviation of the concentration.

t-stat The t-statistic value defined as the ratio of a coefficient to its standard error. 

% RSD %RSD of concentrations

MDL Method detection limits. The calculated limit of detection.

Note  For Method Detection Limit batch reports, the application displays the active view peak graphics only when 
you click a field pertaining to a sample. These numbered fields are to the right of the MDL column.

Table 95.  Method Validation Report Active View columns

Column Description

Avg Conc The average of the concentration for the compound across all samples.

Theo Conc Values for each compound that represent the expected theoretical concentration of 
that compound in the sample as defined in the master method. See the Meth Val 
section in “Editing the QAQC Page” on page 183.

% Diff The percentage difference calculated as ([MethodValidationMeanValue minus the 
Theo Conc] divided by the Theo Conc) multiplied by 100.

Min Conc Calculated by (Min recovery percent * Theo Conc) divided by 100.

Max Conc Calculated by (Max recovery percent * Theo Conc) divided by 100.

% RSD %RSD of concentrations

Max % RSD The maximum relative standard deviation (RSD) of the set of observed 
concentrations for a component across the set of method validation samples (when in 
average RF mode) as defined in the master method. See the Meth Val section in 
“Editing the QAQC Page” on page 183. 

Calculated Amount <Sample 
Name>

This field is reproduced for every Method Val sample.

Table 93. Manual Integration Report Active View columns (Sheet 2 of 2)

Column Description
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Table 96.  MSMSD Report Active View columns 

Column Description

Unknown Concentration Concentration of the unknown sample.

Spike Amount Matrix spike theoretical concentration.

MS Concentration Matrix spike concentration.

MS % Received Matrix spike concentration percentage.

Lower Limit % Recovery lower limit as specified in the master method. See the Limits section in 
“Editing the QAQC Page” on page 183. 

Upper Limit % Recovery upper limit as specified in the master method. See the Limits section in 
“Editing the QAQC Page” on page 183.

MSD Concentration Matrix spike duplicate concentration.

MSD % Received Matrix spike duplicate concentration percentage.

RPD Matrix spike relative percentage difference.

Max RPD Maximum relative percentage difference as specified in the master method. See the 
Lab Control section in “Editing the QAQC Page” on page 183.

Number of Rec Failures Number of matrix spike and matrix spike duplicate failures.

Number of RPD Failures Number of relative percentage difference failures.

Note  For MSMSD batch reports, the active view peak graphics are shown only when you click a field pertaining to 
a sample, such as Unknown, MS, or MSD concentration fields. 

Table 97.  Quantitation Report Active View columns  (Sheet 1 of 2)

Column Description

RT Retention time for the peak. The time after injection when the compound elutes. The 
total time that the compound is retained on the column. 

QIon Mass range for the quantitative peak. 

When you select the analog detector in the signal parameters for the master method, 
the application displays this value as Analog and reports with spectra displays show 
the spectra as Not Available. See “Signal” on page 150.

Response Sum of all quantitative peak response values for the compound.
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Injected Concentration Calculated amount as the sample was injected, with no conversion applied. 

As each additional sample is processed, calibration data change; therefore, except for 
the final sample in a batch, a report in active view or report view shows different 
values from a physical (PDF, XML, or printed) report created at the end of 
processing. To avoid this discrepancy, do one of the following:

• For the standard Quantitation Report or Quantitation Report - 2, observe the 
active or report view for only the last sample in the batch.

• For the custom Quantitation Report, make the report a batch-level report.

Injected Units Injection units specified on the Calibration page in Method Development mode. See 
“Calibration” on page 173.

Sample Conc Calculated injection amount multiplied by the conversion factor. See the Injected 
Concentration description.

Sample Units Sample units specified on the Calibration page in Method Development mode. See 
“Calibration” on page 173.

Table 98. Solvent Blank Report Active View columns

Column Description

RT Retention time for the quantitative peak. The time after injection when the compound 
elutes. The total time that the compound is retained on the column. 

QIon Mass range for the quantitative peak. 

When you select the analog detector in the signal parameters for the master method, the 
application displays this value as Analog and reports that display spectra report the spectra 
as Not Available. See “Signal” on page 150.

Response Sum of all Quan Peak Response values for the compound.

Method Method of evaluation defined in the method.

Upper Limit Defined in the method.

Table 97.  Quantitation Report Active View columns  (Sheet 2 of 2)

Column Description
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Working in the Local Method View 
A local method is a copy of a master method associated with a batch. You can edit only the 
local copy of the method, or you can edit the master method and overwrite the local copy 
with the edited master method.

In the Local Method view, you can edit the local method parameters. See Local Method View. 
A local method is a copy of a master method associated with a batch. Local methods are 
named BatchName_MasterMethodName. 

 To open the Local Method View

1. Do one of the following:

From the dashboard, click Analysis.

–or–

Click Analysis in the navigation pane.

2. In the Analysis navigation pane, click Local Method.

The Local Method view for the currently selected batch opens. 

You can edit many of the method parameters in a local method. Editing the local method 
does not affect parameters in the master method.

For detailed descriptions of method parameters, see “Working with Master Methods” on 
page 100.

3. Enter any local changes to the method.

4. When you have finished editing the local method, choose File > Save.

5. To process the batch or create new reports with the edited local method, return to the 
Batch View and submit the batch.

 To overwrite the local method with the master method in the Batch View

In the Batch View, click Update.

The application overwrites the local method with the master method of the same name. 
You can use this feature to overwrite an edited local method with the original master 
method or to overwrite the local method with an updated master method.
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Figure 107. Local Method View
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Working in the Batch Template Editor
In the Batch Template Editor, you can create a batch template that contains the basic settings 
for your batches. See “Batch Template Editor” on page 421. Batches are created as a routine 
operation and, because the nature and types of batches are often similar (in some cases 
specified by laboratory operating procedure), you can define a batch template that supplies 
the basic structure of a batch. 

To create a batch using a batch template, choose File > New > Batch Using Wizard from the 
application menu. See “Creating a Batch Using the Batch Wizard” on page 331.

Follow these procedures:

• To create a new batch template

• To specify active compounds

• To specify template method information

• To specify active compounds

• To insert a sample into the list

• To copy a sample

• To remove samples from the list

• To edit sample values

• To add multiple samples of the same type

• To specify report options

• To specify active compounds

 To create a new batch template

1. Choose File > New > Batch Template from the application menu.

The Open Method dialog box opens where you can select a master method to use for 
your template.
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2. Select a master method and click Open.

The Batch Template Editor opens. For detailed descriptions of all parameters, see “Batch 
Template Editor” on page 421.

The editor uses the selected master method for the template. 

 To open a batch template

1. Choose File > Open > Batch Template from the application menu.

The Open Batch Template dialog box opens.

2. Select a batch template and click Open.

The Batch Template Editor opens with the settings from the selected template. To view 
the editor and for detailed descriptions of the parameters, see “Batch Template Editor” on 
page 421.

 To specify template method information

1. From the Project list, select a project name.

2. From the Subproject list, select a subproject name.

3. To change the current method, click Select Method and select a new method.

Tip  If there are no projects or subprojects to select, go to the Project Administration 
view of the Configuration mode and create a new subproject. See “Project 
Administration” on page 49.



 6 Using the Analysis Mode
Working in the Batch Template Editor

Thermo Scientific TraceFinder User Guide 417

 To add a sample to the batch

Right-click and choose Add Sample from the shortcut menu, or click the add sample 
icon, .

The application adds a new, Unknown sample to the end of the sample list.

 To insert a sample into the list

1. Select the sample above which you will insert a new, Unknown sample.

2. Right-click and choose Insert Sample from the shortcut menu.

The application inserts a new, Unknown sample above the selected sample.

 To copy a sample

1. Select the sample that you want to copy.

2. Right-click and choose Insert Copy Sample from the shortcut menu.

The application inserts the copy above the selected sample.

 To remove samples from the list

1. Select the sample that you want to remove.

Use the SHIFT or CTRL keys to select multiple samples.

2. Right-click and choose Remove Selected Samples from the shortcut menu, or click the 
Remove Sample icon, .

The application removes the selected samples from the list.

 To edit sample values

1. For each sample, click the Sample Type column and select a sample type from the list.

Available sample types

Matrix Blank Solvent Unknown/TIC

Cal Std Chk Std Unknown

LCS MDL MS

LCSD Method Val MSD

Tune Tune/Breakdown Breakdown

Inserted 
sample
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2. For each Chk Std or Cal Std sample, click the Level cell and select a level from the list.

The calibration and QC levels were defined in the master method. If there is nothing to 
select in the Level list, do the following:

a. Close the Batch Template Editor.

b. Return to the Method Development mode.

c. Open the master method.

d. Click the Compounds tab.

e. Click the Calibration Levels tab.

f. Add the levels.

g. Save the method.

h. Return to the Analysis mode, and begin this batch template again.

You must close your original batch template without saving it and start a new template. 
For detailed instructions, see “Editing a Master Method” on page 119.

3. (Optional) Type a sample ID, sample name, or comment.

These values can be any text string.

 To add multiple samples of the same type

In the Repeat Sample Count column, type the number of samples that you want to create 
for each sample type.

When you use this template to create a batch, the batch will contain this number of 
individual samples of the specified type. In the batch, you can change any of the column 
values for the individual samples.

 To specify report options

1. To specify the type of report output to create for each report type, select the check box in 
the appropriate column.

By default, all report output types are cleared.

2. To duplicate the output type for all reports below the selected report, click the cell to 
select it, and then right-click and choose Copy Down from the shortcut menu.

All check boxes in the column below the selected cell duplicate the selected or cleared 
state of the selected cell.

You can duplicate the output type only for reports that have this output format available.
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3. To duplicate the selected report output formats for all samples in the batch, right-click the 
cell and choose Apply Selection to All Samples from the shortcut menu.

Example
The application copies selected report output formats from the first sample.

The application duplicates the selected report output formats to all samples in the batch.
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 To specify active compounds

1. In the sample table, click anywhere in the sample row to select the sample for which you 
want to specify active compounds.

Compound selections are specific to a sample. You can select different compounds for 
each of the samples even if they are the same sample type. 

2. In the Compound Active Status area, select the Active check box for each compound that 
you want identified in the selected sample.

If you created compound groups, you can make the entire group active or inactive. 
Right-click and choose the group from the list.

Inactive groups Active groups



 6 Using the Analysis Mode
Working in the Batch Template Editor

Thermo Scientific TraceFinder User Guide 421

Figure 108. Batch Template Editor

Table 99. Batch Template Editor parameters  (Sheet 1 of 2)

Parameter Description

Template Method Information

Project The top-level project for the batch.

Subproject The lower-level project for the batch.

Method The master method to use for the batch. The Select Method button opens the Open 
Method dialog box where you can select a different master method for the batch template.

Assay Type The name for the analysis type to be targeted by the method. The assay type associates the 
method with the analysis of a compound or specific class of compounds (for example, an 
assay type of PAH might be used for the analysis of Polynuclear Aromatic Hydrocarbons). 
The application uses this assay type in the batch template. You can also select an 
appropriate combination of method and batch template. 
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Column values

Sample Type Defines how the application processes the sample data. Each sample is classified as one of 
the following sample types: Matrix Blank, Solvent, Cal Std, Chk Std, Unknown, 
Unknown/TIC, LCS, LCSD, MDL, MS, MSD, Method Val, Tune, Tune/Breakdown, or 
Breakdown

Level The level defined for a calibration sample or quality control sample.

Sample ID A user-defined, alphanumeric string that identifies a sample.

Sample Name A user-defined name that identifies a sample.

Comment A user-defined comment for the sample.

Repeat Sample Count Number of samples to create for this sample type.
Sample Level / Batch Level

Report Name The name of a report. 

Type Standard, Custom, or Target Screening

Print Sends reports to the printer. 

Create PDF Saves reports as PDF files. 
Available only for standard and target screening reports.

Create XML Saves reports as XML files. 
Available only for standard reports.

Create XLSM Saves reports in Excel Macro-Enabled Workbook (.xlsm) format.
Available only for custom reports.

Compound Active Status

Compound Name List of all compounds for the method.

Active Compounds to identify in the selected sample.

Table 99. Batch Template Editor parameters  (Sheet 2 of 2)

Parameter Description
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Reports

This appendix contains information about standard and custom reports.

The report engine can generate several different types of reports designed to meet the needs of 
the laboratory, the laboratory's customers, and key regulatory agencies that might review the 
results. The reports listed in this appendix meet the requirements of various methods and 
worldwide regulatory agencies and are designed to help track the performance of the system 
and method. The TraceFinder application can produce both standard reports and custom 
reports.

Specifying Reports
As a user in the ITAdmin or LabDirector role, you can configure a list of reports that are 
available for the Method Development or Acquisition mode. 

For detailed information about configuring reports in the Configuration mode, see 
“Specifying the Reports Configuration” on page 68.

For detailed information about specifying reports when you create a method in the Method 
Development mode, see “Editing the Reports Page” on page 202.

For detailed information about viewing batch reports in the Acquisition mode, see “Selecting 
and Reviewing Reports” on page 265.

Contents

• Specifying Reports

• Report Flags

• Sample Standard Reports
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Standard Reports

For each standard report you generate, you can create a version in hardcopy print, as a PDF 
(.pdf ) file, or in an XML (.xml) output format. In addition to the report type, you can specify 
a report description for each of your reports. The default report description is the report 
name.

The TraceFinder application can generate the following types of standard reports:
• Batch Report 
• Batch Report Rev 1
• Blank Report 
• Breakdown Report
• Calibration Report 
• Check Standard Report 
• Chromatogram Report 
• Compound Calibration Report 
• Compound Calibration Report - Alternate
• Confirmation Report 
• Confirmation Report 2
• High Density Calibration Report 
• High Density Internal Standard Report
• High Density Internal Standard Report Long
• High Density Sample Report 1 
• High Density Sample Report 1 Long
• High Density Sample Report 2 
• High Density Sample Report 2 Long 
• High Density Sample Report 3 
• High Density Sample Report 3 Long
• Internal Standard Summary Report 
• Ion Ratio Failure Report 
• LCSLCSD Report
• Manual Integration Report 
• Method Detection Limit Report
• Method Report 
• Method Validation Report
• MSMSD Report
• Quantitation Report 
• Quantitation Report - 2
• Solvent Blank Report
• Surrogate Recovery Report 
• TIC Report 
• TIC Summary Report 
• Tune Report

To view an example of each type of standard report, see “Sample Standard Reports” on 
page 430.
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Custom Reports

For each custom report you generate, you can create a hardcopy printout or an Excel 
Macro-Enabled Workbook (.xlsm) output file. The default report description is the report 
name. 

A user in the ITAdmin or LabDirector role can configure custom reports to generate a single 
report for an entire batch or create a separate report for each sample. 

The TraceFinder application can generate the following types of custom reports:

• AltCalibrationReport
• Alternate BatchReport
• Alternate CalibrationReport
• Alternate ConfirmationReport
• Alternate MatrixSpikeReport
• Alternate SampleReport
• Alternate SummaryReport
• BatchReport
• BlankReport 
• CalibrationDensityReport 
• CalibrationReport 
• CheckStandardReport
• CompoundCalibrationReport 
• ConfirmationReport 
• ConfirmationReport2
• HighDensitySampleReport1Long
• HighDensitySampleReport2Long
• HighDensitySampleReport3Long
• HighDensitySampleReport4
• HighDensitySampleReport5
• QuantitationReport
• SteroidAnalysisReport

Target Screening Reports

The TraceFinder application can generate the following types of target screening reports:

• Target Screening Long Report
• Target Screening Summary Report
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Figure 109. Reports page showing standard reports
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Figure 110. Reports page showing custom reports

Figure 111. Reports page showing target screening reports

Note  Target screening reports are available only when you install the ToxID software and 
enable the target screening features. See “Enabling Optional Features” on page 88.
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Report Flags
When generating or viewing a report, you might see one of the following quantification or 
calibration flags listed on the page. 
 

A flags failure is identified by an asterisk (*), a shaded row, or the word Fail.

Table 100. Quantification flags

Flag Definition

b Compound was observed at a concentration in a Matrix Blank sample above the 
specified limit. 

s Compound was observed at a response in a solvent blank sample above the specified 
limit. 

J Compound was observed at a concentration above the limit of detection, but below 
the limit of quantitation. 

I or * Confirming/qualifying ion ratio for a compound was observed outside the target 
ratio range or the coelution between quantification and confirming/qualifying ion 
was larger than acceptable limit. 

C Compound was observed at a concentration above the specified carryover limit. 
? Compound was observed at a concentration above the specified linearity limit. 
D Compound was observed at a concentration below the specified limit of detection. 
Q Compound was observed at a concentration below the specified limit of 

quantitation. 
POS Compound was observed at a concentration above the specified cutoff. 

Table 101. Calibration flags

Flag Definition

D Calibration for this compound exceeded the specified maximum percent relative 
standard deviation (%RSD). 

F Response factor for this compound was below the specified minimum response 
factor (Min RF). 

R Calibration for this compound was below the specified minimum correlation 
coefficient (r2). 

A Back calculation of the calibration points for this compound exceeded the 
specified maximum percent difference (Max %D). 

X Calibration point for this compound was excluded from the overall calibration 
by manual selection. 

X(ISNF) Calibration point for this compound was excluded from the overall calibration 
because its associated internal standard was not found. 
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Values on a report that are the result of a manual integration use an uppercase M to signify a 
manually integrated quantification ion and a lowercase m to signify a manually integrated 
qualifying/confirming ion. On alternate reports, manual integration uses a black box around 
the value. 
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Sample Standard Reports
This section shows samples of the following standard report types: 

• Batch Report
• Batch Report Rev 1
• Blank Report
• Breakdown Report
• Calibration Report
• Check Standard Report
• Chromatogram Report
• Compound Calibration Report
• Compound Calibration Report - Alternate
• Confirmation Report
• Confirmation Report 2
• High Density Calibration Report
• High Density Internal Standard Report
• High Density Internal Standard Report Long
• High Density Sample Report 1
• High Density Sample Report 1 Long
• High Density Sample Report 2
• High Density Sample Report 2 Long
• High Density Sample Report 3
• High Density Sample Report 3 Long
• Internal Standard Summary Report
• Ion Ratio Failure Report
• LCSLCSD Report
• Manual Integration Report
• Method Detection Limit Report
• Method Report
• Method Validation Report
• MSMSD Report
• Quantitation Report
• Quantitation Report - 2
• Solvent Blank Report
• Surrogate Recovery Report
• TIC Report
• TIC Summary Report

Tip  To easily view reports in landscape format, choose View > Rotate View > Clockwise 
from the Adobe Acrobat™ viewer menu. 
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Batch Report 
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Breakdown Report 
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Calibration Report 
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Calibration Density Report 
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Chromatogram Report 
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Compound Calibration Report 
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Compound Calibration Report - Alternate
�
�
0
�

"

�
%

�

�
�
�
�
�
�
�
	

�
�
���

�
��
�
�

�
�
�
�

�

A

B
��
�

�
�
��

-
�
�

.
�
�
�
/

0�
1
�

�
�
�
�
�/

2
1
�

/

�
�
�
�
�
�
�
�
	

�
�

�


�
��
�
��
�
�

�
�
�
�
�
�
�
�

�
�
��


�

�
�
�
�
�
�


�

�
�
�

�
�
�

�
�
���
�
���

�
�
�
�
�
�


�
�
�
 
�
�
�
!
�
"
�
�

�
�
�
�
�
�


�
#�
�
�$

�
 
�
�
�
!
�
"
�
�

 
�%
�
��
&'
��
%

�
�
�
(
�
'
%
�
�)
�
�
�
�

�
�
��
�*
�
�

+2
�*
�
�
'
%
�

2
��
�*
�
�
'
%
�

�
�
,
�
�

�
�
-
-

�
'
�
�
��
��
�

�
%
��
-

.
�

2
 
�
��
/
-

�
�%
�

�
%
/
�

�
�
$
�

�
%
/
�

�
���
�)
�
�
�



�
-
(
�
%
-
�
�&
�
�
��
�

+2
�*
��
�

2
��
�*
��
�

�
0
�
6
�

1
�
#�
�

�
2
"
�
!
�
1

2
�
3
�
�
#�
�
�

1
1
#�
�

�
�
�

)
4*

�
�
0
�
6
�
�
�
�
�
�
�
�
�
�

�
�
#�
�

1
!
#�
�

1
0
�
6
�

!
�
#�
�

�
�
"
!
�
�
�

2
�
3
"
�
#1
3
!

!
1
#"
3

�
�
�

)
4*

�
1
0
�
6
�
�
�
�
�
�
�
�
�
�

�
1
#�
�

!
3
#�
�

!
0
�
6
�

3
�
#�
�

�
�
1
!
�
!
�

3
2
�
"
2
#1
�
�

3
1
#1
1

�
�
�

)
4*

�
!
0
�
6
�
�
�
�
�
�
�
�
�
�

�
!
#�
�

2
�
#�
�

�
0
�
6
�

�
1
�
#�
�

�
�
!
�
�
3
�
"

3
�
2
1
�
#!
"
�

�
1
1
#"
!

�
�
�

)
4*

�
�
0
�
6
�
�
�
�
�
�
�
�
�
�

2
�
#�
�

�
!
!
#�
�

�
�
0
�
6
�

1
�
�
#�
�

�
�
�
"
�
3
2
1

3
�
�
�
2
#!
�
�

1
�
!
#1
�

�
�
�

)
4*

�
�
�
0
�
6
�
�
�
�
�
�
�
�
�
�

�
�
�
#�
�

1
!
�
#�
�

�
�
0
�
6
�

�
1
�
#�
�

1
!
1
3
�
�
�
"

�
"
3
2
�
#�
�
�

�
�
�
#"
2

�
�
�

)
4*

�
�
�
0
�
6
�
�
�
�
�
�
�
�
�
�

1
"
�
#�
�

�
3
!
#�
�

�
1
0
�
6
�

�
!
�
#�
�

!
�
2
2
!
3
�
3

�
"
�
�
�
#2
�
!

�
!
1
#�
!

�
�
�

)
4*

�
�
1
0
�
6
�
�
�
�
�
�
�
�
�
�

"
�
1
#�
�

�
�
3
#�
�

�
�
%
'
�
��5
�+
%
��
/
��
��
�
�

�
�
���
��
��
�
%
��
��
/
-
��
 
�6


2
 
7�
�
�6
�

�
-
(
�
%
-
�
�&
�
�
��
�7
�

�6
�

�2
8
'
�
��
�
7�
*
�6
�*
�
�
'
%
�



A Reports
Sample Standard Reports

444 TraceFinder User Guide Thermo Scientific

�
�
/
�
�1
��
&�
1

�
�
�
(
�
'
%
�
��
�
���
��
��
�
%
�

�
(
�
��
�9
�*
��
�
�%
�
��

�
�
�
�)
�
�
�
�

+%
-
��
'
�
�
%
��

�
-
�
��

�
�
�
�
�
�
�
�
	

�
�

�


�
��
�
��
�
�

�
�
�
�
�
�
�
�

�
�
��


�

�
�
�
�
�
�


�

�
�
�

�
�
�

�
�
���
�
���

�
�
�
�
�
�


�
�
�
 
�
�
�
!
�
"
�
�

�
�
�
�
�
�


�
#�
�
�$

�
 
�
�
�
!
�
"
�
�

�
�
�
�
�
%
�

�
���
� 
�
��

2
�
�
(
��
�)
�
�
�

�
�
,
�
�

�
���
�)
�
�
�

2
�
�
(
��
�+
 

:
��
��
�
�
-

�
�
0
�
6
�
�
�
�
�
�
�
�
�
�

1
�
�
0
�
6
�
�
�
�
�
�
�
�
�
�

�
4�
�
41
�
�
�
��
��
�
��
�
��
�

�
0
�
6
�

"

�
1
0
�
6
�
�
�
�
�
�
�
�
�
�

�
�
1
0
�
6
�
�
�
�
�
�
�
�
�
�

�
4�
�
41
�
�
�
��
�1
�
�1
2
��
�

1
0
�
6
�

"

�
!
0
�
6
�
�
�
�
�
�
�
�
�
�

!
�
!
0
�
6
�
�
�
�
�
�
�
�
�
�

�
4�
�
41
�
�
�
��
�!
�
�1
�
��
�

!
0
�
6
�

"

�
�
0
�
6
�
�
�
�
�
�
�
�
�
�

"
�
�
0
�
6
�
�
�
�
�
�
�
�
�
�

�
4�
�
41
�
�
�
��
��
�
��
�
��
�

�
0
�
6
�

"

�
�
�
0
�
6
�
�
�
�
�
�
�
�
�
�

�
�
�
�
0
�
6
�
�
�
�
�
�
�
�
�
�

�
4�
�
41
�
�
�
��
�1
�
��
�
��
�

�
�
0
�
6
�

"

�
�
�
0
�
6
�
�
�
�
�
�
�
�
�
�

�
�
�
�
0
�
6
�
�
�
�
�
�
�
�
�
�

�
4�
�
41
�
�
�
��
�!
�
��
"
��
�

�
�
0
�
6
�

"

�
�
1
0
�
6
�
�
�
�
�
�
�
�
�
�

3
�
�
1
0
�
6
�
�
�
�
�
�
�
�
�
�

�
4�
�
41
�
�
�
�3
��
�
��
�
��
�

�
1
0
�
6
�

" �
�
%
'
�
��5
�+
%
��
/
��
��
�
�

�
�
���
��
��
�
%
��
��
/
-
��
 
�6


2
 
7�
�
�6
�

�
-
(
�
%
-
�
�&
�
�
��
�7
�

�6
�

�2
8
'
�
��
�
7�
*
�6
�*
�
�
'
%
�



 A Reports
Sample Standard Reports

Thermo Scientific TraceFinder User Guide 445

Confirmation Report 
����������

	
��
���
��

���
�

��
��
�����
�����
�

������������

���
������

��������

����� ���� 

!��"�� �  $��� 

%����&�

��'��#�'��

�  $��� $�%�$�&�'  

�  $��� ("�')

�%�$�&�'  

�����
�#�'��%���*���'��������+�'#�'������*���'��	%1��'����

��,-�.�$$��� �  / ��,-�.�$$��� �  �0 �0,�  �/��������%�,-�.�'

%*1%���

%*1����
�
"� .+�
'�2������
����
�"�#�
&�
� ( ��
�3�"���%����'��%����'���  $��� �%������,-�.�$$��� �  (
�4

%�
�����
�


�&,(�&���!��
"�

	
3�"��& *���'�

�&,(�&���!

����
���
������ &(',

5
��� & 66&/�/

//6�//'$������

��������,(,67���
����',(,/�1�6,(,/7
��'��
����
���
+�

���'�	�
� ��,��(  18  &( '

���
�	�
��,��(  18 ,6( &

#'���'���
&����.%9:9�.�;�	<	�
�
��������'�
�;��<��

2�+�
;�=<��
��
��2�'�����;%<%���"���
�'����;��<���
�'����;��.*<����'����;��<!'�
>;��<*�'+�
����'�
>



A Reports
Sample Standard Reports

446 TraceFinder User Guide Thermo Scientific

Confirmation Report 2

��������

		
��
����

�����
����

���������

�����������

����� �����������	

� ���
���� ��!��"�
��"

#��$ � �""%���"

&�� 
'�

	�(
�)
(��

�""%���"*�+�*�,�-""

�""%���".$�(/

�+�*�,�-""

	
�����)
(��+���)���(��������*�()
(������)���(���++
�(��
�

���,�-�*%���"�"". ���,�-�*%���"�"" �/"�/��""�.��������&��,�-�-

��0�$��'�	
�$�

�,�.�,���#)���(��	
�$�

�,�.�,���#

������

���
��� ,.-�

8����1����2� ,"33,.�.

..3�..-%�
! ��1����2�

���

����.�34����!���-�.�.�5�3�.�.4

���(����

�"�

���(����

���

����

����

&)5+���

&)5�������$� -*��(�6 ���
����$�)
�'���"."���
0�$���+����(��+����(���""%���"�+�������,�-�*%���"�"".��7

	
��
��'������ +
�
�������

���(��
��"�����.""58"",."-

������
������.""58"�3.",



 A Reports
Sample Standard Reports

Thermo Scientific TraceFinder User Guide 447

High Density Calibration Report

��������	
����
���������	�������

���������

�	
�����	��

�
��� ������ !"��


����������

������ !

������������

������ ��������

 ����!�


����"����

��������#���#���-��

��������.���/

���#���-��



A Reports
Sample Standard Reports

448 TraceFinder User Guide Thermo Scientific

High Density Internal Standard Report 



 A Reports
Sample Standard Reports

Thermo Scientific TraceFinder User Guide 449

High Density Internal Standard Report Long



A Reports
Sample Standard Reports

450 TraceFinder User Guide Thermo Scientific

High Density Sample Report 1 
��������	
�����������	��
���


���������

�����������

����� ���������	��

� ���
����

��������

��!��
�
"�#

$��% � �

&��	


'�� 
(�

���)�*)���

�

&��	
+�,�+�-�#



�

&��	
.%��/

�,�+�-�#



�
�����*)���,����������������0��*)���������������,1)����
�

��23�4�+&���
�

5 ��23�4�+&���
�

 �6
�62�

�5��������'�23�4�#

4��� 
��� *
���������

������67��
5�.�-

8�
�����
#5.
:���$

�8�
�����
#5.�����$

������67��
�#.
�

8�
������-2.-����$

�8�
������-2.�����$

	���-.�-�)��9-.�-: 	���-.���)��9-.�#:

,)�
��"����

������67��
2:.
-

���;�8�����-��:2��
 ���;�8�����-
5
:2
2: ���;�8�����-
::-5�5

�8�
������-�.�����$

	���-.#2�)��9-.#
:

8�
������-2.�-���$

�
���8�����

#�2-::- �
���8�����-��:2��
 �
���8�����-
5
:2
2: �
���8�����-
::-5�5

������67���2.
�

4/��<�+4/)��

���;�8�����

#�2-::-

	���-.�2�)��9-.�
:

�8�
�����
25�.�����$

8�
�����
25�.:����$

��
���
%��� �<����
7)��

������67��
�2.��

8�
�������5.
:���$

�8�
������-�.�����$

������67��
�#.
�

8�
�����
��.
#���$

�8�
�����
��.�����$

	���-.#��)��9-.#�: 	���-.#��)��9-.#�:

8�()%���+�42

������67��
-5.�-

���;�8�����2���-���5 ���;�8�����
:
5#2�: ���;�8�������5�:2�:

�8�
������-�.�����$

	���-.�:�)��9-.�5:

8�
������-�.�5���$

�
���8�����-��##2## �
���8�����2���-���5 �
���8�����
:
5#2�: �
���8�������5�:2�:

������67��
�2.�#

8�()%���+�4

���;�8�����-��##2##

	���-.#2�)��9-.#2:

�8�
������-�.�����$

8�
������-
.2:���$

'�� 
�<� *�
�)%��)(

������67��55.
�

8�
�����
25
.�2���$

�8�
�����
25�.�����$

������67��2��.��

8�
�����
:2�.#-���$

�8�
�����
:2�.�����$

	���-.:5�)��9-.:5: 	���#.�-�)��9#.��:

4,'�

������67��
�:.��

���;�8������
:�
��2 ���;�8�����
��2#-
� ���;�8�����-��-��
:

�8�
������2�.�����$

	���#.���)��9#.��:

8�
������2�.
-���$

�
���8����������5:� �
���8������
:�
��2 �
���8�����
��2#-
� �
���8�����-��-��
:

������67��:�.��

4/��<�

���;�8����������5:�

	���-.�5�)��9-.��:

�8�
������-�.�����$

8�
������-�.�5���$

� )���� 
/�� '
�
%�
�
� 
�

������67��
5
.
�

8�
�����
��.
2���$

�8�
�����
��.�����$

������67��
:�.��

8�
������2�.2����$

�8�
������2�.�����$

	���#.
��)��9#.
2: 	���#.2��)��9#.2�:

��)(�%�
��)(

������67��2�:.��

���;�8�����
2����-� ���;�8�����5
:

��� ���;�8�����#�:#�
�#

�8�
������-�.�����$

	���#.���)��9#.�#:

8�
������-�.#2���$

�
���8�����-
2--�#� �
���8�����
2����-� �
���8�����5
:

��� �
���8�����#�:#�
�#

������67��
-�.
�

#>4&+�$?

���;�8�����-
2--�#�

	���#.
2�)��9#.

:

�8�
������2�.�����$

8�
������2�.
#���$

� )����(�7
�� �>4&+����
"����

������67��
�
.
�

8�
������2�.�#���$

�8�
������2�.�����$

������67��
��.�5

8�
������-�.�����$

�8�
������-�.�����$

	���#.55�)��9#.5�: 	����.�-�)��9�.��:

8%����)��)(

������67��
2�.
�

���;�8���������-#�� ���;�8�����
-5�2
2�
 ���;�8�����2�25:��#

�8�
�����
��.�����$

	����.�5�)��9�.��:

8�
�����
��.
#���$

�
���8�����2���-�-2 �
���8���������-#�� �
���8�����
-5�2
2�
 �
���8�����2�25:��#

������67��
�:.
�

��
� )��)()�

���;�8�����2���-�-2

	���#.���)��9#.�
:

�8�
������2�.�����$

8�
������2�.�
���$

� )�%�
��)( '�� )(�� )
�+48

������67��
2�.
�

8�
�����
��.2#���$

�8�
�����
��.�����$

������67��
-#.��

8�
������-�.�#���$

�8�
������-�.�����$

	����.#��)��9�.#
: 	����.���)��9�.�#:

8�()%���

������67��

�.�#

���;�8�����2�:#-
�� ���;�8�����
�:2:2��� ���;�8�����##�2
��:

�8�
������-�.�����$

	����.:#�)��9�.:�:

8�
������-�.�5���$

�
���8�����

����-
 �
���8�����2�:#-
�� �
���8�����
�:2:2��� �
���8�����##�2
��:

������67��
25.
-

�<�
/��)�

���;�8�����

����-


	����.�5�)��9�.��:

�8�
������-
.�����$

8�
������-
.�-���$

*��!���!��(����4,@A@�4�B��C�
�����)
�"�)����B��C����<
0��B�DC�)����)�<��)�)��B,C,���%�)
���)�)�B��C������)�)�B��4�C	����)�)�B��C$���;B��C�
�0���������;



 A Reports
Sample Standard Reports

Thermo Scientific TraceFinder User Guide 451

High Density Sample Report 1 Long
&&)! �,���)�<��������	��
���
��
�!

���������

�����������

����� ���������	��

� ���
����

��������

��!��
�
"�
�

���� � �

&��	


 �� 
!�

���)�")���

�

&��	
#�,�#�$�%



�

&��	
.���/

�,�#�$�%



�
�����")���,����������������0��")���������������,1)����
�

��23�4�#&���
�

5 ��23�4�#&���
�

 �6
�62�

�5�������� �23�4�%

4/��<�#4/)�� 4��� 
��� "
���������

������67���2.
�

8�
�����
25�.:�����

�8�
�����
25�.������

������67��
5�.�$

8�
�����
%5.
:����

�8�
�����
%5.������

������67��
�%.
�

8�
������$2.$�����

�8�
������$2.������

	���$.�2�)��9$.�
: 	���$.�$�)��9$.�$: 	���$.���)��9$.�%:

,)�
��"����

������67��
2:.
$

���;�8�����

%�2$::$ ���;�8�����$��:2��
 ���;�8�����$
5
:2
2: ���;�8�����$
::$5�5

�8�
������$�.������

	���$.%2�)��9$.%
:

8�
������$2.�$����

�
���8�����

%�2$::$ �
���8�����$��:2��
 �
���8�����$
5
:2
2: �
���8�����$
::$5�5

8�!)����#�4 ��
���
���� �<����
7)��

������67��
�2.�%

8�
������$
.2:����

�8�
������$�.������

������67��
�2.��

8�
�������5.
:����

�8�
������$�.������

������67��
�%.
�

8�
�����
��.
%����

�8�
�����
��.������

	���$.%2�)��9$.%2: 	���$.%��)��9$.%�: 	���$.%��)��9$.%�:

8�!)����#�42

������67��
$5.�$

���;�8�����$��%%2%% ���;�8�����2���$���5 ���;�8�����
:
5%2�: ���;�8�������5�:2�:

�8�
������$�.������

	���$.�:�)��9$.�5:

8�
������$�.�5����

�
���8�����$��%%2%% �
���8�����2���$���5 �
���8�����
:
5%2�: �
���8�������5�:2�:

4/��<�  �� 
�<� "�
�)���)!

������67��:�.��

8�
������$�.�5����

�8�
������$�.������

������67��55.
�

8�
�����
25
.�2����

�8�
�����
25�.������

������67��2��.��

8�
�����
:2�.%$����

�8�
�����
:2�.������

	���$.�5�)��9$.��: 	���$.:5�)��9$.:5: 	���%.�$�)��9%.��:

4, �

������67��
�:.��

���;�8����������5:� ���;�8������
:�
��2 ���;�8�����
��2%$
� ���;�8�����$��$��
:

�8�
������2�.������

	���%.���)��9%.��:

8�
������2�.
$����

�
���8����������5:� �
���8������
:�
��2 �
���8�����
��2%$
� �
���8�����$��$��
:

"��!���!��!����4,=>=�4�?��@�
�����)
�"�)����?��@����<
0��?�A@�)����)�<��)�)��?,@,�����)
���)�)�?��@������)�)�?��4�@	����)�)�?��@����;?��@�
�0���������;



A Reports
Sample Standard Reports

452 TraceFinder User Guide Thermo Scientific

High Density Sample Report 2

&&)! �,���)�<��������	��
����

�������	


��
����	��


�
	�
 ������������

��	�������

��������

���	���� ���

!��"�
 ���#����

$	���%


��&'�('&	


���#����)�*�)�+�,��

���#����-"�&.

�*�)�+�,��

����	��('&	�*��	/��0&	����	�	1	&('&	����	/��0&	��*2'�&���


���3�4�)#�������5 ���3�4�)#������� �6��6�����5
��
����$��3�4�,

4.��7&)4.'�	 4�	�����	 (���	�����	 *'���	 ����

������68
���-��

9�����
���5�-:����!

�9�����
���5�-�����!

������68
��5�-�+

9�����
��,5-�:���!

�9�����
��,5-�����!

������68
���,-��

9�����
��+�-+����!

�9�����
��+�-�����!

������68
���:-�+

���&��68
�:�-��

����	
��-���:�;���-�,�:

���&��68
���,-��

���'�
��+-���:

����	
�,�-+:�:�;�:�-+:�:

���&��68
����-��

���'�
�5-���:

����	
��-���:�;��5-�:�:

���&��68
���+-�,

���'�
���-�:�:

����	
�,�-�5�:�;�:�-�5�:

��
�+-���'��<+-��= ��
�+-�+�'��<+-�+= ��
�+-���'��<+-�,=

�	�>�9�	�
���,��+::+ �	�>�9�	�
�+��:���� �	�>�9�	�
�+�5�:���:

9�	�
�5��+�:� 9�	�
��,+��5�: 9�	�
���,,�:,: 9�	�
����,5::,

����&9�	�
���,��+::+ ����&9�	�
�+��:���� ����&9�	�
�+�5�:���:

�9�����
��+�-�����!

9�����
��+�-�+���!

��
�+-,��'��<+-,�=

�	�>�9�	�
�+�::+5�5

����&9�	�
�+�::+5�5

9&%'"���)/4 ���0���"��� �7�	���8'�	 9&%'"���)/4�

������68
����-�,

9�����
��+�-�:���!

�9�����
��+�-�����!

������68
����-��

9�����
���5-�:���!

�9�����
��+�-�����!

������68
���,-��

9�����
����-�,���!

�9�����
����-�����!

������68
��+5-�+

���&��68
�5:-��

����	
�+5-5��:�;�55-5��:

���&��68
��++-��

���'�
�+�-���:

����	
��:-�5�:�;�,:-�5�:

���&��68
��5-��

���'�
���-,+�:

����	
��-���:�;���-�5�:

���&��68
�5�-��

���'�
�,:-+5�:

����	
�+�-5��:�;�5�-5��:

��
�+-,��'��<+-,�= ��
�+-,��'��<+-,�= ��
�+-,��'��<+-,�=

�	�>�9�	�
�+��,,�,, �	�>�9�	�
�����+���5 �	�>�9�	�
��:�5,��:

9�	�
������++� 9�	�
�:����::� 9�	�
��+����� 9�	�
�+�:�5,,,

����&9�	�
�+��,,�,, ����&9�	�
�����+���5 ����&9�	�
��:�5,��:

�9�����
��+�-�����!

9�����
��+�-�5���!

��
�+-�:�'��<+-�5=

�	�>�9�	�
���5�:��:

����&9�	�
���5�:��:

4.��7& $	����7& (&��'"��'% 4*$/

������68
�:�-��

9�����
��+�-�5���!

�9�����
��+�-�����!

������68
�55-��

9�����
���5�-�����!

�9�����
���5�-�����!

������68
����-��

9�����
��:��-,+���!

�9�����
��:��-�����!

������68
���:-��

���&��68
���:-��

����	
��-���:�;���-���:

���&��68
����-��

���'�
����-���:

����	
�5,-+��:�;���,-+��:

���&��68
�:5-��

���'�
�,�-���:

����	
���-���:�;���-���:

���&��68
���5-:,

���'�
�+�-�:�:

����	
��:-���:�;��:-���:

��
�+-�5�'��<+-��= ��
�+-:5�'��<+-:5= ��
�,-�+�'��<,-��=

�	�>�9�	�
������5:� �	�>�9�	�
���:����� �	�>�9�	�
�����,+��

9�	�
�����+�+ 9�	�
���5��+5, 9�	�
�,,+���� 9�	�
���:��:��

����&9�	�
������5:� ����&9�	�
���:����� ����&9�	�
�����,+��

�9�����
����-�����!

9�����
����-�+���!

��
�,-���'��<,-��=

�	�>�9�	�
�+��+���:

����&9�	�
�+��+���:

(&���&	�	�%
���4*@A@�4�B��C�������'�� �'&��	B��C����7�1	�B�DC�'�	��'�7�&'�'��B*C*	�	"�'���&'�'�B��C�����&'�'�B��4/C�0��&'�'�B��C!&��>B�
C/�&1	�����&��>



 A Reports
Sample Standard Reports

Thermo Scientific TraceFinder User Guide 453

High Density Sample Report 2 Long
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High Density Sample Report 3 
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High Density Sample Report 3 Long
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Internal Standard Summary Report
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Ion Ratio Failure Report 
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LCSLCSD Report
IMPORTANT  When the Sample ID is the same for an unknown sample and an LCS or LCSD sample, the unknown 
sample is included in the LCSLCSD report. The report information for the unknown sample is displayed as zeros.

LCSLCSD Report
Lab name:
Instrument:
User: AMER\jamie.humphries

Thermo Fisher Laboratory
Thermo Scientific Instrument

Page 1 of 1

Batch: Preview2

Method:

Cali File:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

Level File DateSample Name CommentSample ID FilenamePos
5ppb-002SampleID002 D008 New Dilutions 6/26/2007 H6/27/2007 1:25:44 AMN/ATray1:16
500ppt-002SampleID002 D002 New Dilutions 6/26/2007 H6/26/2007 9:47:43 PMQCTray1:9
Cal002SampleID002 D002 New Dilutions 6/26/2007 H6/26/2007 6:09:47 PMc2Tray1:3
5ppb-001SampleID008 D008 New Dilutions 6/26/2007 H6/27/2007 12:54:35 AMN/ATray1:15
500ppt-001SampleID008 D008 New Dilutions 6/26/2007 H6/26/2007 9:16:35 PMQCTray1:8

Compound Spike Amt
Lower 
Limit % 

Upper
Limit % % Rec RPD

Max 
RPD

Rec 
Fails

RPD 
Fails

LCSD 
Conc

SampleID002

DIA 0.500 50.00 150.00 0.00 50.00 50.00 0 04.712
DEA 0.500 50.00 150.00 0.00 50.00 50.00 0 05.065
Cyanazine 0.500 50.00 150.00 0.00 50.00 50.00 0 05.127
Simazine 0.500 50.00 150.00 0.00 50.00 50.00 0 04.862
Atrazine 0.500 50.00 150.00 0.00 50.00 50.00 0 05.184
Propazine 0.500 50.00 150.00 0.00 50.00 50.00 0 03.829

Compound Spike Amt % Rec
Lower 
Limit % 

Upper
Limit % % Rec RPD

Max
RPD

Rec 
Fails

RPD 
FailsLCS Conc

LCSD 
Conc

SampleID008

DIA 0.500 4.754 0.00 50.00 150.00 0.00 0.00 50.00 0 04.712
DEA 0.500 4.960 0.00 50.00 150.00 0.00 0.00 50.00 0 05.065
Cyanazine 0.500 5.218 0.00 50.00 150.00 0.00 0.00 50.00 0 05.127
Simazine 0.500 4.839 0.00 50.00 150.00 0.00 0.00 50.00 0 04.862
Atrazine 0.500 5.178 0.00 50.00 150.00 0.00 0.00 50.00 0 05.184
Propazine 0.500 3.829 0.00 50.00 150.00 0.00 0.00 50.00 0 03.829

Manually integrated
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Manual Integration Report 
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Method Detection Limit Report 
Method Detection Limit Report

Lab name:
Instrument:
User: AMER\jamie.humphries

Thermo Fisher Laboratory
Thermo Scientific Instrument

Page 1 of 3

Batch: Preview2

Method:

Cali File:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

Method Detection Limit Summary
Compound Avg Conc Std Dev t-stat % RSD MDL

DIA D-5 290218 0 0.00  IS

DIA 0.095 0.000 0.000 0.00 <<<0.000

DEA D-7 1704578 0 0.00  IS

DEA 0.065 0.000 0.000 0.00 <<<0.000

Cyanazine D-5 2204710 0 0.00  IS

Cyanazine 0.062 0.000 0.000 0.00 <<<0.000

Simazine D-10 513521 0 0.00  IS

Simazine 0.168 0.000 0.000 0.00 <<<0.000

Atrazine D-5 2292164 0 0.00  IS

Atrazine 0.023 0.000 0.000 0.00 <<<0.000

Propazine -1069.216 0.000 0.000 0.00 <<<0.000

Propazine D-14 826 0 0.00  IS

Manually integrated
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Method Detection Limit Report
Lab name:
Instrument:
User: AMER\jamie.humphries

Thermo Fisher Laboratory
Thermo Scientific Instrument

Page 2 of 3

Batch: Preview2

Method:

Cali File:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

1Compound
Method Validation Report Data

DIA D-5 290218
DIA 0.095
DEA D-7 1704578
DEA 0.065
Cyanazine D-5 2204710
Cyanazine 0.062
Simazine D-10 513521
Simazine 0.168
Atrazine D-5 2292164
Atrazine 0.023
Propazine -1069.216
Propazine D-14 826

Manually integrated
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Method Detection Limit Report
Lab name:
Instrument:
User: AMER\jamie.humphries

Thermo Fisher Laboratory
Thermo Scientific Instrument

Page 3 of 3

Batch: Preview2

Method:

Cali File:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

Level File DateSample Name CommentSample ID FilenamePos
Cal007SampleID007 D007 New Dilutions 6/26/2007 H6/26/2007 8:45:28 PMN/ATray1:1

Manually integrated
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Method Report 
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Method Validation Report
Method Validation Report

Lab name:
Instrument:
User: AMER\jamie.humphries

Thermo Fisher Laboratory
Thermo Scientific Instrument

Page 1 of 3

Batch: Preview2

Method:

Cali File:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

Method Validation Summary
Compound Avg Conc Theo Conc % Diff Min Conc % RSD Max % RSDMax Conc

DIA D-5 295652  IS0.00

DIA 0.358 0.500 -28.34 0.250 20.000.750 0.00

DEA D-7 1778658  IS0.00

DEA 0.602 0.500 20.45 0.250 20.000.750 0.00

Cyanazine D-5 2224244  IS0.00

Cyanazine 0.565 0.500 12.90 0.250 20.000.750 0.00

Simazine D-10 505462  IS0.00

Simazine 0.607 0.500 21.49 0.250 20.000.750 0.00

Atrazine D-5 2334865  IS0.00

Atrazine 0.512 0.500 2.46 0.250 20.000.750 0.00

Propazine 0.757 0.500 51.41 0.250 20.00 <<<0.750 0.00

Propazine D-14 272050  IS0.00

Manually integrated <<< = Failure
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Method Validation Report
Lab name:
Instrument:
User: AMER\jamie.humphries

Thermo Fisher Laboratory
Thermo Scientific Instrument

Page 2 of 3

Batch: Preview2

Method:

Cali File:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

1Compound
Method Validation Report Data

DIA D-5 295652
DIA 0.358
DEA D-7 1778658
DEA 0.602
Cyanazine D-5 2224244
Cyanazine 0.565
Simazine D-10 505462
Simazine 0.607
Atrazine D-5 2334865
Atrazine 0.512
Propazine 0.757
Propazine D-14 272050

Manually integrated <<< = Failure
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Method Validation Report
Lab name:
Instrument:
User: AMER\jamie.humphries

Thermo Fisher Laboratory
Thermo Scientific Instrument

Page 3 of 3

Batch: Preview2

Method:

Cali File:

Preview2_EPA536-Triazines

Preview2.calx
EPA536-Triazines

Level File DateSample Name CommentSample ID FilenamePos
500ppt-003SampleID003 D003 New Dilutions 6/26/2007 H6/26/2007 10:18:49 PMN/ATray1:10

Manually integrated <<< = Failure
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MSMSD Report
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Solvent Blank Report 
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Surrogate Recovery Report
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TIC Report
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TIC Summary Report 
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B

Using Copy Down and Fill Down

This appendix describes the Copy Down and Fill Down commands that you can use to make 
entering column values easier.

• Use the Fill Down command for the Filename, Sample Name, Sample ID, and Vial 
Position columns.

• Use the Copy Down command for the Sample Type, Vial Position, Injection Volume, 
Conv Factor, Level, Comment, and other columns.

Follow these procedures:

• To automatically copy column values

• To automatically enter sequential column values

• To use Copy Down or Fill Down for a range of samples

 To automatically copy column values

1. Select the cell whose value you want to copy to all cells below it.

Observe the difference between a selected and nonselected cell. 

2. Right-click and choose Copy Down from the shortcut menu.

The value is copied to all rows below the selected row. 

 To automatically enter sequential column values

1. Enter a value for the first row of the fill down sequence.

This does not have to be the first sample row. You can begin the fill down procedure from 
any row in the sequence.

Selected 

Not selected 



B Using Copy Down and Fill Down

478 TraceFinder User Guide Thermo Scientific

2. Select the cell whose value is the first in the fill down sequence.

Observe the difference between a selected and nonselected cell. 

3. Right-click and choose Fill Down from the shortcut menu.

The application enters sequential column values starting with the value in the selected 
row and ending with the last row in the column. 

You can repeatedly use the Fill Down command to create multiple sequences.

When you use the Fill Down command for the Vial Position column with an autosampler 
configured, the TraceFinder application knows the number of vial positions configured in 
your autosampler and numbers the positions accordingly. 

Selected 

Not selected 



 B Using Copy Down and Fill Down

Thermo Scientific TraceFinder User Guide 479

 To use Copy Down or Fill Down for a range of samples

1. To select a range of sample values, do one of the following:

Drag your cursor to select a contiguous group of sample values.

–or–

Hold down the SHIFT key to select a contiguous group of sample values.

2. Right-click and choose the appropriate command from the shortcut menu.

The column values are copied or entered sequentially starting with the value in the first 
selected row and ending with the last selected row. 
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C

Using Filter Criteria

The filter criteria tool is available from the compound datastore in the Configuration mode 
and the acquisition list in the Method Development mode. 

 To filter the compound list

1. To display only a filtered list of compounds, click the funnel icon, , in the column 
header.

For each column, a list of filterable criteria is displayed. In all columns, your filter choices 
are All, Blanks, and NonBlanks. Other filter criteria are specific to the individual 
columns.

2. To create a custom filter based on compound values in a specific column, choose Custom 
from the column list.

The Enter Filter Criteria dialog box opens. See “ Enter Filter Criteria dialog box” on 
page 482.

3. From the Operator list, select an operator.

4. From the Operand list, select an operand.

5. When all conditions are defined, click OK.

The complete filter string is displayed at the bottom of the dialog box, for example, 
chemical formula = Blanks.

Note  The Enter Filter Criteria dialog box is specifically named for the column on which 
you are filtering. In this example, the selected column is the Compound Name column.
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Figure 112. Enter Filter Criteria dialog box

Table 102. Enter Filter Criteria dialog box parameters

Parameter Description

And 
Conditions

Requires meeting all filter criteria.

Or 
Conditions

Requires meeting any of the specified filter criteria.

Add a 
Condition

Adds a new, empty condition to the filter criteria.

Delete 
Condition

Deletes the selected condition. Click the box at the left of the row to select 
the condition.

Operator The mathematical function applied to the operand.

Operand The arguments to which the operator is applied.
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I

Symbols
.csv, defined  2
.meth, defined  2
.pmd, defined  2
.raw, defined  2
.xml, defined  2
# Background Scans parameter

application configuration  80
method development  159

% Test parameter  178
%CV parameter  349
%Diff parameter  349
%RSD parameter  349

A
Account Number parameter  45
Acquire a New Raw Data File parameter  109
Acquisition command  35
Acquisition List page, Master Method View  129
Active parameter

Breakdown page  187
Data Review sample list  349
Identification page  134

Active View page  399
Actual RT parameter  348
Add a Condition parameter  482
Add Compound command  63
Add Confirming Ion command  65
Add Group command  201
Add Quan Peak command  64
Add Sample command

Acquisition mode  263
Batch View sample list  307
Batch Wizard  339

Add This Mass as New Confirming Ion command  170
Add This Mass to Existing Quan Mass Ranges command  170
Add to CDS command  112

Add User parameter  45
Adduct 1–n parameter  214
Amount parameter  174
Analysis command  36
And Conditions parameter  482
Area Noise Factor parameter

application configuration  82
Detect page  162

Area parameter  348
Area Scan Window parameter

application configuration  83
Detect page  163

Area Tail Extension parameter
application configuration  83
Detect page  163

Area Threshold, event type  86
Assay Type parameter

Batch Wizard  333
Master Method View  127

Associate a Raw Data File dialog box  113
Associate a Raw Data File parameter  113
Auto TSRM Update parameter  276
Autocalc Initial Events parameter, Avalon  165
automated background subtraction options  123
Automatically Create the Master Method parameter  109
Available Methods parameter  333
Available Templates parameter  333
Avalon detection algorithm  76
Avalon Event List dialog box  85

B
background subtraction options  123
Background Subtraction Range Option parameter  127
Barcode Actual parameter  306
Barcode Expected parameter  306
Baseline Window parameter

application configuration  82
Detect page  162

Index
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Index: C

Batch Level parameter
method development  204
report configuration  68

Batch view  297
Batch/Template Selection view  250
batches

Acquisition mode  246
Analysis mode  297
calibration  270
development batch  235

Best Match Method parameter  223
Breakdown sample type, defined  292
Browse In Raw File command  307
Bunch Factor, event type  86

C
cal1-caln parameter  176
Calc Amt parameter  348
Calculation Based On parameter  214
Calculation Type parameter  306
Calibration Curve Type command  370
Calibration Levels page, Master Method View  174
Calibration Method parameter  223
Calibration page

Compounds page  173
QAQC page  185

Calibration parameter  276
calibration standard (Cal Std) sample type, defined  292
Cancel Changes parameter  45
Carryover Limit parameter  184
CAS No parameter, Identification page  134
Category parameter

Acquisition List  131
Compound Datastore  59

caution flags  352
Channel parameter

Batch View  306
Data Review  349

check standard (Chk Std) sample type, defined  292
Chemical Formula parameter

Acquisition List  131
Compound Datastore  60

Chk Std page, Master Method View  186
Collision Energy parameter

Acquisition List
confirming ion  132
quantitative peak  132

Compound Datastore
confirming ion  61
quantitative peak  60

color codes, Sample Definition view  264

commands
Acquisition  35
Add Compound  63
Add Confirming Ion  65
Add Group  201
Add Quan Peak  64
Add Sample

Acquisition mode  263
Batch View sample list  307
Batch Wizard  339

Add This Mass as New Confirming Ion  170
Add This Mass to Existing Quan Mass Ranges  170
Add to CDS  112
Analysis  36
Apply to All Peaks in Compound

Avalon  165
Genesis  160
ICIS  163

Apply to All Peaks in Method
Avalon  165
Genesis  159
ICIS  163

Apply to All Peaks with Like Sensitivity Settings
Avalon  165
Genesis  160
ICIS  163

Browse In Raw File  307
Calibration Curve Type  370
Configuration  36
Confirming Ion List  364
Continue to Method  112
Copy Down  477
Copy With Headers

Acquisition mode  264
Batch View sample list  307

Create New  343
Enable Target Screening  90
Exit TraceFinder  12
Export to CSV File

Acquisition mode  264
Batch View sample list  308

Extend Calibrations  343
Fill Down  477
Import Compounds  62
Import Published Method  226
Import Samples  307
Insert Copy Sample

Acquisition mode  263
Batch View sample list  307
Batch Wizard  339

Insert Sample
Acquisition mode  263
Batch View sample list  307
Batch Wizard  339
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Index: C

Load Compound Datastore  57
Log Off  35
Manual Integration Settings  364
Map Raw Files to Samples  307
Method Integration Settings  364
Methods  36
Modify Columns

Batch View sample list  299
Data Review sample list  350

Move Sample Down  339
Move Sample Up  339
New Compound Datastore  57
Pause Queue  287
Peak Detection Settings  365
Peak Labels  364
Real Time Status  35
Reinject Selected Samples

Acquisition mode  263
Batch view sample list  307

Remove Pending Batch  289
Remove Pending Batches  288
Remove Pending Samples  289
Remove Selected Samples

Acquisition mode  263
Batch view sample list  307
Batch Wizard  339

Save As Compound Datastore  58
Save Compound Datastore  57
Send RT to Method  364
Set This Mass as a New Quan Peak  170
Set This Mass as Quan Mass  170
Show Peak Info  365
Sort by Alphabetical  357
Sort by Flag and Alphabetical  357
Sort by Flag and Retention Time  357
Sort by Retention Time  357
Stop Active Batch  287
Stop All Batches  288
Stop Batch  289
Turn Device Off  271
Turn Device On  270
Turn Device Standby  270
Update Confirming Ion Ratios with This Spectrum  

170
comma-separated values, defined  2
Comment parameter

Batch View  306
Data Review  349

Company Logo parameter  213
Company Name parameter  213
Compound Datastore view  59
Compound Datastore, administration  55

Compound Name parameter
Acquisition List  131
Compound Datastore  59

Compound parameter
Calibration page  185
Lab Control page  193
QC levels page  178

Compound Type parameter
Calibration  173
Identification page  134

compound types
internal standards

Detection page  136
Identification page  133

non quan
Detection page  136
Identification page  133

quan
Detection page  136
Identification page  133

surrogates, Detection page  136
target

Detection page  136
Identification page  133

Compounds for Group parameter  187
Compounds page, Master Method View  129
compounds, importing to compound datastore  62
Configuration command  36
Configuration navigation pane  38
Confirming Ion List command  364
Confirming n Ion Ratio Flag parameter  402
Confirming n Ion Ratio parameter  402
Confirming n Manual Flag parameter  402
Confirming n Mass parameter  401
Confirming n Range parameter  402
Confirming n Response parameter  402
Constrain Peak Width parameter

Genesis
application configuration  79
Detect page  158

ICIS
application configuration  82
Detect page  162

Continue to Method command  112
Conversion Factor parameter  306
Copy Down command  477
Copy With Headers command

Acquisition mode  264
Batch View sample list  307

Correct Surrogates parameter  209
Create Master Method dialog box  101
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Index: D

Create Method parameter  98
Create New command  343
Create PDF parameter

Batch Template Editor  422
Master Method view  203

Create Tune Report as PDF parameter  199
Create XLSM parameter

Batch Template Editor  422
Master Method View  204

Create XML parameter
Batch Template Editor  422
Master Method View  203

Curve Type parameter
Calibration page  174
Method Template Editor  223

custom reports, listed  7
CV Test (%) parameter  190

D
Data Review view  345
Decimal Places to be Reported parameter  208
Delay Calibration Calculation option  93
Delete Condition parameter  482
Detection Method parameter

Avalon
application configuration  84
Detect page  164

Genesis
application configuration  78
Detect page  158

ICIS
application configuration  81
Detect page  162

Detection page, Master Method View  135
Detection Type parameter, Times page  148
Detector parameter, Signal page  155
Development Batch view  235
Device Name parameter

Acquisition mode  274
Batch View  328

dialog boxes
Add Library  15
Associate a Raw Data File  113
Avalon Event List  85
Create Master Method  101
Edit Compound Dependent Parameters  111
Import an Xcalibur Method  110
Invalid Compound Datastore Not Saved  58
Open Chromatograph Reference Sample  124
Open Compound Datastore  57
Save Compound Datastore  58
Select Compounds to Add  117

Thermo Library Manager  15
Thermo Xcalibur Instrument Setup  122
Thermo Xcalibur Roadmap  14

Dilution Factor parameter  306
Disable Cluster Off, event type  87
Disable Cluster On, event type  87
Display Compounds Above Set Limit parameter  208
Display Quan Flags and Legend parameter  208
Displayed Reports parameter  72

E
Edit Compound Dependent Parameters dialog box  111
Edit User parameter  45
Email Address parameter  45
Enable parameter, Ratios page  172
Enable Peak Threshold parameter  223
Enable Target Screening command  90
Enable Tune Time Tracking parameter  209
Enable Valley Detection parameter

application configuration  79
method development  158

Enabled parameter  45
End RT parameter, Times page  149
End Threshold, event type  86
Energy Ramp parameter

application configuration  61
method development  132

Event parameter  85
Event types  86
Exact Mass Window parameter  214
Example parameter, Reports page  203
Exclude Matching Quan Peaks parameter  225
Excluded parameter  349
Exclusion Window parameter  225
Exit TraceFinder command  12
Expected RT parameter  348
Expected RT parameter, Times page  148
Expected Width parameter

application configuration  79
method development  158

Experiment Type parameter
Acquisition List  131
Compound Datastore  59

experiment types  66
Export SRM Data parameter  99
Export to CSV File command

Acquisition mode  264
Batch View sample list  308

Extend Calibrations command  343
Extracted Ion Chromatogram  66
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Index: F

F
feature summary  4
file types, supported  2
Filename parameter

Batch View  305
Data Review  347

Fill Down command  477
Filter parameter, Detection  155
Filter parameter, Signal page  154
Final Units parameter  306
Finish view  269
Flag Values Above Carryover parameter  209
Flag Values Above LOR parameter  209
Flag Values Above ULOL parameter  209
Flag Values Below LOD parameter  209
Flag Values Below LOQ parameter  209
Flag Values Between LOD and LOQ parameter  209
Flags parameter  347
Force Cluster Off, event type  87
Force Cluster On, event type  87
Full Name parameter  45

G
General page

Background Subtraction Range Option  127
editing  121
Injection Volume parameter

Batch View  306
method development  127

Instrument Method parameter  127
Ion Range Calc Method parameter  127
Mass Precision parameter  127
Mass Tolerance parameter  128
Number of Scans to Subtract parameter  128
Qualitative Peak Processing Template parameter  127
Set Chromatogram Reference Sample parameter  128
Set Reference sample parameter  128
Stepoff Value parameter  128
Tune/Breakdown parameter  127

General page, Master Method View  121
Generate Only parameter  400
Genesis detection algorithm  76
Groups page, Master Method View  200
Groups parameter, Breakdown page  187

H
Height parameter  348

I
ICIS detection algorithm  76
Identification page, Master Method View  133
Import an Xcalibur Method dialog box  110
Import Compounds command  62
Import parameter  72
Import Published Method command  226
Import Published Method parameter  99
Import Samples command  307
Import Xcalibur Processing Method parameter  110
Include Compound Peak Spectrum as Reference Spectrum 
parameter  223

Include Confirming Ions parameter  223
Injection Amount parameter  109
Injection Concentration parameter  402
Injection Units parameter  402
Injection Volume parameter

Batch View  306
method development  127
sample list  348

Insert Copy Sample command
Acquisition mode  263
Batch View sample list  307
Batch Wizard  339

Insert Sample command
Acquisition mode  263
Batch View sample list  307
Batch Wizard  339

Installed Reports parameter  72
installing NIST and QED libraries  14
installing TraceFinder  10
Instrument Method parameter

Batch View  306
General page  127
Method Forge  109

instrument status indicators  271
Instrument view  228
instruments, supported  ix
Integration Mode parameter  348
Invalid Compound Datastore Not Saved dialog box  58
Ion Coelution parameter

application configuration  77
Ratios page  172

Ion Range Calc Method parameter  127
Ion Ratio Window parameter  214
Ionization parameter

Acquisition List  131
Compound Datastore  60

IS Amt parameter  348
IS Resp parameter  348
ISTD Matching parameter  224
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Index: L

ISTD page, Master Method View  190
ISTD parameter  174
IT Administrator role  46

L
Lab Control page, Master Method View  193
lab control sample (LCS) sample type, defined  292
lab control sample duplicate (LCSD) sample type, defined  
292

Lab Name parameter  127
Laboratory Name parameter  213
Lens parameter

application configuration  60
method development  132

Level parameter
Batch View  305
Data Review  347
QC Levels page  178

licenses, types of  x
Limit Library Hits parameter  223
Limit the Retention Time Range parameter  223
Limits page, Master Method View  184
Load Compound Datastore command  57
Local Method view  413
LOD (Detection Limit) parameter  184
Log Off command  35
Login parameter  12
login screen  12
LOQ (Quantitation Limit) parameter  184
LOR (Reporting limit) parameter  184

M
m/z Window parameter  213
Manual Flags parameter  401
Manual Injection parameter  109
Manual Integration Settings command  364
Map Raw Files to Samples command  307
Mass parameter

confirming ion
Acquisition List  132
Compound Datastore  61

quantitative peak
Acquisition List  131
Compound Datastore  60

Mass Precision parameter  127
Mass Tolerance parameter  128

Master Method View
Acquisition List page  129
Calibration Levels page  174
Calibration page

Compounds page  173
QAQC page  185

Chk Std page  186
Compounds page  129
Detection page  135
General page  121
Groups page  200
Identification page  133
ISTD page  190
Lab Control page  193
Limits page  184
Matrix Blank page  188
Matrix Spike page  195
Method Val page  194
QC Check page  186
QC Levels page  176
Ratios page  171
Real Time Viewer page  179
Reports page  202
Solvent Blank page  191
Spectrum page  166
Surrogate page  192

Master Method View, QAQC page  183
Matrix Blank page, Master Method View  188
Matrix Blank sample type, defined  292
matrix spike (MS) sample type, defined  292
matrix spike duplicate (MSD) sample type, defined  292
Matrix Spike page, Master Method View  195
Max % Breakdown parameter  187
Max Amt Diff (%) parameter  185
Max Conc parameter  189
Max Recovery (%) parameter

Lab Control page  193
Matrix Spike page  195
Method Val page  194
Surrogate page  192

Max Recovery (%) parameter, ISTD page  190
Max RF Diff (%) parameter  186
Max RPD parameter

Lab Control page  193
Matrix Spike page  195

Max RSD (%) parameter
Method Val page  194

Max RSD (%) parameter, Calibration page  185
Max RT (+min) parameter, ISTD page  190
Max Stepoff parameter  199
Measurement Unit parameter  214
method detection limits (MDL) sample type, defined  292
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Index: N

Method Integration Settings command  364
Method parameter

Matrix Blank page  188
Solvent Blank page  191

Method Template Editor  222
Method Val page, Master Method View  194
method validation (Meth Val) sample type, defined  292
Method view  101
methods

importing Xcalibur  110
instrument  228
local  413
master  100
Method Template Editor  222
update TSQ method  269

Methods command  36
Min Peak Height (S/N) parameter

Genesis
application configuration  79
Detect page  159

ICIS
application configuration  82
Detect page  162

Min Peak Width parameter
application configuration  83
Detect page  163

Min recovery (%) parameter
ISTD page  190
Lab Control page  193
Matrix Spike page  195
Method Val page  194
Surrogate page  192

Min RF parameter  186
Min RT (–min) parameter  190
modes

choosing  32
defined  35

Modify Calibrations or Active Compounds by Group 
parameter  341

Modify Columns command
Batch View sample list  299
Data Review sample list  350

Move Sample Down command  339
Move Sample Up command  339
MS2 Search Library parameter  214
MS3 Search Library parameter  214
Multiplet Resolution parameter

application configuration  83
Detect page  163

Multiplexing Channels parameter  263

N
Name the Master Method parameter  109
Negative Peaks, event type  86
New Compound Datastore command  57
New Instrument Method parameter  99
New Sample List parameter  99
NIST library, installing  14
No Specified Retention Time parameter  214
Noise Method parameter

application configuration  82
Detect page  163

Number of Confirming Ions parameter  223
Number of Scans to Subtract parameter  128

O
Only Select Top Peaks parameter  223
Open Chromatograph Reference Sample dialog box  124
Open Compound Datastore dialog box  57
Open Instrument Method parameter  99
Open Method parameter  98
Open Qual Browser parameter  99
Operand parameter  482
Operator parameter  482
Or Conditions parameter  482
Origin parameter

Calibration  174
Method Template Editor  224

P
parameters

# Background Scans  159
application configuration  80

% Test  178
%CV  349
%Diff  349
%RSD  349
Account Number  45
Acquire a New Raw Data File  109
Active

Breakdown page  187
Data Review sample list  349
Identification page  134

Actual RT  348
Add a Condition  482
Add User  45
Adduct 1–n  214
Amount  174
And Conditions  482
Area  348
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Index: P

Area Noise Factor
application configuration  82
Detect page  162

Area Scan Window
application configuration  83
Detect page  163

Area Tail Extension
application configuration  83
Detect page  163

Assay Type
Batch Wizard  333
Master Method View  127

Associate a Raw Data File  113
Auto TSRM Update  276
Autocalc Initial Events, Avalon  165
Automatically Create the Master Method  109
Available Methods  333
Available Templates  333
Background Subtraction Range Option  127
Barcode Actual  306
Barcode Expected  306
Baseline Window

application configuration  82
Detect page  162

Batch Level
method development  204
report configuration  68

Best Match Method  223
cal1-caln  176
Calc Amt  348
Calculation Based On  214
Calculation Type  306
Calibration  276
Calibration Method  223
Cancel Changes  45
Carryover Limit  184
CAS No, Identification page  134
Category

Acquisition List  131
Compound Datastore  59

Channel
Batch View  306
Data Review  349

Chemical Formula
Acquisition List  131
Compound Datastore  60

Collision Energy
Acquisition List

confirming ion  132
quantitative peak  132

Compound Datastore
confirming ion  61
quantitative peak  60

Comment
Batch View  306
Data Review  349

Company Logo  213
Company Name  213
Compound

Calibration page  185
Lab Control page  193
QC levels page  178

Compound Name
Acquisition List  131
Compound Datastore  59

Compound Type
Calibration  173
Identification page  134

Compounds for Group  187
Confirming n Ion Ratio  402
Confirming n Ion Ratio Flag  402
Confirming n Manual Flag  402
Confirming n Mass  401
Confirming n Range  402
Confirming n Response  402
Constrain Peak Width

Genesis
application configuration  79
Detect page  158

ICIS
application configuration  82
Detect page  162

Conversion Factor  306
Correct Surrogates  209
Create Method  98
Create PDF

Batch Template Editor  422
Master Method view  203

Create Tune Report as PDF  199
Create XLSM

Batch Template Editor  422
Master Method View  204

Create XML
Batch Template Editor  422
Master Method View  203

Curve Type
Calibration page  174
Method Template Editor  223

CV Test (%)  190
Decimal Places to be Reported  208
Delete Condition  482
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Index: P

Detection Method
Avalon

application configuration  84
Detect page  164

Genesis
application configuration  78
Detect page  158

ICIS
application configuration  81
Detect page  162

Detection Type, Times page  148
Detector  155
Device Name

Acquisition mode  274
Batch View  328

Dilution Factor  306
Display Compounds Above Set Limit  208
Display Quan Flags and Legend  208
Displayed Reports  72
Edit User  45
Email Address  45
Enable Peak Threshold  223
Enable Tune Time Tracking  209
Enable Valley Detection

application configuration  79
method development  158

Enable, Ratios page  172
Enabled  45
End RT, Times page  149
Energy Ramp

application configuration  61
method development  132

Event  85
Exact Mass Window  214
Example, Reports page  203
Exclude Matching Quan Peaks  225
Excluded  349
Exclusion Window  225
Expected RT  348
Expected RT, Times page  148
Expected Width

application configuration  79
method development  158

Experiment Type
Acquisition List  131
Compound Datastore  59

Export SRM Data  99
Filename

Batch View  305
Data Review  347

Filter  154
Filter, Detection  155
Final Units  306
Flag Values Above Carryover  209

Flag Values Above LOR  209
Flag Values Above ULOL  209
Flag Values Below LOD  209
Flag Values Below LOQ  209
Flag Values Between LOD and LOQ  209
Flags  347
Full Name  45
Generate Only  400
Groups, Breakdown page  187
Height  348
Import  72
Import Published Method  99
Import Xcalibur Processing Method  110
Include Compound Peak Spectrum as Reference 

Spectrum  223
Include Confirming Ions  223
Injection Amount  109
Injection Concentration  402
Injection Units  402
Injection Volume

Batch View  306
method development  127
sample list  348

Installed Reports  72
Instrument Method

Batch View  306
General page  127
Method Forge  109

Integration Mode  348
Ion Coelution

application configuration  77
Ratios page  172

Ion Range Calc Method  127
Ion Ratio Window  214
Ionization

Acquisition List  131
Compound Datastore  60

IS Amt  348
IS Resp  348
ISTD  174
ISTD Matching  224
Lab Name  127
Laboratory Name  213
Lens

application configuration  60
method development  132

Level
Batch View  305
Data Review  347
QC levels page  178

Limit Library Hits  223
Limit the Retention Time Range  223
LOD (Detection Limit)  184
Login  12
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Index: P

LOQ (Quantitation Limit)  184
LOR (Reporting limit)  184
m/z Window  213
Manual Flags  401
Manual Injection  109
Mass

confirming ion
Acquisition List  132
Compound Datastore  61

quantitative peak
Acquisition List  131
Compound Datastore  60

Mass Precision  127
Mass Tolerance  128
Max % Breakdown  187
Max Amt Diff (%)  185
Max Conc  189
Max Recovery (%)

Lab Control page  193
Matrix Spike page  195
Method Val page  194
Surrogate page  192

Max Recovery (%), ISTD page  190
Max RF Diff (%)  186
Max RPD

Lab Control page  193
Matrix Spike page  195

Max RSD (%)
Method Val page  194

Max RSD (%), Calibration page  185
Max RT (+min), ISTD page  190
Max Stepoff  199
Measurement Unit  214
Method

Matrix Blank page  188
Solvent Blank page  191

Min Peak Height (S/N)
Genesis

application configuration  79
Detect page  159

ICIS
application configuration  82
Detect page  162

Min Peak Width
application configuration  83
Detect page  163

Min recovery (%)
ISTD page  190
Lab Control page  193
Matrix Spike page  195
Method Val page  194
Surrogate page  192

Min RF  186
Min RT (–min)  190
Modify Calibrations or Active Compounds by Group  

341
MS2 Search Library  214
MS3 Search Library  214
Multiplet Resolution

application configuration  83
Detect page  163

Multiplexing Channels  263
Name the Master Method  109
New Instrument Method  99
New Sample List  99
No Specified Retention Time  214
Noise Method

application configuration  82
Detect page  163

Number of Confirming Ions  223
Number of Scans to Subtract  128
Only Select Top Peaks  223
Open Instrument Method  99
Open Method  98
Open Qual Browser  99
Operand  482
Operator  482
Or Conditions  482
Origin

Calibration  174
Method Template Editor  224

Password
login screen  12
user administration  45

Path  109
Peak Height (%)

Genesis
application configuration  79
Detect page  158

ICIS
application configuration  82
method development  162

Peak Noise Factor
application configuration  82
method development  162

Peak S/N Cutoff
application configuration  80
Detect page  159

Percentage  189
Perform Background Subtraction  199
Phone Number  45
Polarity

Acquisition List  132
Compound Datastore  60
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Post-run System State  274, 328
Precursor Mass

Acquisition List
confirming ion  132
quantitative peak  131

Compound Datastore
confirming ion  61
quantitative peak  60

Priority Sequence  274, 328
Processing Configuration File  213
Product Mass

Acquisition List
confirming ion  132
quantitative peak  131

Compound Datastore
confirming ion  61
quantitative peak  60

QAQC Flags  401
QC1-QCn  178
QIon  402
Qualitative Peak Processing Template  127
Quan Flags  401
Quan Mass  402
Quan Peak m/z  401
Quan Peak Response  401
Quan Peak RT  401
Quick Mode  333
R^2 Threshold  185
Ranges, compound detection  155
Raw Filename  109
Recent Files, Method view  99
Reference Compound, Identification page  134
Remove User  45
Report All Compounds Listed in Configuration File  

214
Report Concentration  208
Report Description  203
Report Name  203
Report Noise As

application configuration  80
Detect page  159

Report Semi-Quantitative Result  214
Report Type  203
Reset Password  45

user administration  45
Resp Ratio  348
Response  402
Response Via

Calibration  174
Method Template Editor  224

Retention Time  402
RMS

application configuration  83
Detect page  163

Role  45

RT
Acquisition List  132
Calibration  173
Calibration levels  176
Calibration page  185
Chk Std page  186
Compound Datastore  60
Identification page  134
ISTD page  190
Lab Control page  193
Limits page  184
Matrix Blank page  188
Matrix Spike page  195
Method Val page  194
QC levels page  178
Solvent Blank page  191
Surrogate page  192

RT Window  214
S/N Threshold

application configuration  79
method development  158

Sample Amt  348
Sample Comment  109
Sample Concentration  402
Sample File  400
Sample ID

Batch View  305
Data Review  348

Sample Name
Batch View  306
Data Review  348

Sample Type
Batch View  305
Data Review  347

Sample Units  402
Sample Volume  306
Sample Weight  306
Save Changes  45
Screening Method  213
Select a Custom Template  108
Select a Report  400
Select Batch Location  99
Select Compounds from CDS  117
Select File and Mass Spectrum  199
Sensitivity

Avalon
application configuration  84
Detect page  164

Genesis
application configuration  78
Detect page  158

ICIS
application configuration  81
Detect page  162

Method Template Editor  223
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Separate Ion Overlay Display  208
Set Chromatogram Reference Sample  128
Set Ion Ratio to All Confirming Peaks in Compound  

172
Set Ion Ratio to All Confirming Peaks in Method  172
Set Peak Windows Settings to All Peaks in Compound  

149
Set Peak Windows Settings to All Peaks in Method  

149
Set Reference sample  128
Shade Row when Sample is Outside of Evaluation 

Criteria  208
Show Chromatogram on Quantitation Report  208
Show Quan Peaks Only  179
Showing, Active View  400
Smoothing

Avalon
application configuration  84
Detect page  165

Genesis
application configuration  79
Detect page  158

ICIS
application configuration  81
Detect page  162

Specify Default Ion Ratio Ranges  223
Standard type  174
Start Device  274, 328
Start RT

Times page  149
Start When Ready  274, 328
Starting vial number  333
Status

Active View  401
Batch View  305
Data Review  347

Stepoff Value  128
System Shutdown Method  276
System Startup Method  276
System Status  276
Tailing Factor

Genesis
application configuration  79
method development  158

ICIS
application configuration  82
method development  162

Target Ratio  172
Template Layout  333
Theo Amt  348
Theo Conc

Lab Control page  193
Matrix Spike page  195
Method Val page  194
Surrogate page  192

Theoretical Amount  401
Time  85
Time/Event/Value  84
Total Batch Rows  333
Total Response  401
Total Rows  400
Trace, Detection  155
Tune Compound  199
Tune File Lifetime  209
Tune/Breakdown, General page  127
ULOL (Linearity Limit)  184
Units  174
Upper Limit

Solvent Blank page  191
Use Alternate Calibration Report Format  208
Use an Existing Raw Data File  109
Use as RT Reference, Identification page  134
Use Autosampler  109
Use Average Scan  214
Use Data Dependent Scans  225
Use Full MS Scan to Confirm  214
Use Genesis Algorithm for Qual Processing  224
Use Method Forge  102, 106
Use Only Selected Method  199
Use Scan at Peak Apex  214
Use the Default Template  108
Use These Libraries  223
User Security  90
Username  12, 45
Valley Rise (%)

application configuration  80
Detect page  159

Valley S/N
application configuration  80
method development  159

Value  85
Vial Position

Batch View  306
Data Review  348
Method Forge  109

View Only  400
View Width

application configuration  77
Times page  149

Weighting
Calibration  174
Method Template Editor  224

Window
Acquisition List  132
application configuration

ion ratio  77
retention time  77

Compound Datastore  60
Ratios page  172
Times page  148
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Window Type
application configuration  77
Ratios page  172

XIC  154
Password parameter

login screen  12
user administration  45

password, administrator  11
Path parameter  109
Pause Queue command  287
Peak Detection Settings command  365
Peak Height (%) parameter

Genesis
application configuration  79
Detect page  158

ICIS
application configuration  82
method development  162

Peak Labels command  364
Peak Noise Factor parameter

application configuration  82
method development  162

Peak S/N Cutoff parameter
application configuration  80
Detect page  159

Percentage parameter  189
Perform Background Subtraction parameter  199
Phone Number parameter  45
Polarity parameter

Acquisition List  132
Compound Datastore  60

Post-run System State parameter  274, 328
P-P Threshold, event type  86
Precursor Mass parameter

Acquisition List
confirming ion  132
quantitative peak  131

Compound Datastore
confirming ion  61
quantitative peak  60

Priority Sequence parameter  274, 328
procedures

acquisition mode
access real-time display  279
add samples to the sample list  256
assign a specific channel to a sample  262
create a batch template  254
export reports to a folder  266
import samples into the sample list  259
insert samples into the sample list  257
pause all batches in a queue  286
preview a standard report  265

re-inject a sample from  261
remove a batch from a queue  288
remove a pending batch from a queue  288
remove a pending sample from a queued batch  289
remove a single batch from a queue  287
remove all batches in a queue  287
remove all pending batches in a queue  287
remove pending samples from a queued batch  289
remove samples from the sample list  261
save a to-be-run batch  271
select a previously acquired batch  253
select a ready-to-acquire batch  252
specify a calibration batch  270
specify device states  270
specify startup or shutdown methods  269
start a new batch  250
start an acquisition  271
update TSRM data  269
view output files  275

analysis mode
access the Analysis mode  294
add samples to the samples list  310
change the displayed information for detected peaks

qualitative peak  382
quantitative peak

Data Review  362
method development  136

change the library entry for a selected peak  385
change the peak panes display  359
copy a sample in the samples list  312
create a new batch  309
customize the column display

Batch View  315
Data Review view  350

display peaks for a specific compound  376
quantitative peak  358

display specific problems with a compound  357
edit samples in a batch  318
edit the batch-level output formats  321
edit the sample-level output formats  320
enlarge the report text  398
exclude a calibration point  355
export a report  397
insert samples in the samples list  311
make a compound active or inactive  354
manually add a peak

chromatogram pane  379
qual peak pane  381
quantitation peak  361

manually exclude a calibration point  369
manually integrate a confirming ion peak  367
manually integrate a quantitative peak  361
modify the peak detection settings  363
open a recent batch  318
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open a saved batch  317
open the Batch View  297
open the Data Review view  345
open the Local Method View  413
open the Report View  387
print a report  396
reinject a sample  313
reinject a sample from a previously acquired batch  

318
remove a manually created peak  361
remove a peak from the peak list  377
remove a peak from the qual peak pane  382
remove samples from the samples list  312
scroll the samples list  299, 350
search for text  398
select a compound  390
select a report

generating reports  392
viewing reports  388

select a sample
generating reports  393
viewing reports  390

sort the compounds list  357
submit all samples in the batch  325
submit selected samples  326
switch between method and manual integration

qual mode  382
quan mode  362

zoom in on a peak
chromatogram navigation  379
qual peak  381
quantitation peak  359
spectra pane  384

configuration mode
access the Configuration mode  37
add a compound to the datastore  63
add a confirming ion to a quan peak  65
add a quantitation peak to a compound  64
add a user  41
change the default drive  51
choose a drive  50
copy the folder hierarchy from another drive  54
create a new compound datastore  57
create projects or subprojects  52
delete projects or subprojects  53
edit user information  42
enable user security  90
hide a drive from display  51
import compounds  62
import new report types  69
open a compound datastore  57
open the Application Configuration view  67
open the Compound Datastore editor  56
open the Defaults page  73

open the Project Administration view  49
open the User Administration view  40
refresh the drives display  51
remove a compound  63
remove a confirming ion  65
remove a user  44
remove all empty folders  53
save a datastore  57
save a datastore to a new name  58
specify common detection parameters  76
specify default laboratory and instrument names  74
specify default mass precision and intensity scale  74

getting started
choose a node  32
display a log of instrument errors  33
install the NIST library  14
install the QED library  14
log in to the TraceFinder application  11
monitor the instrument status  33
start the TraceFinder application  11
watch the real-time display from the dashboard  34

method development mode  174
access the Method Development mode  97
acquire selected samples  240
acquire the batch  240
add a compound to the list  130
add a mass as a new compound  141
add a mass as a new confirming ion peak  145
add a mass to the existing quan mass ranges  140
add a quan peak  141
add a quan peak to an existing compound  168
add compounds to the method  115, 137
add confirming ions to an existing compound  169
add ions to get an accumulated signal  168
add sample to the development batch  236
associate a raw data file with the method  113
automatically select compounds to create a new 

method  102
calculate and report semi-quantitative results  211
calibrate the compounds  219
change the compound reference spectrum  140
change the quantitation mass used for a quan peak  

166
copy a sample  237
correct surrogates  207
create a group  200
create a new instrument method  229
create a new multiplexing instrument method  231
delete a compound from the list  130
edit the instrument method parameters  122
enter a note for the method  221
enter column values  238
export SRM data to an XML file  227
filter the displayed compounds  133, 136
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identify the peaks  218
import a master method  226
import an instrument method  234
import an Xcalibur method  110
insert samples into the development batch  237
manually select compounds to create a new method  

106
open a saved master method  119
open an instrument method  233
open the Development Batch view  235
open the Instrument View  228
open the Qual Browser  241
remove all samples from the samples list  239
remove selected samples from the samples list  239
replace a confirming ion peak  145
replace a quantitation mass  140
replace a quantitative peak with a confirming ion 

peak  143
resize or reorganize the columns  239
save the method template  221
save the new method  145
select compounds from the datastore  117
set a confirming ion peak as an additional 

quantitative peak  143
set automated background subtraction options  123
specify a chromatogram reference sample  124
specify a location for development batch data  236
specify an internal standard for a compound  173
specify general information for a master method  121
specify ion ratio criteria  171
specify mass tolerance  125
specify peak criteria  217
specify QC levels and concentrations  176
specify qualitative peak processing  220
specify quantitation flag options  206
specify quantitation limits  205
specify ranges of ions for detection and integration  

150
specify standard report types and output formats  202
specify the default parameters  210
specify the exact mass window  212
specify the Exactive parameters  212
specify the ion ratio calculation method  212
specify the maximum concentration as a percentage  

188
specify user interface options  206
track the use of the tune file  207
update confirming ion ratios  166
zoom in the chromatogram or spectrum displays  169

Processing Configuration File parameter  213
Product Mass parameter

Acquisition List
confirming ion  132
quantitative peak  131

Compound Datastore
confirming ion  61

quantitative peak  60
Project Administration view  49
projects and subprojects, creating  49

Q
QAQC Flags parameter  401
QAQC page, Master Method View  183
QAQC role  48
QC Check page, Master Method View  186
QC Levels page, Master Method View  176
QC1-QCn parameter  178
QED library, installing  14
QIon parameter  402
Qual Mode  345
Qualitative Peak Processing Template parameter  127
Quan Flags parameter  401
Quan Mass parameter  402
Quan Mode  345
Quan Peak m/z parameter  401
Quan Peak Response parameter  401
Quan Peak RT parameter  401
quan report settings, specifying  205, 210
Quick Mode parameter  333

R
R^2 Threshold parameter  185
Ranges parameter, compound detection  155
Ratios page, Master Method View  171
Raw Filename parameter  109
Real Time Status command  35
Real Time Viewer page, Master Method View  179
real-time display  279
Recent Files parameter, Method View  99
Reference Compound parameter, Identification page  134
reference spectra  384
Reinject Selected Samples command

Acquisition mode  263
Batch view sample list  307

Remove Pending Batch command  289
Remove Pending Batches command  288
Remove Pending Samples command  289
Remove Selected Samples command

Acquisition mode  263
Batch view sample list  307
Batch Wizard  339

Remove User parameter  45
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Report All Compounds Listed in Configuration File 
parameter  214

Report Concentration parameter  208
Report Description parameter  203
report formats, specifying  202
Report Name parameter  203
Report Noise As parameter

application configuration  80
Detect page  159

Report selection view  265
Report Semi-Quantitative Result parameter  214
Report Type parameter  203
Report View  387
reports

Acquisition mode  265
Analysis mode  387
configuring  68
flags defined  428
listed  6
sample PDFs  430
viewing landscape in PDF  430

Reports page, Master Method View  202
Reset Password parameter  45

user administration  45
Resp Ratio parameter  348
Response parameter  402
Response Via parameter

Calibration  174
Method Template Editor  224

Retention Time parameter  402
RMS parameter

application configuration  83
Detect page  163

Role parameter  45
RT parameter

Acquisition List  132
Calibration  173
Calibration levels  176
Calibration page  185
Chk Std page  186
Compound Datastore  60
Identification page  134
ISTD page  190
Lab Control page  193
Limits page  184
Matrix Blank page  188
Matrix Spike page  195
Method Val page  194
QC levels page  178
Solvent Blank page  191
Surrogate page  192

RT Window parameter  214

S
S/N Threshold parameter

application configuration  79
method development  158

Sample Amt parameter  348
Sample Comment parameter  109
Sample Concentration parameter  402
Sample definition view  255
Sample File parameter  400
Sample ID parameter

Batch View  305
Data Review  348

Sample Name parameter
Batch View  306
Data Review  348

Sample Type parameter
Batch View  305
Data Review  347

sample types, defined  292
Sample Units parameter  402
Sample Volume parameter  306
Sample Weight parameter  306
Save As Compound Datastore command  58
Save Changes parameter  45
Save Compound Datastore command  57
Save Compound Datastore dialog box  58
Screening Method parameter  213
Select a Custom Template parameter  108
Select a Report parameter  400
Select Batch Location parameter  99
Select Compounds from CDS parameter  117
Select Compounds to Add dialog box  117
Select File and Mass Spectrum parameter  199
Selected Reaction Monitoring  66
Send RT to Method command  364
Sensitivity parameter

Avalon
application configuration  84
Detect page  164

Genesis
application configuration  78
Detect page  158

ICIS
application configuration  81
Detect page  162

Method Template Editor  223
Separate Ion Overlay Display parameter  208
Set Chromatogram Reference Sample parameter  128
Set Ion Ratio to All Confirming Peaks in Compound 
parameter  172



Thermo Scientific TraceFinder User Guide 499

Index: T

Set Ion Ratio to All Confirming Peaks in Method parameter  
172

Set Peak Windows Settings to All Peaks in Compound 
parameter  149

Set Peak Windows Settings to All Peaks in Method parameter  
149

Set Reference sample parameter  128
Set This Mass as a New Quan Peak command  170
Set This Mass as Quan Mass command  170
Shade Row when Sample is Outside of Evaluation Criteria 
parameter  208

Shoulders On, event type  87
Show Chromatogram on Quantitation Report parameter  
208

Show Peak Info command  365
Show Quan Peaks Only parameter  179
Showing parameter, Active View  400
SIM experiment type  66
Single Ion Monitoring  66
Smoothing parameter

Avalon
application configuration  84
Detect page  165

Genesis
application configuration  79
Detect page  158

ICIS
application configuration  81
Detect page  162

Solvent Blank page, Master Method View  191
Solvent sample type, defined  292
Sort by Alphabetical command  357
Sort by Flag and Alphabetical command  357
Sort by Flag and Retention Time command  357
Sort by Retention Time command  357
Specify Default Ion Ratio Ranges parameter  223
Spectrum page, Master Method View  166
SRM data, exporting  227
SRM experiment type  66
standard reports, listed  6
Standard type parameter  174
Start Device parameter  274, 328
Start RT parameter

Times page  149
Start Threshold, event type  86–87
Start When Ready parameter  274, 328
Starting vial number parameter  333
status color codes, Sample Definition view  264
Status parameter

Active View  401
Batch View  305
Data Review  347

Stepoff Value parameter  128
Stop Active Batch command  287
Stop All Batches command  288
Stop Batch command  289
Supervisor role  47
supported file types, defined  2
supported software and hardware  ix
Surrogate page, Master Method View  192
system requirements  ix
System Shutdown Method parameter  276
System Startup Method parameter  276
System Status parameter  276

T
Tailing Factor parameter

Genesis
application configuration  79
method development  158

ICIS
application configuration  82
method development  162

Tangent Skim, event type  87
Target Ratio parameter  172
target screening reports, listed  7
Technician role  47
Template Layout parameter  333
templates

batch  254
method  216

Tension, event type  87
Theo Amt parameter  348
Theo Conc parameter

Lab Control page  193
Matrix Spike page  195
Method Val page  194
Surrogate page  192

Theoretical Amount parameter  401
Thermo Xcalibur Instrument Setup dialog box  122
Time parameter  85
Time/Event/Value parameter  84
Total Batch Rows parameter  333
Total Response parameter  401
Total Rows parameter  400
Trace parameter, Detection  155
Tune Compound parameter  199
Tune File Lifetime parameter  209
Tune sample type, defined  292
Tune/Breakdown parameter, General page  127
Tune/Breakdown sample type, defined  292
Turn Device Off command  271
Turn Device On command  270
Turn Device Standby command  270
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U
ULOL (Linearity Limit) parameter  184
Units parameter  174
Unknown sample type, defined  292
Unknown/TIC sample type, defined  292
Update Confirming Ion Ratios with This Spectrum 
command  170

Upper Limit parameter
Solvent Blank page  191

Use Alternate Calibration Report Format parameter  208
Use an Existing Raw Data File parameter  109
Use as RT Reference parameter, Identification page  134
Use Autosampler parameter  109
Use Average Scan parameter  214
Use Data Dependent Scans parameter  225
Use Full MS Scan to Confirm parameter  214
Use Genesis Algorithm for Qual Processing parameter  224
Use Method Forge parameter  102, 106
Use Only Selected Method parameter  199
Use Scan at Peak Apex parameter  214
Use the Default Template parameter  108
Use These Libraries parameter  223
user accounts, creating  40
User Administration view  40
user roles and permissions  46
user roles, defined  46
User Security parameter  90
user security, enabling  90
Username parameter  12, 45

V
Valley Rise (%) parameter

application configuration  80
Detect page  159

Valley S/N parameter
application configuration  80
method development  159

Value parameter  85
Vial Position parameter

Batch View  306
Data Review  348
Method Forge  109

View Only parameter  400
View Width parameter

application configuration  77
Times page  149

views
Batch  297
Batch/Template Selection  250
Compound Datastore  59
Data Review  345

Development Batch  235
Finish  269
Instrument  228
Local Method  413
Method  101
Project Administration  49
Report selection  265
Report View  387
Sample definition  255
User Administration  40

W
Weighting parameter

Calibration  174
Method Template Editor  224

Window parameter
Acquisition List  132
application configuration

ion ratio  77
retention time  77

Compound Datastore  60
Ratios page  172
Times page  148

Window Type parameter
application configuration  77
Ratios page  172

workflow
acquisition mode  248
general  5

X
XIC experiment type  66
XIC parameter, Signal page  154
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